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1Phoenix

1.  Quick Start Guide

1.1.  Introduction

1.1.1.  Installation

To install Phoenix, double-click the .dmg (on a Mac) or .exe (on a PC) file, and follow the installation
wizard prompts. Installation is a breeze!

1.1.2.  Licensing

Use the provided license key or tilia Cloud credentials to license Phoenix. If you were provided a 25
digit license key in the format XXXXX-XXXXX-XXXXX-XXXXX-XXXXX be sure to click the blue link on
this window. you can copy and paste the license key into the license key field.
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1.1.3.  Basic Concepts

There are some basic concepts you need to understand about Phoenix. The ones below are very brief
but help describe the concepts of the software. For more detailed info, check out Key Concepts on
page 73

Products
 

 

A Product is a piece of artwork that needs to be printed. Products come in different types, like a flat,
folded, tiled, or bound. Products also have specific properties, like quantity, height, width, and what
stock it needs to be printed on. For our guide, we’ll be working with flat products without artwork,
represented by the ‘Height’ and ‘Width’ (also known as blank size).

Layouts
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A layout is a representation of the actual printed layout or press form. Layouts are assigned a stock and
can also be assigned a press. The layouts in Phoenix are interactive, meaning you can always edit what
is on a layout to add, remove, edit, and rearrange products and production marks.

Projects
Projects are the native files that are used in Phoenix. A project consists of everything involved in that
particular order/job/project, including the products, layouts, marks, and any assigned properties.

Things, Plates and Stocks
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Phoenix creates a model of your production environment, including the presses, stocks, plates and die
cutting equipment you use. This allows your production capabilities, including costs, to be factored in
to determine the most cost effective layout and stock choices.

1.2.  Commercial Flat Work Quick Start

If you're strapped for time and just want a quick, step-by-step introduction to some Phoenix basics,
follow the Commercial Flat Work Quick Start guide below. For more info, check out the complete user
guide, or try out the search bar to find a particular term.

For this Quick Start Guide, you'll need a few files to get started. Grab those here, and we'll tell you where
to use them later on in the guide.

Name Download

Phoenix Library phoenix-library.phxlib

CSV Order orders.csv

1.2.1.  Creating your first project

Importing the Library
The first thing we need to do is to load the Phoenix library that you downloaded from above so that
Phoenix will include a sample production environment (with a predefined press and stock). Open
Phoenix, and navigate to Preferences. On a Mac, Preferences can be found in the Phoenix menu.
On a PC, go to Edit and then select Preferences. From there, click on Diagnostics, and then Import
Libraries. Select okay, choose the .phxlib file you downloaded earlier, and click OK once it's loaded.
Phoenix will close down. Open Phoenix back up, and confirm you see the ’40 Offset’ press in the ‘Things’
panel as well as ‘18pt SBS’ in the ‘Stocks’ panel (see screenshots below). If everything looks good, now
we're ready to create a project!
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Create a project
To create a new project, go to File > New project (or press Command or Control and "N"). This will create
a new project and display a prompt for what you want to name the project.

 

 

Set the filename to “test-job-smartplanning“ and leave the rest of the fields blank. These fields can be
used to add additional information to the project, but are not necessary. Now click "OK". You should
now see a blank layout like the screenshot below.
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Add Products with CSV
Now we want to add products to the project. Phoenix has the ability to import products using CSV file.
This CSV has the product parameters already predefined, making for fewer steps in Phoenix. Phoenix
can map data from the CSV into any product property (don’t worry, this is already done for you!)

To import the products, drag the orders.csv file into Phoenix to import the products (just drop the csv
file on the blank canvas in Phoenix - if anything pops up, click ‘OK'). You'll notice the parameters are all
mapped correctly, and the order quantity, name, height, width, and stock are properly assigned. You
will see the products displayed in the Products panel on the left side of the application window. You
should see the list of products in you panel similar to the screenshot below:
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Now the products have been added to the project, and we're ready to start planning!

Run Imposition AI (part1 - straight forms)
Now, Phoenix knows what stock the products need to be placed on since the information was provided
in the CSV file. Phoenix also knows your production capabilities since the press and stock is already
predefined. So, we are now ready to intelligently find the best plan.

Navigate to the Window menu at the top of the application and choose Imposition AI.

Click the "Plan" button at the top of the Imposition AI window, and then choose the following settings:

• Profiles: Single Plan

• Products: Select All

• Things: 40 Offset

• Sheets/Rolls: Select All
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Now click Run. Phoenix uses the parameters above to calculate results for the ’40 Offset' press. You
should see one result:

 

 

Double-click to apply this result.

Now you will see that Phoenix shows you the Project view. This view reports the details about the
Project with production costing and time information.

Look at the ‘Properties’ panel on the right hand side. Scroll down to the ‘Facility’ section and take a
screenshot of your screen.

Note the 'Total Cost‘ (above facility tab), 'Stock Cost' (above facility tab), 'Total Layouts’ (below facility
tab) and 'Time' (below facility tab) properties. Your results should match the results below. Make sure
your screenshot looks similar to the below screenshot:
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Run Imposition AI (part2 - combo forms)
Now, let’s let Phoenix calculate the best way to run these orders considering combo (mixed) forms.

Go back to the Imposition AI window (if you closed it, navigate to the Window menu at the top of the
application and choose Imposition AI).

Again, click the "Plan" button to make sure Plan is active at the top of the Imposition AI window, and
then change the Profile to ‘Combo Plan’. Your settings should be set as follows:

• Profiles: Combo Plan

• Products: Select All

• Things: 40 Offset

• Sheets/Rolls: Select All

 

 

Now click Run. Phoenix uses the parameters above to begin searching for the best possible plan using
the stock and press specified. Allow Phoenix to generate the results — the list is sorted by cost by
default, so the top result in the list will be the most cost-effective:
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Double-click to apply the top result after the algorithm finishes searching. Phoenix will show you the
Project view. Look at the ‘Properties’ panel on the right hand side. Scroll down to the ‘Facility’ section
and take a screenshot of your screen.

Note the 'Total Cost‘ (above facility tab), 'Stock Cost' (above facility tab), 'Total Layouts’ (below facility
tab) and 'Time' (below facility tab) properties. Your results should match the results below. Make sure
your screenshot looks similar to the below screenshot:

 

 

Run Imposition AI (part3 Combo + 56 Offset)
For the final part of the guide, we will use Phoenix to evaluate the same job running on a larger, 7-color
press.

Adding a New Press
In Phoenix, a 'Thing' (or plural 'things') is a physical object or process that is used in a production flow
when transforming a product part and/or component into a final product. A 'Thing' could be a piece of
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equipment such as a digital press or a die- cutting device, or it could be a manual resource that would
perform a task such as diemaking or hemming/sewing a banner.

Presses consist of the following:

• Speed and cost information used by estimation + ganging
• Min/max sheet constraints used by ganging
• Media template (optional)
• Gripper, sheet placement, content and image margins
• Press-specific marks (optional)

There are different types of Presses available within Phoenix:

• Digital, both Sheet-fed and Web-fed
• Offset, both Sheet-fed and Web-fed
• Wide Format, both Flatbed and Roll-fed

For the guide, we will be duplicating and modifying the existing Sheet-fed Offset Press ‘Thing’ (’40
Offset’). To duplicate the existing press, right-click on the press named ’40 Offset’ in the Things panel,
and select ‘Duplicate’

 

 

After duplicating, double-click on the new duplicated press to edit the press settings. Use the following
values to update the fields to match our new press settings:

General:

• 1. Rename the press to 56 Offset
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• 2. Change ‘Number of Units’ to 7

Costing:

• 3. Change 'Setup Layouts’ to 300 (this is for make ready sheets)
• 4. Change ‘Running Waste’ to 10.5% (scrap %)

Capabilities:

• 5. Change ‘Min Width’ to 40”
• 6. Change ‘Min Height’ to 28”
• 7. Change ‘Max Width’ to 56”
• 8. Change ‘Max Height’ to 38”

Click ‘OK‘ to save the new press settings. You will now see a new ‘Thing’ named ’56 Offset’ in the ‘Things’
panel.

Now, let’s use Phoenix to calculate the best way to run these orders considering combo forms on our
new 7-color 56 Offset press.

Go back to the Imposition AI window (if you closed it, navigate to the Window menu at the top of the
application and choose Imposition AI). Again, click "Plan" to make sure the Plan tool is active at the top
of the Imposition AI window, and set the Profile to ‘Combo Plan’. Make sure to use the ’56 Offset’ press!
Your settings should be set as follows (see screenshot):

• Profiles: Combo Plan
• Products: Select All
• Things: 56 Offset
• Sheets/Rolls: Select All

 

 

Now click Run. Phoenix uses the parameters above to begin searching for the best possible plan using
the stock and press specified. Allow Phoenix to generate the results — this one is more complicated so
may take slightly longer to find the best results; the top result in the list will be the most cost-effective.

After clicking Run, Phoenix will display results on the right side of the window. Double-click to apply the
top result after the algorithm finishes searching.

Look at the ‘Properties’ panel on the right hand side (just like the above exercises). Scroll down to the
‘Facility’ and take a screenshot of your screen.
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Note the 'Total Cost‘ (above facility tab), 'Stock Cost' (above facility tab), 'Total Layouts’ (below facility
tab) and 'Time' (below facility tab) properties.

Now that we've seen the ways to make layouts and how Imposition AI works, the only thing left to do is
export our production files.

Go to the File menu, click on "Export for Printing" and choose "Imposed PDF..." In the resulting export
dialog, choose the Factory Default PDF Export and click OK. Now choose where to save your PDF.

You can similiarly export a file for cutting if you need to create a die or send a cutting PDF, CF2, DXF, or
ZCC file downstream.

Lastly, export a PDF report of the project. Go to the File menu, click on Export Report and choose
PDF... You can modify the settings if you'd like, and then click OK to create a report. Save the report,
and then open it.

Here you can see the details of the project. On the first page you can see total run length, cost, waste,
sheet usage, and more, along with a breakdown of each layout. After the overview, there is a layout by
layout breakdown with a preview of the layout, followed by an overview of each product in the project.

1.3.  Corrugated Quick Start

If you're strapped for time and just want a quick, step-by-step introduction to some Phoenix basics,
follow the steps below. For more info, check out the complete user guide, or try out the search bar to
find a particular term.

For this Quick Start Guide, you'll need a few files to get started. Grab those here, and we'll tell you where
to use them later on in the guide.

Download these files to your desktop and unzip:

Quickstart for Corrugated Assets.zip

Contents:

1. Folder containing example artwork
2. Phoenix Quickstart Library
3. Example Order CSV file

Important:  Preserve the names and structure of the contents of this folder. Changing names
or folder structure will disrupt the flow of this guide.

1.3.1.  Creating your first project

Importing the Library
Phoenix stores configurations in Phoenix Libraries. Let’s load a pre-built library so that you can follow
along with this guide.

Open Phoenix, and navigate to Preferences. On a Mac, Preferences can be found in the Phoenix menu.
On a PC, go to Edit and then select Preferences. From there, click on Diagnostics in the left hand panel,
and then click Import Libraries.
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Select okay, choose the .phxlib file from the .ZIP file you downloaded earlier, and click OK once it's
loaded. Phoenix will close down. Open it back up, and now we're ready to create a project!

Create a project
To create a new project, go to File > New project (or press Command or Control and "N"). This will create
a new project, and prompt you for additional project information. It is best-practice to fill out the
project properties.

Set the filename to "GettingStarted" and leave the rest of the fields blank. These fields can be used to
add additional information to the project, but are not necessary. Now click "OK". You should now see a
blank layout like the screenshot below.
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Add Products
Let’s start adding products to this project. We can do this by simply dragging and dropping the
products you downloaded earlier into Phoenix.

After dragging and dropping, you will see the products displayed in the Products panel on the left side
of the window. The products have been given some default properties, so let's modify them to make
sure they're set properly.

Click on the first product to select it. Notice the Properties panel on the right side of the screen. It now
is displaying the properties for the product you have selected - things like Quantity, Stock, and Grain
Direction. Let's specify a Quantity of 400 and a Grain Direction as Horizontal.
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Product Properties with the pencil icon are editable. For a full list of product properties, see General
Properties on page 81

Tip:  Certain product properties like Grain Direction can be set to default values by navigating
to Preferences > Product and clicking on the Default Properties tab.

Change the quantity ordered and grain direction for the other products to match the first product. Note
that you can also select multiple products at once to change parameters for multiple products at the
same time. Now the products have been added to the project, and we're ready to create a layout.

PDF Spot Color and Layer Mapping
Did you notice how Phoenix automatically created a shape for our products? This happened behind
the scenes using a process called Tool Type Mapping. Phoenix is looking for inks or layers in the PDF to
define things like cut and crease lines.

You can see how Phoenix mapped the layers in our files by visiting Libraries > Tool Types... in the menu
bar.

 

 

Phoenix found inks called “Cut” and “Crease” in our example PDFs and automatically mapped those
for us. Use the Tool Types Library in your own workflow when you need to add, delete, or edit these
mappings.

Creating our first layout
Let’s start building layouts! The tool inside Phoenix for automatically generating layouts is called
Imposition AI. You can open Imposition AI by navigating to Window > Imposition AI or by using the
shortcut Command/Crtl + Shift + I.
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Your screen should now look like this:
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Before proceeding, there are four boxes at the top of the Imposition AI window labelled: Impose,
Populate, Optimize, and Plan. Make sure Plan is selected by clicking it. The box will highlight in blue.

 

 

Next, select an Imposition AI profile from the Profiles dropdox. Profiles are customizable recipes that
instruct Phoenix how to generate layouts and what rules to follow. More on these in a bit.

For this first example, select the profile called “Single Product per Sheet.”

Next, select the Products dropdown and click “Select All.” This will tell Phoenix to make layouts from
all products in the project. You could also select individual products for certain cases but for now let’s
select them all.

Up next is the Things dropdown. We will cover Things in more detail with you in training but for now, just
select the Thing called “Vutek H5.”

From the Sheets dropdown, click the “Select All” checkbox. One exciting feature of Phoenix is its ability
to select the most optimal sheet size for a set of orders. You can also select a specific size from this
list.

Finally, you can ignore the Templates dropdown for now. We can populate this list later with existing
steel rule dies that match the size and shape of our products.

To recap, your Imposition AI menu should look like this:

 

 

Click the Run button and after a few moments, Imposition AI should return one result. View this result
in more detail by clicking the (i) button. Double click the the result in the Imposition AI window to apply
this result.

27



1 Phoenix

 

 

After double clicking to apply the results, you can close your Imposition AI window or move it out of
the way. You will be looking at the job summary screen. Click the Layout tab at the top of the Project
workspace to view the individual layouts.
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Scroll through your layouts using the left and right arrow buttons or pick a specific layout by using the
dropdown list.
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Finally, export the print files as a high res PDF, cutting file as a PDF / ZCC / DXF / CFF2, and a PDF
report file. You can find all these exports in the File Menu.

 

 

Congratulations! You have created and exported your first layouts! If you are struggling at all, don’t
hesitate to reach out for help. Otherwise, let’s take things one step further.

Creating Ganged Layouts in Phoenix
The power behind Phoenix is its ability to look at different products and optimize material by ganging
things together. This reduces waste and press time.

We will continue to use our current GettingStarted project. Open the Imposition AI window again
(Window > Imposition AI) and let’s take a closer look at Profiles.

You can open an Imposition AI profile by clicking on the Profile dropdown list then clicking the pencil
icon. Open the Imposition AI profile we first used called “Single Product per Sheet.”
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There are a lot of options and rules inside of Imposition AI profiles. It’s not necessary to know them all
right now but more reading and videos on Imposition AI profiles can be found in Imposition AI on page
206

For now, let’s remove the rule that we have set limiting the number of products that appear on layout.
Uncheck the box next to the option “Limit unique products per layout.”

Let’s save this new profile with a different name.
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We have now told Imposition AI that we can mix our products to get better, more optimized results.
Let’s run Imposition AI with this new Profile selected.
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After a few moments, Phoenix starts generating a number of results sorted by cost (material + press
time). Clicking on the “(i)” button at the top right corner of each layout proposal will give you a more
detailed view of the job and each layout.

As before, you can double click the layout proposal that you want to apply and follow the previous
process to export print and cut files.

A bit about Presses, Stocks and Marks

Presses Library
Phoenix has a library of Things that include presses, finishing devices, and processes. Double clicking
on a Thing will open the configuration menu. From here, you can preset information about the Thing
such as minimum and maximum sheet sizes, speeds, margins, marks, and more.

Right clicking on a Thing in the Things panel will duplicate it. Try duplicating the Vutek H5 and playing
around with the settings to get a feel for how to make changes to the press.
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Note:

You can also set up finishing devices like conventional and digital die cutting equipment and
die creation cost. This is an advanced topic that you can read about here or cover in your full
Phoenix training sessions.

Stocks Library
Let’s add some additional stocks and stock sizes in the Stocks library. Access the Stocks library by
clicking the “Stocks” tab in the bottom left panel (it is probably currently on the “Things” tab).

Start by adding another stock to our library. When importing multiple products with different stocks,
Phoenix will automatically ensure that products end up on the correct stock!
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Let’s add a B-Flute White stock to our library. Clicking the grey “+” button will add new items to Phoenix
libraries. Start by giving this new stock a name - ideally one that correlates with your upstream
ordering system for good data consistency.

Another good practice for further automation in to select the appropriate “Stock Type” from the
dropdown list.

Add a new Grade (caliper) and fill in the Caliper and Cost information at the bottom of the dialogue.

Finally, add your available sheet sizes. Be sure to add a flute direction by specifying the “Grain” property
of the sheet. Long refers to the flutes running parallel to the larger dimension and short refers to the
flutes running parallel to the shorter dimension.

Tip:  Phoenix can also determine the optimal sheet size based on the order but more on that
during your full training.

Marks Library
Phoenix has a vast library of dynamic, “smart” productions marks that can be applied to artwork or
layouts. These marks include things like variable text, barcodes, and registration marks. While we
don’t have time to cover all the different kinds of marks and their use cases, let’s spend a bit of time
reviewing the most important marks for digital corrugated print and finishing.

First, navigate to the Marks panel by clicking the “Marks” tab in the bottom right panel. You should see a
few pre-built marks for our Quickstart Library. You can build marks from scratch by clicking the triangle
menu icon at the top left corner of the marks panel.
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From here you can browse the different kind of marks available for various applications and build them
from scratch. A full rundown of our marks and keywords can be found here:

• Marks on page 128

• Phoenix Keywords on page 249

For now, let’s just stick to the pre-built marks that we have included in this quickstart library.

One common set of marks we need for digital print and finishing are camera registration marks.
Navigate to the Marks panel and open the “Digital Finishing” folder. You should see a mark called
“Camera”. Double click this mark to open the wizard.

 

 

Browse through the wizard screen by clicking the “Continue” button. You can change these settings to
match the specifications required by your cutting table - although these default setting should work for
most common kinds of cutting tables.

We can apply these camera marks to a layout in one of two ways:

Manually drag them onto a layout we have created.

Click here to open a video on adding marks to a layout.

Or add them to a Thing as default marks. This ensures that any layout created using this Thing always
has a given set of marks. Let’s add Camera marks to the Vutek H5.
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Double click the Vutek H5 in the Things panel. Navigate to the “Media Rules” tab in the wizard. Under the
Marks window, click the “+” button and add the Camera mark.

Now any layout created for the Vutek H5 will include these camera marks!

 

 

1.3.2.  Add a little automation: Importing products from a CSV file

In this final section, let’s explore how we can speed up the process by importing products from an Excel
spreadsheet.

Instead of manually dragging and dropping PDF files, Phoenix has the capability to mass import
products from a spreadsheet. Take a look at the included .CSV file. Double clicking it will open it in
Excel or Numbers.

 

 

Notice this spreadsheet contains a row for each product we will import into Phoenix. We have a column
for Product Name, Quantity, Stock, and Artwork File.

Create a new Phoenix job. Next, drag this spreadsheet file directly into Phoenix from your finder.
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Click here to watch a video on CSV Import.

You will now see all five products import at one time with the proper Stock and Quantities already set.
From here, proceed to Imposition AI to create your layouts!

1.4.  Folding Carton Quick Start

If you're strapped for time and just want a quick, step-by-step introduction to some Phoenix basics,
follow the Folding Carton Quick Start. For more info, check out the complete user guide, or try out the
search bar to find a particular term.

For this Quick Start Guide, you'll need a few files to get started. Grab those here, and we'll tell you where
to use them later on in the guide.

Download these files to your desktop and unzip:

QuickStartFC.zip

This .zip contains:

1. Folder containing example artwork
2. Phoenix Quickstart Library
3. Example Order CSV file

Important:  Preserve the names and structure of the contents of this folder. Changing names
or folder structure will disrupt the flow of this guide.

1.4.1.  Creating your first project

Importing the Library
Phoenix stores configurations in Phoenix Libraries. Let’s load a pre-built library so that you can follow
along with this guide.

Open Phoenix, and navigate to Preferences. On a Mac, Preferences can be found in the menubar under
the Phoenix menu. On a PC, navigate to the Edit menu and then select Preferences. From there, click
on Diagnostics, and then Import Libraries.

Select OK, choose the .phxlib file you downloaded earlier, and click OK once it's loaded. Phoenix will
shut down once the libraries have been imported. Open Phoenix back up, and now we're ready to create
a project!

Create a project
To create a new project, go to File > New project (or press Command or Control and "N"). This will create
a new project, and prompt you for additional project information. It is best-practice to fill out the
project properties.
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Set the filename to "GettingStarted" and leave the rest of the fields blank. These fields can be used to
add additional information to the project, but are not necessary. Now click "OK". You should now see a
blank layout like the screenshot below.
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Add Products
Let’s start adding products to this project. We can do this by simply dragging and dropping the
products you downloaded earlier into Phoenix.

After dragging and dropping, you will see the products displayed in the Products panel on the left side
of the window. The products have been given some default properties, so let's modify them to make
sure they're set properly.

Click on the first product to select it. Notice the Properties panel on the right side of the screen. It now
is displaying the properties for the product you have selected. Let's specify a quantity of 2400.

 

 

Product Properties with the pencil icon are editable. For a full list of product properties, visit General
Properties on page 81.

Change the quantity ordered for the second carton. Note that you can also select multiple products at
once to change parameters for multiple products at the same time. Now the products have been added
to the project, and we're ready to create a layout.

PDF Spot Color and Layer Mapping
Did you notice how Phoenix automatically created a shape for our products? This happened behind
the scenes using a process called Tool Type Mapping. Phoenix is looking for inks or layers in the PDF to
define things like cut and crease lines.

You can see how Phoenix mapped the layers in our files by visiting Libraries > Tool Types... in the menu
bar.
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Phoenix found inks called “Cut” and “Crease” in our example PDFs and automatically mapped those
for us. Use the Tool Types Library in your own workflow when you need to add, delete, or edit these
mappings.

Create a layout
Let’s start building a layout by hand. Click the Layout Panel tab to view the project’s layouts.

 

 

When the project was created, a blank layout was automatically added. You can see this in the Layouts
panel as "Layout 1."

Double click Layout 1 in the Layout Panel. Your screen should now look like this:
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Notice that in the staus bar at the bottom of the window, there is no sheet size or press specified,
and it shows "None." This means that there is a layout, but no actual stock size defined, and no press
assigned. Let's fix that.

Navigate to the Things panel in the bottom left of the Phoenix window. Click and drag the CD102 press
from the Things panel onto your artboard.
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A few things happened:

1. A press is assigned. You can see this in the status bar at the bottom, where it shows "CD102"
2. A stock and sheet is assigned. This press had a default sheet assigned, which was a 40x28 sheet of

Paperboard.
3. You can also see the layout itself looks different, as we can see the plate, gripper margin, and some

default marks.

Our default sheet size is 40 x 28" but let’s change that.

Everything in Phoenix is drag-and-drop. Select the “Stocks” panel and drag a different sheet size onto
the artboard. Notice how the sheet size changes?

 

 

Now drag our 40 x 20” sheet back onto the artboard. We will continue with this size for now.
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Where did our default press settings come from?
Phoenix has a library of Things that include presses, finishing devices, and processes (more about
Things here). Double clicking on a Thing will open the configuration menu. From here, you can preset
information about the Thing such as minimum and maximum sheet sizes, speeds, margins, marks, and
more.

Right clicking on a Thing in the Things panel will duplicate it. Try duplicating the CD 102 and playing
around with the settings to get a feel for how to make changes to the press

 

 

Add your products to the layout
Back in the Products Panel, select on the first product and drag it onto the Layout.

 

47



1 Phoenix

 

Tilia Labs is a full imposition editor. Move products around, hold option and drag to duplicate, or delete
products as you please. Many of the keyboard shortcuts for Phoenix are the same as those found in
applications like Adobe Illustrator.

Creating a new Step-and-Repeat or Die Template
Let’s use Phoenix to create a step-and-repeat of a product. Delete all but one product from our
artboard.

Now, right-click on the product, or go to the Tools menu, and select “Step-and-Repeat” to show the
Step-and-Repeat panel.

You can click the “Apply” button on the Step-and-Repeat panel to create a repeat of the selected
product with the current settings.

Click the drop down and choose “Auto Fill Pack Single-Cut” to turn on Auto Apply. This will use a preset
to automatically fit as many products as can be placed on the sheet both horizontally and vertically,
using the cut path of the artwork and no gap distance. Since this artwork has 3mm bleed, change the
step distance to 3mm both horizontally and vertically.

If you'd like, play around with the other settings in the Step and Repeat tool to get a feel for what they
do.

At this point the layout is complete with one product and should look like this:
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Now let's add another product to our step and repeat. Double click on the repeat to enter the repeat
context so you can select individual items in the repeat.

Hold the SHIFT key while selecting individual products inside the step-and-repeat. Now, drag and drop
the another product on top of the selected products, but before releasing, hold down the Command
(on a Mac) or Control (on a PC) key. Now release, and you'll see that the selected products have been
replaced by the new product.
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Important:  If selecting a product in the step-and-repeat isn’t working it may be because you
have not first double-clicked on the step-and-repeat to get inside the group. Notice if you see
a blue bar at the top of the artboard. This indicates you have selected into the step-and-repeat
group.

Already have an existing die template?
Phoenix allows you to import existing die templates from CFF2 files, DXF files, or even PDF with vector
dies lines! Let’s give this a try to see how it works.

From inside our current project, navigate to the menu bar to File > Export for Cutting > CFF2...

This prompts us with the export dialogue. For now, let’s just click “OK” and save a CFF2 file to our
desktop.

Note:  Despite the fact that we are generating this example CFF2 file right from Phoenix, the
next few steps will work with any CFF2, DXF, or PDF file that was created in an external CAD
program such as ArtiosCAD or Cimex.

Next, navigate to the Templates panel in the bottom right set of panels. If you do not see a Templates
tab, navigate to the menu bar Window > Template.
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Click the small triangle icon on the top left corner of the Templates panel to open up our die import
tools. Select “Import using Die Import Wizard...”

Select the .cf2 file we just created and saved to your desktop. This will open our CFF2 in the Die Import
Wizard.

Luckily, since we created this CFF2, all the lines map perfectly! But if you needed to remap lines from a
file created in another program, notice that you can use this tool to assign line types to different tools.
Much more on the Import Dies tool here.

For now, let’s click “Done”. Notice that this adds a new die template to our die design library!

Navigate to the Layouts panel and click the triangle icon in the top left corner. Select “Add Layout”.

We now have a new empty layout. Drag your CD102 onto the artboard from the Things panel. Drag our
new die from the Templates panel onto the layout.
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From here, we can add products to the template the same way we did for the Step-and-Repeat. Simply
double click a die cavity to select it. Drag and drop products and hold the Command key (Control on
Windows) to snap into the die cavities.
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Export your project
Now that the layout is finished, we need to export it.

Go to the File menu, click on "Export for Printing" and choose "Imposed PDF..." In the resulting export
dialog, choose the Factory Default PDF Export and click OK. Now choose where to save your PDF.

Let’s also export a PDF report of the project. Go to the File menu, click on Export Report and choose
PDF... You can modify the settings if you'd like, and then click OK to create a report. Save the report,
and then open it.

Here you can see the details of the project. On the first page you can see total run length, cost, waste,
sheet usage, and more, along with a breakdown of each layout. After the overview, there is a layout by
layout breakdown with a preview of the layout, followed by an overview of each product in the project.

1.4.2.  Creating your first project with Imposition AI

Now that you have a basic overview of creating a project manually, we'll go through a much faster and
ecient method using Imposition AI.

Create a project
Go to the File menu and select New Project, or press Command + N or Control + N to create a new
project.
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Add Products with CSV
This time, instead of dragging and dropping the PDF artwork directly into Phoenix, we'll use a CSV. This
CSV has the product parameters already predefined, making for fewer steps in Phoenix. Phoenix can
map data from the CSV into any product parameter. So much more on the data you can import from a
CSV file here!

Find the provided CSV file called “orders.csv” and drag into Phoenix to import the products. You'll notice
the parameters are all mapped correctly, and the order quantity, file name, and stock are properly
assigned.

Click “OK” in the CSV import dialogue and notice that thirteen products are automatically imported
including their stock and variety of order quantities - 120,000 all the way down to 5,000.

Run Imposition AI
Now, Phoenix knows what stock the product needs to be placed on since the information was in the
CSV. It also knows your production capabilities since the presses and stocks are predefined. Phoenix is
now equipped to automatically find the best layout for you!

Navigate to the Window menu at the top of the screen and choose Imposition AI. Click the "Plan" option
at the top of Imposition AI, and then choose the following settings:

• Profiles: Use Existing Tooling - Combo Forms
• Products: Select All
• Devices: CD102
• Sheets/Rolls: Select All

Now click Run. Phoenix uses the parameters above to find the best possible layout using all the sheets
of that stock and the possible options onto our existing tooling that we imported earlier.

You can play around with other settings here if you'd like. Try running different profiles and different
presses to see what is possible!
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When you find a plan you like, click on the (i) to view more information about the result, or double click
in the Impostition A.I. window to apply.

Now you will see that Phoenix shows you the Project view, which is similar to the exported Project
Report from earlier. This shows you the details about the Project. You can navigate back to the Layout
View by clicking on the "Layout" button. This layout is still editable, so you can add or remove marks, or
change the products in the layout however you see fit.

Finally, you can export your project by navigating to the File menu and choosing Export for Printing,
Imposed PDF... as you did earlier.

1.5.  Labels Quick Start

If you're strapped for time and just want a quick, step-by-step introduction to some Phoenix basics,
follow the Labels Quick Start. For more info, check out the complete user guide, or try out the search
bar to find a particular term.

For this Quick Start Guide, you'll need a few files to get started. Grab those here, and we'll tell you where
to use them later on in the guide.

Download these files to your desktop and unzip:

QuickStartLabels.zip

This .zip contains:

• Phoenix Library (.phxlib) containing all of the Phoenix settings
• Demo Artwork Files
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• Example order csv

1.5.1.  Creating your first project

Importing the Library
Phoenix stores configurations in Phoenix Libraries. Let’s load a pre-built library so that you can follow
along with this guide.

Open Phoenix, and navigate to Preferences. On a Mac, Preferences can be found in the Phoenix menu.
On a PC, go to Edit and then select Preferences. From there, click on Diagnostics in the left hand panel,
and then click Import Libraries.

Select okay, choose the .phxlib file from the .ZIP file you downloaded earlier, and click OK once it's
loaded. Phoenix will close down. Open it back up, and now we're ready to create a project!

Create a project
To create a new project, go to File > New project (or press Command or Control and "N"). This will create
a new project, and prompt you for additional project information. It is best-practice to fill out the
project properties.

Set the filename to "LabelJob" and leave the rest of the fields blank. These fields can be used to add
additional information to the project, but are not necessary. Now click "OK". You should now see a blank
layout like the screenshot below.
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Add Products
Now we want to add products to the layout. For this first example we’ll just grab the first 6 products.
We can do this by simply dragging and dropping the first 5 pdf artwork files you downloaded earlier
onto Phoenix. As you drag the files onto the Phoenix interface, you’ll see that you have different options
depending on where you drop the files. For now, just drop the files anywhere other than the two boxes.
We’ll use the default drag and drop behavior, which is to simply add the products to the project.

 

 

Click on the first product to select it, and then find the Properties panel on the right side of the screen.
It now is displaying the properties for the product you have selected. Let's specify a quantity of 5000
and change the stock to Label Stock.

 

58



1Phoenix

 

Repeat the same steps with the remaining labels. Note that you can select multiple products at once
by shift+clicking the first and last products in a selection, or holding the control/command keys while
clicking to add to an existing selection. With multiple products selected, you can change parameters
for multiple products at the same time. Now the products have been added to the project, we have
order quantity and stock defined, and we're ready to create a layout. Notice that there are many more
product properties available to us, including bleed, grain direction, rotation, and more. For our example
these aren’t necessary to set, but they all can have an effect on the way Phoenix creates layouts and
are useful depending on your needs.

Create a layout
When the project was created, a blank layout was automatically added. You can see this in the Layouts
panel as "Layout 1." You could create another layout, but we'll stick with this one. Notice that in the
staus bar at the bottom of the window, there is no sheet size or press specified, and it shows "None."
This means that there is a layout, but no actual sheet sizes have been defined and no press assigned.
Let's fix that.

Navigate to the Things panel in the bottom right of the Phoenix window. Click and drag the HP Indigo 6k
from the Things panel onto your Artboard. This assigns the press to this layout. You can see this in the
status bar at the bottom, where it shows "HP Indigo 6k", and if you navigate back to the Project tab you’ll
see the press listed in the “Things” column.

Now let's add a stock to the layout. Navigate to the Stocks panel and find the Label Stock. For each
stock, there is one or more grades defined, and one or more sheets or rolls. For this example, the label
stock has a grade of 90 gsm and different roll widths available. Click and drag the 12.4” wide roll onto
the layout. You’ll see the layout has a size defined now, represented by a tall rectangle
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Even though the stock is defined as a roll with no set "height", the layout only shows a height of around
38 inches, or around 985mm. This is because the press assigned, the HP Indigo 6k, has a max height
defined, so Phoenix is smart enough to know that the layout created cannot exceed the max height of
the press.

Now we have our layout set up with the correct stock and press.

Add your products to the layout
Drag the “quackers-beer1” product from the Products Panel onto the Layout. Now, rotate the product
by either selecting it and typing in 90 in the rotation field in the very top right of the Phoenix window,
or by clicking and holding one of the corners of the product and rotating it interactively. Note that if
you’re interactively rotating, you can hold the shift key on your keyboard to restrict the rotation to 45°
increments.

Now right-click on the product, or go to the Tools menu, and select “Step-and-Repeat” to show the
Step-and-Repeat panel. You can click the “Apply” button on the Step-and-Repeat panel to create a
repeat of the selected product with the current settings.
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Click the drop down and choose “Auto Fill Pack Single-Cut” to turn on Auto Apply. This will use a preset
to automatically fit as many products as can be placed on the sheet both horizontally and vertically,
using the cut path of the artwork and no gap distance. Since this artwork has 1.5 mm bleed, change the
step distance to 3mm both horizontally and vertically. If you'd like, play around with the other settings in
the Step and Repeat tool to get a feel for what they do.

At this point the layout is complete with one product and should look like this:

 

 

Now let's add the other labels to our step and repeat. Phoenix allows you to easily swap out products in
a layout with drag and drop, so we’ll see how that’s done. Double click on the repeat to enter the repeat
context so you can select individual items in the repeat. You’ll see a blue bar at the top of the layout
window that indicates you’re currently looking at “Repeat 1” within the Layout.

You’ll notice that if you now click on the products, you can select an individual one instead of selecting
the entire repeat group. Click and drag to make a marquee selection that includes the all but the first
column of labels. Now, with those products selected, click on the “quackers-beer2” product in the
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products list, and drag and drop it onto your selection while holding the control/command key. When
you release the mouse, Phoenix will replace the selected products with the “quakers-beer2” product.
Repeat this process for the rest of the products so that each column of the layout has a different
product.

 

 

Now that the layout is complete, let’s look at a few things:

The status bar at the bottom now shows a cost and waste for this layout
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If you exit the context of the repeat by clicking the X in the blue bar mentioned earlier or double clicking
on a blank spot in the layout view, you’ll be able to see the properties for this layout. The properties
view now displays everything about this layout, including cost, run length, waste, and plate count. The
run length is automatically calculated, but you can change this to be a fixed number and change the run
length manually. If you do this, the cost and overruns/underruns will update dynamically.

In the Products panel, the ordered quantity is displayed as well as the total quantity as determined by
the number placed on the layout multiplied by the run length.

 

 

Export your project
Now that the layout is finished, we need to export it.

Go to the File menu, click on "Export for Printing" and choose "Imposed PDF..." In the resulting export
dialog, choose the Factory Default PDF Export and click OK. Now choose where to save your PDF.

You can similiarly export a file for cutting if you need to create a die or send a cutting PDF, CF2, DXF, or
ZCC file downstream.

Lastly, export a PDF report of the project. Go to the File menu, click on Export Report and choose
PDF... You can modify the settings if you'd like, and then click OK to create a report. Save the report,
and then open it.

Here you can see the details of the project. On the first page you can see total run length, cost, waste,
sheet usage, and more, along with a breakdown of each layout. After the overview, there is a layout by
layout breakdown with a preview of the layout, followed by an overview of each product in the project.

Save layout as a template
Now that we’ve manually made this layout, we can save time by saving it as a template for use in the
future. Navigate to the Layouts panel, where you can see a list of any layouts in the project. Since we
only have one layout, right click it, and choose Save as Template, and give it the name QuackersLabel.
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This will save the layout as a template to our Templates library for later use. You can browse all
template in the Templates panel which should be in the bottom right of your Phoenix window, or
available via the Window > Templates menu.

1.5.2.  Creating your first project with Imposition AI

Now that you have a basic overview of creating a project manually, we'll go through a much faster and
ecient method using Imposition AI.

Create a project
Go to the File menu and select New Project, or press Command/Control + N, to create a new project
and name it LabelJob-ImpositionAI

Add Products with CSV
This time, instead of dragging and dropping the PDF artwork directly into Phoenix, we'll use a CSV file.
This CSV has the product parameters already predefined, making for fewer steps in Phoenix. Phoenix
can map data from the CSV into any product parameter.

Drag the downloaded CSV into Phoenix to import the products. You'll notice the parameters are all
mapped correctly, and the order quantity, file name, and stock are properly assigned.

Run Imposition AI
Now, Phoenix already knows what stock the product needs to be placed on since the information was
in the CSV. It also knows your production capabilities since the presses and stocks are predefined. So,
Phoenix is now equipped to automatically find the best layout for you!

Navigate to the Window menu at the top of the screen and choose Imposition AI. Click the "Plan" option
at the top of Imposition AI, and then choose the following settings:

• Profiles: * Roll Labels - Lanes

• Products: Select All

• Devices: * HP Indigo 6k

• Sheets/Rolls: Select All

Now click Run. Phoenix uses the parameters above to find the best possible layout using all available
sizes of that stock that will fit the selected press and the possible options with the two presses
specified. You can play around with other settings here if you'd like, and see what a different press
could do, for example.
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Note:

Imposition AI Profiles allow you to set parameters around how Imposition AI finds results.
Feel free to click the pencil icon next to a profile name to see the available options, or visit the
documentation for Imposition AI to learn more.

One of the options within a profile is to evaluate any existing templates to see if the products
match the template and can be used. This is where you might use the template we created
earlier to automate this, if, for instance, you were trying to use the template to ensure the
products match on a particular die.

After clicking Run, Phoenix will return potential layouts on the right side of the window. You can click
on the (i) for more information about the result, or just double click to apply. Once you're ready, double-
click the top result to apply it. Now you will see that Phoenix shows you the Project view, which is
similar to the exported Project Report from earlier. This shows you the details about the Project. You
can navigate back to the Layout View by clicking on the "Layout" button. This layout is still editable,
so you can add or remove marks, or change the products in the layout however you see fit. You can
navigate to other layouts by clicking the arrows at the top of the main window, selecting a specific
layout from the dropdown menu, or navigating to the Layouts panel and choosing a layout.

Finally, you can export your project by navigating to the File menu and choosing Export for Printing,
Imposed PDF... as you did earlier.
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2.  User Guide

2.1.  Intro

User Guide
Welcome to the Phoenix User Guide. Inside, you will find a comprehensive guide to Phoenix, including
explanations of the features, settings, and UI of Phoenix, along with use cases and examples. This
documentation is designed to help you understand how Phoenix works and in the process increase
eciency, productivity, and use of Phoenix.

What is Phoenix?
In the simplest terms, Phoenix exists to increase the productivity and eciency of your print
production workflow through creating intelligent, cost-optimized layouts. Phoenix is the flagship
product of Tilia Labs and is used by hundreds of businesses worldwide to drive down costs and reduce
errors.

Application Architecture
Phoenix is a desktop application for Mac and Windows that integrates with your existing software.
Phoenix is made to be open and can easily ingest and export files and data in a variety of formats
to make integration seamless. Phoenix can also be automated through the use of hot folders and a
modern REST API, as well as integrations with CERM and Enfocus Switch.

How to read the documentation
The documentation can be consumed in a variety of ways. You can:

• read it straight through by following the links at the bottom of each page
• click directly to a topic of interest on the sidebar
• search for a term using the search bar at the top of the screen (or via the shortcut "s")

The goal is that it is easily digestible, so if you ever see something that doesn't make sense, or you think
is better explained in a different way, please let us know.

2.2.  The Basics

Built from the ground up to cut costs, Phoenix is a sophisticated open-API planning and imposition
application that uses AI technology to improve eciencies for print service providers in all sectors
including packaging, labels, commercial, and wide format printing.

Phoenix Imposition AI takes an entirely different approach to common imposition solutions.
Rather than template-driven, it operates according to machine and production requirements to
generate print-ready layouts on-the-fly. It factors in parameters such as project specifications, print
devices, finishing requirements, and delivery considerations to search across potentially millions of
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possibilities for the optimal layout. When a final option has been selected, Phoenix generates print-
ready layouts, JDF or die instructions, and reports for all devices in the production chain.

Uniting planning and prepress functions, Phoenix can be integrated into your chosen workflow or MIS
system to enable fast accurate estimates, shrink prepress time, automate error-prone tasks, maximize
media usage, and reduce postpress complexity.

2.2.1.  Modules

Phoenix is modular which enables you to pick and choose exactly what features you need for your
production environment. The features of Phoenix are separated out into the following modules:

Imposition AI
Imposition AI is the heart of Phoenix and provides intelligent planning and ganging tools. The
Imposition AI module includes four tools to heuristically find the most cost-effective way to combine
print products - Plan, Optimize, Impose, and Populate. Imposition AI evaluates millions of possible
layout options based on each unique production environment, combining the press, stock, template,
and device possibilities to find the most ecient results in a matter of seconds. Digital printers are
able to leverage ‘Just In Time’ planning to reduce waste and human intervention with shorter runs.
Conventional printers can find combination layouts on-the-fly to reduce plates, make-readies, press
time, material, and waste to print more profitably than ever before.

For more on Imposition AI, see Imposition AI on page 206.

Products Plus
The Products Plus module increases how many products Phoenix can handle for simultaneous planning
and ganging, bringing the total from 50 up to 2000 products in one project.

CAD
Essential for step-and-repeat workflows, CAD makes Phoenix the fastest and most advanced CAD-
based step-and-repeat (imposition) application in the industry.

Featuring its unique auto-alignment algorithm, Phoenix uses AI to autosnap artwork to the multi-out
die and provide instant feedback when a mismatch occurs between the artwork and die. The net result
is hours of saved preproduction time per day. Supported formats include CFF2, DXF, DDES 2/3, and
Structural PDF.

Barcodes
For print providers using barcoded product tracking right through fulfillment, this module adds support
to generate dynamic data-driven barcodes featuring vector precision for accurate scanning.

Supported formats include UPC-A, UPC-E, EAN-13, EAN-8, Codabar, Code 128, Code 39, Interleaved 2
of 5, POSTNET, and QR Code.

Braille
A specialized capability that generates dynamic data-driven braille with ADA compliance including
hardcoded size and spacing.

The default alphabet is set to US English Grade 2. Supported languages include US English Grade 1, US
English Grade 2, UK English Grade 1, UK English Grade 2, Unified English Grade 1, Unified English Grade
2, Unified French Grade 2, German Grade 1, German Grade 2, and Spanish.
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Grand Format
Indispensable for those offering a large-format print service, Grand Format increases the maximum
export size from 3.5m x 3.5m to 10m x 10m.

Scripting
Gain access to powerful scripting features to draw customized marks, set properties, automate
processes, and much more. This module exposes much of the core architecture allowing for
unprecedented customization and automation.

Automate
Phoenix Automation offers an open API platform allowing integration with any external system.
Automation options include REST Web Service, Switch Connector, Scriptable Hot Folders, and MIS
Connectors.

Warning:

The Phoenix base limits for automation are as follows:

• Phoenix base maximum number of layouts per day is 3000.
• Phoenix base maximum area export per day is 1000 m2.
• Phoenix base maximum number of Imposition AI sessions per day is 1000.

To scale for additional output, see Production Max below.

Tip:  The Automate module can be purchased multiple times as desired to meet specific
ImpositionAI concurrency needs.

Production Max
The Production Max module increases max output in automated scenarios.

Production Max increases the base Automation limits to add an additional 30,000 maximum layouts,
10,000 m² maximum export area, and 10,000 maximum Imposition AI sessions. This module can be
purchased multiple times as desired to meet specific production needs.

Note:

The Phoenix base limits for automation are as follows:

• Phoenix base maximum number of layouts per day is 3,000.
• Phoenix base maximum area export per day is 1,000 m2.
• Phoenix base maximum number of Imposition AI sessions per day is 1,000.

2.2.2.  Installation

Phoenix is packaged as a .msi installer for Windows and a .dmg disk image for Mac. You can download
Phoenix from our Downloads page.

Upgrading
Before upgrading Phoenix, please be aware of the following:
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We always recommend exporting a copy of your Phoenix Libraries before performing any upgrade. You
can export your Phoenix libraries from the Preferences > Diagnostics window.

Note:  If you’re upgrading from a Phoenix tech preview, alpha, or beta build, and you are using
Windows, you need to uninstall that version of Phoenix before installing the ocial release
build.

Windows
Open the Phoenix .msi installer and follow the installation wizard instructions.

MacOS
Mount the Phoenix .dmg disk image. In the resulting mounted installer, copy Phoenix to your
Applications directory

2.2.3.  License Activation

Phoenix can be activated with an activation key or by logging in to a tilia Cloud account. On startup,
Phoenix will check to see if you have a license and, if not, prompt you to enter your activation key or
choose to log in with tilia Cloud.

For more information on licensing, check How Tilia Labs Licensing Works on page 69.

How Tilia Labs Licensing Works
All variations of Phoenix licenses are software based. In order to activate a license an internet
connection is required. During activation Tilia Labs licensing server will be contacted over https. This
connection is secure and safe.

Once a standalone license is activated on a computer it will be locked to that computer and cannot be
activated simultaneously on another workstation. This also applies to virtual machines, which means
a single license cannot be activated on a machine and then also activated on a VM running on that
machine.

Trial License
Tilia Labs can generate trial licenses with either a trial period or a fixed expiry date. In the case of a
trial period, once the license has been activated the trial period will begin. This means that a customer
does not need to activate their trial immediately. So as an example if a customer receives a 15 days
trial license and they activate it 1 week after receiving it, it will be valid for 15 days from the time it was
activated. Fixed expiry trial licenses do not have this flexibility, and will expiry on the specified expiry
date regardless of the activation time. For all trial licenses, an internet connection is required during
Phoenix start-up to verify it's authenticity.

Partner License (NFR)
Partner licenses are essentially the same as trial licenses, with the exception that they do not require
an internet connection at start-up to verify authenticity. This is particularly useful for resellers who
perform on-site demos with a laptop and tradeshows.
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Perpetual License
Perpetual licenses are the licenses generated for purchased copies of Phoenix. During purchase an
initial expiry is usually set while payment is collected. Once payment has been received this expiry is
removed and the license can then be used indefinitely.

Use with Tilia Cloud
Tilia Cloud licenses allow you to manage, distribute, and set up licenses online. You can create an
unlimited number of users for your organization and define exactly who can and can't have access to
your licenses.

Note:

When licenses of products such as Phoenix, tilia Grin, etc., are used with tilia Cloud, an active
MSA is required at all times.

Additionally an active tilia Cloud account is required at all times.

Upgrades
For Trial and Partner Licenses, upgrades are always valid. For perpetual licenses during start-up
Phoenix will verify that the license is valid for the current version of Phoenix. If the license is not valid
for the current version of Phoenix, Phoenix will attempt to update the license by contacting Tilia Labs
servers. This process is automatic and requires no manual intervention by the user. If the license
is covered under an MSA or the server has an updated copy of the license with support for a newer
version of Phoenix, the upgrade will be successful. If the license cannot be updated for the current
version of Phoenix, the user will be required to downgrade back to their previous version in order to
continue using Phoenix.

Deactivation
Local licenses, defined as those licenses distributed as a license key and not using Tilia Cloud, cannot
be shared between multiple computers, and should be activated and used on one dedicated computer.
These licenses should be deactivated and moved to a different computer only out of necessity.

In order to deactivate a license an Internet connection is required. Once a license has been deactivated
on a given computer, Phoenix can no longer run on that workstation. This process unlocks the license
from the computer it was activated on, and the user is then free to activate the license on a different
workstation. Please note this feature is not intended as a method to allow users to periodically use
Phoenix on different machines. There is a limit to the number of times Phoenix can be deactivated.
If this limit is surpassed, the customer or reseller will need to contact Tilia Labs in order to allow the
license to be deactivated.

Computer Failure
In the event of computer failure please contact Tilia Labs to resolve the issue. We will manually
deactivate the license on the broken workstation, at which point the customer will be able to use the
same license on a new computer.

Remote Desktop
Standalone licenses are not intended for use in perpetual with remote desktop access. This essentially
allows customers to use a single standalone license as multiple licenses. We are not able to enforce
this for all remote desktop systems on the market, but it is against our policy and will violate the EULA
if customers utilize Phoenix in this way.
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Firewall/Proxy settings
If you are experiencing issues with connecting to our licensing server due to a firewall or proxy, add an
exclusion to your firewall or proxy settings to allow the following URLs on port 443:

• engine.tilialabs.com
• engine2.tilialabs.com
• engine3.tilialabs.com
• engine4.tilialabs.com
• https://cloud.tilialabs.com
• https://api.tilialabs.com
• wss://stream.tilialabs.com

Alternatively, you can set a wildcard exception for any URLs ending in tilialabs.com.

2.3.  System requirements

The requirements below are the minimum system requirements for running Phoenix 23.3. Exceeding
these requirements will, in most cases, lead to a performance increase.

Note

It is recommended that Automated Phoenix configurations be on dedicated computers on which no
other software is running for optimal performance.

Operating System
Phoenix is supported on the following operating systems:

Windows

• Windows 11
• Windows 10
• Windows Server 2022
• Windows Server 2019
• Windows Server 2016

MacOS

• 14.x (Sonoma)
• 13.x (Ventura)
• 12.x (Monterey)

Ubuntu (Automation only via REST API)

• Ubuntu 16.0.4+
• Debian 8+

CPU Requirements

Phoenix Configuration CPU RAM

Phoenix 2 processor cores (x86-64) 8 GB (16 GB for Products Plus)

Phoenix + Automate 4 processor cores (x86-64) 16 GB

+1 Concurrency 4 processor cores (x86-64) 24 GB
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Phoenix Configuration CPU RAM

+2 Concurrnecy 6 processor cores (x86-64) 32 GB

+4 Concurrency 10 processor cores (x86-64) 36+ GB

Note:

As a general rule:

4 cores and 10 GB is considered to be a base performance layer. 3 GB of RAM is expected to be
available per extra core for regular processing.

Hard Disk
• The installation takes up 2 GB of disk space.
• 100GB free space is required, 200GB recommended for Phoenix + Automate
• Take into account the need for storage of temporary and production data.
• A back-up solution is strongly advised.

Network
• 10/100/1000 Base-T Ethernet, TCP/IP v4 protocol. TCP/IP version 6 is not supported.

Graphics
• Minimum 1280 x 1024 screen resolution, true color depth.

Virtualization
Phoenix supports virtualization on:

• VMware ESX
• Microsoft Hyper-V For Phoenix client, Parallels Desktop or VMware Fusion is supported, but please

be aware that Tilia Labs does not test all combinations of OS X or macOS and Parallels Desktop/
VMware Fusion.

File Server
All Tilia Labs applications running on Windows or Mac OS can use data that is available on network
shares.

Additional Notes
Installing and using Tilia Labs software on a Terminal Services or Remote Desktop Services server
(Microsoft, Citrix,...) is not supported, except if licenses are being administered via Tilia Cloud (paid
option).

Warning:

It is against the Tilia Labs Inc. EULA to use Remote Desktop to access Tilia Labs software
without a Tilia Cloud subscription. Please contact us with any questions.

Although we don't expect issues with Microsoft OS patches, Tilia Labs only guarantees support on the
ocial MS Service Pack (SP) level, not on individual OS patches. Please contact Tilia Labs support in
case of specific questions.
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Tilia Labs software will only work with properly licensed versions of operating systems and other
software. Tilia Labs is not responsible for any loss of functionality due to use with unlicensed software.
Tilia Labs will not provide assistance in installing software on equipment lacking properly licensed
software.

2.4.  Key Concepts

To fully understand how to Phoenix works, there are a few key concepts we need to discuss and define.
Nearly Everything in Phoenix is built around the idea of Products and Costing.

First, products are the artwork items that can be placed on a Layout. There can be one or more layouts
within a Project.

Next, nearly everything with in Phoenix can have a cost associated with it to be used for estimating as
well as making decisions based on cost. We can associate costs with Things (like a press or finishing
device), Consumables (like stocks and plates), and Tooling (such as thru-cut or creasing). So, for
example, Phoenix can intelligently decide that it may be cheaper to use Press 1 and stock size A instead
of Press 2 and stock size B because it is cheaper (when combining press costs, finishing costs, and
stock costs).

Let's dive into more specifics on each of these concepts.

2.4.1.  Products

A Product is the fundamental building block of any project in Phoenix. Simply put, in Phoenix a product
is the unique postcard, sign, carton, label, artwork, etc... that needs to be printed. Products are the
reason for Phoenix - the item you need to produce is a product.

Every instance of a product in your project will have the same front and back side artwork, marks, and
die design. Any change made to a product is propagated to all instances of that product in your layout
automatically. The Product is also where all the parameters for a product is stored, such as the ordered
quantity that need to be fulfilled, grain direction, stock, spacing, bleed, and so on.

For a given product, the following aspects will be the same across all instances placed in the project:

• Die design including all cut and crease lines.
• Artwork for front and back of product including artwork offset within the die.
• Marks including mark positions within the die.

Whereas the following aspects can be customized for each instance:

• Bleeds. Product instances will have the same bleed as defined by the product by default but each
instance's bleed path can be changed independently from the Artboard Toolbar, the Overlap Tool, or
by directly editing the bleed with the Edit Bleeds tool.

• Mark visibility. Turning off visibility of a mark in one instance of a product does not affect other
instances.
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Products can be edited in the Product View or directly within the Layout View by drilling down into
product context.

2.4.2.  Layouts

A Layout is the arrangement of Products in Phoenix, and is a representation of how the products will
eventually be printed our output on either a sheet or roll. Each Phoenix project will contain one or more
layouts and all layouts in a project can be viewed in the Layouts panel (Window > Layouts).

When a new project is created in Phoenix, a layout is created for the project. To see the layout, click
the Layout view button, jus t under the project tab. You can select a different layout by clicking on
the layout selection dropdown, or by double-clicking the desired layout in the Layouts panel. You can
create a new layout from the layout selection dropdown, or from the dropdown menu in the Layouts
panel.

By default, a layout doesn't have a stock defined. A stock can be added to a layout through drag-
and-drop from the Stocks panel, or can be automatically assigned when a layout is created through
Imposition AI.

2.4.3.  Projects

A project is the native file type of Phoenix, and was formerly called a "job" in prior versions. Everything
in Phoenix is based on a project. Projects are typically based on a customer order, and can contain
one or many products and one or many layouts. To create a new project, navigate to the File menu and
select "New Project" or use the keyboard shortcut Command + "n" (on a Mac) or Control + "n" (on a PC).

Projects contain everything about the order, including products, layouts, marks, and all of the
associated parameters, such as product order quantity, or layout sheets. A Phoenix project can be
saved to the .phx file format, and reopened later. You can optionally save the artwork in a project file by
enabling the preference "Embed artwork in project save" in the Preferences > Project menu.

2.4.4.  Things

Phoenix models your production environment and includes the "things" in your production
environment. A Thing could be a Press, a Finishing Device, or Die Making. You can read more about
Things and the various types of Things in Things on page 104.

2.4.5.  Tooling

Tooling refers to any process that needs to be performed before a project is complete.

Tooling could include cut or crease lines, varnish or coating inks, embossing/debossing, glueing, and
many other configurable processes. The inks within a product are used to describe steps in a process
chain that require additional inline or nearline steps to create the finished product.
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Mapping Tool Types is an integral part of Phoenix to capture all neccessary costing of a product to be
used with the ImpositionAI module.

2.4.6.  Consumables

Consumables refer to the materials used in the process of making a project. Phoenix includes costing
breakdowns for Inks, Stocks, Die Templates, and Plates (if a convential printing press is used).

Ink costing is specified at the press level. For each press, Phoenix allows you to customize the costing
of inks using either a Click-based ink cost or a Coverage-based ink cost. You can also model the ink
costs using different print 'Modes' for each press (for example, the EPM mode on an HP Indigo press may
have a $0.00 click cost for the black ink)

Stocks are the material on which the project will be produced, such as a sheet or roll of paper or
corrugate. More can be found on Stocks in Configuration on page 103

Plates are the medium that transfers ink to the stock in offset and flexo printing. Plates are necessary
to model in Phoenix for costing as well as ensuring correct product and sheet placement in a layout.
More can be found on configuring Plates in Phoenix in Configuration on page 103

2.5.  Products

Products are the fundamental unit in Phoenix. Below, we go in depth into the various types of products
in Phoenix, how to create products, setting properties, and importing products from a CSV file.

2.5.1.  Types of Products

Phoenix understands that different products serve different purposes for various market segments,
and as such have different properties based on how they are produced. The product types are:

Flat Bound Folded Tiled

Flat
A 'Flat' product type (flatwork) in Phoenix is any non-bound, non-folded product or a product that only
contains packaging folds. A 'Flat' product can consist of one or two pages (front only or front & back).

Examples include (but not limited to): business cards, postcards, leaflets, flyers, posters, folding carton,
corrugated, banners, labels, shrink-sleeves, etc...
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Bound
A 'Bound' product type in Phoenix is any product which will contain many pages that are printed using
mulitple printed signatures (sheets) which are gathered and bound together to create a finished
booklet.

Folded
A 'Folded' product type in Phoenix is any product which will contain many pages that are printed using
one printed signature (sheet) which is folded to create the finished booklet.

Examples include (but not limited to): folded flyers, brochures, 4-page single fold or half fold, tri-fold or
letter fold, z-fold, gate folds, etc...

Tiled
A 'Tiled' product type in Phoenix is any product which will require tiling of the graphical element. Tiling
is common for large-format or wide-format graphics where the finished product exceeds the size of
the printer and/or cutting equipment. A 'Tiled' product in Phoenix makes the printing process easier by
ensuring your overlaps/gaps/bleeds will be correct, plus there’s no need to create a separate file per
tile as there is when you use Photoshop or Illustrator.

2.5.2.  Creating Products

Products can be created in multiple ways:

• Defining die dimensions (New Empty Product)
• From PDF or AI artwork
• From CAD file
• From the Die Design Library
• From CSV file
• By dragging and dropping artwork files into Phoenix
• Automatically, using a hot folder, 3rd party integration, or via the Phoenix API

New Empty Product
Products can be created by simply defining the width and height. This is referred to as an Empty
Product, with no artwork specified. This is particularly useful for creating layouts with placeholder
shapes before you have the artwork, or to create a reusable layout template where artwork can be
replaced at any time.

To create an empty product, go to the File menu, find the product type for which you want an empty
product, and then select the corresponding Empty… option.

Alternatively, select one of the New ... Product options from the Product Panel action menu (upper left
corner of panel) and then choose Empty

When selected, the New Empty Product dialog will appear, where the dimensions and select properties
of the product are defined

Field Description

Name Unique name of this product.
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Field Description

Quantity Order Quantity needing to be fulfilled for this product.

Due Date (Optional) The date the product is due.

Stock Stock this product is to be printed on.

Grain Grain direction required for this product: Horizontal, Vertical
or None. Grain direction and current sheet grain are used to
determine product orientation the ganging tools.

Width Width of product die.

Height Height of product die.

Bleed Bleed offset from rectangular die defined by Width and Height.

When you are done click the OK button. You can assign artwork, changed the bleed, change the die line
and more in Product View. You can also edit properties by selecting the product in the Product Panel
and editing the properties in the Properties Panel.

New Product from Artwork
Products can be created directly from PDF and AI artwork files, as well as from image files. Products
can be created from a "New Product" dialog in the File menu or the Products panel. In addition, flat
products can be created by dragging and dropping into the file into a layout. By default, for PDF files
the PDF Trim Box is used to create a rectangular die line of the new product and the first page is
assigned as the front side artwork of the new product.

In Preferences > Product you can change the default behavior to automatically set die design from
Line Type mappings. After creating the product, you can set the die line to spot colors in the artwork by
going into Product View and selecting the cut and optionally crease line spot colors.

For image-base file types such as TIFF, PNG, BMP, JPG, and GIF, the dimensions of the image are used
to create a rectangular die line for the new product. If the artwork file contains exactly two pages, the
second page artwork is automatically assigned to the back side of the product. This default behavior
can also be changed in Preferences > Product by editing the Page Handling options.

Using New Product from Artwork Dialog
To create a new product from artwork using the New Product from Artwork Dialog, go to the File menu,
find the New ... Product flyout menu for the product type you are wanting to create, and then click the
corresponding "From Artwork... button.

Alternatively, select New ... Product for the desired product type from the Product Panel action menu
and then click From Artwork... (upper left corner of panel).

Once selected a file dialog will appear. Select the artwork file you wish to import and click OK. Once
the artwork has been loaded you will be presented with a dialog allowing you to define select product
properties.

Field Description

Name Unique name of this product.

Quantity Order Quantity amount needing to be fulfilled for this product.

Due Date (Optional) The date the product is due.
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Field Description

Stock Stock this product is to be printed on.

Grain Grain direction required for this product: Horizontal, Vertical
or None. Grain direction and current sheet grain are used to
determine product orientation the ganging tools.

Width Width of product die.

Height Height of product die.

Bleed Bleed offset from rectangular die defined by Width and Height.

Using File Drag-and-Drop
Products can also be created from artwork by dragging the artwork into Phoenix from the desktop or
file explorer. The overall behavior is the same as creating product from dialog with ordered amount
and grain direction set to default values from the Products section in Preferences (Edit menu). Product
name will be generated from the file name of the dropped in artwork file.

Pressing Alt / Option key during artwork drop will cause Phoenix to look through the existing list of line
type mappings in preferences to automatically create the product die design based on spot inks and
PDF layer paths in the artwork.

New Product from CAD
Module: CAD Products can be created from CAD files. Phoenix supports CFF2, DDES2, DDES3 and DXF
CAD formats. Select a 1-up design within a CAD file using the New Product from CAD dialog or drag-
and-drop a CAD file into Phoenix to automatically create products for each unique 1-up in the CAD file.
If a CAD file contains lines mapped to bleed, a bleed mask will be created from the CAD bleed lines,
otherwise a bleed is generated as an offset from the CAD cut lines using the Default Bleed defined in
the project.

Using New Product from CAD Dialog To create a new product from artwork using the New Product
from CAD Dialog, go to the File menu and select New Product from CAD.

Alternatively, select New Product from Artwork… from the Product Panel action menu (upper left
corner of panel).

Once selected a file dialog will appear. Select the CAD file you wish to import and click OK. Once the
CAD file has been loaded you will be presented with a dialog allowing you to choose the 1-up design you
want to use as well as CAD line mappings and product properties.

Field Description

Die Name of 1-up die within CAD file to use to create new product.

Name Unique name of this product.

Quantity Order Quantity amount needing to be fulfilled for this product.

Due Date (Optional) The date the product is due.

Stock Stock this product is to be printed on.
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Field Description

Grain Grain direction required for this product: Horizontal, Vertical
or None. Grain direction and current sheet grain are used to
determine product orientation the ganging tools.

Preset CAD Import preset to use to define line mappings such as cut,
crease and bleed. For well- defined CAD formats like CFF2 and
DDES, most often the default presets will correctly map line
types. CAD files from certain applications and the DXF format
in general can contain non-standard line types that need user-
defined mappings to correctly import the 1-up design. User
defined presets are a simple, powerful way to define the line
mappings from a specific client or application to reuse again in
the future.

Line Mappings Table of line type mappings used to map lines to cut, crease
and bleed lines in the product. Line mappings can be added,
removed or edited with the icons below the line mappings table.
Line mappings can also be defined directly in the interactive
preview pane on the left by right clicking on a line and selecting
the appropriate line type from the context menu.

Save Preset To save the current line mappings as a preset to reuse again
in the future either here or in the Die Import Wizard, click this
button and enter the name you would like to save the preset
as. If using an existing preset name, you will be prompted to
confirm you would like to override the existing preset.

New Product from Die Design
Choose a 1-up die design that has already been imported into the Die Design Library to create a product
from.

Using the New Product from Die Design Dialog

To create a new product from Die Design using the New Product from Die Design Dialog, go to the File
menu and select New Product from Die Design.

Alternatively, select New Product from Die Design… from the Product Panel action menu (upper left
corner of panel).

In the Dialog, Select the die design you want to use and specify the properties.

Field Description

Name Unique name of this product. By default, die design name is
populated in this field.

Quantity Order Quantity amount needing to be fulfilled for this product.

Due Date (Optional) The date the product is due.

Stock Stock this product is to be printed on.
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Field Description

Grain Grain direction required for this product: Horizontal, Vertical
or None. Grain direction and current sheet grain are used to
determine product orientation the ganging tools.

2.5.3.  Autosnap

Autosnapping artwork into a product die or die template is one of the most powerful features in
Phoenix. Autosnap handles a wide range of scenarios such as mismatched rotation, non-centered
artwork, incorrect Trim Box sizes, etc., providing perfect placement of artwork in the product die for a
vast majority of cases.

The normal way to autosnap artwork into a die is by clicking on the Choose Artwork button in the
Product View or Layout View toolbar.

A shortcut for snapping artwork into the die is to hold down the Control key while dragging and
dropping the artwork file into the desired side (Front or Back) in Product View or in Layout View. If
Control key is not held down, a new product will be created from the artwork.

When in Layout View, the artwork being dropped into Phoenix will be snapped into all selected product
or die template items in the Artboard. If all instances of a product are selected, artwork will be snapped
into the existing product. In cases where a subset of all product's instances are selected, the following
steps take place automatically:

1. A new product will be created using the name of the artwork file by duplicating the existing product.
2. The artwork will be autosnapped into this new product.
3. Selected product or template items in the Artboard will be replaced by instances of this new

product.

If you are drilled into the context of a product instance in Layout View, you are editing the product itself
and behavior is the same as in Product View.

Also note, if you are snapping to the Front of the product or template item and the given artwork has
two pages, the first page automatically snaps into the Front of the product while the second page
snaps to the Back of the same product. If you need to snap different pages of the artwork file to the
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given side(s) of a product, click on the Choose Artwork button down arrow to open the Page Mapping
dialog.

2.5.4.  General Properties

Bleed
To change the bleed settings for individual product (or multiple products at one time):

1. Click to select the Product (or Products) you wish to modify
2. Look to the right side of the window to find the Product Properties sidebar
3. Scroll down to find the Bleed Type setting. This allows you to choose how you want bleed in this

product

• None - no bleed will be allowed for the selected product(s)
• Contour - bleed will be specified as a distance from the contour
• Margins - bleed will be specified as a distance from each side of the product. This should only be

used with rectangular products.
4. Adjust the Bleed Type option to your preferred setting
5. Click on the existing values to modify the bleed values, then click away or press Enter/Return to

accept the setting.

Other Properties

Property Description

Type Type of product

Name Unique name of the product

Color Color to use to represent the product in Phoenix. This color is
not printed, but only a representation within the UI to identify the
product, and will also be displayed in an exported project report

Index Index of the product within the project

Description Optional product description

Notes Optional notes to associate with product

Quantity Number of product ordered in the project, also referred to as
ordered quantity

Due Date Product due date

Group Optional product group used in Imposition AI

Priority Optional priority of product starting from 1 as highest priority

Min Overruns Minimum overrun percentage allowed for the product

Max Overruns Maximum overrun percentage allowed for the product
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Property Description

Bundle-size Bundle size needed for product. When set, Imposition AI tools
will ensure layouts including this product will have run length
multiples of this bundle size

Placed The number of products placed on a layout

Total The total number of products produced when the project is run
the specified number of times in the project run length

Overrun The number of overruns of the product

Overrun % The overrun percentage, calculated as total / quantity

Stock Stock of product

Grain Direction Grain direction of product ('Horizontal', 'Vertical', 'Consistent',
'None')

Processes List of processes the product will route through which controls
process-specific behavior. For example 'Printing, Cutting'

Mode When clicking on 'Process Setting', Mode is the name of Mode to
run the given process at

Mode Value When clicking on 'Process Setting', Mode Value is the specific
mode value to run the given process at

Rotation Rotation type to allow in product, defaults to Product Settings
defaults unless allowed-rotations is defined in which case
'Custom' rotation type is assumed = ['Any', 'Orthogonal', 'None',
'Custom']

Allowed-rotations Allowed rotations of product when rotation type is 'Custom'

Templates List of templates this product can be used with

Component Type Type of product component: flat, tiled, bound, folded. For
example, a 32 page bound product with an F16-7 folding pattern will
be made up of two bound components (2x F16-7 signatures)

Part Product parts that make up this product

Width Width of product when creating a custom size product or the
desired scaled width or scale percentage when creating the
product die from a die design or artwork

Height Height of product when creating a custom size product or the
desired scaled height or scale percentage when creating the
product die from a die design or artwork

Double-sided If product is two-sided (Boolean)

Bleed-type Product bleed type = [Margins, Contour, Cad, or None] =
['Margins', 'Contour', 'CAD', 'None']

Bleed Margin Scalar offset from die design to generate bleed

Bleed Margins Four sided bleed margins when bleed type is Margins
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Property Description

Spacing Type How products should be spaced. Choose from Margins, Uniform
Spacing, Spacing from Bleed, or Spacing from Tool

Spacing Margin Single scalar spacing offset when spacing type is Uniform

Spacing Margins Four sided spacing margins when spacing type is Margins

Offcut Margins Four sided offcut margins

Die Type Die design typeAllowed: Rectangle, Irregular, Open

Die Name Name or 1-up die

Die Source Name of the source file for the dieline

Die Path Local path to the die source file

2.5.5.  Product Inks

Phoenix will automatically find the inks in a product and display them in the Ink Panel. Inks are a
fundamental part of how Phoenix works, so let's take a closer look at how this all works.

Ink Mappings
First, there are different types of inks, such as Normal inks (process or spot color printing inks),
Coatings, Technical, and so on. The ink types are set based on the Ink Mappings set in the Preferences.
You can also set the ink type manually by right-clicking on the ink type in the Inks panel. Phoenix will
use this ink type to determine what presses and devices are capable of producing the product when
using Imposition AI.

Tool Type Mappings
In addition to Ink Mappings, Phoenix uses Tool Type Mappings. Tool Types represent any tooling to be
done on a product, such as die cutting, creasing, or scoring. You can learn more about Tool Types and
how they are configured in Tool Types on page 167

Automatic Ink Coverage Calculation
Phoenix 8.0 also introduces Automatic Ink Coverage Calculation. Phoenix auto-computes ink coverage
percentages in product artwork by rasterizing each separation of the artwork and analyzing the raster
data. This new feature is controlled via the new Color Analysis property in each product page. By
default, Color Analysis is set to Fast which analyzes the artwork content stream without rasterizing
in the same way as previous versions of Phoenix. When Color Analysis is set to Raster, the new
separations raster algorithm automatically computes ink coverages in that page’s colors list and
removes any colors that are not output. An additional Color Detection property is also available in
Raster mode which controls whether colors are detected only within the cut shape of the product or
within the bleed area as well. The new Color Analysis property can be set to Raster by default if desired
via product preferences for each product type.
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Ink Coverage can be used to calculate much more accurate project costing and lead to more accurate
Imposition AI results. Simply make sure you have your press configured to have an Ink Cost based on
ink coverage in the Operation Properties on page 108.

2.5.6.  Product CSV Import

Importing Products from CSV allows you to create several products at once. Define multiple products
manually in Excel or similar application to save significant time or export product order information
already stored in your MIS system and import directly into Phoenix. All product fields such as dieline,
bleed offset, spacing, stock, and order amounts can be defined in the CSV file.

Use the predefined column heading names or create your own custom presets to map spreadsheet
columns to product fields. Column name and column number mappings are both supported, allowing
you to import CSVs from any pre-defined third-party column format.

To import products from a spreadsheet (csv), go to the File menu and select Import Products…

Alternatively, you can select the same action from the Products Panel menu by clicking on the button
in the upper-left corner of the panel.

You will be prompted to select a CSV file, after which you can define column to product field mappings.

Note:  Phoenix also supports copying and pasting of spreadsheet data directly into a project!
You can copy data from a spreadsheet (i.e. Excel, Numbers, .csv text, etc...) and paste in a
project to import spreadsheet data without having to save a file and import it or drag and drop
into Phoenix.

2.5.7.  CSV Product Import Fields

Columns in your CSV spreadsheet will be mapped to product fields. The following table lists all
supported product fields you can define in your CSV files.

Note:  At a mimimum, you must have Height and Width specified (which will create an empty
product), or Artwork File specified. Otherwise, Phoenix will not be able to create a product. All
other fields are optional.

Field Name Field Type Description

Allowed Rotations Comma delimited list
of numbers

Allowed rotations of product used for ganging when
Rotation is set to Custom or is not specified. If
Rotation is set to a value other than Custom, this field
is ignored.

Example: 0, 90

Default: None

Artwork File Path Relative or absolute path to PDF or AI file containing
artwork for product.

Example: "artwork/prd-29211.pdf"
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Field Name Field Type Description
Example: "C:\Users\cliff\prd-29211.pdf"

Default: None

Artwork Page
Number

Number If artwork file is defined, the page number of artwork
to use on front side of product.

Example: 4

Default: 1

Autosnap Ink Spot Color Name When present, specified ink name will be used when
autosnapping front artwork into product die. If not
specified, Phoenix will attempt to automatically
detect the correct cut line ink.

Example: TiliaCut

Default: None

Autosnap Layer PDF Layer Name When present, specified PDF layout name will be used
when autosnapping front artwork into product die.

Example: Cut

Default: None

Back Artwork File Path Relative or absolute path to PDF or AI file containing
artwork for back of product.

Note:  If Artwork File is defined and back side
artwork comes from same file, you do not
need to re-enter the same path in this field.

Example: "artwork/prd-29211.pdf"

Example: "C:\Users\cliff\prd-29211.pdf"

Default: None

Back Artwork Page
Number

Number If artwork file or back artwork file is defined, the page
number of artwork to use on back side of product.

Example: 4

Default: 1

Back Autosnap Ink Spot Color Name When present, specified ink name will be used when
autosnapping back artwork into the back side of the
product die. If not specified, Phoenix will attempt to
automatically detect the correct cut line ink.

Example: TiliaCut

Default: None
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Field Name Field Type Description

Back Autosnap Layer PDF Layer Name When present, specified PDF layout name will be used
when autosnapping back artwork into back side of the
product die.

Example: Cut

Default: None

Back Colors Text Comma-separated list of back colors for back side of
flat products

Example: Cyan, Magenta, Yellow

Default: None

Back Color Values Text Comma-separated list of back color values

Example: 100 0 0 0, 0 100 0 0, 0 0 100 0

Default: None

Back Color
Coverages

Text Comma separated list of back color coverages ranging
from 0.0 to 100.0

Back Color
Processes

Text Comma separated list of processes the back colors
represent

Default: Printing

Back Color Types CMYK, Lab, RGB Comma separated list of types of back colors

Back Inks Comma delimited list
of ink names (text)

If specified, this list is considered to be the ocial
printing inks for the back side of the product. Used
during ganging and estimation to determine how many
colors/plates are needed for a given layout. When not
specified, all normal inks from the back-side artwork
are considered the printing inks.

Example: Black

Default: None

Back Marks Comma delimited list
of marks (text)

Optional product marks to apply to the back side of the
product

Bleed Bottom Scalar3
Distance of bleed from the bottom of the die shape. If
Bleed also defined, this value overrides Bleed value on
bottom side. This field is ignored when Bleed Type is
not Margins

Example: "3mm"

Default: None
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Field Name Field Type Description

Bleed Ink Spot Color Name [Deprecated, could be removed in a future release. Use
Die Design Source or automatic line mappings instead].

If front artwork specified, spot color ink name
specified here is used to define product bleed mask.

Example: TiliaBleed

Default: None

Bleed Layer PDF Layer Name [Deprecated, could be removed in a future release. Use
Die Design Source or automatic line mappings instead].

If front artwork specified, PDF layer name specified
here is used to define product bleed mask.

Example: Bleed

Default: None

Bleed Left Scalar3
Distance of bleed from the left of the die shape. If
Bleed also defined, this value overrides Bleed value on
left side. This field is ignored when Bleed Type is not
Margins.

Example: "3mm"

Default: None

Bleed Right Scalar3
Distance of bleed from the right of the die shape. If
Bleed also defined, this value overrides Bleed value on
right side. This field is ignored when Bleed Type is not
Margins

Example: "3mm"

Default: None

Bleed Top Scalar3
Distance of bleed from the top of the die shape. If
Bleed also defined, this value overrides Bleed value on
top side. This field is ignored when Bleed Type is not
Margins

Example: "3mm"

Default: None

Bleed Type Margins, Contour,
CAD, None

Bleed Type of Product. If not specified bleed type is
automatically determined based on these rules: If die
design comes from CAD or artwork inks/layers and
there are Bleed line types, bleed type is CAD. If the die
design is defined from width and height dimensions or
from PDF TrimBox

defaults to Margins, otherwise Contour.
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Field Name Field Type Description

Bleed Scalar3
Offset from die-line to create bleed mask. When Bleed
Type is Margins, all four sides will be set to this value
and overridden by individual side spacing below.

Example: 0.25"

Default: Current job's Default Bleed value

Binding Edge Top, Bottom, Right,
Left

Page binding edge for bound work

Binding Method SaddleStitch,
PerfectBound, None

Optional binding method for bound work

Bundle Size Number The allowed multiples of the product that can be
produced. When set, ganging tools will ensure layouts
including this product will have run length multiples of
the bundle size

Example: 1250

Default: None

CAD Design Name CAD File 1-up Name If CAD File defined and CAD file contains multiple 1-up
designs, name of 1-up design to use to define product
die.

Note:

Requires CAD Module

Example: "Design 29211"

Default: First 1-up design in CAD file

CAD File Path Relative or absolute path to CAD file containing cut
and crease lines to define product die.

Note:  Requires CAD Module

Example: "cad\prd-29211.cf2"

Example: "/home/cliff/cad/prd-29211.cf2"

Default: None

Color RGB color hex value Product color to display in Products panel, PDF report,
and artboard when artwork is not present or visible.

Example: FFB200

Default: None

Colors Text Comma-separated list of colors for front side of flat
products
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Field Name Field Type Description
Example: Cyan, Magenta, Yellow

Default: None

Color Values Text Comma-separated list of front color values

Color Coverages Text Comma separated list of front color coverages ranging
from 0.0 to 100.0

Color Processes Text Comma separated list of processes the front colors
represent

Default: Printing

Color Source Artwork, Specified Specify how to set up colors for each page

Crease Ink Spot Color Name [Deprecated, could be removed in a future release. Use
Die Design Source or automatic line mappings instead].

If front artwork specified, spot color ink name
specified here is used to define product crease lines.

Example: TiliaCrease

Default: None

Crease Layer PDF Layer Name [Deprecated, could be removed in a future release. Use
Die Design Source or automatic line mappings instead].

If front artwork specified, PDF layer name specified
here is used to define product crease lines.

Example: Crease

Default: None

Creep None, Inward,
Outward, Both,
Custom

Type of creep to apply to bound signatures

Creep Amount Scalar3
Amount of creep to apply which can be total or per-
sheet amount based on the calculation mode

Example: .0625in

Default: 0in

Creep Calculation From Stock, Per
Page, Total

Creep calculation mode to use to determine creep
amount to apply

Example: Total

Default: Per Page

Creep Method 5 Offset, Scale Creep method to use for performing creep on bound
signatures.Page content may get trimmed in finishing
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Field Name Field Type Description
due to pages pushing out when the sections get
folded. You compensate for this issue by applying
creep settings on the Product so each page image
area shifts Inward/Outward from the Spine to
decrease/increase the Spine Trim/Face Trim, without
affecting content. If you want to maintain the Spine
Trim and Face Trim gutters, you can choose to Scale
the pages instead of Offsetting them.

Example: Scale

Default: Offset

Creep Transition String (percentage) Percentage from the inner most signatures towards
the spine when to change creep direction from inward
to outward when using 'Custom' creep type

Example: 40%

Default: 50%

Cut Ink Spot Color Name [Deprecated, could be removed in a future release. Use
Die Design Source or automatic line mappings instead].

If front artwork specified, spot color ink name
specified here is used to define product die design
shape and internal cut lines.

Example: TiliaCut

Default: None

Cut Layer PDF Layer Name [Deprecated, could be removed in a future release. Use
Die Design Source or automatic line mappings instead].

If front artwork specified, PDF layer name specified
here is used to define product die design shape and
internal cut lines.

Example: Cut

Default: None

Description Text Optional notes related to the product visible in product
properties and <product.description> mark keyword.

Example: "Company X juice label Spanish"

Default: None

Die Design Name Die Design Library 1-
up Name

The name of the 1-up design stored in the Die Design
Library including any parent folders separated by
forward slashes ("/").

Example: "Cartons/DIE-126B"
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Field Name Field Type Description

Die Design Source4 ArtworkPaths,
ArtworkTrimbox,
CAD,CustomSize,
DieDesignLibrary

Defines the source of the die design for the product.

If ArtworkPaths is used, line type mappings in
Preferences will be matched with spot colors and
layers in the artwork PDF to find the die design and
various die lines, falling back on PDF Trimbox if no
matches are found.

If ArtworkTrimbox is used, the PDF Trimbox alone is
used for die design.

If CAD is used, the CAD file defined in this row is used
for die design.

If CustomSize is used, the Width and Height fields in
this row are used for die design.

If DieDesignLibrary is used, the die design defined
in the Die Design Name CSV field specifies the 1-up
design from the DieDesign Library to use.

Due Date Date Format Due date of product. This field is used by the Plan
ganging tool to organize layouts by due dates and also
as a property for reporting and mark keywords

Example: 2016-10-31

Default: None

Face Trim Scalar3
Face trim amount in bound signatures

Example: .0625in

Folding Patterns List Comma separated list of folding patterns for a bound
product. Phoenix will create the signatures largest
(outter signatures) > smallest (inner signature) from
the list of specified folding patterns.

Example: F16-8,F4-2

Example (passing only one folding pattern): F16-8

Front Inks Comma delimited list
of ink names (text)

If specified, this list is considered to be the ocial
printing inks for the front side of the product. Used
during ganging and estimation to determine how many
colors/plates are needed for a given layout. When not
specified, all normal inks from the front-side artwork
are considered the printing inks.

Example: Cyan,Black,Pantone 3425

Default: None

Front to Back None, Copy, Mirror Action to perform to copy or mirror artwork on the
front side of the flat product to the back side
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Field Name Field Type Description
Example: Mirror

Default: None

Grade Text Name of grade product is to be printed on. If specified
it must match a grade within the specified stock in the
Stock Library.

Example: 340 gsm"

Default: First grade within the Stock

Grain Vertical, Horizontal,
None

Grain direction product must be printed on.

Example: Horizontal

Default: None

Group Text Product group name used by the Plan ganging tool
to ensure products with the same group name are
imposed together on the same layouts

Example: "Group A"

Default: None

Height Scalar3
Height of product die

Example: 100mm

Default: None

Horizontal Tile Gap Double Gap distance between tiles in the given direction
(expressed in points: 72pts = 1in = 25.4mm)

Example: 720

Horizontal Tile Gap
Extension

Double Amount of extra artwork content beyond the tile gap
boundary to extend into the gap in the given direction

Example: 25

Horizontal Tile Gap
Extension Rule

Opposite Start, Both Rule defining which direction(s) the extension is
applied for each tile in the given direction

Example: Both

Horizontal Tile
Overlap

Double Distance beyond tile edge to extend the tile to create
overlap in the given direction

Example: 25

Horizontal Tile
Overlap No Image

Double Distance of the section at the end of the overlap where
artwork content is to be clipped

Example: 25
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Field Name Field Type Description

Horizontal Tile
Overlap Rule

Top, Bottom, Both Rule defining what edge(s) of tiles overlap is applied to
in the given direction

Example: Both

Horizontal Tiles Int, Double, List Horizontal tiling rule value, could be single integer,
double, or list of comma separated doubles depending
on tile rule type (Horizontal Tiling)

Example (FixedNumber): 6

Example (FixedSize): 60in

Example (VariableSizes): 60in,40in,60in

Horizontal Tiling Double The horizontal tiling rule type which can be, None,
FixedNumber, FixedSize, or VariableSizes

Example: FixedNumber

Default: None

Horizontal Uniform
Final Size

Boolean If enabled, tile sizes will be uniform after applying
overlap or gap methods to the tile, otherwise tile sizes
are uniform before overlap or gap methods are applied

Example: 100mm

Default: None

Jog Edge Top, Bottom, Right,
Left

Jog edge for bound work. When set, this edge must
be perpendicular to the binding edge. Setting jog to
Bottom for left- or right-bound work results in 'Foot to
Foot' page orientation

Example: Top

Default: Top

Jog Trim Scalar3
Jog trim amount in bound signatures

Example: .25in

Lip Scalar3
Lip amount to add to bound signatures

Example: .25in

Lip Type6 Auto, Front, Back 6Lip type for determining where lip gets added to
bound signatures

Example: Auto

Marks Comma delimited list
of marks

Name of smart product marks to apply to the product
from the Marks library. Names must include any parent
folders separated by forward slashes ("/").
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Field Name Field Type Description
Example: Barcodes/QR_PRD, Patches/CMYK

Max Overruns Percentage Maximum percentage above ordered amount to allow
during ganging.Percentage sign is not required.

Example: 10%

Default: 100%

Min Overruns Percentage Minimum percentage above or below of ordered
amount to allow during ganging. Negative values are
allowed meaning the job is allowed to produce less
than the ordered amount. Percentage sign is not
required.

Example: -10%

Default: 0%

Modes Text Names of Modes to run the given process at

Name Text Unique name of the product

Example: Item1234_Eng_12oz

Non-Jog Trim Scalar3
Non-jog trim amount in bound signatures

Example: .25in

Notes Text Text notes related to the product visible in product
properties and <product.notes> mark keyword.

Example: "Order date: March 31"

Default: None

N-Up Scalar For bound signatures, the number of N-ups which can
be a value of 1, 2, or 3 with 1 signifying normal non N-up
repeated signatures

N-Up Gap Text Gap spacing to apply between N-up repeat pages

Offcut Bottom Scalar3
Amount of offcut margin to apply to the bottom side of
the product die.

Example: "2mm"

Default: None

Offcut Left Scalar3
Amount of offcut margin to apply to the left side of the
product die.

Example: "2mm"

Default: None
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Field Name Field Type Description

Offcut Right Scalar3
Amount of offcut margin to apply to the right side of
the product die.

Example: "2mm"

Default: None

Offcut Top Scalar3
Amount of offcut margin to apply to the top side of the
product die.

Example: "2mm"

Default: None

Ordered Number Number of orders for product

Example: 40000

Default: Product defaults in preferences

Page Bleed Scalar Bleed margins of individual pages in bound and folded
products

Page Handling OnePerFile,
OnePerPage,
OnePerTwoPages

Multi-page artwork handling options for flat and tiled
products

OnePerFile: Create one Phoenix product per file (if file
is multi-page, only one product is created)

OnePerPage: Create one Phoenix product per each
PDF page

OnePerTwoPages: Create one Phoenix product per
two pages (odd pages will be the front-side graphic,
even pages will be the back-side graphic)

Ordered Number Number of orders for product

Example: 40000

Default: Product defaults in preferences

Pages Per Section Number Number of pages per section for multi-section bound
work (i.e. smyth sewn books)

Example: 16

Priority Number Optional priority of product starting from 1 as highest
priority

Example: 2

Default: 1

Process Types Text List of process types the product can use
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Field Name Field Type Description

Processes Text List of processes the product can use

Reading Order Normal, Calendar Reading order of pages in bound workExample:
CalendarDefault: Normal

Rotation Any, Orthogonal,
None, Custom

If “custom” then
include another
column called
“Allowed Rotation” and
express the allowed
degrees of rotation as
a comma-separated
list of numbers.

Type of rotation that can be used during ganging for
this product.

Default: From Preferences > Product > New Product
Defaults > Rotation, unless Allowed Rotations is
specified in which case Custom rotation is used.

Scale Proportionally Boolean Whether to scale proportionally when either width
or height are not specified. When false, only the
dimension that is specified is scaled.

Default: false

Self Cover Boolean Whether bound part includes cover or not. When
'Calendar' is the value set for 'Reading Order', 'true' will
cause the last page to be rotated by 180 degrees.

Example: true

Shape Search Largest, Multiple Shape handling mode to use when finding closed
path shapes from the dielines in the artwork. 'Multiple'
mode will create a new artwork item for each closed
path shape detected in the artwork.

Example: largest

Spacing Bottom Scalar3
Amount of spacing required below the die shape. If
Spacing also defined, this value overrides Spacing
value on bottom side. This field is ignored when
Spacing Type is not Margins.

Example: "2mm"

Default: None

Spacing Left Scalar3
Amount of spacing required to the left of the die
shape. If Spacing also defined, this value overrides
Spacing value on left side. This field is ignored when
Spacing Type is not Margins.

Example: "2mm"

Default: None
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Field Name Field Type Description

Spacing Right Scalar3
Amount of spacing required to the right of the die
shape. If Spacing also defined, this value overrides
Spacing value on right side. This field is ignored when
Spacing Type is not Margins.

Example: "2mm"

Default: None

Spacing Top Scalar3
Amount of spacing required above the die shape. If
Spacing also defined, this value overrides Spacing
value on top side. This field is ignored when Spacing
Type is not Margins.

Example: "2mm"

Default: None

Spacing Type Margins, Uniform,
Bleed

Spacing type of product. If not specified, default
spacing type from the CSV Import

Preset will be used.

Spacing Scalar3
Amount of spacing required outside of the die shape
when placing product. When Spacing Type is Margins,
all four sides will be set to this value and overridden by
individual side spacing below.

Example: "4mm"

Default: None

Spine Trim Scalar3
Spine trim amount in bound signatures

Example: .25in

Stock Text Name of stock product is to be printed on. If specified
must match a stock in the Stock Library.

Example: Gloss Coated"

Default: First stock in Stocks Library

Templates Comma delimited list
of template names

List of templates from the Templates library that this
product is allowed to be placed into during ganging.
When not specified, all templates with matching
diedesign shapes are used.

Things Text Comma-separated list of things this process can use

Note:  If defining a Thing, you must also add
a Processes column and value to define what
process(es) the product will require.
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Field Name Field Type Description

Pages Number Total number of pages for bound and folded work

Tiling Order Snaking Vertical,
Snaking Horizontal,
Zigzag Vertical,
Zigzag Horizontal

Order rule to use from start corner to define tile
placement order

Example: Snaking Vertical"

Tiling Start Top Left, Top Right,
Bottom Left, Bottom
Right

Starting corner for tile placement order

Example: Top Left"

Type Flat, Tiled, Folded,
Bound

Type of product: flat, tiled, bound, folded

Example: flat"

Vertical Tile Gap Double Gap distance between tiles in the given direction
(expressed in points: 72pts = 1in = 25.4mm)

Example: 720

Vertical Tile Gap
Extension

Double Amount of extra artwork content beyond the tile gap
boundary to extend into the gap in the given direction

Example: 25

Vertical Tile Gap
Extension Rule

Opposite Start, Both Rule defining which direction(s) the extension is
applied for each tile in the given direction

Example: Both

Vertical Tile Overlap Double Distance beyond tile edge to extend the tile to create
overlap in the given direction

Example: 25

Vertical Tile Overlap
No Image

Double Distance of the section at the end of the overlap where
artwork content is to be clipped

Example: 25

Vertical Tile Overlap
Rule

Top, Bottom, Both Rule defining what edge(s) of tiles overlap is applied to
in the given direction

Example: Both

Vertical Tiles Int, Double, List Vertical tiling rule value, could be single integer,
double, or list of comma separated doubles depending
on tile rule type (Vertical Tiling)

Example (FixedNumber): 6

Example (FixedSize): 60in

Example (VariableSizes): 60in,40in,60in
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Field Name Field Type Description

Vertical Tiling Double The vertical tiling rule type which can be, None,
FixedNumber, FixedSize, or VariableSizes

Example: FixedNumber

Default: None

Vertical Uniform
Final Size

Boolean If enabled, tile sizes will be uniform after applying
overlap or gap methods to the tile, otherwise tile sizes
are uniform before overlap or gap methods are applied

Example: 100mm

Default: None

Width2 Scalar3
Width of product die

Example: 120mm

Default: None

1 When Product Name is not present, name is taken from the file name in Artwork File excluding filename
extension. If Artwork File is also not specified, Phoenix assigns a unique name following the naming
convention "New Product 1", "New Product 2", etc.
2 Width and Height are required when Artwork File and CAD File are both not specified.
3 Scalars are decimal numbers that can optionally contain units. Supported units are: mm, cm, pt, ", or in.
If scalar does not have unit defined, the default units for the current job are used.
4 If Die Design Source is not defined, the source of the die design is inferred from other CSV fields as
explained in section 3.2.2 below.
5 Scaling happens in a horizontal only manner to achieve desired creep value.
6 When Lip Type is set to 'Auto', When Lip Type is set to Auto, the lip is applied to the high folio when
running “head to head” and the lip is applied to the low folio when running “foot to foot”.

Die Design (Cut Path) Logic
When importing products, the die design (cut path) is determined from fields in the following order:

1. Die Design Source - If this field is present, the die design will be generated from the specified
source, one of ArtworkPaths, ArtworkTrimbox, CAD, CustomSize, or DieDesignLibrary.

Note:  If ArtworkPaths is used, paths in the artwork are automatically matched with Tool
Type mappings defined in preferences. If no matches are found, the artwork Trimbox is
used.

2. CAD File / CAD Design (CAD Module) – If CAD File and optionally 1-up CAD Design name are defined,
product die design is created from the cut lines in the CAD die.

3. Die Design Name – If Die Design Name is defined, DieDesignLibrary die design source is assumed
and the corresponding 1-up in the Die Design library is used as the die design.

4. Cut Ink (deprecated) – If CAD die has not been defined (A), artwork has been specified with Artwork
File and optionally Artwork Page, and Cut Ink has been defined specifying the cut line spot color in
the artwork, die design is created from the die ink contours.
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5. Cut Layer (deprecated) - If CAD die has not been defined (A) and Cut Ink has also not been defined
(B), all paths in the PDF layer defined in Cut Layer will be used to define die design if specified.

6. Width & Height – If none of the fields above have been defined die design shape is created the
Width and Height fields if present.

7. Artwork File / Artwork Page – If artwork file and optionally artwork page are defined and Die
Ink and Width / Height fields are all not defined, die design is created from the PDF paths if
"Automatically set die design from line type mappings" is enabled in Product preferences. If no
matches are found or this setting is disabled, die design will be generated from the Trimbox of the
artwork.

Note:  If none of the fields above are defined, CSV import will fail since the product die
design has not been defined.

Note:

In Phoenix the binding and jog edge are completely customizable so the technical definition of
'Auto' Lip Type is this:

• If binding is set to the Left or Right edge, then high folio lip is used when jog edge is Top
while low folio lip is used when jog edge is Bottom.

• If binding is set to the Top or Bottom edge, then high folio lip is used when jog edge is Right
while low folio lip is used when jog edge is Left.

Defining Mappings
After you select the CSV file you are going to import you are presented with a dialog to define column
to product field mappings or choose an existing import preset.

Once you have defined the correct mappings from your CSV columns to product fields you can save the
mappings as a preset to reuse again in the future.

Import Preset – Dropdown list of all available presets. Selecting a preset will change all options and
mappings to the last saved values of the given preset. If edits are made, the preset name is appended
with the text "(Edited)".

Save Preset Button – Click the button to the right of the preset dropdown to save the current options
and mappings to the existing or a new preset.

Spreadsheet has column headings – Option specifying whether the first row of the CSV file is a
headings row or not. If not, then columns can be mapped only by number as there are no heading
names to match and the first row of the CSV file will be interpreted as a product.

Map Columns by – Choose whether to map columns to fields by column heading names from the first
row of spreadsheet or by column numbers. Column numbering starts at 1. Note that mapping by column
heading names option is disabled when Spreadsheet has column headings is unchecked.

Delimited by – Specify whether columns in the CSV file are separated by commas, tabs, semi- colons,
carets, or pipe characters. CSV files are typically separate by commas, for example when saving as CSV
in Microsoft Excel.

Character encoding – Character encoding of the CSV file. By default, CSV import will use the default
system encoding of the operating system. UTF-8, UTF-16, and several other encodings are available to
choose from covering most language environments worldwide.

Default Spacing Type – Default spacing to apply to products when Spacing Type is not present.
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Mappings – Define the mappings from column name or number to product field. CSV Column values are
left empty if a mapping is not defined. To edit a CSV Column value, click on the cell and start editing the
text. Product Field values (see CSV Product Import Fields on page 84) marked with the * character
denote required fields.

Clear All – Button to clear all CSV Column values in the Mappings table.

Mapping from Column Name Example
In the following example, the CSV file contains headings row of column names. Columns correspond
to product name, width, height, and order amount respectively. We will create a mapping from these
column heading names to the product fields.

product width height amount

PRD-19001 120mm 100mm 20000

PRD-19002 110mm 85mm 18000

PRD-19003 80mm 67.5mm 40000

To import this CSV file correctly we need to check Spreadsheet has column headings checkbox, select
the Headings option in Map Columns by and enter the following mappings:

• product -> Product Name
• amount -> Ordered
• width -> Width
• height -> Height

Mapping from Column Number Example

Mapping from Column Number Example
In the following example, the CSV file does not start with a headings row of column names, instead
starting with the first product. Columns correspond to product name, width, height, and order amount
respectively. We will create a mapping from the column numbers to the product fields.

PRD-19001 120mm 100mm 20000

PRD-19002 110mm 85mm 18000

PRD-19003 80mm 67.5mm 40000

To import this CSV file correctly we need to check Spreadsheet has column headings checkbox, select
the Numbers option in Map Columns by and enter the following mappings:

• 1 -> Product Name
• 4 -> Ordered
• 2 -> Width
• 3 -> Height

Saving Spreadsheet as CSV in Excel
Follow the steps below to save a spreadsheet in CSV format in Microsoft Excel:
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1. Go to the File menu and click on Save As.
2. In the Save As dialog click on the Save as type dropdown menu below File Name
3. Select the option labeled 'CSV (Comma Delimited) (*.csv)'
4. Enter the desired file name and press Save

2.5.8.  Filename Conventions

Filename convention allow product properties to be automatically set simply by encoding the value
in a product's filename, and can even include multiple parameters separated by a delimeter. You can
customize which product parameters are encoded in the filename, which delimeter is used, and
whether or not a given parameter is optional - that is, whether or not it will definitely be in the filename
and should be mapped, or it may not appear and won't be mapped.

To enable file name conventions, go to Preferences > Product and toggle the checkbox next to "Enable
file convention"

You can see in this Product view of the Preferences what the current file convention is configured to
be. For example, in the screenshot above, the convention is as follows: $Product Name$Ordered
$Stock$Group?

This means that the filename will begin with a '$', and anything between the first $ and the second $ in
the filename will be used as the Product Name. Anything between the second $ and third $ will be set
to the Ordered quantity. Anything between the third $ and the fourth $ will be set to the Stock property.
Finally, anything after the fourth $ will be set to the Group property. Notice that the convention has a ?
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after the "Group" text. This means that this value is optional, and may not appear in the filename. If it
doesn't appear in the filename, nothing will be mapped to the Group property.

To edit and customize the file name convention, click on the Edit button:

Here, we can add (+), remove ( ), edit, and reorder the sections of the convention we are setting. You
can also use different prefixes, so, for example, the filename could be $springwater#1500%PVC, where
the product name is prefixed by $, the ordered quantity prefixed by #, and the stock prefixed by %.

You can choose any product property and even specify custom product properties to be set via file
naming conventions. When done, click OK to return to the Preferences window, and OK again to save
the Preference changes.

2.6.  Configuration

This configuration page will guide you through each part of Phoenix and the various ways that Phoenix
can be configured.

Phoenix is built around the idea of modeling your production environment, so Phoenix must be
configured to represent how your environment is currently set up. This includes the following, which
are explained in detail below:

• Things on page 104 (presses and finishing devices)

• Stocks on page 121

• Plates on page 124 (optional)

• Templates on page 124 (optional)

• Marks on page 128

• Die Design on page 164
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• Mark Sets on page 166

• Tool Types on page 167

• Ink Mappings on page 170

• Presets on page 171

Phoenix has the ability to import and export each of these configuration libraries via a single
library archive file, in the format .phxlib. You can import and export your Phoenix Libraries from the
Preferences dialog, under the Diagnostics tab. Exporting your libraries will create a single .phxlib
file, containing all of your libraries. You can import these .phxlib archives as well, but do keep in mind
that by importing libraries you will overwrite all existing libraries with what is in the imported .phxlib.
Phoenix also has ability to Merge Libraries, which will combine the contents of two separate Libraries.
Before performing a Merge Libraries function, it is recommended to first create a backup of the
current libraries by exporting them.

In addition to importing and exporting all of your libraries, Phoenix 7.0 enables you to import and export
individual libraries. You can do this from each individual library's panel under the dropdown menu.
These panels also make the library searchable, making it easier than ever to find the item you're looking
for.

2.6.1.  Things

In Phoenix, a 'Thing' (or plural 'things') is a physical object or process that is used in a production flow
when transforming a product part and/or component into a final product. A 'Thing' could be a piece of
equipment such as a digital press or a die-cutting device, or it could be a manual resource that would
perform a task such as diemaking or hemming/sewing a banner.

Presses
A Press represents the physical press. For most types of work in Phoenix, Presses are technically
optional as Sheets and Plates can be used directly, but they are strongly recommended, especially for
use with Imposition AI. Presses consist of the following:

• Speed and cost information used by estimation + ganging
• Min/max sheet constraints used by ganging
• Media template (optional)
• Gripper, sheet placement, content and image margins
• Press-specific marks (optional)

There are different types of Presses available within Phoenix:

• Digital, both Sheet-fed and Web-fed

• Offset, both Sheet-fed and Web-fed

• Wide Format, both Flatbed and Roll-fed

To add a new press, click the dropdown in the top left of the Things panel, and select the type of press
you want to add.
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Once you select a press type, the Press Configuration window will appear. The settings vary slightly
based on what press type you select, but they all consist of the following tabs:

• General
• Costing
• Operation
• Capabilities
• Media Rules
• Placement
• Workflow
• Script

General Properties
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Field Description

Name Name of the press

Folder Folder to organize the press in Phoenix. You can click the
folder icon to choose from existing folders, or drag and
drop in the Devices panel after creation.

Description Press Description

Manufacturer Press Manufacturer

Process What this device does. For Presses, this will always be
“Printing”

Process Type What type of Printing Press this press is, based on the
type of press you selected.

Feed Type How stocks are fed into the press

Number of Units Total number of printing units on the press

Coatings Max number of coatings on the press

Foils Max number of foils possible on the press

Sheet Turn Workstyle of the press. Either turn or tumble. *Only
available for sheet-based presses

Single pass double-sided Checkbox to enable whether this press can perform
single pass double-sided printing

Number of Units If Single pass double-sided is enabled, the number of
printing units for the backside. See Note below.

Coatings If Single pass double-sided is enabled, the number of
coatings possible for the backside

Foils If Single pass double-sided is enabled, the number of foils
possible for the backside

Speed Reduction Percentage of speed reduction when doing single-pass
double sided printing

Gripper Gripper distance from the bottom of sheet

Note:

If using the "Single pass double-sided" option, the Number of Units for the back side will
subtract from the total Number of Units specified above.

This means that if you have a press with 6 stations, and four of these stations allow for single
pass double sided printing, you would specify the total Number of Units as 10, and single pass
double-sided Number of Units as 4.

In the above example, Phoenix would understand that to mean that the press can handle
layouts with up to 6 front inks and up to 4 back inks.
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Note:

In Phoenix 7.0, the option for multiple passes has been moved to the Imposition AI profile rather
than in the Press settings

Costing Properties
 

 

Field Description

Rate Cost to operate this press, per time unit specified

Setup Time How long it takes to setup the device, per time unit
specified

Setup Layouts How many layouts (sheets) the device requires for
make-ready

Setup / Color Time Per-color make ready time

Setup / Color Layouts How many layouts (sheets) per color are required for
make-ready

Minimum Cost Per Layout Minimum cost required per layout

Minimum Run Length Minimum run length allowed for layouts
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Field Description

Running Waste Percentage of project assumed to be waste. Phoenix
will compensate for this value.

Operation Properties
 

 

Field Description

Modes Some devices can run in a specific mode, such as high
quality print mode, or eciency modes. The Modes option
allows you to choose the operating costs and speeds for
each mode. Modes are described in more detail under the
Estimating section of the Preferences page.

Ink Cost Define how inks are costed. Choose between click count or
ink coverage per area and percent coverage

Speed Type Define whether the press runs at a fixed speed, or a stepped
speed

Speed Units Choose the units and time for the press speed

Value Set the speed value
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Capabilities Properties
 

 

Field Description

Width Set the min and max stock width for the press

Height Set the min and max stock height for the press

Caliper Set the min and max stock caliper for the press

Weight Set the min and max stock weight for the press

Units Choose which weight to use for the stock weight

Sheet Handling Set how the press handles sheets, either Long Edge
Horizontal, Long Edge Vertical, or None

Limit allowed Stocks Enable if the press should limit which stocks can be run
on this press, either Exclusively or Inclusively

Stock Types Define entire types of stocks to be excluded or included
from this press

Specific Stocks Define specific stocks to be excluded or included from
this press
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Media Rules Properties

Media Rules allows you to define press settings based on the stock used. The rules column on the left
side of the window allows you to select a stock (or the default), and then define the settings for that
stock. To set the parameters for your press and media, first add or select the desired stock on the left
side, and then define the settings for that stock.

 

 

Field Description

Rules Add or remove a media rule based on the stocks
in your stocks library

Marks Define marks to be used on this press when the
selected stock is used. Once a mark is selected,
you can choose which side(s) of the layout it
should be applied to - Front, Back, or Both.

Regions Define regions on the stock where items won't be
placed. Regions are defined by Direction (Vertical
or Horizontal), Position (Left, Right, or Center),
Offset, Size, and when they are Applied (Always
or only for Perfecting layouts). These regions can
be shown in a layout by enabling the option "Show
Regions"
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Field Description

Speed Reduction Define any possible speed reduction for this
media rule

Ink Adjustment If the selected media requires an adjustment of
ink, set it here. For example, a particular stock
may require 25% more ink then a different stock
based on it's ink absorbing qualities.

Margins Define the margin where for the media. Margin
is the area along the edge of the sheet or roll
where no product dieline can be placed. Note
that product bleed can extend into the margin,
depending on the Image Margins defined.

Image Margins Define the image margins. Image Margins are
the area around the sheet or roll where no image
can be printed, regardless of whether or not it is
bleed. The Image Margin should always be less
than or equal to the Margin value.

Placement Properties

Note:  Only the relevant parameters will be available for any given press type. There may be
certain parameters that appear in screenshots that do not appear for every press type.
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Field Description

9-Point Selector The 9-Point Selector is an easy way to visually define
placement. The smaller box with the "R" represents the
corners and center of the bounds of the sheet, while
the outer box represents the corners and bounds of the
context area. Click and drag the smaller box to set one of
the anchor points of the sheet to an anchor point on the
context area. This anchor point is where the sheet will be
placed relative to the context area.

Context Dropdown selection for where the placement is based off
of - the Plate, the Sheet, or Content Area (default)

X, Y Define an x & y offset from the selected location

Use die template specification for sheet
size and placement

Option to use the sheet and placement saved in a die
template to specify the location of the sheet (if available)
instead of manually setting it. The template needs to have
a sheet defined in it for this feature to work.

Sheet Optionally select a default sheet for the press. This will
automatically assign the selected sheet when the press is
brought into a new layout.

Plate Optionally select a default plate for the press. This will
automatically assign the selected plate when the press is
brought into a new layout.

Sheet Position For offset presses, define the sheet alignment and offset

Workflow Properties

Workflow properties per device can be used to emulate your production workflow within Phoenix.
Every process in the print production workflow requires input resources starting with the client’s files
or artwork and ending with the final bound, packaged and labeled print product. For example, before
you can print, you need paper, ink and plates, and before you can send a document to a die cutter line,
you need printed sheets and physical die (or the creation of a die).
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ield Description

Direct Inputs Displays all 'Things' which have this particular
'Thing' defined as a 'Direct Output'. This field is
read-only.

Direct Outputs Specify a list of valid ouputs to be used after
a product/component has finished this
proccessing step. For example, a direct output for
a 'Die Making Process' thing is a Flatbed Die Cutter
thing. Defining specific Direct Outputs forces
Phoenix to evaluate many routing options when
printing/finishing a product.

Allow pass through Allow passthrough means a thing can be part of
a workflow but does not have to take part in it's
cost/time/etc.

Example: Attaching a coater to a press inline.
If allow passthrough is on then coater would be
ignored if there wasn't any coating process on the
products going through it

Script Properties
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Finishing Devices
In Phoenix, a 'Finishing Device' is a physical object which performs activities on printed material after
printing. This includes binding, the fastening of individual sheets together, die-cutting, and decorative
processes such as die-stamping, embossing, foiling or laminating.

There are currently three different types of Finishing Devices available within Phoenix:

• Digital Cutting Table
• Guillotine Cutter
• Flatbed Die Cutter Cutter

To add a new finishing device, click the dropdown in the top left of the Things panel, and select the type
of finishing device you want to add.
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Once you select a finishing device, the Finishing Device Configuration window will appear. The settings
vary slightly based on what device is selected.

Note:  The finishing devices have many of the same settings as the presses, described above.
Any configuration tabs or settings that are duplicated in finishing devices can be found in the
Press section, above.

Digital Cutting Table
A digital cutting table is a CAD/CAM device such as a Zund or Kongsberg digital cutting table that uses
a moving head to drive a tool across a substrate in multiple dimensions (typically x, y, and z). It has the
following settings:

General
 

 

Field Description

Estimating Engine Select the estimating engine for costing. You can choose from
Tilia Labs estimating engine, or Zund Cut Center. If using Zund
Cut Center, you will also need to specify the hostname and
port of the computer running Zund Cut Center. In addition,
you can specify a timeout if no connection is established with
Zund Cut Center.
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Operation
 

 

General

Field Description

Clearing Distance The full lifting height of the tool when the traverse is moving
between disconnected path segments.

Auto Lift Angle For most CAD/CAM tables, you can set the angle for automatic
corner lifting for a tool (typically around 40 degrees). If a
direction change of more than the specified value is detected
during the cutting process, the table will raise the tool, turn the
tool into the cutting direction, and lower again to finish cutting.

Auto Lift Distance This is the total amount of z-axis lift when the tool is lifting
during the auto lift activity.

Motion Lowered

Field Description

Velocity The set XY velocity with tool down performing the tool operation

Acceleration The set XY acceleration with tool down performing the tool
operation

Motion Lifted
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Field Description

Velocity The set XY velocity with tool up moving between path segments

Acceleration The set XY acceleration with tool up moving between path
segments

Motion Lowering

Field Description

Velocity The set Z-axis velocity while the tool is lowering

Acceleration The set Z-axis acceleration while the tool is lowering

Motion Lifting

Field Description

Velocity The set Z-axis velocity while the tool is lifting

Acceleration The set Z-axis acceleration while the tool is lifting

Guillotine Cutter
A guillotine cutter is used to make a single guillotine cut at a time.

Costing
 

 

Field Description

Setup Time General setup time per layout
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Field Description

Setup Time / Cut Setup time for each cut

Average Time / Cut Average amount of time per cut through the stack of
material

Average Time / Turn Average amount of time to turn the stack of material

Flatbed Die Cutter
A Flatbed Die Cutter is used (in conjuction with a die template) to cut or perforate products of a desired
shape out of material using a hydraulic flatbed press.

Costing
 

 

Field Description

Minimum Run Length Sets the minimum run length needed to use this Die Cutter

Speed Speed of the die cutter

Speed Units Speed units

Other Settings
The remaining device configuration tabs are the same as the press tabs defined above

Die Making
The Die Making Process describes the production of tools for a die cutter (e.g., in a die maker shop).
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Field Description

Type Specify the type of die - Steel Rule, Solid, or Flexible

Cost Define the cost of each die

Area Cost If the die is costed by area, specify the cost here.

Cost Per 1up If the die is costed per 1-up, specify that cost here.

Steel Rules For Steel Rule dies, define a linear cost per tool type, or
specify a default cost.
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Field Description

Width and Height Specify the max and min width and height for dies created
with this device

Limit Allowed Devices Optionally limit what process types or devices can or
cannot be used with this device. Inclusively means that
only selected process types or devices below can be
used with this device. Exclusively means that this device
will not work with any selected process types or devices
selected below

Importing Things from Tilia Cloud
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You can import things that have been preconfigured via Tilia Cloud. Click the dropdown in the top left
of the Things panel, and choose "Import from Tilia Cloud". This will bring up the dialog shown above,
which allows you to search the Tilia Cloud library for hundreds of common devices.

This is a good place to start to add things to your library. Keep in mind that the things in Tilia Cloud have
been configured to the manufacturer's specifications and do not include costs, so you may need to
adjust the capabilities and parameters to suit your exact environment.

2.6.2.  Stocks

Stocks represents the type of material that will be used for printing. This can be any type of material,
such as gloss paper, matte paper, plastic, cardboard, and so on. Stock properties consist of name, an
optional description and vendor, as well as stock type. Stocks also have a grade, as well as sheets and/
or rolls.

Grades
A grade is a specific thickness and weight of a particular Stock. Grade properties consist of thickness
in mm or mil, weight in gsm or lb, and cost. Each Grade also has a list of available sheets and/or rolls
associated with it.

Sheets
Sheets are a piece of a Stock of a particular Grade at specified dimensions. Sheet properties consist of
width, height, cost, and grain direction.

Adding Stocks
To add a stock to Phoenix, navigate to the Stocks panel, and click the dropdown in the top left. Choose
New Stock...

The following dialog will appear, allowing you to configure the stock with the options below:
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Field Description

Name Unique name of the stock

Description Optional description of what the stock is

Vendor Optional field for stock vendor name

Stock Type Define the type of stock. This list is populated by the stock
types configured in Preferences > Estimating > Stock Types
and is described further in the Estimating section of the
Preferences page.

Grades List of grades of this particular stock. There is no limit to the
number of grades, and grades can be added, duplicated, or
removed by clicking the icons below

Grade Display Whether grade is defined by weight, caliper, or both

Weight Weight of the selected grade of the stock

Caliper Caliper of the selected grade of the stock
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Field Description

Cost Define a cost at the grade level for all sheets or rolls of this
grade

Sheets of any size available When enabled, Phoenix will not be restricted to a particular
sheet size, but can use any sheet size from this grade and
stock. This option is useful if you sheet your own stock,
as Phoenix's Imposition AI tool will create a sheet for the
resulting layout that fits the size of the press.

Sheets Define a sheet size for the selected grade. See below for
New Sheet options.

Rolls Define a roll size for the selected grade. See below for New
Sheet options.

 

 

Field Description

Dimensions Define the height and width of the sheet

Grain Optionally infer the grain direction from the dimensions, or
specify a specific grain direction

Cost Assign costing at a sheet level

Rolls
Rolls represent actual rolls of a Stock of a particular Grade at a defined width. Rolls have the properties
of roll Width, Grain, and Cost.
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Field Description

Width Define the width of the roll

Grain Specify the grain direction of the roll

Cost Assign costing of the roll, either from the grade, per weight,
or per area

2.6.3.  Plates

Plates are a direct representation of the plate that is used on press, whether Offset or Flexo. Plate
properties consist of cost, width and height, punch height, and horizontal and vertical distortion. To
create a plate, navigate to the Plates panel, click the dropdown in the top left, and select New Plate...

 

 

Field Description

Description Optional description for the plate

Price Per Plate Cost per plate

Dimensions Plate dimensions

Punch Punch Height

Dimensions Plate distortion in horizontal and vertical dimensions

2.6.4.  Templates

Templates are used to specify a pre-defined position for one or many product when being imposed on a
sheet. In many cases, templates are physical steel rule dies used in finishing.
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Phoenix uses templates to intellignetly 'snap' artwork to die templates by using shape-detection
algorithms, taking the guess-work out of impositioning and eliminting human errors when imposing
to existing tooling. Phoenix ensures graphics snap to the dieline (automatically handling front & back
artwork) and even notifies the end-user when the artwork does not match the dieline perfectly.

Templates can be built manually, or imported (requires CAD module) from industry standard CAD file
formats (ARD, MFG, PDF, AI, CF2, DXF, DDES, etc...). This allows you to store existing tooling direclty
inside of Phoenix to be used and detected automatically during the imposition process.

 

 

Field Description

Name Name given to the imported template which will be displayed in
the 'Templates' library.

Folder Templates Library folder which the imported template will be
stored. Default is 'Templates' folder which stores the imported
template in the Root of the Templates library.
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Field Description

Import Preset CF2 import preset to be used during the import. The Import
Preset specifies CFF2 line type mappings.

CAD Line Mappings* Editable list of mappings to map CFF2 line types to Phoenix
Tool Types.

Mirror During template importing, you can Mirror the imported
geometry Horizontally or Vertically. This is useful for scenarios
when you want to create inside or outside layouts without
needing to create a new CAD file.

Rotation Rotation allows the import wizard to rotate the imported
geometry 90, 180, or 270 degrees if required for your
imposition needs.

Design Placement When mirroring and rotating during import, use 'Design
Placement' to specify the order of operations. 'Apply rotation
before mirroring' or 'Apply mirroring before rotation'

Pattern Matching** None: Do not run any special pattern matching processes
during import

Merge Similar 1-ups: Find 1-ups that are defined separately in
the CAD file but are identical and treat them as the same during
import.

Advanced Pattern Matching: Searches all paths that are not
clearly defined in a 1-up die to find common elements and infer
1-up dies from them. Before 6.1, this algorithm was used only
with PDF die import where there are no clearly defined 1-ups.
This option is useful when all paths in the CAD file are lumped
together instead of being properly defined as stepped up dies.

Advanced Shape Detection: Shape detection will run pattern
matching first on any non-die paths, and then do an additional
step of finding die candidates from closed paths. This step can
be significantly more time consuming but has the ability to find
single instances of 1-ups in the CAD layout that cannot be found
using Advanced Pattern Matching.

Fix Common Knife Cuts For CAD files with common knife
cut path segments, some or all dies can be defined with the
common section omitted, instead relying on neighboring
dies or lines defined in the main section of the CAD format to
define common cuts. Commonly, this can result in holes in the
imported die. The Fix Common Knife Cuts option will auto-
detect common knife cut segments in CAD files and ensure
that that all missing common segments are included in the
imported dies so they can be processed correctly.

Preview The Preview window displays a preview of the imported die
template. At the top of the Preview Section, click on the
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Field Description
dropdown and select the 1-up Design to make it easier to
change line mappings of the die.

*You can also right-click on lines in the 'Preview' window to map CFF2 line types interactively.

**Note: all five options are available for all CAD formats except for in the case of PDF where advanced
pattern matching is always needed to infer the CAD structure since the PDF specification does not
define 1-up dies, which means only Advanced Pattern Matching and Advanced Shape Detection options
are available during PDF die import

Import Die Designs
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Field Description

Import Die Designs If checked, you can optionally import the 1-up designs to the
Phoenix 'Die Designs Library' that were identified inside the die
template.

Folder Die Designs Library folder where the imported 1-up die design will
be stored. Default is 'Die Designs' folder which stores the imported
1-up die design in the Root of the Die Designs library

Use Grain Direction From MFG/ARD
New in version 23.3, Phoenix can detect the grain direction within ArtiosCAD files. To use this grain
direction, enable the preference Use grain direction from cad data when available within Preferences
> Product.

After enabling this, any products created from or using a Die Design that had grain direction in the cad
file will have that grain direction set.

Import Die Template Shortcuts
Templates can be imported normally by using the File menu and selecting "Import Die Template…" to
use the default import preset for the given CAD format defined in Preferences > Die Import.

They can also be imported and placed into the current layout in a single action by selecting "Place Die
Template…" instead, or by simply dragging and dropping a CAD file format (CFF2, DXF, DFS, etc...) on
the new job canvas.

You can also import die layouts using the interactive Die Import Wizard to interactively define and
confirm line mappings, choose a different import preset or define a new preset. To do this normally,
select the "Import using Die Import Wizard" and "Place using Die Import Wizard" options from the File
menu.

Import actions are also accessible from the action menu in the Templates panel (small triangle in the
upper left corner).

Place Die Template Shortcut
Shortcut: Drag and Drop CAD File

Description: Dropping a die layout CAD file directly into Phoenix while in Layout View will import the
layout as a die template using the default import preset for the given CAD format and place it in the
current layout being viewed. If no default import preset is defined for the CAD format the Die Import
Wizard is launched.

Place Using Die Import Wizard Shortcut
Shortcut: Control + Drag and Drop CAD File

Description: To force the Die Import Wizard to be used to import and place the CAD file, hold down the
Control key while dropping the file into Phoenix.

2.6.5.  Marks

There are 18 different types of marks available within Phoenix, plus an optional Script Mark available
with the Scripting module that allows you to create any mark you can think of.
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To create a new mark (or modify an existing one), navigate to the Marks panel, and select "New Mark..."
from the dropdown in the top left of the panel.

This will open the Mark Creator Wizard, which will allow you to select the type of mark, as well as how
it will be placed. The screens in the Mark Creator Wizard will vary based on the options selected. After
the settings are chosen for each screen, use the navigation buttons at the bottom right of the window
to either Continue, Go Back, Cancel, or complete the wizard by clicking "Done."

 

 

Field Description

Mark Type Select your mark type. As you click on each type, the
preview will change to reflect the mark you have selected

Placement Type Choose whether to place the mark manually, or using Smart
placement. Smart placement will attach the mark to an
anchor, as selected below

Anchor If Smart placement is selected, choose to anchor the mark
to the Plate, the Sheet, a Group, or an individual Product.
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Field Description
Exact placement will be determined in the final step of the
Mark Creator Wizard.

Print Settings
Every mark has the same print settings options. Here, you can define how the object will print,
including overprint, whether to ignore ink types, the layer name, underprint, and clipping

 

 

Field Description

Overprint Option to enable overprint for the mark, and if so, which
overprint Modeto use.

Ignore Technical Inks Option to ignore technical and/or varnish inks in the Colorof
the mark

Layer Name This field allows you to specify which output layer the mark
is placed on. If a value is set here, a layer will be created
with the layer name specified. If no value is set, no layer is
created for the mark, and it is placed with the rest of the
layout artwork.

Double-sided Optionally mirror the mark to the back side if the item is
double-sided

Underprint Option to add underprint, in the specified color, to the mark.

Clipping Option Option available in some mark types to clip the mark to the
anchor bounds. You can specify a margin inside the bounds
to clip the mark so that it doesn't extend past the bounds.
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Mark Placement
When Smart Mark Placement Type is chosen, the Mark Placement screen will be available. This screen
allows you to define how the mark will be placed relative to the anchor.

 

 

Field Description

Name Give the mark a unique name

Folder Optionally, select a folder within the Marks panel for
organization

Placement Instance By default, one instance of the mark is created. You can
add additional instances with unique placement for each by
clicking the Add button at the bottom, or remove instances,
by selecting the instance you want to remove, and clicking
the remove button.

Rotation Rotate the selected mark instance in 90° increments

Mirror Mirror mark horizontally. Useful for backside printing on
transparent materials

Anchor Select from the 9-point grid where the mark should be placed
relative to the anchor. This grid represents the anchor. For
instance, if you want the center of the mark to be placed on
the center of the anchor, select the middle of this 9-point
grid and the middle of the Mark 9-point grid. If you want the
center of the mark to be anchored to the bottom left of the
anchor, select the bottom left of this 9-point grid and the
middle of the Mark 9-point grid.
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Field Description

Mark Select from the 9-point grid where the mark should be placed
relative to the anchor. This grid represents the mark. For
instance, if you want the top right of the mark to be placed
on the top left of the anchor (so that the top of the mark is
aligned to the top of the anchor, and the mark sits to the left
of the anchor), select the top right of this 9-point grid and the
top left of the anchor 9-point grid. If you want the bottom left
of the mark to be anchored to the bottom left of the anchor,
select the bottom left of this 9-point grid and the bottom left
of the Mark 9-point grid.

X and Y Define how the mark should be transformed horizontally and
vertically from the anchor point. A positive X value moves the
mark to the right, and a positive Y value moves the mark up.

Reference Point Selection This graphic provides an alternate representation of the
Anchor and Mark selections. As you make changes to the
Anchor, Mark, or the Reference Point Selection, the others
will update to reflect the change.

Rules operate on anchor global
bounding rect

Define position and rotation based on the global bounding
rectangle of the anchor item.

Barcode
Barcode marks allow you create one of 14 common barcode types. The barcode parameters will vary
based on the symbology chosen, but many of the parameters are common to all barcode types.
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Field Description

Symbology The type of barcode desired. Supported Barcode types are
Aztec, Codabar, Code 39, Code 128, Data Matrix, EAN-8,
EAN-13, Interleaved 2 of 5, One-track Pharmacode, Two-
track Pharmacode, POSTNET, QR Code, UPC-A, and UPC-E

Color Define the Color of the barcode

Box Option to create a box around the barcode. You can define
the fill and stroke colors, stroke size, as well as extra margin
around the Top, Bottom, Left, and Right of the amrk.

Content The data to be encoded in the barcode. This field is dynamic
keyword enabled, meaning that you can have the content
automatically populated with data from the project. To use
a dynamic keyword, enter < in the content field, and either
type or click the dynamic keyword you want to use. For more
on keywords, check out Dynamic Keywords. For applicable
barcode types, an Add-On content field is available.

Quiet Zone Indicator A quiet zone adds a margin around the outside of the mark to
make scanning easier.

Factor Scales the barcode by the specified factor

Bar Height Defines the height of each bar

Bar Width Adjustment Adjust the width of the bar to account for the printing
process

Add-on Distance If Add-On content is sepcified, this field defines how far the
add on is away from the primary barcode content.

Bearer Bar
Bearer Bars are two solid bars added to either side of a layout that run the length of the layout,
generally for flexo printing.
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Field Description

Bearer Bar Type Select the type of bar you prefer. As you select
each option, the preview will update to show you
how they will appear. The graphic representatin
includes callouts with arrows and letters that
correspond to each setting below.

Color Define the Colorof the bar. By default the Coloris
registration.

Width Set the width of each bar.

Side Offset The offset distance from the outer vertical edge
(left and right) of the layout to where the bar
starts.

Top Margin The margin distance from the top of the layout to
where the bar starts.

Bottom Margin The margin distance from the bottom of the
layout to where the bar starts.

Thickness For certain Bearer Bar Types, thickness refers to
the stroke width of the lines that appear in the
bearer bar.

Repeats For certain Bearer Bar Types, the number of
repeated sections in each bar

Step Height For certain Bearer Bar Types, the step distance
between bearer bar patches
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Field Description

Patch Height For certain Bearer Bar Types, the height of each
bearer bar patch

Braille
With the optional Braille module, this marks allows you to dynamically create braille.

 

 

Field Description

Content The data to be represented with brailled. This
field is dynamic keyword enabled, meaning that
you can have the content automatically populated
with data from the project. To use a dynamic
keyword, enter < in the content field, and either
type or click the dynamic keyword you want to
use. For more on keywords, check out Dynamic
Keywords.

Mode Choose between Standard braille or ADA
Compliant braille.

Alphabet Select which braille alphabet to use

Color Define the Color of the braille mark

Dot Diameter Set the diameter of each braille dot

Dot Spacing Set the spacing between dots within a cell
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Field Description

Cell Spacing Set the spacing between each cel

Camera
Camera marks are designed for items that need to be cut out on a table cutter equipped with a camera.
These marks enable a camera on the table to align with the printed piece and ensure the machine is
making accurate cuts.

 

 

Field Description

Mark Shape Choose between a circle or cross

Color Define the fill and stroke of the mark

Size Set the Sizeof the mark and thickness of stroke, if
applicable

Auto Distribute Marks Automatically place marks along the length of the
layout

Perimeter Only If auto distributing marks, only place them along
the outside of the layout

Mode Choose between Quantity, where a specific
number of marks are distributed, or spacing,
which sets a minimum spacing between marks
and lets Phoenix determine the quantity and
placement location.
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Field Description

Corner Marks Sets marks to be placed in the corners of the
layout.

Double Corner Optionally sets the lower right corner to place two
marks. This allows for a registration corner for the
table.

Double Corner Spacing Sets the spacing between the two marks in the
corner

Minimum Distance Sets the minimum distance between two marks.

Distancefrom Sheet Sets the minimum distance from the edge of the
material. A value of 0 will place marks on the edge
of the material.

Center
Center marks place a center registation mark on the layout.

 

 

Field Description

Center Mark Type Choose from the predefined mark types, or select
a custom mark from a PDF

Color Sets the Colorof the mark
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Field Description

Dimensions Set the width and height of the mark, which
correspond to the dimensions in the graphic

Distance Sets the offset distance for the mark from the
edge of the sheet

Diameter For marks with a circle, defines the diameter of
the circle

Thickness Sets the stroke thickness

Collation
Collation marks place a mark for delineating collation patterns across collated signatures in bookwork.
Collation marks are highly configurable with options controlling mark dimensions, color, text
numbering position, and font. A location settings allows you to place collation marks in the spine, face,
jog, and non-jog folded edges to handle perfect bound, section stitch (Smyth sewn), and saddle stitch
binding methods. In addition, text can optionally be placed in user-defined top or bottom margins of
the folded edges with full dynamic keyword support.

 

 

Field Description

Pattern Choose the pattern: Zig Zag Up, Zig Zag Down,
Snake Up, or Snake Down

Size Set the width and height of the mark

Color Set the color of the collation mark
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Field Description

Font If using numbering, set the font to be used

Location Define where the number should be placed

Position Sets the rotaiton of the numbering

Rotation Sets number rotation

Format Define the format of the numbering

Margins Set top and bottom margins. In addition,
optionally add static or dynamic keyword text to
be placed in the margin.

Color Bar
The Color Bar marks allows you to create a fully customizable Color Bar. To create the bar, first choose
the general settings, shape, dimensions, optional stroke, and label. If you want to create a custom bar,
choose the "Choose Inks" option in the Inks dropdown of the General Settings. Then, in the Ink Order
section, click and drag the ink swatches into the box below to create the Color Bar configuration. The
swatches, left to right, are a CMYK shortcut, then cyan, magenta, yellow, black, inks by index, and finally
spot inks by index. You can also create custom gradations, as well as choose inks from your ink library.

 

 

Field Description

Inks Choose Layout Inks, Item Inks, or manually
Choose Inks
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Gap Sets the gap between ink swatches

Repeat Method Define how the Color Bar should be repeated

Length or Number of Repeats Specifies either a length relative to the anchor
item, or the number of times the bar is repeated

Shape Choose the swatch shape

Dimensions Defines the Sizeof the swatch

Stroke Optionally add a stroke, define the thickness, and
Color

Label Optionally add a label to each swatch, choose
what kind of label, and positioning

Ink Order If using Choose Inks, this lets you set the ink order
by dragging and dropping the inks into the box
below to create a custom swatch order. You can
drag the colors in, and then double click on a
swatch to customize it

Color Patch
Color Patch marks are very similar to Color Bars, but do not repeat.
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Field Description

Inks Choose Layout Inks, Item Inks, or manually
Choose Inks

Gap Sets the gap between ink swatches

Shape Choose the swatch shape

Dimensions Defines the Size of the swatch

Stroke Optionally add a stroke, define the thickness, and
Color

Label Optionally add a label to each swatch, choose
what kind of label, and positioning

Ink Order If using Choose Inks, this lets you set the ink order
by dragging and dropping the inks into the box
below to create a custom swatch order. You can
drag the colors in, and then double click on a
swatch to customize it

Corner
Corner marks add marks to the corners of the item they are anchored to, whether plate, sheet, group,
or product.
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Field Description

Mark Type Select the type of corner mark to be used, or
upload a PDF to use a custom corner mark

Color Define the Colorof the corner mark

Dimensions Set the dimensions of the mark. The graphic on
the right side of the mark creator wizard displays
a representation of the mark to easily allow you
to correlate what each dimension affects in the
mark

Bleed The distance to offset the corner mark to account
for any potential bleed. Can use the bleed of the
item the mark is anchored to by checking the
From anchor button.

Thickness The stroke thickness of the corner mark

Crop
Crop marks add tick marks around a sheet or group to easily allow for a cutter to separate items in a
group or on a sheet. Crop marks can only be placed with Smart Placement and attached to either a
sheet or a group.
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Field Description

Mark Type Select the type of crop mark to be used. The
differences here revolve around where the ticks
are placed, either around the bounds of each
product, the bounds of a rectangle formed by
all the products, or marks for every cut, even for
products not on the outside of the group or sheet.

Bounds Select if you want to create a mark for the bounds
of the group or sheet, along with the Colorof the
crop mark and line style

Bleed Select if you want to create a mark for the bleed
of products in the group or sheet, along with the
Colorof the crop mark and line style

Cut Select if you want to create a mark for the cut
lines of products in the group or sheet, along with
the Colorof the crop mark and line style

Crease Select if you want to create a mark for the crease
lines of products in the group or sheet, along with
the Colorof the crop mark and line style

Fold Select if you want to create a mark for the folds
of products in the group or sheet, along with the
Colorof the crop mark and line style

Length Specify the length of each tick mark

Offset Specify the offset of each tick mark

Thickness Specify the stroke thickness

Allow Marks in Bleed Areas Optionally allow crop marks to extend into
product bleed

Custom
Custom marks allow you to create marks from an existing PDF file.
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Field Description

File Location Choose the where the PDF is located that you
want to use for this mark.

PDF Box Select which PDF box to use for the dimensions of
the mark.

Scale Optionally scale the mark horizontally or vertically

Custom Mark Ink Mapping
When using a custom mark, Phoenix can dynamically remap inks in the PDF to an ink of your choosing.
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Field Description

Perform Ink Mapping Choose this option to enable the ink mapping

Mapping Preset Choose a preset, or click edit to create or modify
an existing preset

Ink Name Ink Name lists the names of inks in the input PDF
to be remapped

Map To Map To lists the corresponding ink that the Ink
Name of the input PDF needs to be mapped to

Note:  The Ink Mappings will only appear if the pdf used has an ink name that matches what's
in the ink mapping. So, for instance, if the ink mapping is only for the ink "Reflex Blue" but
the custom mark pdf doesn't contain "Reflex Blue", the mapping won't appear in the available
mappings dropdown.

Custom Mark Keyword Mapping
When using a custom mark that contains text, Phoenix can automatically remap text or parts of text
from the input PDF using keywords.
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Field Description

Perform Keyword Mapping Choose this option to enable the keyword
mapping

Mapping Preset Choose a preset, or click edit to create or modify
an existing preset

Keyword Define the keyword that appears in the input PDF
that needs to be mapped to something else

Map To Choose what the keyword should be remapped to
in the mark

Text Content The Text Content field displays the text in the
input PDF and highlights any keywords that
have been added as a mapping in the Keyword
Mappings section

Die Design
The Die Design mark creates a mark in the shape of the product.
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Field Description

Shape Type Choose from a rectangular shape or die shape

Color Select the Colorof the shape stroke and fill

Thickness If using a stroke, set the stroke thickness

Send to Back Optionally send the shape behind the product

Dimension
Dimension marks add dimensions to the object they are anchored to. New to v8.0, Dimension marks no
include options for folded and bound signatures!
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Field Description

Stroke Define the stroke Colorand thickness for the
dimension lines

Text Choose the dimension text typeface, style, and
font Size

Position Choose where you want the mark to go, top,
bottom, left, or right

Placement Select whether the value should go outside or
inside of the dimension lines

Offset Set the offset distance for the dimension mark

Arrow Size Set the Sizeof the dimension line arrow point

Stem extension Set how far the stem should extend from the
product

Stem gap Define the gap Sizebetween the stem and the
product

Draw stems from center Optionally choose to draw stems from the center

Show Units Optionally choose to have dimension units
displayed in the mark

Measurement Points Set where the dimensions should be based on.
Choose the edge or center of the product, or
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Field Description
for folded products choose Page Edges, Page
Centers, or Folds.

Eye Mark
Eye marks are rectangular marks typically used in packaging used to indicate the position of each
product in a layout to a camera mounted on a finishing device.

 

 

Field Description

Color Select the Colorof the shape stroke and fill

Thickness If using a stroke, set the stroke thickness

Dimensions Set the dimensions of the mark. The graphic on
the right side of the mark creator wizard displays
a representation of the mark to easily allow you
to correlate what each dimension affects in the
mark

Gap Set the distance of the gap between the product
and the eye mark

Columns Select which columns the eye mark should appear
on

Rows Select which rows the eye mark should appear on
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Field Description

Position Set the position of the eye mark to be at the
bottom, center, or top of each product

Grommet
 

 

Field Description

Mark Type Select the type of grommet mark to be used, or
upload a PDF to use a custom grommet mark

Color Select the Colorof the grommet mark

Dimensions Set the dimensions of the mark. The graphic
below this setting displays a representation of the
mark to easily allow you to correlate what each
dimension affects in the mark

Thickness Set the stroke thickness

Hem Width Set the width of the hem

Offset Set the offset of each mark from the edge of the
product

Max Interval Set the maximum interval between grommet
marks. Phoenix will automatically distribute
Grommet marks at the corners and evenly along
each edge, up to this maximum distance
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Field Description

Location Optionally choose to remove marks from one or
more sides by unchecking the corresponding side

Marks on Hem Optionally place marks inside the product on the
hem.

Ink Eater
Ink Eater marks are used in offset printing to place additional ink in what would otherwise be a non-
printing area in order to help ensure consistent ink consumption across the plate.

 

 

Field Description

Steps Defines the number of repeats of the ink order
specified below

Orientation Sets the direction that the ink eaters appear,
vertically or horizontally, as well as the order the
ink order appears

Ink Order The ink order defines how the inks appear. You
can add inks by clicking and dragging from the
swatches into the box below, or click either the
Choose Ink or Composite button. You can also
click and drag to rearrange swatches, or double
click on a swatch to edit it.
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Field Description

Margins Define the margin around the sheet where ink
eaters should not appear

Apply using Choose to mask out the product, and which
product area to use

Extra Margin Give an extra margin around the product where
ink eaters should not appear

Registration
Registration marks are used to ensure the print inks are in register. This includes registration marks as
well as side guides.

 

 

Field Description

Standard Registration Marks Select the style of registration mark to use

Side Guides Select the style of side guide to use

The next page in the wizard displays the sizing for the registration mark

Field Description

Dimensions Set the dimensions of the mark. The graphic on
the right side of the mark creator wizard displays
a representation of the mark to easily allow you
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Field Description
to correlate what each dimension affects in the
mark

Shape
 

 

Field Description

Shape Type Choose between a rectangle or ellipse shape
mark

Color Select the Colorof the shape stroke and fill

Dimensions Set the dimensions of the mark. The graphic on
the right side of the mark creator wizard displays
a representation of the mark to easily allow you
to correlate what each dimension affects in the
mark

Thickness If using a stroke, set the stroke thickness

Signature
Signature marks have been added for folded and bound signatures with options delimiting signature
bounds, page edges, page centers, bleeds, folds, and fold crosses. Line color, length, offset, and
thickness can be customized for each delimiter type.
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Text
Text marks allow you to add static and dynamic text to a layout.
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Field Description

Font Choose the typeface, style, and font Size

Underline Optionally add an underline to the text

Color Select the Colorof the text

Keywords Add dynamic keywords to the text content

Text Box Add the text to be used in the mark here

Note:  Dynamic keywords will only appear if attached to the relevant item. For example, if
the mark is using manual placement, product keywords are not available. If the text mark is
anchored to a product, however, product keywords are available in the dropdown

Script
The optional Scripting module allows you to create custom marks using javascript, which open up the
full power of Phoenix's drawing tools to allow you to create any mark you can think of. The settings are
fairly straightforward, since the mark itself is completely driven from the script. The main section of
the window is where you can write your script. You can also load a script from a library or load one from
an external file.

 

 

Field Description

Select from library Choose a saved script from your library

Load from file Load a script in from a .js file on your disk
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Reload from source Updates a mark that has previously been loaded
from disk and has since been modified.

Clear Removes any mark currently loaded

Assigning Product Group Marks Shortcut
By default, dropping a Group or Product Mark from the Marks Panel into Layout View will apply that
mark to all Group or Products in the current side of the layout respectively. You can assign a Group or
Product Mark to a specific Repeat item or specific Product by holding down the Control key.

Dropping Group or Product Marks into Layout View applies that mark globally to the project. This
means that mark will be in all current and future Groups/Products unless removed or hidden explicitly
within them. By using the Control key shortcut you can apply the smart mark to the specific Repeat the
cursor is under when releasing the mouse button in the case of Group Smart Marks or, in the case of
Product Smart Marks, you can apply the mark to the product that a product item belongs too under the
cursor. The mark will appear only in instances of the given product in the project.

Mark Inspection Mode
To highlight all the marks in Layout View, navigate to the Tools menu and select Mark Inspection, or use
the keyboard shortcut Control + Shift + M. Mark Inspection Mode provides a clear way to verify mark
placement.

You can adjust the visibility of the Products in the Layout as well as the Marks by adjusting the sliders
in the Mark Inpsection toolbar at the top of the window. You can also change the highlight Color of the
Marks by clicking the swatch next to the "Marks" text in the Mark Inspection toolbar.

2.6.6.  Marks 2.0

Phoenix 23.3 introduces the future of marks in Phoenix - what we're dubbing "Marks 2.0"

To create a new mark of this type (or modify an existing one), navigate to the Marks panel, and select
New Mark... from the dropdown in the top left of the panel.

 

 

This will open the Mark Creator Wizard, which will allow you to define the mark settings. The screens
in the Mark Creator Wizard will vary based on the options selected. After the settings are chosen for
each screen, use the navigation buttons at the bottom right of the window to either Continue, Go Back,
Cancel, or complete the wizard by clicking "Done."
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The two types of Marks 2.0 marks to start are Shape and Barcode. Both Marks will allow you to set some
general settings such as the Name (required), the folder, and a brief description of the mark.

Shape mark
 

 

The Shape mark allows you to choose from a list of different shapes. You can use a combination of
shape marks to create many diverse marks.

Barcode Mark
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The Barcode mark allows you to define the type of barcode and content, much like the traditional
barcode mark you've known and loved. Based on the barcode symbology, you can define additional
parameters like shape, size, and bar width adjustment.

Placement
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The placement window allows you to define where the mark should be, well, placed! At the top you can
define whether this mark is Smart or Manual. Manual marks must be placed by clicking and dragging
the mark to the desired location. Smart placement allows you to specify logic for mark placement using
the other settings on this window.

For Smart placement, use the Anchor dropdown to choose between 16 different anchors:

• Plate
• Plate punch
• Sheet
• Content Margins
• Image Margins
• Gripper
• Group
• Die Template
• Step & Repeat
• Component
• Flat
• Signature
• Bound Signature
• Folded Signature
• Tile
• Page
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Finally you can choose the mode. Basic mode brings up the classic 9-dot grid for placement that you
may be familiar with in our traditional marks. Advanced mode gives you new functionality:

 

 

You can see in the above screenshot that now there are additional options for mirroring and padding,
and most importantly the placement is defined with separate Horizontal and Vertical rules.

For each axis, you can choose an Anchor option. These are detailed below:

Rules
The Rules option allows you to define one or more rules for placement based on the bounds of the mark
and the anchor. For horizontal rules, you can choose between left, center and right for both anchor
and mark, as well as a horizontal offset with the "X" field. You can also add additional rules to combine
multiple rules.

For example, if you wanted the mark to be placed on the left and right of a product on the outside with a
10mm offset, you would first define the anchor as the Component (this encompasses all product types).
Then, add a horizontal rule with Anchor = Left, Mark = Right. This will place the right side of the mark on
the left side of the product. Then specify X = -10mm to offset it. Then add another horizontal rule, with
Anchor = Right, Mark = Left. This places the left side of the mark on the right side of the product, and
then adding X = 10mm will add the 10mm offset.
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Note that if you choose Rules as your Anchor option, you must have at least one rule. Otherwise the
mark is not fully defined and won't work.

Max Spacing
Max Spacing allows you to specify that the mark be distributed automatically along the given axis,
based on the maximum spacing allowed before another instance is placed. Specify the Maximum
spacing, the side of the mark you want to base the spacing on, and any offset.

Quantity
Quantity will distribute the number of mark instances that you define. Specify the quantity, the side of
the mark to base it on, and any offset.

Folds
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This option only appears if the Anchor is set to a product signature. This allows you to place a mark
relative to a fold. You can specify how often it repeats based on the folds:

• All: Places the mark on all folds in the specified axis

• Range: Places the mark on a user defined range of folds in the specified axis (comma-separated)

• Outer: Places marks only on the outer folds

• Inner: Places marks only on the inner folds

• First: Places marks only on the first fold

• Last: Places marks only on the last fold

• Odd: Places marks only on the odd folds

• Even: Places marks only on the even folds

Properties
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Field Description

Layer This field allows you to specify which output layer
the mark is placed on. If a value is set here, a layer
will be created with the layer name specified. If no
value is set, no layer is created for the mark, and it
is placed with the rest of the layout artwork.

Stroke Choose the stroke color, define the thickness, set
a cap and join style, as well as the dash pattern

Fill Select the fill Color

Underprint Option to add underprint, in the specified color, to
the mark. You can define the margin to be added
on the four sides of the mark, as well as set a
stroke for the underprint

Clipping Option Option to clip the mark to the anchor bounds,
shape, or bleed, as well as the mark bounds.

Overprint Mode Option to enable overprint for the mark, and if so,
which overprint Mode to use.

Double-sided Optionally mirror the mark to the back side if the
item is double-sided, and if so, whether to mirror
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Field Description
the mark, or copy the placement rules to the back
side

Width and Height Define the size of the mark. You can set this as a
fixed value, or make it dynamic based on the item
size, either as an adjustment or a percentag

Conditions
 

 

The Conditions allow you to specify when the mark should be applied. You can add any number of
conditions using ANY or ALL logic and groups therein to add custom logic. For instance, in the example
above, the mark will only be applied to the first signature of a bound product. Subsequent signatures of
that bound product will not have the mark, nor will any other type of product.

2.6.7.  Die Design

A die design is a one-up die shape for a die. Die Designs can be imported from a structural CFF2 or DXF
file, as well as an ArtiosCAD ARD or MFG file. The Die Designs library allows you to store commonly used
Die Designs and use them in projects by assigning die designs to products.
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To import die designs into the die designs library, navigate to the Die Designs panel, click the dropdown
in the top left, and choose Import Die Design... Phoenix will prompt you to select the die design file to
import, and once selected will open the Import Die Design wizard, shown below.

 

 

Field Description

Die Name of the imported die

Name Set the desired name for the die in Phoenix.
Defaults to the name of the imported die

Folder Define where the die should be stored in your Die
Designs library

Preset Choose the Import Preset setting for the chosen
filetype

Mappings If not using a preset, or if you need to modify
the mappings, you can use this mapping tool to
set the mapping for the die design. Add, edit,
reorder, or remove mappings for your filetype. In
the example above, the CFF2 Line Type numbers
are being mapped to Tool Types in Phoenix

Use Grain Direction From MFG/ARD
New in version 23.3, Phoenix can detect the grain direction within ArtiosCAD files. To use this
grain direction, enable the preference "Use grain direction from cad data when available" within
Preferences > Product.
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After enabling this, any products created from or using a Die Design that had grain direction in the cad
file will have that grain direction set.

2.6.8.  Folding Pattern

 

 

The Folding Patterns library stores all of the possible folding patterns for bound and folded products.
You can double click on any folding pattern to see it in detail, or create a new one from the dropdown >
New Folding Pattern.

In the Folding Pattern Creation window, you can interactively create a folding pattern.

First, enter in the number of columns and rows in the signature. This will update the preview of the
signature in the window. You can then hover your mouse over any of the fold lines to fold the signature
however you need to. As you move your cursor, you can see a preview of the fold, and can move your
mouse to indicate whether the fold should be up or down. Once you've decided on all of the folds, you
can click OK to save it, or click on the Front and Back tabs to preview the signatures with the page
numbers.

You can edit the page numbers to allow for custom pagination if you need to, simply click and change
the page number. This will be saved to the Folding Pattern when you click OK.

2.6.9.  Mark Sets

Mark Sets provide an easy way to group many existing marks together. This way, you can simply select
one mark set that includes many separate marks instead of having to manually add marks. Think of it
as a shortcut for reusing groups of marks that are commonly used together.

To view mark sets, or create new ones, make sure the Mark Sets panel is visible from the Window
menu. From here, you can click the dropdown in the top left of the panel to access the Mark Sets panel
options.

Click "New Mark Set..." to create a new set, and the following window will appear. You can assign this
mark set a unique name, place it within a folder for organizational purposes, and optionally give it a
description.
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Field Description

Name Name of the mark set

Folder Folder within the Mark Sets panel for this set to be
located

Description Optional description of this mark set

Add Mark Click the + button at the bottom to add new marks
to this set

2.6.10.  Tool Types

Tool Types represent the various tooling used by your Things to perform processes such as varnish,
emboss, deboss, coating, glueing, braille, cut, score, crease, etc. Each tool type defines tool properties
as well as a list of mappings from artwork spot colors (fills and/or strokes) or PDF layer names to
automatically map inks in your artwork to the correct tool type.

To add, edit, and remove tool types from your library, go to the Libraries menu and select 'Tool Types...'.
This will open the Tool Types dialog that displays a list of all current tool types and their properties.
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Field Description

Name Name of the tool type

Subtitle Optional description of the tool type

Color Representative color of the tool type. This is the
color that will be used for the tool type on output

Process Define the process this tool type falls under

Width Define the width of the cutting tool

Use as default cutting tool Set a tool type to be the default cut tool

Mappings Define how objects should be mapped to this tool,
as configured in the window described below.
Phoenix will then use these mappings to assign
a tool type to matching inks or layers in product
artwork.

 

 

Field Description

Source Select whether the mapping source should come
from a layer or a spot color
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Field Description

Painting Select whether the object is stroked, filled, both
filled and stroked, or either filled or stroked

Text Define the name of the layer or spot ink to be
mapped

offset Optionally define the offset the tooling should
have from the mapped artwork tooling line

Join Style For artwork mappings where two lines join
together, choose how should the intersection be
joined

Miter Limit If using a miter, define the maximum distance of
the miter before it is truncated
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You can create a new tool type by clicking the add button (+) and then configure it as described above.

2.6.11.  Ink Mappings

Ink Mappings allow you to define mappings for how a given ink in product artwork should be mapped to
the various ink types - Bleed, Cut, Crease, Foil, Glue, Technical, and Varnish.

To add an ink mapping, or modify an existing one, first select the ink type from the dropdown at the top
of the window. Then click the + button to add a mapping, or select an existing mapping and click the
Edit or Remove buttons.

 

 

Field Description

Ink Type Dropdown to select the list of mappings for a
given ink type

Name The name of the ink in the artwork to map to the
selected ink type

Ignore Case Choose false to make the ink mapping case
sensitive, or true to ignore the case of the ink
name when performing ink mappings
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When creating a new ink mapping, or editing an existing one, the following dialog appears, allowing you
to configure the mapping:

 

 

Field Description

Name Ink name in the artwork to map

Ignore Case Toggle on to ignore case, or off to make the
mapping case-sensitive

2.6.12.  Presets

Phoenix allows you to create presets for the following items in the configuration to store commonly use
settings:

• CF2 Export
• CF2 Import
• Cover Sheet Export
• Cutting JDF Export
• DDES2 Import
• DDES3 Import
• DXF Export
• DXF Import
• Dynamic Ink Mapping
• Dynamic Keyword Mapping
• HP JDF Export
• Imposition AI Profile
• JDF
• JSON Job Report
• Number Style
• PDF Die Export
• PDF Job Report
• PDF
• Product CSV Import
• Step & Repeat
• Stock CSV Import
• Structural PDF Import
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• Tiling Report
• Vector Export
• XML Job Report
• ZCC Export

Each of these presets are created in their respective locations within Phoenix. For instance, the PDF
Die Export Preset can be created or modified in the File > Export for Cutting > PDF... window. Once the
dialog is open, make the desired changes, and click Save Preset at the top of the window.

To see a list of your current presets, and to remove presets, navigate to the Preferences window and
select "Presets" from the left side of the Preferences window.

 

 

Field Description

Preset Selection This dropdown shows the various types of presets
available

Remove After selecting a preset in the list, you can remove
them by clicking this trash icon
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2.7.  Working with Phoenix

Phoenix is designed from the ground up to be easy to use, yet powerful and feature rich. There are
many different windows and menu options, which are explained in detail below.

2.7.1.  Main Window

The main window of Phoenix consists of the Project window, various Panels surrounding the Artboard,
and Toolbars. In addition, there are menu options that provide further options for what is displayed and
what can be done with the current project.

Drag and Drop
Drag and drop behavior in Phoenix has been greatly enhanced in 8.0 with a novel, patent pending
approach that results in significant productivity boosts for several common use cases. Now, when
dragging files into Phoenix, an overlay is displayed explaining the default behavior and in many cases
giving alternative actions to perform by dragging the file(s) into clearly designated regions within the
overlay.

Furthermore, multiple actions are now performed when two or more file types are dragged into
Phoenix at a time to automate common tasks like placing a die template and snapping artwork
files into it or importing a spreadsheet and assigning artwork files to products by filename. The
default actions performed for various drag and drop scenarios involving one or more file types can be
customized in Preferences # Drag and Drop.
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2.7.2.  Projects

Phoenix uses the concept of Projects. A project in Phoenix can contain multiple products, or artwork
files. Projects also contain layouts, which are imposed products on a particular sheet or roll. A Phoenix
project also refers to a file saved in the native Phoenix format, .phx, which saves the entire project,
including any layout(s), product(s), mark(s), and so on.

To create a project, navigate to the File menu and select New Project. A project will open, and
depending on your preferences, a New Project Properties window will appear.
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Here you can set various project properties that will be saved along with the project and can be used in
Dynamic Keywords later. Once the New Project Properties window is closed, or if it's set to not display
in Preferences, you'll see the main project window.

Project Views
There are multiple ways to view at a project. The views are Project, Layout, and Product, and are shown
just below the project tab at the top of the Artboard. The views are briefly described below, and more
detail for each view is provided later in the user guide.

Project View
The Project View provides an overview of the project, almost like a digital project ticket. There's a
summary section that shows the total run length, cost, waste, sheet usage, press time, and percent of
overage or under for the project. In addition, it shows a layout-by-layout breakdown of the press and
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sheet used for that layout, along with the layout run length, cost, waste, sheet usage, press time, and
overage or under.

Layout View
The Layout View shows a selected layout on the arboard and allows you to modify it. Each layout is
interactive, so if anything needs to be moved or changed, you can simply click on it and drag it to
another location, replace it, or remove it. You can drag products from the Products panel into a layout
to manually make a layout, or view a layout that has been created via Imposition AI.

Product View
The Product View shows a single product on an artboard and allows you to edit the product and set
product parameters.

2.7.3.  Panels

Each of the panels surrounding the artboard has a different purpose, but they all have a similar setup.
Panels are used to show all of the Things available to Phoenix, such as Devices, Plates, Stocks, as well
as resources like Marks, Templates, and Die Designs. Panels also are used to display information about
the open project, such as Products, Layouts, Items in the project, Inks, and Properties.

Working with Panels
Each panel can be closed or opened by navigating to the Window dropdown and clicking on the panel
name. You can also close panels by clicking on the X in the top right of each panel, and pop out a panel
into it's own window by clicking the  button in the header of the panel.

Alternatively, you can right-click on any panel header to bring up a contextual menu from which panels
can be opened and closed.

Panels can be rearranged and repositioned through a simple drag and drop interface to make
customizing your workspace easy.

New in Phoenix 7.0, panels are also searchable by clicking the magnifying glass icon in the header. This
makes it incredibly easy to find items that are in large libraries.

Also new in Phoenix 7.0 is the ability to import and export individual libraries as opposed to only being
able to import and export all Phoenix libraries. Phoenix libraries can be exported and shared by clicking
the dropdown in the top left corner, and selecting the Export Library option. This can then be imported
into Phoenix using the Import option from the same dropdown menu. Individual library items can also
be exported by right clicking on the item and selecting Export.

Copying Library Items
If you would like to make a copy of a library item (Press, Plate, Mark, Mark Set) you can right click on the
item and select "Duplicate". This makes a copy of the item in the same folder as the original. Now if you
want to move the copy to a different folder you can drag and drop the new item into the folder.

Pressing Control while dragging and dropping the original item will keep that item in place while
making a copy of the item. If you want to make a copy in the same folder make sure to keep the cursor
position within that folder. You can also move the cursor into a different folder to make the copy
directly into that destination folder.
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Products
The Products panel shows all the products currently in the project. Each product has a thumbnail on
the left side, the name of the product, the product size, stock, ordered quantity, and total quantity
placed in the project. Products also have a color assigned that represents the product die shape if
the artwork is hidden in the Items view and also displayed in reports (if Show Artwork is disabled) and
Imposition AI summary previews

The Products panel is useful for selecting products to manually create layouts by dragging and
dropping from the Products panel into a Layout.

Create New Products

To create a new product, click the dropdown in the top left of the panel, find the product type you wish
to create, and then select the artwork source. For more in depth info on products, check out Projects
on page 174.

Contextual Menu
If you right click on a product, you have some additional options from the contextual menu.
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Option Description

Impose, Populate, Optimize Quickly run Imposition AI on the product

Enter Product View Open this product in the Product View

Select Items Selects all instances of this item in the current
layout

Die Design from Artwork Opens the Tool Mapping window to create a die
design from layers or inks in the artwork

Mirror Front to Back Mirrors the artwork on the front of the product to
the back

Send Front to Back Copies the artwork from the front of the artwork
to the back

Reset Item Bleeds Resets the item bleed to the default value
specified in Preferences
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Option Description

Duplicate Create a copy of the product

Duplicate Many Create multiple copies of the product

Duplicate from Artwork Create a copy of the product with different
artwork

Save As Die Design Saves the die shape of the product to the Die
Design library

Export Die Exports the die shape as a CFF2, DXF, or PDF

Remove Removes the product from the project

Filter and Sort
The Products panel allows for filtering and sorting to make it easier to view specific products. You can
filter and sort through the dropdown menu in the top left of the panel.

Layouts
The layouts panel shows all layouts currently in the project. Each layout has a thumnail with the
product colors to show a representation of the layout, along with the stock, size, and run length
displayed. You can add new (empty) layouts from the dropdown in the top left of the panel.

In addition, there are a few important options available by right-clicking an existing layout. First,
you can enter the Layout view for that particular layout (you can also enter the layout view by simply
double-clicking a layout in the list).

Next, you can save the layout (including product die designs and their positions) as a template for
reuse. You can also export the layout, either with die information as a CFF2, DXF, PDF, ZCC, or Cutting
JDF file, or export vector separations of the layout. Finally, you can remove a layout from a project.
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Files
The Files panel displays a list of all external files used in the project, separated by imported die
templates and artwork files. You can import die templates through this panel using the dropdown menu
option.

Properties
The Properties panel is one of the most important panels in all of Phoenix. It dynamically shows the
properties of the currently selected item. Some properties may be editable, and these are notated with

the pencil icon ( ). You can double click these fields to edit the property of the selected item. Each
item in Phoenix has unique properties.

Custom Properties
You can add custom properties to Projects, Layouts, Layout Surfaces, Product Parts, Product
Components, and Library Items, which can be referenced later in keywords and through the optional
Scripting module. To add a custom property from the Properties panel, click the dropdown in the top
left of the panel and choose Add Property.

Items
The Items panel displays all items in the current layout. This includes all marks, templates, and
products. The items can be rearranged through drag and drop to re-order the items. You can toggle the
visibilty of an item by clicking the checkbox to the right of each item.
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Inks
The Inks panel displays the inks in the current layout or product. For each ink, a swatch is displayed,
followed by the ink index, the name of the ink, and the ink type.

The ink order can be changed through dragging and dropping an ink, or by right-clicking on an ink,
selecting "Change Ink Order" and specifying the desired ink index for that ink. In addition, the ink type
can be quickly changed by right clicking on the current ink type and selecting the desired ink type.
Otherwise, the ink types are pulled from the Phoenix Preferences.

New in version 8.0, Phoenix has a Separations View which can be enabled by toggling off one or more
Inks. Simply click on the Swatch next to the Ink name, which will automatically switches the current
view to Output Preview mode for more accurate rendering of the currently visible inks. Note that
current ink visibility is purely a display feature and does not affect the way layouts are exported in any
way. In the screenshot below, the Dieline and TiliaVarnish inks have been disabled, as can be seen by
the Swatch not being filled.

Starting in Phoenix 8.0, any ink in product components and in layouts can be removed at any time.
Inks are removed directly from the Inks Panel or from the product page color properties list in the
Properties Panel. This allows users to remove inks that should not have been included in imported
artwork or inks that were detected incorrectly during the import process.

An ink can be added from the ink library by clicking the drop-down in the top left of the panel. You can
also reset the ink order in that same menu by clicking "Reset Ordering." Finally, if there are any inks
listed in the Inks panel that are unused, you can select "Remove Zero Coverage Inks" to remove them
from the Inks panel.
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Layers
The Layers panel displays the PDF layers in artwork files in either the product view or layout view. You
can turn the visibility on/off by clicking the checkbox next to the layer, which will then affect output
from Phoenix.

New in version 8.0, the Layers panel is now active in Project View, showing all layers across every layer
in the current project. Each individual layer can be turned on or off in Project View which turns them on

and off in all layouts where this layer is present.

Status
The Status panel shows various warnings and errors that may occur in a project.

Imposition AI
The Imposition AI panel allows you to run the four Imposition AI tools, specify exactly how you want
Imposition AI to run, and what criteria should be evaluated when run.
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For the Plan and Optimize tools, you can choose the profile to be run, the products to evaluate, which
devices you want to use, what sheets or rolls should be considered, and what templates Imposition AI
can attempt to use. The Impose and Populate tools don't have the Devices and Sheets/Rolls options,
as they only look to find results with the current device and stock in the project. In addition, Populate
doesn't have an option for Templates.

The other option for running Imposition AI is the Stopping Parameters. The Stopping Parameters
simply allow you to specify if Imposition AI should stop searching for results after a preset amount of
time. In some cases, Phoenix could continue searching for results, but in most cases, it should finish
searching in a reasonable amount of time.

Finally, the Imposition AI panel allows you to sort results. By default, the results are sorted by cost,
but you can change this to sort based on time, waste, sheet usage, run length, or layout count. When
using Plan mode, you can also enable the Priorities option, which restricts Imposition AI to only plan
products that have a priority value within a certain range.

While running Imposition AI, a status message will appear to update you on the status until results
are found. If Imposition AI is run with a Zund Cutting Device configured to connect to Zund Cut Center
Server, Imposition AI will report the status of the connection until it is connected.

For more detailed information on Imposition AI Profiles and Modes, please see the dedicated page to
Imposition AI on page 206.

Automate
The Automate panel is where Phoenix automation can be configured and managed. The Automation
module is an optional part of Phoenix and is spelled out in detail in the Automation Guide. See https://
www.esko.com/en/support/product?id=Phoenix.
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To use the panel, first add an automation type through the drop-down menu. You can choose from
Hot Folder, REST service, Switch connector, or CERM connector. Once added, you can right-click the
service to configure it.

For hot folders, you'll need to specify the details of the hot folder before you can add it. When you add a
hot folder, the hot folder setup will pop up and allow you to set the following options:

Field Description

Name/Description Set the desired name and description of the hot
folder

Polling Interval Set how often should the hot folder check for new
files
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Field Description

Folder Choose the folder to be monitored where new
files will be ingested for the hot folder.

(Output) Folder Optionally set the output folder where successful
files will be placed

File Convention Optionally enable and define the .File name
Conventions

For the Actions tab, click the Load... button to select the actions .xml file that defines the actions to be
completed by the hot folder.

On the Scripting tab, you can click the folder icon at the bottom to optionally load a script to run on
input files in your hot folder.

For more information on Hot Folders, see the dedicated pages in the Automation guide. See https://
www.esko.com/en/support/product?id=Phoenix

Commands
The Commands panel shows a reverse chronological history of the commands run in Phoenix.

Measure
The Measure panel is used in conjunction with the Measure tool to display the X and Y coordinates of
the cursor on the layout, along with the width, height, distance, and angle of the measured line.

Overlaps Tool
The Overlaps Tool panel is used to analyze the current layout for overlaps and control how overlaps
should be handled.
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The Analyze Same Overlaps button searches for overlaps that are the same across the layout to enable
the Resolve Same button for handling all similar overlaps at once.

Focus Overlap enables Phoenix to automatically zoom to highlight and focus on the selected overlap.
You can click through the various overlaps with the arrow buttons, and select how they should be
handled from the following options:

• Split - splits the overlap down the middle between the two objects
• A over B - allows object A to overlap on top of object B
• B over A - allows object B to overlap on top of object A
• Resolve - applies the selected overlap decision
• Resolve Same - applies the selected overlap decision to all same overlaps
• Split All - Splits all overlaps in the project

2.7.4.  Artboard

The Artboard is shown when in the Layout View or Product view and is where layouts or products can
be previewed and manipulated.

Artboard Toolbar
The Artboard Toolbar is the toolbar shown just below the project tab in Phoenix.

The Artboard Toolbar allows you to change views of the project between the Project View, Layout
View, and Product View. In addition, each view has additional tools available specific to that view as
described in detail below.

Project View
The Project View provides an overview of the project, broken down into a project summary, layouts,
and templates.

The Summary provides data about the entire job, including total run length, cost, and time, as well as
figures for the average waste, sheet usage, and unders or overs.

The Layouts section provides a breakdown of each layout. This includes the devices and sheet used for
the layout, total run length required, cost, waste, sheet usage, estimated time, and unders or overs.
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Finally the templates section provides a list of templates used in the project, as well as what layouts
they are used on, the source of the template, Die Making information, and any file path if using a
referenced template.

Layout View
The Layout View displays a selected layout in the project. You can choose which layout is selected via
the dropdown in the Artboard Toolbar, or by double clicking a layout in the Layouts panel. In addition,
the Artboard Toolbar contains a dropdown for selecting the work style of the layout, and a toggle to
display either the front or back of the current layout.

Work and Turn / Work and Tumble
New to Phoenix 8.0, you can change the work style of a layout to Work and Turn or Work and Tumble.

If you choose Work and Turn, the layout automatically changes to reflect the change, and you'll see
a dividing line running vertically in the middle of the layout, while Work and Tumble will do the same
thing but with a horizontal line showing the axis that is used to flip the sheet. Everything on one side
of the line shows the front of the product, and the other side shows the back, reflecting the workstyle
chosen. While working with the layout manually in this workstyle, any changes you make to positioning
is reflected on the opposite side to keep the products in perfect register. You can build up and manually
edit with the full set of artboard tools, such as the Step & Repeat tool and the Alignment and Geometry
toolbars.

Editing Items in a Layout
Layouts in Phoenix are always editable - you can just click and drag to move items, or use any of the
tools at any point. There are a few tips and tricks to make Phoenix even easier to use and get print
ready files out quicker.

You can move any item by clicking and dragging, and can restrict the movement to be only horizontal or
only vertical by holding the Shift key while dragging. In addition, you can hold the Option key to make a
copy of the item as you drag and drop. If you have multiple items on a layout, Phoenix will automatically
help you align items by snapping to bounds of other items on the layout to make alignment even easier.
If you drag a product next to another product, Phoenix will auto-snap the products so the bleeds are
perfectly aligned. Keep dragging and you can auto-snap the dielines if you want a dutch-cut.

New to version 8.0, you can interactively rotate items in the Layout view. Simply select an item and
move the cursor to a corner of the bounding box. The cursor will change shape to indicate rotation,
and you can rotate by clicking and dragging to the desired rotation. Holding the Shift key will lock the
rotation to 45° increments.

Phoenix also makes replacing artwork very easy. If you have a product in a layout, simply click it to
select it. Then find a different product in the Products panel, click and drag it on top of the existing
artwork in the layout, all while holding the control or command key. Phoenix will automatically swap out
the artwork without changing the product placement.

Product View
The Product View displays a singular product from the project. You can select the product to view by
double-clicking in the Products panel to enter the Product View, or click the Product View button in
the Artboard Toolbar. Each product type provides slightly different tools in the Artboard Toolbar for
working with the product.
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All products contain the Pages view, which displays the pages in the product and allows you to assign
artwork to a page.

Flat Product
Flat Products show the following tools in the Artboard Toolbar:

A - Front and Back options provide a quick toggle to view the front or back side of the product.

B - The Choose Artwork button allows you to choose an artwork file to assign to the product. The
dropdown option provides perform Page Mapping for both the Front and Back of the product.

C - The autosnap dropdown allows you to use the autosnap tool on a layer or ink to have Phoenix
automatically find the die shape based on an ink or layer in the artwork. If artwork is assigned to the
product, the Autosnap Analysis tool will appear to display if and how an autosnap match was detected.

D - The bleed opacity slider allows you to define how much of the artwork outside of the bleed should
be displayed in the Product View. Note that this does not affect output, but is a useful tool for seeing
artwork outside of the bleed.

E - The Die Design dropdown allows the Die Design to be set from an external CAD file, from the artwork
using a tool type mapping, from the trim box of the artwork, or based on custom dimensions.

F - The Edit Die Design button allows you to manually edit the die design. When this button is selected,
the product enters the Die Design Editor mode. This mode allows you to click and select any die lines
in the artwork and assign a line type using the dropdown menu that appears in the toolbar. Further, you
can use Shape Search along with setting a Gap Margin to find a die design from current die lines. You
can also use the Drawing tools which appear under the main Toolbox at the top of the screen to select,
draw, and edit die lines in the artwork.

G - The Generate Bleed Mask from Die allows you to easily create a bleed mask based on the die shape
of the product.

H - The Rectangular Bleed Mask button creates a rectangular bleed mask based on the bounds of the
die shape.

I - The No Bleed Mask button disables the bleed mask altogether.

J - If there is a bleed mask, this field allows you to specify the bleed distance. This value can also be set
in the product's properties using the Properties panel.

Bound Product
Bound products have two primary view modes, parts/sections and signatures.

The Parts/Sections view allows you to visually see the parts that make up the bounded product,
including the folding pattern and how the signatures are bound together.

You can add, match, or remove signatures through the buttons in the toolbar or by right clicking in the
main window. You can easily add a signature in a particular location by right clicking on the signature
just before or after the spot where you want to add the new one.
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The other main view is the Signatures view, which shows each individual signature.

A - The signature dropdown allows you to select a particular signature to view. You can also double
click on a signature in the Parts view to open it up in the Signature view.

B - Easily toggle between signatures using the arrow selectors.

C - Choose the front or back side to display.

Folded Product
Folded products have the same Signature View as described above in the bound Signature section.

Tiled Product
Tiled products give you two views, one for all of the tiles together, and then one for individual tiles.

The Tiles view shows an overview of all the tiles in the product.

In the Tiles view, you have many of the same options as for normal Flat products. In addition, there is a
toggle to show the overlay of the tiles on the Product, or to just display the tiles with dummy colors to
easily view the shapes.

The Tile view shows each individual tile. The toolbar allows you to choose which tile to view, along with
the standard product toolbar buttons.

Artboard View
Just underneath the artboard toolbar is the Artboard itself. There are a few items to point out in the
artboard:

• Rulers - Rulers are shown along the top and left sides of the artboard and behave similar to the
rulers in other programs. You can see and change the units in the ruler by right-clicking on it and
choosing a different unit. You can also create a horizontal or vertical guide line by clicking and
dragging from the ruler down or over into the artboard. These guides can then be locked in place
or removed by right-clicking on the guide line. The guides can be repositioned by clicking and
dragging, or by single clicking to select a guide and then typing in an exact position in either the Y or
X coordinate in the toolbar.

• Origin - By default, the origin of a layout is in the bottom left corner of a layout. To move the origin,
you can either right-click on the area where the two rulers meet, or click and drag from this area
and then release at the spot where you'd like the new origin to be.

2.7.5.  Toolbars

The tools in the main Toolbar are split into six sections. The different sections can be shown/hidden
from the Window -> Toolbars sub-menu or by right clicking on the toolbar and checking the sections to
be shown.

Phoenix is built for speed. This secion also describes the shortcuts in Phoenix that can dramatically cut
down the time it takes to build print-ready layouts in Phoenix. To switch between tools, you can click
on the corresponding button or you can use the keyboard shortcut (as long as the corresponding tool is
visible).
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Toolbox
Some of the most frequently used tools in Phoenix are placed in the Toolbox Toolbar.

Tool Hotkey Tool Overview

 Selection v Main selection tool for selecting
items, entering item context,
moving items and more

 Hand h Hand tool for moving artboard
around and zooming in and out

 Measure m Measure distances between
items in artboard

 Move t Move one product relative to
another by selecting reference
points on die lines between the
two

 Zoom z Zoom in and out of the artboard

 Fit All in View ctrl+alt+0 Fit all items in the current
artboard into view

Selection Tool
ypically, left click is used with Selection Tool (v) to select a given item while right click on an

item will show that item's Content Menu. Left clicking and dragging the mouse in an area

with no items will create a selection area that will select all items inside the rectangle when you release
the mouse button.

The following additional are available:

Forcing Selection Area
Shortcut: Control + Shift + Left Click + Mouse Drag

Description: Normally selection area gets created when you start Left Click + Mouse Drag in an area
with no items. Sometimes you will want to select multiple items with selection area but it is dicult
or impossible to start selection area in an empty region. If you hold down the Control and Shift keys, a
selection area will be created regardless of whether an item is beneath the cursor or not.

Multiple Item Selection
Shortcut: Shift

Description: To add more items to your current selection, hold down the Shift key while clicking on
the additional items. Similarly, hold Shift key while using Selection Area to add all items in the current
mouse selection area to your existing selected item(s).
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Alt+Drag Duplicate
Shortcut: Alt + Left Click Item(s) + Mouse Drag

Description: Holding the Alt key while moving items in the Artboard with your mouse will duplicate the
item in the destination instead of moving the items, essentially performing duplicate and move in a
single action.

Alt+Drag Duplicate works on single items as well as multiple selected items, giving you the power to
duplicate entire groups of items to a specific location in one shot. All relative positions of selected
items are preserved during this action.

Alt+Click
Shortcut: Alt + Left Click when item(s) are selected

Description: This shortcut behaves similarly to Alt + Drag Duplicate. Select item(s) and click anywhere
on the artboard to duplicate those items in the location of the mouse click. The new duplicate item(s)
will be centered in the cursor position of the click. For multiple item selection, the relative positions of
items are preserved.

Swap Items Shortcut
Shortcut: Control + Left Click Item(s)

Description: You can swap two items or groups of items in the sheet in a single action by selecting an
item (source) and click on another item (destination) while holding the Control key. The selected source
items will move to the position of the clicked destination item while the destination item will move
into the position of the source items. Product items, marks, and groups can all be swapped using this
shortcut. If any source or destination items are locked, a dialog will appear explaining the swap action
cannot be performed.

The reference point used during Swap Items is controlled by the 9-point selection widget in the
Geometry Panel. For example, if the center point is selected in the Geometry Panel, the center source
and destination item positions are swapped. If the lower-left corner of the 9-point selector is chosen
instead, the lower-left corner positions of source and destination items are swapped.

Multiple destination items can be swapped by holding the Control key and left mouse button while
dragging the mouse to create a selection area. Once the mouse button is released, all items in the
selection area will be treated as destination swap items. This features allows you to quickly swap entire
groups of items without explicitly grouping them beforehand.

Zooming in Selection Tool
Shortcut: Control + Mouse Scroll Wheel

Description: You can quickly switch to the Zoom Tool to zoom in and out of the Artboard but if your
mouse has a scroll wheel it can be even faster to stay in the Selection Tool, hold down the Control key
and move the scroll wheel up and down to zoom in and out.

Scrolling Up and Down in Selection Tool
Shortcut: Mouse Scroll Wheel

Description: To move the Artboard up and down in Selection Tool move your mouse scroll wheel up and
down respectively.

Fit Item in View
Shortcut: Alt + Shift + Left Click
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Description: If you hold the Alt and Shift keys and click on an item, the Artboard will automatically
zoom in fitting the item in the visible space. For example, if you want to zoom into a specific mark, hold
down Alt and Shift and click on the mark in the Selection Tool.

Entering Item Context
Shortcut: Double Click

Description: If you want to edit child items of another item, such as Repeat Marks within a Repeat
or Artwork within a Product, double click on the parent item(s) until you are in the desired context to
perform edits.

Leaving Item Context
Shortcut: Escape

Description: To quickly leave any item context and go back to the global context press the Escape key.
Note this also works for leaving Overlaps Tool Mode, Output Preview Mode and other context-based tool
modes.

Delete Multiple Anchors Shortcut
Shortcut: Shift + Delete

Description: Removes all currently selected anchor points in a single action. Available in both Die edit
and Bleed edit modes

Hand Tool
Hand Tool (h) works normally by holding down the left mouse button and dragging to move the Artboard
around. This is at times the most ecient way to move around.

Zooming in Hand Tool
Shortcut: Mouse Scroll Wheel

Description: You can quickly switch to the Zoom Tool to zoom in and out of the Artboard but if your
mouse has a scroll wheel you can also zoom in and out by moving the scroll wheel up and down.

Spacebar Shortcut
Shortcut: Hold down Spacebar key

Description: Hold down the spacebar at any time to temporarily switch to the Hand Tool. Once the
spacebar is released the previous tool will be restored. This shortcut allows you to pop into Hand Tool
to do fast navigation before continuing with your current tool without having to switch back and forth.

Measure Tool
Measure Tool (m) works normally by holding down the left mouse button to start measuring, dragging
the cursor to the desired location and releasing the button to take a measurement at any angle. When
starting a measurement, the Measure Panel will appear automatically if not visible.

Forcing Horizontal or Vertical Measurements
Shortcut: Shift + Left Click + Mouse Drag
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Description: Holding down the Shift key while taking measurements forces the measurement line to
be either horizontal or vertical depending on current cursor position. This is useful for measuring the
distance in a single dimension only.

Zoom Tool
Zoom Tool (z) will zoom into the Artboard when left mouse button is clicked. Also you can zoom into a
defined area by holding down left mouse button, dragging the mouse to define the desired zoom area
and releasing the mouse button.

Zooming Out in Zoom Tool
Shortcut: Control + Left Click

Description: Holding down the Control key while clicking will zoom out slightly instead of zoom in.

Imposition AI
The Imposition AI toolbar is available when the license includes the Imposition AI module.

Tool Hotkey Tool Overview

 Smart Place s Select an open area in the layout
to find unfulfilled products in the
project that can be placed while
honoring spacing and media
margin constrains

 Impose Opens the Imposition AI dialog
and runs the Impose tool with
the latest settings

 Populate Opens the Imposition AI dialog
and runs the Populate tool with
the latest settings

 Optimize Opens the Imposition AI dialog
and runs the Optimize tool with
the latest settings

 Plan Opens the Imposition AI dialog
and runs the Plan tool with the
latest settings

Alignment
The Alignment toolbar provides tools to quickly align selected items to media or other items.
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Tool Tool Overview

 Alignment Target Select what target the alignment is to be based
off

 Align Left Align to the left edge of the alignment target

 Align Center Horizontal Align to the horizontal center of the alignment
target

 Align Right Align to the right edge of the alignment target

 Align Bottom Align to the bottom edge of the alignment target

 Align Center Vertical Align to the vertical center of the alignment
target

 Align Top Align to the top edge of the alignment target

 Span Horizontally Horizontally space the selected items evenly
spanning the alignment target by the given gap
distance

 Span Vertically Vertically space the selected items, evenly
spanning the alignment target by the given gap
distance

Geometry
The Geometry toolbar reports the positions, rotations, and dimensions of selected items and when
possible allows you to accurately define new values for them.

Tool Tool Overview

 Reference Point Set the reference point for the item

 X Position X position of item relative to the reference point.
When possible, item position(s) can be moved by
editing this field.

Y Position Y position in layout relative to the reference point.
When possible, item position(s) can be moved by
editing this field.

 Item Width Item width. When possible, item widths can be
changed by editing this field.

 Item Height Item height. When possible, item widths can be
changed by editing this field.

 Item Rotation Item rotation. When possible, item widths can be
changed by editing this field.

 Lock Items Lock/Unlock items
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Marks
The Marks toolbar contains mark-related tools Place Numbers, Camera mark, and Dimension Mark.

Tool Hotkey Tool Overview

 Place Number n Place new Product Number
Marks directly into Products
in Product or Layout View by
mouse click

 Camera Mark Manually place a camera mark in
the layout by clicking mouse in
the artboard

 Dimension Mark d Manually create a dimension
mark by clicking on snap points
in Product or Layout View to
measure distances

Drawing
The drawing tools are used for drawing and editing die designs and bleed paths in die edit and bleed
edit modes, drawing shape marks to products or layouts in normal mode, or manipulating bleed
overlaps in overlaps mode.

Tool Hotkey Tool Overview

 Direct Selection a Select and move individual
control points on a path in die
edit and bleed edit modes.

 Line l Add new lines in die and bleed
edit modes. Draw line marks in
normal mode.

 Rect r Add new rectangles in die and
bleed edit modes. Draw line
marks in normal mode.

 Ellipse e Add new ellipses in die and bleed
edit modes. Draw line marks in
normal mode.

 Pen p Draw paths (lines and curves)
directly in the shape in die edit
and bleed edit modes.

 Add Anchor Point = Add anchor points to an existing
path in die edit and bleed edit
modes.
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Tool Hotkey Tool Overview

 Delete Anchor Point - Delete anchor points to an
existing path in die edit and
bleed edit modes.

 Anchor Point Tool shift + c Select anchor points and
manipulate the handles to
change the curve shape in die
edit and bleed edit modes.

 Cut c Clicking on a path splits the path
segment in two in die edit and
bleed edit modes. In overlaps
mode, drawing a line splits bleed
overlaps in two so they can
beresolved independently.

Cut Overlap Tool
The Cut Tool (c) works in Overlap Mode by drawing a line bisecting a given overlap. Start the cut by
holding the left mouse button and moving the cursor to the desired endpoint.

Releasing the left mouse button will perform the cut on the overlap closest to the start point of the line
drawn.

Cutting All Same Overlaps at Once
Shortcut: Control + Left Click + Mouse Drag

Description: Holding down the Shift key while drawing the bisection line will cause the overlap cut
to extend to all other identical overlaps in the layout. For example if you have the cartons with the
same flaps overlapping 20 times that all need to be cut before resolving, holding the Control key during
overlap cut will perform all 20 cuts at once.

2.7.6.  View Menu

The View Menu in the top menubar of Phoenix (or in the Mac Menubar) provides additional ways to view
Phoenix.

These options give an easy way to change the artboard view, or provides a way to show or hide a path,
tool type, or attribute of an item in the artboard.
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2.8.  Phoenix Tools

Phoenix has a number of tools available to make creating and editing layouts fast, ecient, and easy.
These tools can be accessed from the Tools menu at the top of the window on Windows, or in the Tools
dropdown in the menu bar on a Mac
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2.8.1.  Imposition AI

The dropdown options for Impose, Populate, Optimize, and Plan are shortcuts to open Imposition AI to
each mode.For more about Imposition AI, see Imposition AI on page 206

2.8.2.  Step and Repeat Tool

The Step and Repeat tool allows you to easily build a Step and Repeat grid from a selected product. To
use the Step and Repeat tool, you must have a product placed in a layout and selected, otherwise the
tool will appear grayed out.

With a product selected, the tool becomes editable and shows the current settings for the given
product's step and repeat grid. The easiest way to see how the Step and Repeat tool works, enable the
Auto apply option which will show all changes to the Step and Repeat grid as you edit the settings.

At the top of the tool, you can select or save a step and repeat preset. To save, click the floppy disk
save icon

Icon or field Description

Save preset

H Horizontal Repeat Count

V Vertical Repeat Count

Set the horizontal gap based on the product
edges, not including product width

Sets the horizontal gap based on the center of the
product, including product width

Sets the horizontal gap based on the die lines

Odd Gap distance for odd numbered gaps in the repeat
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Icon or field Description

Checkbox Optionally specify a different gap distance for
even gaps in the repeat

Set the vertical gap based on the product edges,
not including product height

Sets the vertical gap based on the center of the
product, including product height

Sets the vertical gap based on the die lines

Odd Gap distance for odd numbered gaps in the repeat

Checkbox Optionally specify a different gap distance for
even gaps in the repeat

No head turn

Head turn on rows

Head turn on columns

Head turn on columns and rows

No product rotation

90° product rotation

180° product rotation

270° product rotation

Create Bleeds Whether or not to add product bleed

Set no stagger

Stagger on columns

Stagger on rows

Stagger Amount How much to stagger, can be set in percentages
or absolute values with units

Restart After When to restart the stagger back to the start

Do not automatically place products horizontally

Automatically pack products horizontally

Automatically expand products horizontally

Automatically wrap products horizontally

Do not automatically place products vertically

Automatically pack products vertically

Automatically expand products vertically

Automatically wrap products vertically

Use Sheet Margins When automatically creating the step and repeat
grid, whether or not to use the sheet margins.
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Icon or field Description
If not using the sheet margins, specify custom
margins.

2.8.3.  Edit Bleed Tool

In the product view, the Edit Bleeds... tool will highlight the bleed path of the product and allow you to
edit the bleed path using the Drawing tools.

While in the Edit Bleeds mode, you can go to Window > Toolbars > Drawing, and use the tools to
manipulate the bleed. You'll notice that the artwork is greyed out and the bleed path becomes clickable.
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You can make the artwork more or less visable with the slider just below the project tab next to the
Done and Cancel buttons. When you're done editing, click the Done button.

2.8.4.  Overlaps Tool

The overlaps tool will analyze the layout for any instances of a product overlapping another product.
If there are any overlaps, you will see a view similar to the screenshot above. Overlaps are highlighted
in a light red, and you can click on any individual overlap to highlight it. When you do, you'll see the two
products overlapping will get labeled "A" and "B", which then lets you make the decision on how the
overlap should be treated. You can split the overlap down the middle, choose A over B, or B over A. At
this point, you can choose whether or not this choice is applied to both sides of the layout, and then

201



2 Phoenix

can click Resolve to apply the selection, or Resolve Same if there are multiple instances of this same
overlap, which can occur in a step and repeat grid for example. You can toggle between the overlaps by
clicking the arrow keys, and you can also split all overlaps with the Split all button.

2.8.5.  Strips Tool

The Strips Tool adds strips for die cutting to break down the waste by adding additional cut paths to a
layout. With a layout selected, go to Tools > Add Strips to display the Strips Tool.

Field Description

Tool Type Choose the tool to use for the strips that will be
addded

Max Length Specify the maximum length that an outer strip
may be

Margins Specify the margins between outer strips

Connector Offset Specify the offset from products that a connector
line between strips must be

Margins Set the margins between inner strips

Spacing Type Decide how inner strips will be spaced

Quantity/Spacing If quantity, determine the number of inner strips.
If spacing, decide the min/max distance between
strips

2.8.6.  Nicks Tool

The Nicks Tool adds nicks to the die to create a small gap so that die-cut pieces remain connected to
the waste material. With a layout selected, go to Tools > Add Nicks to display the Nicks Tool.

Field Description

Min Line Length Sets the minimum line length in the layout to add
a nick

Margins Specify the distance between nicks

Spacing Type Decide how nicks should be spaced out

Quantity/Spacing If quantity, determine the number of nicks. If
spacing, decide the min/max distance between
nicks

Width Determine how wide each nick should be
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2.8.7.  Media Tool

The Media Tool allows you to easily set the sizes and margins for a layout. You can specify the width/
height of the plate and sheet, as well as use the  button to fit the sheet/plate to the size of the current
selection in the layout or the  button to fit the sheet/plate to the products in the layout. You can click
the link icon to lock the ratio of width to height.

You can also set the Content and Image Margins, and set the Sheet position on the plate

2.8.8.  Repeat Tool

203



2 Phoenix

The Repeat Tool is an easy way to repeat an item on a layout. Choose the direction you want to repeat
by clicking the appropriate arrow button, set the number you want to repeat in the # field, and the

product gap in the  field

2.8.9.  Number Tool

The Number Tool lets you customize the product numbering on a given layout. This does not print the
number, but lets you customize it for use with keywords.

To use the tool, enter in the starting number, and whether or not the number should restart at this
value on each row. Then select the number style from numbers, letters, roman numerals, and the
various formatting options. You can specify a pre- or post-fix for the number. Then specify the start
corner and the direction of ordering. You can include the row number (and if so, whether that row
number should be relative to the number, front or back) as well as the format of the back number.
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Finally choose if you'd like to apply the numbering to both sides if you have a two-sided layout, and
whether to apply numbers to all products or only selected products.

2.8.10.  Output Preview

The Output Preview tool provides an output preview of your layout, similar to how Adobe Acrobat or
Illustrator can.

2.8.11.  Mark Inspection Tool
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The Mark Inspection Tool will highlight all marks on the layout to make it easier to see before
generating output. You can choose the color of the highlighting box as well as the visibility of products
by dragging the slider at the top of the layout.

2.9.  Imposition AI

The Imposition AI tools within Phoenix provide the most advanced ways to impose and plan. There are
multiple options to optimize the output from Imposition AI, so let's take a look at how it all works

2.9.1.  Profiles

Imposition AI profiles allow fine-grained control over the layout and plan creation process. You can
create as many profiles as you would like and choose from them while running the Imposition AI tools in
Phoenix or reference them during automation.

To create a new Imposition AI Profile, go to the upper-left corner of the Imposition AI panel, click on the
down arrow, and select “New Profile” from the menu.

You can also edit existing Profiles by clicking on the Profiles dropdown and clicking the pencil icon.

2.9.2.  General Settings

When creating or modifying a profile, you will see the following window with the general settings:
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Strategies
Strategies control how products are laid out on the sheet and correspond to the type of cutting you are
doing.

Field Description

Horizontal Cut Guillotine cut layout (square cut) with first cut in the
horizontal direction

Vertical Cut Guillotine cut layout (square cut) with first cut in the
vertical direction

Lanes Products are placed in lanes

Die / Table Cut Product items are tightly nested in the layout to be cut
out with a cutting die or on a cutting table. Within this
strategy there are three general nesting options that can

207



2 Phoenix

Field Description
be utilized. Any combination of these nesting options
can be enabled at the same time to find the best nested
layouts.

Free Nesting Product items can be tightly nested in any way on the
sheet without a discernible pattern.

Grid Nesting Product items are nested into step and repeat grids for
more consistent grid-like pattern layouts. This option
is especially useful when there are a smaller number of
unique shapes being nested onto a layout.

Strip Nesting Product items are roughly nested into vertical or
horizontal strips. Items can be rotated to fit together
better, and some free nesting is performed to maximize
sheet usage, so strips are not as rigidly defined as
Horizontal Cut or Vertical Cut strategies.

Templates Place products into existing layout templates loaded
into the Templates library or imported directly into the
current project (from CF2, DXF, etc)

Strip Options
These rules give control to how pieces are placed into strips when Horizontal Cut, Vertical Cut, and
optionally Templates strategies are being used.

Field Description

Strip Rule Controls which products can be placed in the
same horizontal or vertical strip. For example,
"Same Product" means a single product can be
placed in a strip with no other products mixed in
that strip.

* None - No strip rules, all combinations of
products are allowed within a strip (horizontal row
or vertical column).

* Same Product - Within a strip, only instances of
a single product are allowed. no other products
can be placed in the strip.

* Same Dimensions - Within a strip, only products
with the same width and height are allowed, other
products with differing widths or heights cannot
be placed in the same strip. Note that the die
shape itself can differ for products in the same
strip as long as the dimensions are the same.

* Same Property - Within a strip, only products
with the same product property are allowed.
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Field Description
* Same Width - Within a strip, only products with
the same width are allowed. Note that the die
shape itself can differ for products in the same
strip as long as the widths are the same.

* Same Height - Within a strip, only products with
the same height are allowed. Note that the die
shape itself can differ for products in the same
strip as long as the heights are the same.

* Same Shape - Within a strip, only products with
the same die shape are allowed, other products
with different die shapes cannot be placed in the
same strip.

* Same Colors - Within a strip, only products that
have the same normal printing colors (inks) are
allowed, other products that have fewer, more,
or at least one different printing color cannot be
placed in the same strip. Technical inks, varnish
inks, and foil inks are not considered printing
colors and are ignored when comparing colors
between products for this rule.

* Same Varnish - Within a strip, only products that
have the same varnish colors (inks) are allowed,
other products that have fewer, more, or at least
one different varnish color cannot be placed
in the same strip. Note that products with no
varnish colors can be combined on a strip.

* Same Foil - Within a strip, only products that
have the same foil colors (inks) are allowed, other
products that have fewer, more, or at least one
different foil color cannot be placed in the same
strip. Note that products with no foil colors can be
combined on a strip.

* Has Varnish - Within a strip, only products that
either all contain one or more varnish inks or all
have no varnish inks are allowed. In other words,
products with one or more varnish inks are not
allowed to be combined with products with no
varnish inks in the same strip and vice-versa.

* Has Foil - Within a strip, only products that
either all contain one or more foil inks or all have
no foil inks are allowed. In other words, products
with one or more foil inks are not allowed to be
combined with products with no foil inks in the
same strip and vice-versa.
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Field Description

Strip Property If using Strip Rule Same Property, specify which
product property to separate based on

Template Rule The rule controlling when to apply the strip rules
to templates if at all. When a strip rule is chosen,
you can apply this same rule to a template,
treating the templates as either horizontal or
vertical strips. Phoenix will analyze the templates
being used to detect these strips and then
enforce the strip rule.

Alignment How the strips of products are aligned on the
sheet and how products are aligned within the
strips. If you are cutting the sheet along left and
top edges first, then you will want "Top Left" to
reduce the number of cuts needed.

Gutter The amount of space to guarantee between strips
of products on the sheet.

Gutter Rule Rule for when to apply the gutter space between
two strips on the sheet. For example, if you
always want 10 mm space between strips
containing foil and those that do not contain foil,
then you can use the "Has Foil" rule.

Gutter Property If using the Gutter Rule Properties Differ, specify
which property to base the gutter rule on. This
gives more fine-grained control when gutters are
added between strips in layouts generated with
Horizontal Cut and Vertical Cut strategies.

Applying Results
These settings control what happens when results are applied to the project, by double click, by
clicking "Apply" from the detailed info popup dialog for the given result, and during automation.

Field Description

Split bleed overlaps When enabled, split all overlapping bleed paths
between products when the layouts from
Imposition AI are applied to the project.

Place products in group When enabled, place all product items in each
layout into a group when applying the layouts
to the project so product layout positions are
locked and can be easily moved around as a group
in the layout. Note that these products can be
ungrouped at any time in the layouts after the
result is applied.

Ensure placement honors press margins By default, the placement rules of the press are
used when applying results. Depending on the
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Field Description
way placement rules are defined in the press
and the sizes of product bleed paths, it might be
possible at times for the press placement rules to
push the bleed paths of products in the generated
layouts into an image margin. If you disable this
option, then the layout will be automatically
shifted in these cases to avoid content getting
into press margins, meaning the final placement
might differ from the press's placement rules.

Layout Options
Layout options apply to all layout strategies and control how many products are placed on the sheet
and the order of placement.

Field Description

Sheet Fill Controls how aggressively the sheet is filled up
with products.

* Balanced mode will use the best ratios of
products to avoid making too many products
above the order quantities, i.e. "overrun". Phoenix
does try to fill sheets with the best product
combinations to keep all layouts filled without
much overrun, but sometimes there are no great
options. Balanced mode allows you to easily add a
few more products onto the sheet manually.

* Max mode will aggressively fill up the sheet up
to the max overrun allowed for the products on
the sheet. This is good if you prefer to use the
sheet up always, even if it creates unnecessary
overruns.

* Min mode will place only the minimum number of
products on the sheet. It is only useful if you are
mostly trying to place as many 1-ups as possible
on the sheet and would like to go in afterward
and add more products to the project in cases
where there is not a great way to gang all current
products in order to increase the number of
products as much as possible.

Limit unique products per layout By default Plan will place any number of products
on the same layout. You can limit the number of
unique products with this setting. For example,
if you want every product to go on its own layout,
enable this setting and enter "1" in the text field.
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Field Description
We have customers limiting in the number of
unique products on a layout to 6, 8, 9, etc.

Die name matching This option adds additional requirements to
template matching so that the die design name
must match between the product and the die
template. This option prevents the potential of
a product being placed in a template position
where the outer shape is a match, but the inner
shape is not a match, for instance if there is a
window cutout that is unique to a particular die
design.

Allow product bleed in gripper By default, the gripper is treated as an image
margin and the layout strategies will not place
product bleeds into the gripper. Enabling this
setting allows products to be placed right above
the gripper even if their bleed paths go into the
gripper.

Allow work-and-turn Optionally allow Imposition AI to consider Work
and Turn layouts when working with sheetfed
offset presses. If Imposition AI finds that Work
and Turn will create a more cost effective result,
it will automatically select the Work and Turn
layout

Allow work-and-tumble Optionally allow Imposition AI to consider Work
and Tumble layouts when working with sheetfed
offset presses. If Imposition AI finds that Work
and Tumble will create a more cost effective
result, it will automatically select the Work and
Tumble layout

Use derived sheets If enabled, Plan will also search for results using
1/2 and 1/4 sheet sizes. A "derived" sheet means
the original sheet is split in two or in four. Plan will
still use the constraints of the presses to make
sure any derived sheets can be printed on the
selected presses.

Align items to outside edges If enabled, Plan will align the edges of items to
the 'outter-most' item (top, bottom, left, and right)
on the sheet. This provides benefits in finishing
scenarios such as guillotine cutting by reducing
the number of sheet turns and cuts

Aligned to edge:
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Field Description

Not aligned to edge:

Favor ordered placement When enabled, products in the layout will be
ordered according to the ordering pattern based
on the order that the products were added to the
project. You can specify the starting corner, as
well as the order method (by repeating rows or
snaking, either vertically or horizontally)

Note:  Only products with the same
shape are re-ordered within each layout.
Layouts containing products with two or
more shapes are not guaranteed to be
placed sequentially.
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Plan Options
Plan Options control how the Plan tool behaves.

Field Description

Mode Controls the overall behavior of the Plan tool.

* Standard mode will try to optimize the entire project. This is
the recommended way to run Plan in most cases.

* Layout by Layout mode will try to create tightly filled layouts
one at a time. This mode is suitable for cases in digital printing
when products are low order quantities and products are
allowed to be split up across layouts, i.e. "spanning".

* Sequential mode ensures that products are planned
sequentially across layouts according to the original order
products were added to the project. Sequential planning can
greatly simplify collection / packing processes.

Note:  Sequential mode ensures products are assigned
to layouts in sequential order, but does not ensure
products are positioned sequentially within each
layout.

* Cut and Stack mode plans products in stacks for easy
stacking after finishing. Cut and Stack is also helpful for
ensuring the stack of press sheets fits into the cutting
machine.

When using the Cut and Stack setting, a new parameter called
Stack Size appears, allowing you to define how tall the stacks
should be.

For example, if the stack size is 250 and there are four products
each with an order quantity of 500 each, Phoenix will create a
layout with a run length of 250 and place two instances of each
product, sequentially, so that the order on the layout is Product
1, Product 1, Product 2, Product 2, Product 3, Product 3, Product
4, Product 4.
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Field Description
On the other hand, if the Stack size is 250 and each product
has an order quantity of 125, Phoenix would create two layouts,
each with a run length of 125. Layout 1 would have Product 1 and
Product 3, while layout 2 would have Product 2 and product 4.

* Lanes mode ensures that products are planned in lanes,
maintaining the lane across layouts until the product is fulfilled.
This mode is useful for lane optimization on roll-fed digital print
devices (i.e. digital labels on web-fed device, books/signatures
on web-fed device, etc...).

Finishing Allows you to set whether your finishing equipment is done
Inline or Nearline. This will affect the order in which layouts are
produced. The default option is Inline.

* Inline means that layouts will be produced in the order they
are created. For instance, if Phoenix creates layouts A, B, and
C, then they will be ordered A, then B, then C. If your finishing
equipment is inline with the press, this allows your equipment
to process the layouts in order.

* Nearline means that layouts will be produced in the opposite
order they are created. This means that layouts A, B, C would be
ordered C, then B, then A, so that they would go onto the rewind
in the opposite order. This would then allow your equipment to
process the layouts from the finished roll, as the layouts would
then come out in order: A, then B, then C.

When working with signatures, Nearline reverses the order of
all signatures across the whole job (or across all products).

Allow products to span layouts By default, Plan will ensure that each product is on only one
layout in the project. If this setting is enabled however, the Plan
tool can try to place the same product across multiple layouts
to further optimize the project. Spanning products can lead
to lower costs in printing, sometimes with added overhead in
post-press or shipping.

Allow multiple press passes Enables Imposition AI to evaluate running an imposed press
sheet through the press in multiple passes when the number of
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Field Description
inks on a press form exceeds the number of stations/colors on
press.

- For example, imagine you have the following scenario:

Product 1 = Cyan,Magenta,Yellow,Pantone 185

Product 2 = Cyan,Magenta,Yellow,Black

You have a 4-color Offset Press in Phoenix

Here are the impacts ‘Allow multiple press passes’ will have on
Imposition AI results:

1. Disabled - Phoenix will be forced to create two separate press
layouts and will not be allowed to mix Product 1 & Product 2 on
a sheet because the combined number of inks on the layout
would 5 and the press in Phoenix is only a 4-color press.

2. Enabled - Phoenix will be allowed to mix Product 1 & Product
2 on one layout as a possible result. However, Phoenix will
compute that a result with Product 1 & Product 2 on the same
sheet will require two press runs for the one layout (press setup
time & costs will be calculated for each press pass)

Use run length of 1 for all layouts When enabled, the Plan tool will only create layouts with a run
length of 1, i.e. no repeats. This is useful in some digital printing
environments where it is easier to process one layout at a time.
This option can be used in conjunction with the new Sequential
mode to produce single copy layouts in order.

Web Options
Web Options control how the Plan tool behaves when dealing with a web-fed device.

Field Description

Allow frame spanning Option to span items across frames for roll-fed
work when using the Lanes planning mode. This
can be set to None, Items, or Pages. When set to
“Items”, Phoenix will utilize the full frame height
of the given roll-fed press with component items
placed across frame boundaries when needed.

Allow product sequence changes When enabled, the order the product are laid
out on the web can be changed. When disabled,
products will be ordered the same as the product
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Field Description
list, top to bottom, left to right across the web.
This option allows for more optimization.

2.9.3.  Plan Rules

The second tab in the Imposition AI Profiles is Plan Rules.

Plan Rules allow you to define how products should be placed on a layout produced with this profile.
You can create a rule from any product parameter and add conditional logic to the rules. By default, the
rules shown in the screenshot above are added. You can remove a rule by clicking on the trash icon, or
add a rule by clicking the "Add Rule" button.

New in v8.0, Phoenix can gang bound products together with flat, folded, and tiled products on the
same layout for better optimization. To enable this, simply remove the rule "Part > Is Bound are equal".

To set a rule, first choose what parameter you would like to set. Click the dropdown on the left side of
the rule to choose the parameter, and then on the right side choose the condition for that parameter.
The choices available for the conditions change based on the parameter you have selected. For
instance, parameters with a numerical value will have numerical comparators, such as the product
quantities all "are within" a certain range. Text-based parameters, like product name, will have the
comparators "are equal" or "are not equal."
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You can also group parameters to create advanced logic, so for example condition A, B, and C must be
met, but then either D, E, or F must be true. You can create any number of Plan Rules in an imposition
profile.

2.9.4.  Scripting

Available with the optional Scripting module, the Scripting tab allows you to run custom scripts
when a plan is applied. This feature exposes much of the core architecture of Phoenix and allows for
unprecedented customization and automation. Find out more in our Scripting guide.

2.9.5.  Tools

There are four tools within Imposition AI - Impose, Populate, Optimize, and Plan. These tools each
have a specific purpose, but they have some settings in common

Common Settings
Profiles – Choose the Profile to be used to make decisions when running Imposition AI

Products – Select the Products (from those in the Products Panel) to be used when running Imposition
AI

Presses (only in Optimize and Plan) – Select which presses should be considered when running
Imposition AI

Sheets / Rolls (only in Optimize and Plan) – Select which stocks should be considered when running
Imposition AI

Templates (only in Impose, Optimize, and Plan) – Select which die template to use when running
Imposition AI

Stopping Params - Optional setting to set a limit for how long Phoenix should continue searching
for more layouts. Click the checkbox to enable and set a time limit. The default value is 15 minutes.
Phoenix will intelligently stop searching if there are no additional layouts possible.

Impose
The Impose tool generates layouts for the currently selected press and sheet in the project.

Note:  If a sheet isn't specified for the layout, you cannot use Impose and will get a warning "A
sheet must be specified in the layout before using Impose tool." If you see this, simply drag
your desired sheet size from the stocks library onto your layout and try again.

Populate
The Populate tool will automatically assign products to the current die template. The numbers of each
product placed in the layout are determined by the Populate tool based on the number of orders to
achieve the best balanced result (i.e. lowest amount of overruns). Multiple variations of the original die
layout will appear with products assigned to different dies in the layout:

Note:  The resolved bleed overlaps are left unchanged. Populate does not alter or reset the
bleed masks of the dies when re-arranging products.
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Optimize
The Optimize tool goes another level beyond Impose by searching across several press/sheet
combinations to try to find the most cost effective layouts possible.

Note:

Only sheets that fit at least one selected press are displayed. Sheets that are below or above
min/max sheet sizes or stock thickness constraints of the selected presses are hidden
automatically. Auto Optimize will only generate layouts for legal press/sheet combinations.

Impose and Optimize will always generate layouts suitable for vertical first guillotine cutting
(Layout = Vertical Cut) and horizontal first guillotine cutting (Layout = Horizontal Cut). In
addition, grid-based layouts are also generated (Layout = Die / Table Cut). These layouts are
sometimes more ecient, but can lead to layouts that cannot be handled by a guillotine cutter.

For results with the same cost and waste, results with a lower number of “Sheet Turns”
arelisted first in the results. A lower number of sheet turns indicates a simpler post-press cut.
In general, Impose and Optimize attempt to minimize sheet turns to save time and costs during
post- press.

Plan
The Plan tool is the most powerful tool in Phoenix Imposition AI. It can pack products across multiple
layouts using different press and stock combinations to find the most cost effective layouts possible.

2.10.  Exporting from Phoenix

Phoenix supports outputting in a multitude of file formats. Let's break it all down, based on what
exactly is being output:

• Phoenix Projects

• Phoenix Libraries

• Products and Layouts

• Reports

Tip:

Using Presets:

The output settings described in this section can all be saved as a Preset to be reused for
convenience. To save a preset, simply configure the output settings as desired and click the
Save Preset option at the top of the window. This preset can be chosen in future exports, as
well as specified using any of our Automation tools.

2.10.1.  Exporting a Phoenix Project

Within a Phoenix project, you can save or export in many different ways. The most common is to export
for printing or cutting for producing layouts generated within Phoenix. Each option allows multiple
output formats and choices on how exactly the output is created, from output size to file naming and
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more. You can also save the Phoenix project itself for future use, or generate a template from the
Phoenix project.

Export for Printing
To export a file for printing, simply navigate to the File menu and choose the Export for Printing option.
From here, you can choose to export the project as an imposed PDF, JDF, or HP JDF.

Export Imposed PDF

Export Imposed PDF generates a PDF of the layout(s) in the Phoenix project. This option is the most
commonly used output in Phoenix, and creates a compliant PDF for use in any RIP or downstream 3rd
party system.

Export Imposed PDF is easily accessible with the shortcut Control–P (Windows) or Command–P (Mac).

General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Export as Define whether the layouts will be exported as a
Single File multi-paged PDF or create One File
Per Layout or One File Per Side for layouts with
front and back sides.
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Field Description

Create page for each layout run Optionally define if Phoenix should generate
individual pages for layouts that have a run length
greater than 1. For example, if a layout has a run
length of 50, this option would create 50 separate
pages for layout 1, while disabling this option
would create one pdf page for this layout.

Media Define whether to use the Sheet size or Plate size
for the output PDF

Scale Set the scale for the output PDF. Note this is
different than Distortion, which can be set below

Apply Bleed Margin Add a separate bleed margin to the output PDF,
with the margins set below

Use PDF 1.6 ‘UserUnit’ when media bigger than
200 inches

PDF files have a size limitation of 200 inches. PDF
version 1.6 supports handling larger files using
UserUnits which sets a scaling factor on the PDF.

Use distortion from plate If using Plates, this option automatically applies
the distortion value set for the used plate

Distortion Set a horizontal and vertical distortion value

Dieline

Field Description

Remove Artwork Dielines Optionally remove any dielines in the artwork.
Dielines are defined via the Tool Types Mapping.
Note that this only applies to Tool Type Mappings
specified via Spot color, not Layers

Add Dieline Add a dieline to the output PDF

Place dieline on top of all items Whether the added dieline should be placed on
top of all layout items

Apply Overprint Whether the added dieline should be overprinted

Dieline thickness Thickness of the added dieline(s)

Dieline to add Click the + to add a dieline. Specify the Line Type
to use to generate the dieline, as well as the Ink
and/or Layer to use in the output PDF

PDF/X
If the input artwork files are using PDF/X compliance data, use that in the output PDF. This only works
if the input artwork files do not have conflicting PDF/X versions. In that case, a warning will appear as
seen in the screenshot above.

Layers

Field Description

Existing Artwork Layers If the artwork contains layers, you can choose
how the output PDF should handle these layers.
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Field Description
Preserve will attempt to leave the layers as they
currently exist. Merge will merge any layers with
the same name. Flatten will cause the output PDF
to be flattened to one layer

Artwork Optionally create a separate layer only for artwork
files. Specify the name for this layer and whether
the layer should be On (visible), Off (hidden), or
Locked (visible)

Marks Optionally create a separate layer only for marks.
Specify the name for this layer and whether
the layer should be On (visible), Off (hidden), or
Locked (visible)

Dielines Optionally create a separate layer only for
dielines. Specify the name for this layer and
whether the layer should be On (visible), Off
(hidden), or Locked (visible)

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the PDF with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.

Export Imposed JDF

Export Imposed JDF generates a JDF of the layout(s) in the Phoenix project. The JDF follows the
LayCrImp specification which is an open standard for generic JDF output to RIPs.

Export Imposed JDF is easily accessible with the shortcut Control–J (Windows) or Command–J (Mac).

222



2Phoenix

General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Export as Define whether the layouts will be exported as a
Single File multi-paged PDF or create One File
Per Layout or One File Per Side for layouts with
front and back sides.

Workflow Compatibility Specify whether to create a Generic JDF, or a JDF
designed for compatibility with Fujifilm XMF or
Screen EQUIOS.

JDF Type Define how the artwork should be referenced,
either with an Absolute Path (and whether to
Copy Artwork Files), a Relative Path, or Mime

Media Define the Media size, either Plate or Sheet

Resource Directory Specify where the resources should be placed.
Choose either the Same Directory, Content
Directory, or choose a Specific Directory. If
choosing a directory, you can also perform a
Text Replace to do a find/replace of a string in
the file path that's written to the JDF file. This
functionality was added support Screen EQUIOS
workflows.
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Field Description

JDF Project ID Specify the Project ID for the JDF, using static
text and Dynamic Keywords

Descriptive Name Specify the Descriptive Name for the JDF, using
static text and Dynamic Keywords

Include Choose whether to include Cutting JDF Data and/
or Color Data

Dieline

Field Description

Remove Artwork Dielines Optionally remove any dielines in the artwork.
Dielines are defined via the Tool Types Mapping.
Note that this only applies to Tool Type Mappings
specified via Spot color, not Layers

Add Dieline Add a dieline to the output PDF

Place dieline on top of all items Whether the added dieline should be placed on
top of all layout items

Apply Overprint Whether the added dieline should be overprinted

Dieline thickness Thickness of the added dieline(s)

Dieline to add Click the + to add a dieline. Specify the Line Type
to use to generate the dieline, as well as the Ink
and/or Layer to use in the output PDF

Layers

Field Description

Existing Artwork Layers If the artwork contains layers, you can choose
how the output PDF should handle these layers.
Preserve will attempt to leave the layers as they
currently exist. Flatten will cause the output PDF
to be flattened to one layer

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the JDF with the same
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Field Description
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.

Export HP JDF

Export HP JDF generates a customized JDF output specifically designed for the HP DFE. This makes
for a tighter integration of Phoenix with HP workflows.

Field Description

Version Choose JDF version 1.3 or 1.4

Preset Specify the PDF Export preset to use

Folder Define the name of the content folder

Export Folder Optionally specify an export folder

Filename If using an export folder, specify the filename for
the HP JDF

Export for Cutting
Phoenix can export projects in a number of formats designed for cutting. To export for cutting,
navigate to the File menu and choose Export for Cutting:

CFF2

CFF2 is an industry standard cutting file format, which can be used by most CAD systems.
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General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Export Media Define the Media size, either Plate or Sheet

Units Choose either Millimeters or Inches as the units
for the CFF2 file

Character encoding Define the character encoding if different than
the system encoding

Merge Same Die Designs Optionally simplify the output file by merging die
designs that are the same

Die Name Source Choose how the Die should be named, either from
the Product name, or the Die Design name (if
used)

Dieline

Field Description

Dieline thickness Thickness of the dieline(s) used

Dieline to add Click the + to add a dieline. Specify the Line Type
to use to generate the dieline, as well as the Ink
and/or Layer to use in the output PDF

Marks
Specify whether to include marks, and if so which mark types and what line type to use for the marks

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the CFF2 with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
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Field Description
you to set a custom name, using static text and
Dynamic Keywords.

DXF

The DXF (Drawing Interchange Format) is a AutoCAD drawing file format that can be used as a cutting
file from Phoenix. DXF in general is not as useful as CFF2, but may be required in certain applications.

General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Export Media Define the Media size, either Plate or Sheet

Version Choose the standard version of the DXF file, R12,
R13, or 2007

Units Choose either Millimeters or Inches as the units
for the CFF2 file

Character encoding Define the character encoding if different than
the system encoding

Dieline

Field Description

Dieline thickness Thickness of the dieline(s) used
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Field Description

Dieline to add Click the + to add a dieline. Specify the Line Type
to use to generate the dieline, as well as the Ink
and/or Layer to use in the output PDF

Marks
Specify whether to include marks, and if so which mark types and what line type to use for the marks

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the DXF with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.

PDF

PDF Cutting files generates a PDF file with just the tooling in the project. Since PDF is not designed to
be a CAD format, it's not as powerful as a CF2, but is easier for people to look at and is widely used in
certain fields, such as wide format printing.

Export Cutting PDF is easily accessible with the shortcut ^-Control–P (Windows) or ^-Command–P
(Mac).
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General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Export as Define whether the layouts will be exported as a
Single File multi-paged PDF or create One File
Per Layout or One File Per Side for layouts with
front and back sides.

Sides Specify which side(s) to export, Both, Front, or
Back

Export Media Define whether to use the Sheet size or Plate size
for the output PDF

Dieline thickness Thickness of the added dieline(s)

Dieline to add Click the + to add a dieline. Specify the Line Type
to use to generate the dieline, as well as the Ink
and/or Layer to use in the output PDF

Marks
Specify whether to include marks, and if so which mark types and what line type to use for the marks
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Layers
Choose whether to create a new layer specifically for Marks, and whether that layer should be On, Off,
or Locked in the output PDF

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the PDF with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.

ZCC

Phoenix supports a rich integration with Zund Cut Center, and can natively export ZCC files.

Note:

While Phoenix can output directly to the ZCC format, there are some requirements for this to
work properly. Notably, the tool(s) used in Phoenix must match the tools in Zund Cut Center,
and the stock in Phoenix must match the stock name in Cut Center.

By default, Phoenix uses the tool Cut as the default cut tool, while Cut Center requires the use
of Thru-cut. If a Phoenix project is using Cut as the tool type for a project, and a ZCC file is
output, the ZCC will not contain any cut lines since there is a mismatch. In the export dialog for
ZCC files, you can see a list of the valid tool names for Zund Cut Center, so please ensure your
project is using the correct tool types to match.

In addition, the stock name in Phoenix must match the material name in Cut Center.

Please see our page on the Zund Cut Center Integration for more information.

General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
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Field Description
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Project Name Set the name of the project to be saved in the
ZCC. Note that this is different from the filename,
which is defined in the Export Folder tab.

Dieline thickness Thickness of the added dieline(s)

Line Types ZCC has a predefined list of Line Types, which are
listed here. If the line type in the project is not one
of these line types, it won't appear in the output
ZCC

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the ZCC with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.

Zund Cut Center Integration

Phoenix supports a native integration with Zund Cutting Systems, allowing for bidirectional
communication with Zund Cut Center for cut time and cost estimates, along with easy export of
projects in the .zcc file format.

Configuration
Adding a Zund Cutting Table

To add a new Zund Cutting Table to your Phoenix library, click the dropdown in the top left of the Things
panel, and select New Digital Cutting Table....
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In the General tab, navigate to the Estimating Engine field and select Zund Cut Center. Here you
can enter the Hostname or IP address of your table, along with the port and timeout. The timeout
simply provides the number of seconds Phoenix should try to connect before displaying an error that
it couldn't connect. Once you have the fields entered, Test connection to ensure the connection is
working.

For complete details on the setup of a Cutting Table, see Digital Cutting Table on page 115.

Tool Types

In Phoenix, Tool Types refers to the tooling in a project. This can be a Cut or Crease line, or a custom
tool. The integration with Zund requires the use of tool types that match the tooling in Cut Center. If
there is a mismatch, Phoenix essentially asks Zund for an estimate of how long it would take to produce
something with a tool that Zund doesn't know about, so it returns an error.
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By default, Phoenix uses the tool type Cut as the default. If you are primarily using a Zund table, it's a
good idea to make the Thru-cut tool the default by checking the Use as default cutting tool box in the
Tool Types menu.

Stocks

In addition, Zund Cut Center also must have a matching Material for the given Stock in Phoenix,
otherwise the integration will not work properly.

 

234



2Phoenix

235



2 Phoenix

 

Note:  Phoenix can still output .zcc files from Phoenix without issue if there is a stock
mismatch, but if the tooling is incorrect the .zcc file will not properly contain tooling
information.

Cost and Cut Time Estimations
To use Cut Center for cut time and cost estimations, simply add the Zund table in the list of Things
within Imposition AI. Phoenix will use this connection to request a more accurate cost and time
estimate from Cut Center, and display the Tilia Labs Estimating Engine time and display (Pending) until
a value is returned from Cut Center. Once the result is returned, the value is updated automatically.

In the event there is an error in the request to Cut Center, the Cut Time field will display a cut time of
0:00 and the text (Error occurred). The error could stem from multiple places, such as a tool type or
stock name mismatch, the wrong hostname or port being used, or something else. Phoenix does return
the entire error message and connection status, which is accessible as shown in the above video.
Simply apply the result and navigate to the Job Trail in the layout properties. From there, select the
Zund table to see the full details of the Thing, including External Messages which is the error supplied
by the table.

Cutting JDF

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)
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Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the ZCC with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.

Export Cover Sheet
Cover Sheets allow you to export one or more layouts and add marks on top, to be used as a cover
sheet. This is useful for adding identifying information on top of products, such as text marks or
barcodes.
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General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Export as Define whether the layouts will be exported as a
Single File multi-paged PDF or create One File
Per Layout or One File Per Side for layouts with
front and back sides.

Sides Specify which side(s) to export, Both, Front, or
Back

Marks Specify which marks to add to the exported cover
sheet.

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the PDF with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.

2.10.2.  Exporting Phoenix Libraries

As described in the Configuration page, Phoenix is designed to model your production environment.
Each part of that environment is represented by various libraries, such as your Stock library or Marks
library. Each of these libraries contains a custom setup of items that make your Phoenix setup unique.

Exporting a .phxlib file
You can export your entire Phoenix environment by exporting all of the combined libraries into a
Phoenix Libraries file, or .phxlib. This is a complete copy of your environment containing all libraries
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and preferences, and is the best way to back up Phoenix, share your libraries with a colleague, or send
your libraries to Tilia Labs if you have any questions.

To export your Phoenix Libraries to a .phxlib file, simply navigate to Preferences, click the Diagnostics
tab, and click the Export Libraries button.

Individual Library
In addition, you can also export individual Phoenix libraries. For example, you may have multiple
computers using Phoenix. If you add a new press to your production environment, you will need to
update the Things in Phoenix to reflect the new press. Rather than adding it and all the settings for it to
each machine running Phoenix, you can add it to one Phoenix Things library, then export the library and
simply import it on the other Phoenix clients.

To export an individual library, navigate to the relevant panel (for instance, the Things panel), click the
dropdown menu and choose Export Library. This will create .xml files for each item in the library. Now,
you can simply click the dropdown menu on another machine and choose Import Thing.

Individual Items
You can also select an individual item in a library, right-click it, and export it.

2.10.3.  Exporting Products and Layouts

In addition to exporting print and cut files from a Phoenix project, you can also select individual assets
to export or save. There are a number of reasons to do this, such as creating templates, die designs, or
vector separations.
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Products

You can easily use Products from a Phoenix project to create a 1-up die file by right clicking on the
product (either in a layout or in the Products panel) and choosing the Export Die option. You can then
select the file type for the die, either DXF, CFF2, or PDF.

In addition, you can save a product in the Products panel as a Die Design to your Die Designs library for
future use. Simply right click on the product and choose the Save as Die Design... option

Layouts

Once you have a layout created in Phoenix, you can output it in a number of ways by right-clicking on
the layout in the Layouts panel. You can Save as Template to add the layout to your Templates library.
You can also easily create a cutting file for the layout, using the Export for Cutting option and choosing
the desired filetype. Lastly you can Export Vector Separation from the layout.

2.10.4.  Reporting in Phoenix

There are five types of reports that can be created in Phoenix:

1. Tiling Reports
2. PDF Reports
3. XML Reports
4. JSON Reports
5. CSV Reports
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Tiling Reports

Tiling Reports are used to provide more information about a Tiled product to make assembly easier. To
use Tiling Reports, you must have a tiled product in the project.

Export a tiling report from the File menu.

Field Description

Page Size Choose between A4 and Letter size for the report

Margins Define page margins

Use Export Folder Optionally specify an export folder
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Field Description

Filename If using an export folder, specify the filename for
the HP JDF

PDF Reports

PDF Reports provide a great way to get a quick overview of a project. The first page provides a
project summary that includes total run length, total cost, average waste, average sheet usage, total
production time, and overage/underage. In addition, the first page provides a layout by layout rundown
of this same information as well as the Things and Stocks used.

To export a PDF report, navigate to the File menu and choose Export Report > PDF...
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General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Export as Define whether the layouts will be exported as a
Single File multi-paged PDF or create One File
Per Layout or One File Per Side for layouts with
front and back sides.

Sides Specify which side(s) to export, Both, Front, or
Back

Page Size Choose between A4 and Letter size for the report

Margins Define page margins

Show Artwork Option to show artwork thumbnails in report. If
not selected, report will show the products as a
representative color instead

Include Cost Information Option to show project cost in report

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the PDF with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.
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XML Reports

XML Reports place all of the project data into an xml file. This is useful when communicating with 3rd
party tools for project automation and reporting.

General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts
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Field Description
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Export as Define whether the layouts will be exported as a
Single File or create One File Per Layout

Include Products Option to include information on all products, only
products placed in layouts, or no products

Product Version If including products, whether to use the legacy
Product version V1 or the newer V2. V2 contains
more information on the products, but may not
work with systems designed for V1 product data

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the PDF with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.
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JSON Reports

JSON Reports place all of the project data into an xml file. This is useful when communicating with 3rd
party tools for project automation and reporting.

General

Field Description

Layouts Select whether to output All layouts, or a range of
one or more layouts. The range field can specify
an individual layout number, a range of layouts

246



2Phoenix

Field Description
(i.e. “1-4”), or a comma separated list of layouts
(i.e. “1-3, 5, 7-10”)

Export as Define whether the layouts will be exported as a
Single File or create One File Per Layout

Include Products Option to include information on all products, only
products placed in layouts, or no products

Product Version If including products, whether to use the legacy
Product version V1 or the newer V2. V2 contains
more information on the products, but may not
work with systems designed for V1 product data

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the PDF with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.
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CSV Reports

CSV reports are a new and incredibly powerful reporting tool in Phoenix 8.0. You can create CSV
reports based on virtually any data in a project, and structure it exactly how you need it structured.

General

Field Description

Data Source Select where the data is coming from that you
want to export. Choose from Product data, Roll
data, or Layout data

Delimited by Choose your CSV delimiter

Character Encoding Select the character encoding for the CSV file
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Field Description

Include Header Option to include the Header row in the CSV file

Column Info Provide a name for each column, and specify the
data that should be in the column using Dynamic
Keywords

Export Folder

Field Description

Export Folder Used for export presets - specify whether an
export folder should be predefined. None will
allow you to specify the output location when you
click OK. Use Project Save Folder will use the
same folder where the Project is saved, if one is
specified. Specify Folder allows you to use the
below options to choose a folder and filename

Folder Choose a folder to use for output. Primarily useful
when saving export settings as a preset

Filename Define the output filename. You can Use Project
Filename to simply save the PDF with the same
name as the project filename. Name uses the
project name set in the Project Properties. Use
Project ID Property uses the Project ID set in the
Project Properties. Use Custom Filename allows
you to set a custom name, using static text and
Dynamic Keywords.

2.11.  Dynamic Keyword System

2.11.1.  Phoenix Keywords

Phoenix features over 2000+ unique keywords. Keywords are used in Text Marks, Bearer Bars, Custom
Marks, and Barcodes to create dynamic marks that update in real time as the underlying data changes.
Text keywords are also used during export to create unique, job-specific filenames automatically.

New in 8.0
The Dynamic Keywords have changed during the Phoenix 8.0 release, and some keywords from older
versions are no longer available in Phoenix. Note that no new keywords were deprecated or changed
since version 7.0. The list of changes from 6.0–7.0 can be found at the following links along with more
info:

• Keyword Mappings on page 348

• Deprecated Keywords on page 351
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Index Numbers (.#.)
In many keywords, you will see a # symbol separating components of a keyword. This symbol
represents an index number. This means that it could apply to any number of potential items. For
example, <project.product.#.layouts> is a keyword that returns which layouts a given product
is on. To specify which product, you simply replace the # with the number of the product you
want. So if you want to find the layouts that the first product in the project is on, you would use
<project.product.1.layouts>

Number Padding (.pad.#>)
Phoenix 7.0 added support for padding integer-based keywords by a specified amount. This allows
you to ensure that returned have the same number of characters, regardless of the actual value. For
instance, if a project has 10 layouts, previously the <layout.index> keyword would return 1 for the first
layout, 2 for the second layout, and so on up to 10 for the tenth layout. Now, you can add padding, so
<layout.index.pad.3> would return 001, 002, and 010 for those same layouts!

Navigating the Keywords Documentation
The complete list of text keywords available in Phoenix is below. Keywords in Phoenix are contextual.
For instance, bleed can refer to a component bleed with a keyword like <component.bleed.margin> or
a page bleed like <part.page.#.bleed.bottom> or any other number of bleed values. Even though the
context is different, bleed is still bleed, just the context of what bleed you want is what is changing.

Our keyword documentation is setup to reflect these relationships and the context. To navigate to
a definition, simply click on any part of a keyword to go to that part's page. From here, you will find
any definitions that apply, as well as links to other keyword parts. If you are looking for a particular
definition, the easiest way to find a specific keyword (out of the over 800 available!) is to use the Find
feature in your browser. Press command (or control) + "F", then type in the keyword you're searching for.
That will take you to the keyword on this page. From there, you can click on the link to navigate to that
keyword's page.

CSV Export Keywords
Phoenix 8.0 introduced the ability to create custom csv reports exported from Phoenix projects. These
reports allow you to create a csv with exactly the data that you need, and these are configured with the
use of keywords

There are four types of keywords that are exclusive to this CSV export, so you will not be able to use
them in other places in Phoenix. These keywords are lane, ribbon, roll, and lane. Each of these keywords
is only available in CSV export and only for roll-related data sources.

Cloud
• <cloud.user.description>

• <cloud.user.email>

• <cloud.user.name>

• <cloud.user.name.first>

• <cloud.user.name.last>

• <cloud.user.title>

Component
• <component.bleed.margins>
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• <component.bleed.margins.cm>

• <component.bleed.margins.ft>

• <component.bleed.margins.in>

• <component.bleed.margins.m>

• <component.bleed.margins.mil>

• <component.bleed.margins.mm>

• <component.bleed.margins.pt>

• <component.bleed.margins.um>

• <component.bleed.margins.bottom>

• <component.bleed.margins.bottom.cm>

• <component.bleed.margins.bottom.ft>

• <component.bleed.margins.bottom.in>

• <component.bleed.margins.bottom.m>

• <component.bleed.margins.bottom.mil>

• <component.bleed.margins.bottom.mm>

• <component.bleed.margins.bottom.pt>

• <component.bleed.margins.bottom.um>

• <component.bleed.margins.left>

• <component.bleed.margins.left.cm>

• <component.bleed.margins.left.ft>

• <component.bleed.margins.left.in>

• <component.bleed.margins.left.m>

• <component.bleed.margins.left.mil>

• <component.bleed.margins.left.mm>

• <component.bleed.margins.left.pt>

• <component.bleed.margins.left.um>

• <component.bleed.margins.right>

• <component.bleed.margins.left.cm>
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• <component.bleed.margins.left.ft>

• <component.bleed.margins.left.in>

• <component.bleed.margins.left.m>

• <component.bleed.margins.left.mil>

• <component.bleed.margins.left.mm>

• <component.bleed.margins.left.pt>

• <component.bleed.margins.left.um>

• <component.bleed.margins.top>

• <component.bleed.margins.top.cm>

• <component.bleed.margins.top.ft>

• <component.bleed.margins.top.in>

• <component.bleed.margins.top.m>

• <component.bleed.margins.top.mil>

• <component.bleed.margins.top.mm>

• <component.bleed.margins.top.pt>

• <component.bleed.margins.top.um>

• <component.bleed.type>

• <component.colors>

• <component.column>

• <component.column.pad.#>

• <component.component-type>

• <component.double-sided>

• <component.flat.bundle-size>

• <component.flat.bundle-size.pad.#>

• <component.flat.die.name>

• <component.flat.die.path>

• <component.flat.die.source>

• <component.flat.die.source-noext>
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• <component.flat.die.type>

• <component.instanceid>

• <component.instanceid.pad.#>

• <component.locked>

• <component.name>

• <component.number>

• <component.offcut.margins.bottom>

• <component.offcut.margins.bottom.cm>

• <component.offcut.margins.bottom.ft>

• <component.offcut.margins.bottom.in>

• <component.offcut.margins.bottom.m>

• <component.offcut.margins.bottom.mil>

• <component.offcut.margins.bottom.mm>

• <component.offcut.margins.bottom.pt>

• <component.offcut.margins.bottom.um>

• <component.offcut.margins.left>

• <component.offcut.margins.left.cm>

• <component.offcut.margins.left.ft>

• <component.offcut.margins.left.in>

• <component.offcut.margins.left.m>

• <component.offcut.margins.left.mil>

• <component.offcut.margins.left.mm>

• <component.offcut.margins.left.pt>

• <component.offcut.margins.left.um>

• <component.offcut.margins.right>

• <component.offcut.margins.left.cm>

• <component.offcut.margins.left.ft>

• <component.offcut.margins.left.in>
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• <component.offcut.margins.left.m>

• <component.offcut.margins.left.mil>

• <component.offcut.margins.left.mm>

• <component.offcut.margins.left.pt>

• <component.offcut.margins.left.um>

• <component.offcut.margins.top>

• <component.offcut.margins.top.cm>

• <component.offcut.margins.top.ft>

• <component.offcut.margins.top.in>

• <component.offcut.margins.top.m>

• <component.offcut.margins.top.mil>

• <component.offcut.margins.top.mm>

• <component.offcut.margins.top.pt>

• <component.offcut.margins.top.um>

• <component.offcut.type>

• <component.page.#.bleed.bottom>

• <component.page.#.bleed.bottom.cm>

• <component.page.#.bleed.bottom.ft>

• <component.page.#.bleed.bottom.in>

• <component.page.#.bleed.bottom.m>

• <component.page.#.bleed.bottom.mil>

• <component.page.#.bleed.bottom.mm>

• <component.page.#.bleed.bottom.pt>

• <component.page.#.bleed.bottom.um>

• <component.page.#.bleed.left>

• <component.page.#.bleed.left.cm>

• <component.page.#.bleed.left.ft>

• <component.page.#.bleed.left.in>
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• <component.page.#.bleed.left.m>

• <component.page.#.bleed.left.mil>

• <component.page.#.bleed.left.mm>

• <component.page.#.bleed.left.pt>

• <component.page.#.bleed.left.um>

• <component.page.#.bleed.right>

• <component.page.#.bleed.left.cm>

• <component.page.#.bleed.left.ft>

• <component.page.#.bleed.left.in>

• <component.page.#.bleed.left.m>

• <component.page.#.bleed.left.mil>

• <component.page.#.bleed.left.mm>

• <component.page.#.bleed.left.pt>

• <component.page.#.bleed.left.um>

• <component.page.#.bleed.top>

• <component.page.#.bleed.top.cm>

• <component.page.#.bleed.top.ft>

• <component.page.#.bleed.top.in>

• <component.page.#.bleed.top.m>

• <component.page.#.bleed.top.mil>

• <component.page.#.bleed.top.mm>

• <component.page.#.bleed.top.pt>

• <component.page.#.bleed.top.um>

• <component.page.#.color.#.coverage>

• <component.page.#.color.#.name>

• <component.page.#.color.#.process>

• <component.page.#.color.#.type>

• <component.page.#.color.#.values>
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• <component.page.#.color.count>

• <component.page.#.color.count.pad.#>

• <component.page.#.colors.analysis>

• <component.page.#.colors.detection>

• <component.page.#.colors.source>

• <component.page.#.creep>

• <component.page.#.creep.cm>

• <component.page.#.creep.ft>

• <component.page.#.creep.in>

• <component.page.#.creep.m>

• <component.page.#.creep.mil>

• <component.page.#.creep.mm>

• <component.page.#.creep.pt>

• <component.page.#.creep.um>

• <component.page.#.file.checksum>

• <component.page.#.file.name>

• <component.page.#.file.number>

• <component.page.#.file.number.pad.#>

• <component.page.#.file.path>

• <component.page.#.file.timestamp>

• <component.page.#.index>

• <component.page.#.index.pad.#>

• <component.page.#.locked>

• <component.page.#.name>

• <component.page.#.position.x>

• <component.page.#.position.x.cm>

• <component.page.#.position.x.ft>

• <component.page.#.position.x.in>
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• <component.page.#.position.x.m>

• <component.page.#.position.x.mil>

• <component.page.#.position.x.mm>

• <component.page.#.position.x.pt>

• <component.page.#.position.x.um>

• <component.page.#.position.y>

• <component.page.#.position.y.cm>

• <component.page.#.position.y.ft>

• <component.page.#.position.y.in>

• <component.page.#.position.y.m>

• <component.page.#.position.y.mil>

• <component.page.#.position.y.mm>

• <component.page.#.position.y.pt>

• <component.page.#.position.y.um>

• <component.page.#.rotation>

• <component.page.#.scale.x>

• <component.page.#.scale.x.cm>

• <component.page.#.scale.x.ft>

• <component.page.#.scale.x.in>

• <component.page.#.scale.x.m>

• <component.page.#.scale.x.mil>

• <component.page.#.scale.x.mm>

• <component.page.#.scale.x.pt>

• <component.page.#.scale.x.um>

• <component.page.#.scale.y>

• <component.page.#.scale.y.cm>

• <component.page.#.scale.y.ft>

• <component.page.#.scale.y.in>
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• <component.page.#.scale.y.m>

• <component.page.#.scale.y.mil>

• <component.page.#.scale.y.mm>

• <component.page.#.scale.y.pt>

• <component.page.#.scale.y.um>

• <component.page.#.size.height>

• <component.page.#.size.height.cm>

• <component.page.#.size.height.ft>

• <component.page.#.size.height.in>

• <component.page.#.size.height.m>

• <component.page.#.size.height.mil>

• <component.page.#.size.height.mm>

• <component.page.#.size.height.pt>

• <component.page.#.size.height.um>

• <component.page.#.size.width>

• <component.page.#.size.width.cm>

• <component.page.#.size.width.ft>

• <component.page.#.size.width.in>

• <component.page.#.size.width.m>

• <component.page.#.size.width.mil>

• <component.page.#.size.width.mm>

• <component.page.#.size.width.pt>

• <component.page.#.size.width.um>

• <component.page.#.visible>

• <component.position.x>

• <component.position.x.cm>

• <component.position.x.ft>

• <component.position.x.in>
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• <component.position.x.m>

• <component.position.x.mil>

• <component.position.x.mm>

• <component.position.x.pt>

• <component.position.x.um>

• <component.position.y>

• <component.position.y.cm>

• <component.position.y.ft>

• <component.position.y.in>

• <component.position.y.m>

• <component.position.y.mil>

• <component.position.y.mm>

• <component.position.y.pt>

• <component.position.y.um>

• <component.rotation>

• <component.row>

• <component.row.pad.#>

• <component.signature.folding-pattern>

• <component.signature.folds.horizontal>

• <component.signature.folds.horizontal.pad.#>

• <component.signature.folds.total>

• <component.signature.folds.total.pad.#>

• <component.signature.folds.vertical>

• <component.signature.folds.vertical.pad.#>

• <component.signature.index>

• <component.signature.index.pad.#>

• <component.signature.muller-martini.finishing>

• <component.signature.muller-martini.order>
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• <component.signature.page-count>

• <component.signature.page-count.pad.#>

• <component.signature.relative-index>

• <component.signature.relative-index.pad.#>

• <component.size.height>

• <component.size.height.cm>

• <component.size.height.ft>

• <component.size.height.in>

• <component.size.height.m>

• <component.size.height.mil>

• <component.size.height.mm>

• <component.size.height.pt>

• <component.size.height.um>

• <component.size.width>

• <component.size.width.cm>

• <component.size.width.ft>

• <component.size.width.in>

• <component.size.width.m>

• <component.size.width.mil>

• <component.size.width.mm>

• <component.size.width.pt>

• <component.size.width.um>

• <component.spacing.margin>

• <component.spacing.margin.cm>

• <component.spacing.margin.ft>

• <component.spacing.margin.in>

• <component.spacing.margin.m>

• <component.spacing.margin.mil>
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• <component.spacing.margin.mm>

• <component.spacing.margin.pt>

• <component.spacing.margin.um>

• <component.spacing.margins.bottom>

• <component.spacing.margins.bottom.cm>

• <component.spacing.margins.bottom.ft>

• <component.spacing.margins.bottom.in>

• <component.spacing.margins.bottom.m>

• <component.spacing.margins.bottom.mil>

• <component.spacing.margins.bottom.mm>

• <component.spacing.margins.bottom.pt>

• <component.spacing.margins.bottom.um>

• <component.spacing.margins.left>

• <component.spacing.margins.left.cm>

• <component.spacing.margins.left.ft>

• <component.spacing.margins.left.in>

• <component.spacing.margins.left.m>

• <component.spacing.margins.left.mil>

• <component.spacing.margins.left.mm>

• <component.spacing.margins.left.pt>

• <component.spacing.margins.left.um>

• <component.spacing.margins.right>

• <component.spacing.margins.left.cm>

• <component.spacing.margins.left.ft>

• <component.spacing.margins.left.in>

• <component.spacing.margins.left.m>

• <component.spacing.margins.left.mil>

• <component.spacing.margins.left.mm>
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• <component.spacing.margins.left.pt>

• <component.spacing.margins.left.um>

• <component.spacing.margins.top>

• <component.spacing.margins.top.cm>

• <component.spacing.margins.top.ft>

• <component.spacing.margins.top.in>

• <component.spacing.margins.top.m>

• <component.spacing.margins.top.mil>

• <component.spacing.margins.top.mm>

• <component.spacing.margins.top.pt>

• <component.spacing.margins.top.um>

• <component.spacing.type>

• <component.tile.die.name>

• <component.tile.die.path>

• <component.tile.die.source>

• <component.tile.die.source-noext>

• <component.tile.die.type>

• <component.tile.index>

• <component.tile.index.pad.#>

• <component.tile.tile-count>

• <component.tile.tile-count.pad.#>

• <component.type>

• <component.z-order>

• <component.z-order.pad.#>

Date
• <date.h1>

• <date.h10>

• <date.h11>

• <date.h12>
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• <date.h2>

• <date.h3>

• <date.h4>

• <date.h5>

• <date.h6>

• <date.h7>

• <date.h8>

• <date.h9>

• <date.iso>

• <date.long>

• <date.m1>

• <date.m10>

• <date.m11>

• <date.m12>

• <date.m2>

• <date.m3>

• <date.m4>

• <date.m5>

• <date.m6>

• <date.m7>

• <date.m8>

• <date.m9>

• <date.medium>

• <date.short>

Day
• <day.iso>

• <day.short>

Distortion
• <distortion.horizontal>
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• <distortion.vertical>

Grade
• <grade.caliper>

• <grade.caliper.cm>

• <grade.caliper.ft>

• <grade.caliper.in>

• <grade.caliper.m>

• <grade.caliper.mil>

• <grade.caliper.mm>

• <grade.caliper.pt>

• <grade.caliper.um>

• <grade.cost>

• <grade.external-id>

• <grade.name>

• <grade.stock>

• <grade.weight>

Group
• <group.items>

• <group.items.pad.#>

• <group.locked>

• <group.name>

• <group.position.x>

• <group.position.x.cm>

• <group.position.x.ft>

• <group.position.x.in>

• <group.position.x.m>

• <group.position.x.mil>

• <group.position.x.mm>

• <group.position.x.pt>
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• <group.position.x.um>

• <group.position.y>

• <group.position.y.cm>

• <group.position.y.ft>

• <group.position.y.in>

• <group.position.y.m>

• <group.position.y.mil>

• <group.position.y.mm>

• <group.position.y.pt>

• <group.position.y.um>

• <group.rotation>

• <group.size.height>

• <group.size.height.cm>

• <group.size.height.ft>

• <group.size.height.in>

• <group.size.height.m>

• <group.size.height.mil>

• <group.size.height.mm>

• <group.size.height.pt>

• <group.size.height.um>

• <group.size.width>

• <group.size.width.cm>

• <group.size.width.ft>

• <group.size.width.in>

• <group.size.width.m>

• <group.size.width.mil>

• <group.size.width.mm>

• <group.size.width.pt>
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• <group.size.width.um>

• <group.type>

• <group.z-order>

• <group.z-order.pad.#>

Hour
• <hour>

Ink
• <ink.#.abbr>

• <ink.#.abbr>

• <ink.#.first>

• <ink.#.first>

• <ink.#.name>

• <ink.#.name>

• <ink.#.neutral-density>

• <ink.#.neutral-density>

• <ink.#.number>

• <ink.#.number>

• <ink.#.smart>

• <ink.#.smart>

• <ink.#.type>

• <ink.#.type>

Inks
• <inks>

Inks-stacked
• <inks-stacked>

• <inks-stacked.abbr>

• <inks-stacked.first>

• <inks-stacked.full>

• <inks-stacked.number>
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• <inks-stacked.smart>

• <inks.abbr>

• <inks.first>

• <inks.full>

• <inks.number>

• <inks.smart>

Lane

Layout
• <layout.artwork-files>

• <layout.back-passes>

• <layout.back-passes.pad.#>

• <layout.cad-files>

• <layout.cost>

• <layout.cost-die>

• <layout.cost-plate>

• <layout.cost-press>

• <layout.cost-stock>

• <layout.crease-length>

• <layout.cut-length>

• <layout.front-passes>

• <layout.front-passes.pad.#>

• <layout.index>

• <layout.index.pad.#>

• <layout.name>

• <layout.overrun>

• <layout.placed>

• <layout.placed.pad.#>

• <layout.plate-count>
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• <layout.plate-count.pad.#>

• <layout.press-time>

• <layout.priorities>

• <layout.processes>

• <layout.product-count>

• <layout.product-count.pad.#>

• <layout.product-names>

• <layout.product.#.back-inks>

• <layout.product.#.color>

• <layout.product.#.color.pad.#>

• <layout.product.#.description>

• <layout.product.#.due-date>

• <layout.product.#.front-inks>

• <layout.product.#.group>

• <layout.product.#.index>

• <layout.product.#.index.pad.#>

• <layout.product.#.layouts>

• <layout.product.#.max-overruns>

• <layout.product.#.max-overruns.cm>

• <layout.product.#.max-overruns.ft>

• <layout.product.#.max-overruns.in>

• <layout.product.#.max-overruns.m>

• <layout.product.#.max-overruns.mil>

• <layout.product.#.max-overruns.mm>

• <layout.product.#.max-overruns.pt>

• <layout.product.#.max-overruns.um>

• <layout.product.#.min-overruns>

• <layout.product.#.min-overruns.cm>
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• <layout.product.#.min-overruns.ft>

• <layout.product.#.min-overruns.in>

• <layout.product.#.min-overruns.m>

• <layout.product.#.min-overruns.mil>

• <layout.product.#.min-overruns.mm>

• <layout.product.#.min-overruns.pt>

• <layout.product.#.min-overruns.um>

• <layout.product.#.name>

• <layout.product.#.notes>

• <layout.product.#.overrun>

• <layout.product.#.overrun-percent>

• <layout.product.#.part.#.bound.binding-edge>

• <layout.product.#.part.#.bound.binding-method>

• <layout.product.#.part.#.bound.creep.amount>

• <layout.product.#.part.#.bound.creep.amount.cm>

• <layout.product.#.part.#.bound.creep.amount.ft>

• <layout.product.#.part.#.bound.creep.amount.in>

• <layout.product.#.part.#.bound.creep.amount.m>

• <layout.product.#.part.#.bound.creep.amount.mil>

• <layout.product.#.part.#.bound.creep.amount.mm>

• <layout.product.#.part.#.bound.creep.amount.pt>

• <layout.product.#.part.#.bound.creep.amount.um>

• <layout.product.#.part.#.bound.creep.calculation>

• <layout.product.#.part.#.bound.creep.method>

• <layout.product.#.part.#.bound.creep.transition>

• <layout.product.#.part.#.bound.creep.transition.cm>

• <layout.product.#.part.#.bound.creep.transition.ft>

• <layout.product.#.part.#.bound.creep.transition.in>
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• <layout.product.#.part.#.bound.creep.transition.m>

• <layout.product.#.part.#.bound.creep.transition.mil>

• <layout.product.#.part.#.bound.creep.transition.mm>

• <layout.product.#.part.#.bound.creep.transition.pt>

• <layout.product.#.part.#.bound.creep.transition.um>

• <layout.product.#.part.#.bound.creep.type>

• <layout.product.#.part.#.bound.jog-edge>

• <layout.product.#.part.#.bound.n-up.gap>

• <layout.product.#.part.#.bound.n-up.gap.cm>

• <layout.product.#.part.#.bound.n-up.gap.ft>

• <layout.product.#.part.#.bound.n-up.gap.in>

• <layout.product.#.part.#.bound.n-up.gap.m>

• <layout.product.#.part.#.bound.n-up.gap.mil>

• <layout.product.#.part.#.bound.n-up.gap.mm>

• <layout.product.#.part.#.bound.n-up.gap.pt>

• <layout.product.#.part.#.bound.n-up.gap.um>

• <layout.product.#.part.#.bound.n-up.number>

• <layout.product.#.part.#.bound.n-up.number.pad.#>

• <layout.product.#.part.#.bound.page-size.height>

• <layout.product.#.part.#.bound.page-size.height.cm>

• <layout.product.#.part.#.bound.page-size.height.ft>

• <layout.product.#.part.#.bound.page-size.height.in>

• <layout.product.#.part.#.bound.page-size.height.m>

• <layout.product.#.part.#.bound.page-size.height.mil>

• <layout.product.#.part.#.bound.page-size.height.mm>

• <layout.product.#.part.#.bound.page-size.height.pt>

• <layout.product.#.part.#.bound.page-size.height.um>

• <layout.product.#.part.#.bound.page-size.width>
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• <layout.product.#.part.#.bound.page-size.width.cm>

• <layout.product.#.part.#.bound.page-size.width.ft>

• <layout.product.#.part.#.bound.page-size.width.in>

• <layout.product.#.part.#.bound.page-size.width.m>

• <layout.product.#.part.#.bound.page-size.width.mil>

• <layout.product.#.part.#.bound.page-size.width.mm>

• <layout.product.#.part.#.bound.page-size.width.pt>

• <layout.product.#.part.#.bound.page-size.width.um>

• <layout.product.#.part.#.bound.pages-per-section>

• <layout.product.#.part.#.bound.pages-per-section.pad.#>

• <layout.product.#.part.#.bound.reading-order>

• <layout.product.#.part.#.bound.sections>

• <layout.product.#.part.#.bound.sections.pad.#>

• <layout.product.#.part.#.bound.self-cover>

• <layout.product.#.part.#.bound.signatures>

• <layout.product.#.part.#.bound.signatures.pad.#>

• <layout.product.#.part.#.bound.trim.face>

• <layout.product.#.part.#.bound.trim.face.cm>

• <layout.product.#.part.#.bound.trim.face.ft>

• <layout.product.#.part.#.bound.trim.face.in>

• <layout.product.#.part.#.bound.trim.face.m>

• <layout.product.#.part.#.bound.trim.face.mil>

• <layout.product.#.part.#.bound.trim.face.mm>

• <layout.product.#.part.#.bound.trim.face.pt>

• <layout.product.#.part.#.bound.trim.face.um>

• <layout.product.#.part.#.bound.trim.jog>

• <layout.product.#.part.#.bound.trim.jog.cm>

• <layout.product.#.part.#.bound.trim.jog.ft>
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• <layout.product.#.part.#.bound.trim.jog.in>

• <layout.product.#.part.#.bound.trim.jog.m>

• <layout.product.#.part.#.bound.trim.jog.mil>

• <layout.product.#.part.#.bound.trim.jog.mm>

• <layout.product.#.part.#.bound.trim.jog.pt>

• <layout.product.#.part.#.bound.trim.jog.um>

• <layout.product.#.part.#.bound.trim.lip>

• <layout.product.#.part.#.bound.trim.lip-type>

• <layout.product.#.part.#.bound.trim.lip.cm>

• <layout.product.#.part.#.bound.trim.lip.ft>

• <layout.product.#.part.#.bound.trim.lip.in>

• <layout.product.#.part.#.bound.trim.lip.m>

• <layout.product.#.part.#.bound.trim.lip.mil>

• <layout.product.#.part.#.bound.trim.lip.mm>

• <layout.product.#.part.#.bound.trim.lip.pt>

• <layout.product.#.part.#.bound.trim.lip.um>

• <layout.product.#.part.#.bound.trim.non-jog>

• <layout.product.#.part.#.bound.trim.non-jog.cm>

• <layout.product.#.part.#.bound.trim.non-jog.ft>

• <layout.product.#.part.#.bound.trim.non-jog.in>

• <layout.product.#.part.#.bound.trim.non-jog.m>

• <layout.product.#.part.#.bound.trim.non-jog.mil>

• <layout.product.#.part.#.bound.trim.non-jog.mm>

• <layout.product.#.part.#.bound.trim.non-jog.pt>

• <layout.product.#.part.#.bound.trim.non-jog.um>

• <layout.product.#.part.#.bound.trim.spine>

• <layout.product.#.part.#.bound.trim.spine.cm>

• <layout.product.#.part.#.bound.trim.spine.ft>
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• <layout.product.#.part.#.bound.trim.spine.in>

• <layout.product.#.part.#.bound.trim.spine.m>

• <layout.product.#.part.#.bound.trim.spine.mil>

• <layout.product.#.part.#.bound.trim.spine.mm>

• <layout.product.#.part.#.bound.trim.spine.pt>

• <layout.product.#.part.#.bound.trim.spine.um>

• <layout.product.#.part.#.component.#.bleed.margin>

• <layout.product.#.part.#.component.#.bleed.margin.cm>

• <layout.product.#.part.#.component.#.bleed.margin.ft>

• <layout.product.#.part.#.component.#.bleed.margin.in>

• <layout.product.#.part.#.component.#.bleed.margin.m>

• <layout.product.#.part.#.component.#.bleed.margin.mil>

• <layout.product.#.part.#.component.#.bleed.margin.mm>

• <layout.product.#.part.#.component.#.bleed.margin.pt>

• <layout.product.#.part.#.component.#.bleed.margin.um>

• <layout.product.#.part.#.component.#.bleed.margins.bottom>

• <layout.product.#.part.#.component.#.bleed.margins.bottom.cm>

• <layout.product.#.part.#.component.#.bleed.margins.bottom.ft>

• <layout.product.#.part.#.component.#.bleed.margins.bottom.in>

• <layout.product.#.part.#.component.#.bleed.margins.bottom.m>

• <layout.product.#.part.#.component.#.bleed.margins.bottom.mil>

• <layout.product.#.part.#.component.#.bleed.margins.bottom.mm>

• <layout.product.#.part.#.component.#.bleed.margins.bottom.pt>

• <layout.product.#.part.#.component.#.bleed.margins.bottom.um>

• <layout.product.#.part.#.component.#.bleed.margins.left>

• <layout.product.#.part.#.component.#.bleed.margins.left.cm>

• <layout.product.#.part.#.component.#.bleed.margins.left.ft>

• <layout.product.#.part.#.component.#.bleed.margins.left.in>
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• <layout.product.#.part.#.component.#.bleed.margins.left.m>

• <layout.product.#.part.#.component.#.bleed.margins.left.mil>

• <layout.product.#.part.#.component.#.bleed.margins.left.mm>

• <layout.product.#.part.#.component.#.bleed.margins.left.pt>

• <layout.product.#.part.#.component.#.bleed.margins.left.um>

• <layout.product.#.part.#.component.#.bleed.margins.right>

• <layout.product.#.part.#.component.#.bleed.margins.left.cm>

• <layout.product.#.part.#.component.#.bleed.margins.left.ft>

• <layout.product.#.part.#.component.#.bleed.margins.left.in>

• <layout.product.#.part.#.component.#.bleed.margins.left.m>

• <layout.product.#.part.#.component.#.bleed.margins.left.mil>

• <layout.product.#.part.#.component.#.bleed.margins.left.mm>

• <layout.product.#.part.#.component.#.bleed.margins.left.pt>

• <layout.product.#.part.#.component.#.bleed.margins.left.um>

• <layout.product.#.part.#.component.#.bleed.margins.top>

• <layout.product.#.part.#.component.#.bleed.margins.top.cm>

• <layout.product.#.part.#.component.#.bleed.margins.top.ft>

• <layout.product.#.part.#.component.#.bleed.margins.top.in>

• <layout.product.#.part.#.component.#.bleed.margins.top.m>

• <layout.product.#.part.#.component.#.bleed.margins.top.mil>

• <layout.product.#.part.#.component.#.bleed.margins.top.mm>

• <layout.product.#.part.#.component.#.bleed.margins.top.pt>

• <layout.product.#.part.#.component.#.bleed.margins.top.um>

• <layout.product.#.part.#.component.#.bleed.type>

• <layout.product.#.part.#.component.#.component-type>

• <layout.product.#.part.#.component.#.double-sided>

• <layout.product.#.part.#.component.#.flat.bundle-size>

• <layout.product.#.part.#.component.#.flat.bundle-size.pad.#>
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• <layout.product.#.part.#.component.#.flat.die.name>

• <layout.product.#.part.#.component.#.flat.die.path>

• <layout.product.#.part.#.component.#.flat.die.source>

• <layout.product.#.part.#.component.#.flat.die.source-noext>

• <layout.product.#.part.#.component.#.flat.die.type>

• <layout.product.#.part.#.component.#.offcut.margins.bottom>

• <layout.product.#.part.#.component.#.offcut.margins.bottom.cm>

• <layout.product.#.part.#.component.#.offcut.margins.bottom.ft>

• <layout.product.#.part.#.component.#.offcut.margins.bottom.in>

• <layout.product.#.part.#.component.#.offcut.margins.bottom.m>

• <layout.product.#.part.#.component.#.offcut.margins.bottom.mil>

• <layout.product.#.part.#.component.#.offcut.margins.bottom.mm>

• <layout.product.#.part.#.component.#.offcut.margins.bottom.pt>

• <layout.product.#.part.#.component.#.offcut.margins.bottom.um>

• <layout.product.#.part.#.component.#.offcut.margins.left>

• <layout.product.#.part.#.component.#.offcut.margins.left.cm>

• <layout.product.#.part.#.component.#.offcut.margins.left.ft>

• <layout.product.#.part.#.component.#.offcut.margins.left.in>

• <layout.product.#.part.#.component.#.offcut.margins.left.m>

• <layout.product.#.part.#.component.#.offcut.margins.left.mil>

• <layout.product.#.part.#.component.#.offcut.margins.left.mm>

• <layout.product.#.part.#.component.#.offcut.margins.left.pt>

• <layout.product.#.part.#.component.#.offcut.margins.left.um>

• <layout.product.#.part.#.component.#.offcut.margins.right>

• <layout.product.#.part.#.component.#.offcut.margins.left.cm>

• <layout.product.#.part.#.component.#.offcut.margins.left.ft>

• <layout.product.#.part.#.component.#.offcut.margins.left.in>

• <layout.product.#.part.#.component.#.offcut.margins.left.m>
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• <layout.product.#.part.#.component.#.offcut.margins.left.mil>

• <layout.product.#.part.#.component.#.offcut.margins.left.mm>

• <layout.product.#.part.#.component.#.offcut.margins.left.pt>

• <layout.product.#.part.#.component.#.offcut.margins.left.um>

• <layout.product.#.part.#.component.#.offcut.margins.top>

• <layout.product.#.part.#.component.#.offcut.margins.top.cm>

• <layout.product.#.part.#.component.#.offcut.margins.top.ft>

• <layout.product.#.part.#.component.#.offcut.margins.top.in>

• <layout.product.#.part.#.component.#.offcut.margins.top.m>

• <layout.product.#.part.#.component.#.offcut.margins.top.mil>

• <layout.product.#.part.#.component.#.offcut.margins.top.mm>

• <layout.product.#.part.#.component.#.offcut.margins.top.pt>

• <layout.product.#.part.#.component.#.offcut.margins.top.um>

• <layout.product.#.part.#.component.#.offcut.type>

• <layout.product.#.part.#.component.#.page.#.bleed.bottom>

• <layout.product.#.part.#.component.#.page.#.bleed.bottom.cm>

• <layout.product.#.part.#.component.#.page.#.bleed.bottom.ft>

• <layout.product.#.part.#.component.#.page.#.bleed.bottom.in>

• <layout.product.#.part.#.component.#.page.#.bleed.bottom.m>

• <layout.product.#.part.#.component.#.page.#.bleed.bottom.mil>

• <layout.product.#.part.#.component.#.page.#.bleed.bottom.mm>

• <layout.product.#.part.#.component.#.page.#.bleed.bottom.pt>

• <layout.product.#.part.#.component.#.page.#.bleed.bottom.um>

• <layout.product.#.part.#.component.#.page.#.bleed.left>

• <layout.product.#.part.#.component.#.page.#.bleed.left.cm>

• <layout.product.#.part.#.component.#.page.#.bleed.left.ft>

• <layout.product.#.part.#.component.#.page.#.bleed.left.in>

• <layout.product.#.part.#.component.#.page.#.bleed.left.m>
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• <layout.product.#.part.#.component.#.page.#.bleed.left.mil>

• <layout.product.#.part.#.component.#.page.#.bleed.left.mm>

• <layout.product.#.part.#.component.#.page.#.bleed.left.pt>

• <layout.product.#.part.#.component.#.page.#.bleed.left.um>

• <layout.product.#.part.#.component.#.page.#.bleed.right>

• <layout.product.#.part.#.component.#.page.#.bleed.left.cm>

• <layout.product.#.part.#.component.#.page.#.bleed.left.ft>

• <layout.product.#.part.#.component.#.page.#.bleed.left.in>

• <layout.product.#.part.#.component.#.page.#.bleed.left.m>

• <layout.product.#.part.#.component.#.page.#.bleed.left.mil>

• <layout.product.#.part.#.component.#.page.#.bleed.left.mm>

• <layout.product.#.part.#.component.#.page.#.bleed.left.pt>

• <layout.product.#.part.#.component.#.page.#.bleed.left.um>

• <layout.product.#.part.#.component.#.page.#.bleed.top>

• <layout.product.#.part.#.component.#.page.#.bleed.top.cm>

• <layout.product.#.part.#.component.#.page.#.bleed.top.ft>

• <layout.product.#.part.#.component.#.page.#.bleed.top.in>

• <layout.product.#.part.#.component.#.page.#.bleed.top.m>

• <layout.product.#.part.#.component.#.page.#.bleed.top.mil>

• <layout.product.#.part.#.component.#.page.#.bleed.top.mm>

• <layout.product.#.part.#.component.#.page.#.bleed.top.pt>

• <layout.product.#.part.#.component.#.page.#.bleed.top.um>

• <layout.product.#.part.#.component.#.page.#.color.#.coverage>

• <layout.product.#.part.#.component.#.page.#.color.#.name>

• <layout.product.#.part.#.component.#.page.#.color.#.process>

• <layout.product.#.part.#.component.#.page.#.color.#.type>

• <layout.product.#.part.#.component.#.page.#.color.#.values>

• <layout.product.#.part.#.component.#.page.#.color.count>
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• <layout.product.#.part.#.component.#.page.#.color.count.pad.#>

• <layout.product.#.part.#.component.#.page.#.colors.analysis>

• <layout.product.#.part.#.component.#.page.#.colors.detection>

• <layout.product.#.part.#.component.#.page.#.colors.source>

• <layout.product.#.part.#.component.#.page.#.creep>

• <layout.product.#.part.#.component.#.page.#.creep.cm>

• <layout.product.#.part.#.component.#.page.#.creep.ft>

• <layout.product.#.part.#.component.#.page.#.creep.in>

• <layout.product.#.part.#.component.#.page.#.creep.m>

• <layout.product.#.part.#.component.#.page.#.creep.mil>

• <layout.product.#.part.#.component.#.page.#.creep.mm>

• <layout.product.#.part.#.component.#.page.#.creep.pt>

• <layout.product.#.part.#.component.#.page.#.creep.um>

• <layout.product.#.part.#.component.#.page.#.file.checksum>

• <layout.product.#.part.#.component.#.page.#.file.name>

• <layout.product.#.part.#.component.#.page.#.file.number>

• <layout.product.#.part.#.component.#.page.#.file.number.pad.#>

• <layout.product.#.part.#.component.#.page.#.file.path>

• <layout.product.#.part.#.component.#.page.#.file.timestamp>

• <layout.product.#.part.#.component.#.page.#.index>

• <layout.product.#.part.#.component.#.page.#.index.pad.#>

• <layout.product.#.part.#.component.#.page.#.locked>

• <layout.product.#.part.#.component.#.page.#.name>

• <layout.product.#.part.#.component.#.page.#.position.x>

• <layout.product.#.part.#.component.#.page.#.position.x.cm>

• <layout.product.#.part.#.component.#.page.#.position.x.ft>

• <layout.product.#.part.#.component.#.page.#.position.x.in>

• <layout.product.#.part.#.component.#.page.#.position.x.m>
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• <layout.product.#.part.#.component.#.page.#.position.x.mil>

• <layout.product.#.part.#.component.#.page.#.position.x.mm>

• <layout.product.#.part.#.component.#.page.#.position.x.pt>

• <layout.product.#.part.#.component.#.page.#.position.x.um>

• <layout.product.#.part.#.component.#.page.#.position.y>

• <layout.product.#.part.#.component.#.page.#.position.y.cm>

• <layout.product.#.part.#.component.#.page.#.position.y.ft>

• <layout.product.#.part.#.component.#.page.#.position.y.in>

• <layout.product.#.part.#.component.#.page.#.position.y.m>

• <layout.product.#.part.#.component.#.page.#.position.y.mil>

• <layout.product.#.part.#.component.#.page.#.position.y.mm>

• <layout.product.#.part.#.component.#.page.#.position.y.pt>

• <layout.product.#.part.#.component.#.page.#.position.y.um>

• <layout.product.#.part.#.component.#.page.#.rotation>

• <layout.product.#.part.#.component.#.page.#.scale.x>

• <layout.product.#.part.#.component.#.page.#.scale.x.cm>

• <layout.product.#.part.#.component.#.page.#.scale.x.ft>

• <layout.product.#.part.#.component.#.page.#.scale.x.in>

• <layout.product.#.part.#.component.#.page.#.scale.x.m>

• <layout.product.#.part.#.component.#.page.#.scale.x.mil>

• <layout.product.#.part.#.component.#.page.#.scale.x.mm>

• <layout.product.#.part.#.component.#.page.#.scale.x.pt>

• <layout.product.#.part.#.component.#.page.#.scale.x.um>

• <layout.product.#.part.#.component.#.page.#.scale.y>

• <layout.product.#.part.#.component.#.page.#.scale.y.cm>

• <layout.product.#.part.#.component.#.page.#.scale.y.ft>

• <layout.product.#.part.#.component.#.page.#.scale.y.in>

• <layout.product.#.part.#.component.#.page.#.scale.y.m>
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• <layout.product.#.part.#.component.#.page.#.scale.y.mil>

• <layout.product.#.part.#.component.#.page.#.scale.y.mm>

• <layout.product.#.part.#.component.#.page.#.scale.y.pt>

• <layout.product.#.part.#.component.#.page.#.scale.y.um>

• <layout.product.#.part.#.component.#.page.#.size.height>

• <layout.product.#.part.#.component.#.page.#.size.height.cm>

• <layout.product.#.part.#.component.#.page.#.size.height.ft>

• <layout.product.#.part.#.component.#.page.#.size.height.in>

• <layout.product.#.part.#.component.#.page.#.size.height.m>

• <layout.product.#.part.#.component.#.page.#.size.height.mil>

• <layout.product.#.part.#.component.#.page.#.size.height.mm>

• <layout.product.#.part.#.component.#.page.#.size.height.pt>

• <layout.product.#.part.#.component.#.page.#.size.height.um>

• <layout.product.#.part.#.component.#.page.#.size.width>

• <layout.product.#.part.#.component.#.page.#.size.width.cm>

• <layout.product.#.part.#.component.#.page.#.size.width.ft>

• <layout.product.#.part.#.component.#.page.#.size.width.in>

• <layout.product.#.part.#.component.#.page.#.size.width.m>

• <layout.product.#.part.#.component.#.page.#.size.width.mil>

• <layout.product.#.part.#.component.#.page.#.size.width.mm>

• <layout.product.#.part.#.component.#.page.#.size.width.pt>

• <layout.product.#.part.#.component.#.page.#.size.width.um>

• <layout.product.#.part.#.component.#.page.#.visible>

• <layout.product.#.part.#.component.#.signature.folding-pattern>

• <layout.product.#.part.#.component.#.signature.folds.horizontal>

• <layout.product.#.part.#.component.#.signature.folds.horizontal.pad.#>

• <layout.product.#.part.#.component.#.signature.folds.total>

• <layout.product.#.part.#.component.#.signature.folds.total.pad.#>
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• <layout.product.#.part.#.component.#.signature.folds.vertical>

• <layout.product.#.part.#.component.#.signature.folds.vertical.pad.#>

• <layout.product.#.part.#.component.#.signature.index>

• <layout.product.#.part.#.component.#.signature.index.pad.#>

• <layout.product.#.part.#.component.#.signature.page-count>

• <layout.product.#.part.#.component.#.signature.page-count.pad.#>

• <layout.product.#.part.#.component.#.signature.relative-index>

• <layout.product.#.part.#.component.#.signature.relative-index.pad.#>

• <layout.product.#.part.#.component.#.size.height>

• <layout.product.#.part.#.component.#.size.height.cm>

• <layout.product.#.part.#.component.#.size.height.ft>

• <layout.product.#.part.#.component.#.size.height.in>

• <layout.product.#.part.#.component.#.size.height.m>

• <layout.product.#.part.#.component.#.size.height.mil>

• <layout.product.#.part.#.component.#.size.height.mm>

• <layout.product.#.part.#.component.#.size.height.pt>

• <layout.product.#.part.#.component.#.size.height.um>

• <layout.product.#.part.#.component.#.size.width>

• <layout.product.#.part.#.component.#.size.width.cm>

• <layout.product.#.part.#.component.#.size.width.ft>

• <layout.product.#.part.#.component.#.size.width.in>

• <layout.product.#.part.#.component.#.size.width.m>

• <layout.product.#.part.#.component.#.size.width.mil>

• <layout.product.#.part.#.component.#.size.width.mm>

• <layout.product.#.part.#.component.#.size.width.pt>

• <layout.product.#.part.#.component.#.size.width.um>

• <layout.product.#.part.#.component.#.spacing.margin>

• <layout.product.#.part.#.component.#.spacing.margin.cm>
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• <layout.product.#.part.#.component.#.spacing.margin.ft>

• <layout.product.#.part.#.component.#.spacing.margin.in>

• <layout.product.#.part.#.component.#.spacing.margin.m>

• <layout.product.#.part.#.component.#.spacing.margin.mil>

• <layout.product.#.part.#.component.#.spacing.margin.mm>

• <layout.product.#.part.#.component.#.spacing.margin.pt>

• <layout.product.#.part.#.component.#.spacing.margin.um>

• <layout.product.#.part.#.component.#.spacing.margins.bottom>

• <layout.product.#.part.#.component.#.spacing.margins.bottom.cm>

• <layout.product.#.part.#.component.#.spacing.margins.bottom.ft>

• <layout.product.#.part.#.component.#.spacing.margins.bottom.in>

• <layout.product.#.part.#.component.#.spacing.margins.bottom.m>

• <layout.product.#.part.#.component.#.spacing.margins.bottom.mil>

• <layout.product.#.part.#.component.#.spacing.margins.bottom.mm>

• <layout.product.#.part.#.component.#.spacing.margins.bottom.pt>

• <layout.product.#.part.#.component.#.spacing.margins.bottom.um>

• <layout.product.#.part.#.component.#.spacing.margins.left>

• <layout.product.#.part.#.component.#.spacing.margins.left.cm>

• <layout.product.#.part.#.component.#.spacing.margins.left.ft>

• <layout.product.#.part.#.component.#.spacing.margins.left.in>

• <layout.product.#.part.#.component.#.spacing.margins.left.m>

• <layout.product.#.part.#.component.#.spacing.margins.left.mil>

• <layout.product.#.part.#.component.#.spacing.margins.left.mm>

• <layout.product.#.part.#.component.#.spacing.margins.left.pt>

• <layout.product.#.part.#.component.#.spacing.margins.left.um>

• <layout.product.#.part.#.component.#.spacing.margins.right>

• <layout.product.#.part.#.component.#.spacing.margins.left.cm>

• <layout.product.#.part.#.component.#.spacing.margins.left.ft>
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• <layout.product.#.part.#.component.#.spacing.margins.left.in>

• <layout.product.#.part.#.component.#.spacing.margins.left.m>

• <layout.product.#.part.#.component.#.spacing.margins.left.mil>

• <layout.product.#.part.#.component.#.spacing.margins.left.mm>

• <layout.product.#.part.#.component.#.spacing.margins.left.pt>

• <layout.product.#.part.#.component.#.spacing.margins.left.um>

• <layout.product.#.part.#.component.#.spacing.margins.top>

• <layout.product.#.part.#.component.#.spacing.margins.top.cm>

• <layout.product.#.part.#.component.#.spacing.margins.top.ft>

• <layout.product.#.part.#.component.#.spacing.margins.top.in>

• <layout.product.#.part.#.component.#.spacing.margins.top.m>

• <layout.product.#.part.#.component.#.spacing.margins.top.mil>

• <layout.product.#.part.#.component.#.spacing.margins.top.mm>

• <layout.product.#.part.#.component.#.spacing.margins.top.pt>

• <layout.product.#.part.#.component.#.spacing.margins.top.um>

• <layout.product.#.part.#.component.#.spacing.type>

• <layout.product.#.part.#.component.#.tile.die.name>

• <layout.product.#.part.#.component.#.tile.die.path>

• <layout.product.#.part.#.component.#.tile.die.source>

• <layout.product.#.part.#.component.#.tile.die.source-noext>

• <layout.product.#.part.#.component.#.tile.die.type>

• <layout.product.#.part.#.component.#.tile.index>

• <layout.product.#.part.#.component.#.tile.index.pad.#>

• <layout.product.#.part.#.component.#.tile.tile-count>

• <layout.product.#.part.#.component.#.tile.tile-count.pad.#>

• <layout.product.#.part.#.component.count>

• <layout.product.#.part.#.component.count.pad.#>

• <layout.product.#.part.#.flat.templates>
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• <layout.product.#.part.#.grain>

• <layout.product.#.part.#.is-bound>

• <layout.product.#.part.#.page.#.bleed.bottom>

• <layout.product.#.part.#.page.#.bleed.bottom.cm>

• <layout.product.#.part.#.page.#.bleed.bottom.ft>

• <layout.product.#.part.#.page.#.bleed.bottom.in>

• <layout.product.#.part.#.page.#.bleed.bottom.m>

• <layout.product.#.part.#.page.#.bleed.bottom.mil>

• <layout.product.#.part.#.page.#.bleed.bottom.mm>

• <layout.product.#.part.#.page.#.bleed.bottom.pt>

• <layout.product.#.part.#.page.#.bleed.bottom.um>

• <layout.product.#.part.#.page.#.bleed.left>

• <layout.product.#.part.#.page.#.bleed.left.cm>

• <layout.product.#.part.#.page.#.bleed.left.ft>

• <layout.product.#.part.#.page.#.bleed.left.in>

• <layout.product.#.part.#.page.#.bleed.left.m>

• <layout.product.#.part.#.page.#.bleed.left.mil>

• <layout.product.#.part.#.page.#.bleed.left.mm>

• <layout.product.#.part.#.page.#.bleed.left.pt>

• <layout.product.#.part.#.page.#.bleed.left.um>

• <layout.product.#.part.#.page.#.bleed.right>

• <layout.product.#.part.#.page.#.bleed.left.cm>

• <layout.product.#.part.#.page.#.bleed.left.ft>

• <layout.product.#.part.#.page.#.bleed.left.in>

• <layout.product.#.part.#.page.#.bleed.left.m>

• <layout.product.#.part.#.page.#.bleed.left.mil>

• <layout.product.#.part.#.page.#.bleed.left.mm>

• <layout.product.#.part.#.page.#.bleed.left.pt>
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• <layout.product.#.part.#.page.#.bleed.left.um>

• <layout.product.#.part.#.page.#.bleed.top>

• <layout.product.#.part.#.page.#.bleed.top.cm>

• <layout.product.#.part.#.page.#.bleed.top.ft>

• <layout.product.#.part.#.page.#.bleed.top.in>

• <layout.product.#.part.#.page.#.bleed.top.m>

• <layout.product.#.part.#.page.#.bleed.top.mil>

• <layout.product.#.part.#.page.#.bleed.top.mm>

• <layout.product.#.part.#.page.#.bleed.top.pt>

• <layout.product.#.part.#.page.#.bleed.top.um>

• <layout.product.#.part.#.page.#.color.#.coverage>

• <layout.product.#.part.#.page.#.color.#.name>

• <layout.product.#.part.#.page.#.color.#.process>

• <layout.product.#.part.#.page.#.color.#.type>

• <layout.product.#.part.#.page.#.color.#.values>

• <layout.product.#.part.#.page.#.color.count>

• <layout.product.#.part.#.page.#.color.count.pad.#>

• <layout.product.#.part.#.page.#.colors.analysis>

• <layout.product.#.part.#.page.#.colors.detection>

• <layout.product.#.part.#.page.#.colors.source>

• <layout.product.#.part.#.page.#.creep>

• <layout.product.#.part.#.page.#.creep.cm>

• <layout.product.#.part.#.page.#.creep.ft>

• <layout.product.#.part.#.page.#.creep.in>

• <layout.product.#.part.#.page.#.creep.m>

• <layout.product.#.part.#.page.#.creep.mil>

• <layout.product.#.part.#.page.#.creep.mm>

• <layout.product.#.part.#.page.#.creep.pt>
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• <layout.product.#.part.#.page.#.creep.um>

• <layout.product.#.part.#.page.#.file.checksum>

• <layout.product.#.part.#.page.#.file.name>

• <layout.product.#.part.#.page.#.file.number>

• <layout.product.#.part.#.page.#.file.number.pad.#>

• <layout.product.#.part.#.page.#.file.path>

• <layout.product.#.part.#.page.#.file.timestamp>

• <layout.product.#.part.#.page.#.index>

• <layout.product.#.part.#.page.#.index.pad.#>

• <layout.product.#.part.#.page.#.locked>

• <layout.product.#.part.#.page.#.name>

• <layout.product.#.part.#.page.#.position.x>

• <layout.product.#.part.#.page.#.position.x.cm>

• <layout.product.#.part.#.page.#.position.x.ft>

• <layout.product.#.part.#.page.#.position.x.in>

• <layout.product.#.part.#.page.#.position.x.m>

• <layout.product.#.part.#.page.#.position.x.mil>

• <layout.product.#.part.#.page.#.position.x.mm>

• <layout.product.#.part.#.page.#.position.x.pt>

• <layout.product.#.part.#.page.#.position.x.um>

• <layout.product.#.part.#.page.#.position.y>

• <layout.product.#.part.#.page.#.position.y.cm>

• <layout.product.#.part.#.page.#.position.y.ft>

• <layout.product.#.part.#.page.#.position.y.in>

• <layout.product.#.part.#.page.#.position.y.m>

• <layout.product.#.part.#.page.#.position.y.mil>

• <layout.product.#.part.#.page.#.position.y.mm>

• <layout.product.#.part.#.page.#.position.y.pt>
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• <layout.product.#.part.#.page.#.position.y.um>

• <layout.product.#.part.#.page.#.rotation>

• <layout.product.#.part.#.page.#.scale.x>

• <layout.product.#.part.#.page.#.scale.x.cm>

• <layout.product.#.part.#.page.#.scale.x.ft>

• <layout.product.#.part.#.page.#.scale.x.in>

• <layout.product.#.part.#.page.#.scale.x.m>

• <layout.product.#.part.#.page.#.scale.x.mil>

• <layout.product.#.part.#.page.#.scale.x.mm>

• <layout.product.#.part.#.page.#.scale.x.pt>

• <layout.product.#.part.#.page.#.scale.x.um>

• <layout.product.#.part.#.page.#.scale.y>

• <layout.product.#.part.#.page.#.scale.y.cm>

• <layout.product.#.part.#.page.#.scale.y.ft>

• <layout.product.#.part.#.page.#.scale.y.in>

• <layout.product.#.part.#.page.#.scale.y.m>

• <layout.product.#.part.#.page.#.scale.y.mil>

• <layout.product.#.part.#.page.#.scale.y.mm>

• <layout.product.#.part.#.page.#.scale.y.pt>

• <layout.product.#.part.#.page.#.scale.y.um>

• <layout.product.#.part.#.page.#.size.height>

• <layout.product.#.part.#.page.#.size.height.cm>

• <layout.product.#.part.#.page.#.size.height.ft>

• <layout.product.#.part.#.page.#.size.height.in>

• <layout.product.#.part.#.page.#.size.height.m>

• <layout.product.#.part.#.page.#.size.height.mil>

• <layout.product.#.part.#.page.#.size.height.mm>

• <layout.product.#.part.#.page.#.size.height.pt>
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• <layout.product.#.part.#.page.#.size.height.um>

• <layout.product.#.part.#.page.#.size.width>

• <layout.product.#.part.#.page.#.size.width.cm>

• <layout.product.#.part.#.page.#.size.width.ft>

• <layout.product.#.part.#.page.#.size.width.in>

• <layout.product.#.part.#.page.#.size.width.m>

• <layout.product.#.part.#.page.#.size.width.mil>

• <layout.product.#.part.#.page.#.size.width.mm>

• <layout.product.#.part.#.page.#.size.width.pt>

• <layout.product.#.part.#.page.#.size.width.um>

• <layout.product.#.part.#.page.#.visible>

• <layout.product.#.part.#.part-type>

• <layout.product.#.part.#.processes>

• <layout.product.#.part.#.rotation.custom-values>

• <layout.product.#.part.#.rotation.type>

• <layout.product.#.part.#.stock>

• <layout.product.#.part.#.tiled.die.name>

• <layout.product.#.part.#.tiled.die.path>

• <layout.product.#.part.#.tiled.die.source>

• <layout.product.#.part.#.tiled.die.source-noext>

• <layout.product.#.part.#.tiled.die.type>

• <layout.product.#.part.#.tiled.size.height>

• <layout.product.#.part.#.tiled.size.height.cm>

• <layout.product.#.part.#.tiled.size.height.ft>

• <layout.product.#.part.#.tiled.size.height.in>

• <layout.product.#.part.#.tiled.size.height.m>

• <layout.product.#.part.#.tiled.size.height.mil>

• <layout.product.#.part.#.tiled.size.height.mm>
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• <layout.product.#.part.#.tiled.size.height.pt>

• <layout.product.#.part.#.tiled.size.height.um>

• <layout.product.#.part.#.tiled.size.width>

• <layout.product.#.part.#.tiled.size.width.cm>

• <layout.product.#.part.#.tiled.size.width.ft>

• <layout.product.#.part.#.tiled.size.width.in>

• <layout.product.#.part.#.tiled.size.width.m>

• <layout.product.#.part.#.tiled.size.width.mil>

• <layout.product.#.part.#.tiled.size.width.mm>

• <layout.product.#.part.#.tiled.size.width.pt>

• <layout.product.#.part.#.tiled.size.width.um>

• <layout.product.#.part.#.tiled.tiles>

• <layout.product.#.part.#.tiled.tiles.pad.#>

• <layout.product.#.part.#.tiled.tiling.cutting-tool>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension-rule>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension.cm>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension.ft>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension.in>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension.m>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension.mil>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension.mm>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension.pt>

• <layout.product.#.part.#.tiled.tiling.horizontal.extension.um>

• <layout.product.#.part.#.tiled.tiling.horizontal.gap>

• <layout.product.#.part.#.tiled.tiling.horizontal.gap.cm>

• <layout.product.#.part.#.tiled.tiling.horizontal.gap.ft>

• <layout.product.#.part.#.tiled.tiling.horizontal.gap.in>
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• <layout.product.#.part.#.tiled.tiling.horizontal.gap.m>

• <layout.product.#.part.#.tiled.tiling.horizontal.gap.mil>

• <layout.product.#.part.#.tiled.tiling.horizontal.gap.mm>

• <layout.product.#.part.#.tiled.tiling.horizontal.gap.pt>

• <layout.product.#.part.#.tiled.tiling.horizontal.gap.um>

• <layout.product.#.part.#.tiled.tiling.horizontal.method>

• <layout.product.#.part.#.tiled.tiling.horizontal.no-image>

• <layout.product.#.part.#.tiled.tiling.horizontal.no-image.cm>

• <layout.product.#.part.#.tiled.tiling.horizontal.no-image.ft>

• <layout.product.#.part.#.tiled.tiling.horizontal.no-image.in>

• <layout.product.#.part.#.tiled.tiling.horizontal.no-image.m>

• <layout.product.#.part.#.tiled.tiling.horizontal.no-image.mil>

• <layout.product.#.part.#.tiled.tiling.horizontal.no-image.mm>

• <layout.product.#.part.#.tiled.tiling.horizontal.no-image.pt>

• <layout.product.#.part.#.tiled.tiling.horizontal.no-image.um>

• <layout.product.#.part.#.tiled.tiling.horizontal.number>

• <layout.product.#.part.#.tiled.tiling.horizontal.number.pad.#>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap-rule>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap.cm>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap.ft>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap.in>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap.m>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap.mil>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap.mm>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap.pt>

• <layout.product.#.part.#.tiled.tiling.horizontal.overlap.um>

• <layout.product.#.part.#.tiled.tiling.horizontal.size>
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• <layout.product.#.part.#.tiled.tiling.horizontal.size.cm>

• <layout.product.#.part.#.tiled.tiling.horizontal.size.ft>

• <layout.product.#.part.#.tiled.tiling.horizontal.size.in>

• <layout.product.#.part.#.tiled.tiling.horizontal.size.m>

• <layout.product.#.part.#.tiled.tiling.horizontal.size.mil>

• <layout.product.#.part.#.tiled.tiling.horizontal.size.mm>

• <layout.product.#.part.#.tiled.tiling.horizontal.size.pt>

• <layout.product.#.part.#.tiled.tiling.horizontal.size.um>

• <layout.product.#.part.#.tiled.tiling.horizontal.sizes>

• <layout.product.#.part.#.tiled.tiling.horizontal.type>

• <layout.product.#.part.#.tiled.tiling.horizontal.uniform-final-size>

• <layout.product.#.part.#.tiled.tiling.order>

• <layout.product.#.part.#.tiled.tiling.preset>

• <layout.product.#.part.#.tiled.tiling.start>

• <layout.product.#.part.#.tiled.tiling.vertical.extension>

• <layout.product.#.part.#.tiled.tiling.vertical.extension-rule>

• <layout.product.#.part.#.tiled.tiling.vertical.extension.cm>

• <layout.product.#.part.#.tiled.tiling.vertical.extension.ft>

• <layout.product.#.part.#.tiled.tiling.vertical.extension.in>

• <layout.product.#.part.#.tiled.tiling.vertical.extension.m>

• <layout.product.#.part.#.tiled.tiling.vertical.extension.mil>

• <layout.product.#.part.#.tiled.tiling.vertical.extension.mm>

• <layout.product.#.part.#.tiled.tiling.vertical.extension.pt>

• <layout.product.#.part.#.tiled.tiling.vertical.extension.um>

• <layout.product.#.part.#.tiled.tiling.vertical.gap>

• <layout.product.#.part.#.tiled.tiling.vertical.gap.cm>

• <layout.product.#.part.#.tiled.tiling.vertical.gap.ft>

• <layout.product.#.part.#.tiled.tiling.vertical.gap.in>
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• <layout.product.#.part.#.tiled.tiling.vertical.gap.m>

• <layout.product.#.part.#.tiled.tiling.vertical.gap.mil>

• <layout.product.#.part.#.tiled.tiling.vertical.gap.mm>

• <layout.product.#.part.#.tiled.tiling.vertical.gap.pt>

• <layout.product.#.part.#.tiled.tiling.vertical.gap.um>

• <layout.product.#.part.#.tiled.tiling.vertical.method>

• <layout.product.#.part.#.tiled.tiling.vertical.no-image>

• <layout.product.#.part.#.tiled.tiling.vertical.no-image.cm>

• <layout.product.#.part.#.tiled.tiling.vertical.no-image.ft>

• <layout.product.#.part.#.tiled.tiling.vertical.no-image.in>

• <layout.product.#.part.#.tiled.tiling.vertical.no-image.m>

• <layout.product.#.part.#.tiled.tiling.vertical.no-image.mil>

• <layout.product.#.part.#.tiled.tiling.vertical.no-image.mm>

• <layout.product.#.part.#.tiled.tiling.vertical.no-image.pt>

• <layout.product.#.part.#.tiled.tiling.vertical.no-image.um>

• <layout.product.#.part.#.tiled.tiling.vertical.number>

• <layout.product.#.part.#.tiled.tiling.vertical.number.pad.#>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap-rule>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap.cm>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap.ft>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap.in>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap.m>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap.mil>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap.mm>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap.pt>

• <layout.product.#.part.#.tiled.tiling.vertical.overlap.um>

• <layout.product.#.part.#.tiled.tiling.vertical.size>
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• <layout.product.#.part.#.tiled.tiling.vertical.size.cm>

• <layout.product.#.part.#.tiled.tiling.vertical.size.ft>

• <layout.product.#.part.#.tiled.tiling.vertical.size.in>

• <layout.product.#.part.#.tiled.tiling.vertical.size.m>

• <layout.product.#.part.#.tiled.tiling.vertical.size.mil>

• <layout.product.#.part.#.tiled.tiling.vertical.size.mm>

• <layout.product.#.part.#.tiled.tiling.vertical.size.pt>

• <layout.product.#.part.#.tiled.tiling.vertical.size.um>

• <layout.product.#.part.#.tiled.tiling.vertical.sizes>

• <layout.product.#.part.#.tiled.tiling.vertical.type>

• <layout.product.#.part.#.tiled.tiling.vertical.uniform-final-size>

• <layout.product.#.part.count>

• <layout.product.#.part.count.pad.#>

• <layout.product.#.placed>

• <layout.product.#.placed.pad.#>

• <layout.product.#.priority>

• <layout.product.#.priority.pad.#>

• <layout.product.#.quantity>

• <layout.product.#.quantity.pad.#>

• <layout.product.#.total>

• <layout.product.count>

• <layout.product.count.pad.#>

• <layout.random>

• <layout.random-number>

• <layout.run-length>

• <layout.run-length-type>

• <layout.run-length.pad.#>

• <layout.run-number>
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• <layout.run-number.pad.#>

• <layout.things>

• <layout.time>

• <layout.underrun>

• <layout.usage>

• <layout.waste>

• <layout.workstyle>

Minute
• <minute>

Month
• <month.iso>

• <month.letter>

• <month.long>

• <month.medium>

• <month.short>

Part
• <part.bound.binding-edge>

• <part.bound.binding-method>

• <part.bound.creep.amount>

• <part.bound.creep.amount.cm>

• <part.bound.creep.amount.ft>

• <part.bound.creep.amount.in>

• <part.bound.creep.amount.m>

• <part.bound.creep.amount.mil>

• <part.bound.creep.amount.mm>

• <part.bound.creep.amount.pt>

• <part.bound.creep.amount.um>

• <part.bound.creep.calculation>

• <part.bound.creep.method>
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• <part.bound.creep.transition>

• <part.bound.creep.transition.cm>

• <part.bound.creep.transition.ft>

• <part.bound.creep.transition.in>

• <part.bound.creep.transition.m>

• <part.bound.creep.transition.mil>

• <part.bound.creep.transition.mm>

• <part.bound.creep.transition.pt>

• <part.bound.creep.transition.um>

• <part.bound.creep.type>

• <part.bound.jog-edge>

• <part.bound.n-up.gap>

• <part.bound.n-up.gap.cm>

• <part.bound.n-up.gap.ft>

• <part.bound.n-up.gap.in>

• <part.bound.n-up.gap.m>

• <part.bound.n-up.gap.mil>

• <part.bound.n-up.gap.mm>

• <part.bound.n-up.gap.pt>

• <part.bound.n-up.gap.um>

• <part.bound.n-up.number>

• <part.bound.n-up.number.pad.#>

• <part.bound.page-size.height>

• <part.bound.page-size.height.cm>

• <part.bound.page-size.height.ft>

• <part.bound.page-size.height.in>

• <part.bound.page-size.height.m>

• <part.bound.page-size.height.mil>
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• <part.bound.page-size.height.mm>

• <part.bound.page-size.height.pt>

• <part.bound.page-size.height.um>

• <part.bound.page-size.width>

• <part.bound.page-size.width.cm>

• <part.bound.page-size.width.ft>

• <part.bound.page-size.width.in>

• <part.bound.page-size.width.m>

• <part.bound.page-size.width.mil>

• <part.bound.page-size.width.mm>

• <part.bound.page-size.width.pt>

• <part.bound.page-size.width.um>

• <part.bound.pages-per-section>

• <part.bound.pages-per-section.pad.#>

• <part.bound.reading-order>

• <part.bound.sections>

• <part.bound.sections.pad.#>

• <part.bound.self-cover>

• <part.bound.signatures>

• <part.bound.signature.pad.#>

• <part.bound.trim.face>

• <part.bound.trim.face.cm>

• <part.bound.trim.face.ft>

• <part.bound.trim.face.in>

• <part.bound.trim.face.m>

• <part.bound.trim.face.mil>

• <part.bound.trim.face.mm>

• <part.bound.trim.face.pt>
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• <part.bound.trim.face.um>

• <part.bound.trim.jog>

• <part.bound.trim.jog.cm>

• <part.bound.trim.jog.ft>

• <part.bound.trim.jog.in>

• <part.bound.trim.jog.m>

• <part.bound.trim.jog.mil>

• <part.bound.trim.jog.mm>

• <part.bound.trim.jog.pt>

• <part.bound.trim.jog.um>

• <part.bound.trim.lip>

• <part.bound.trim.lip-type>

• <part.bound.trim.lip.cm>

• <part.bound.trim.lip.ft>

• <part.bound.trim.lip.in>

• <part.bound.trim.lip.m>

• <part.bound.trim.lip.mil>

• <part.bound.trim.lip.mm>

• <part.bound.trim.lip.pt>

• <part.bound.trim.lip.um>

• <part.bound.trim.non-jog>

• <part.bound.trim.non-jog.cm>

• <part.bound.trim.non-jog.ft>

• <part.bound.trim.non-jog.in>

• <part.bound.trim.non-jog.m>

• <part.bound.trim.non-jog.mil>

• <part.bound.trim.non-jog.mm>

• <part.bound.trim.non-jog.pt>
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• <part.bound.trim.non-jog.um>

• <part.bound.trim.spine>

• <part.bound.trim.spine.cm>

• <part.bound.trim.spine.ft>

• <part.bound.trim.spine.in>

• <part.bound.trim.spine.m>

• <part.bound.trim.spine.mil>

• <part.bound.trim.spine.mm>

• <part.bound.trim.spine.pt>

• <part.bound.trim.spine.um>

• <part.flat.templates>

• <part.grain>

• <part.is-bound>

• <part.page.#.bleed.bottom>

• <part.page.#.bleed.bottom.cm>

• <part.page.#.bleed.bottom.ft>

• <part.page.#.bleed.bottom.in>

• <part.page.#.bleed.bottom.m>

• <part.page.#.bleed.bottom.mil>

• <part.page.#.bleed.bottom.mm>

• <part.page.#.bleed.bottom.pt>

• <part.page.#.bleed.bottom.um>

• <part.page.#.bleed.left>

• <part.page.#.bleed.left.cm>

• <part.page.#.bleed.left.ft>

• <part.page.#.bleed.left.in>

• <part.page.#.bleed.left.m>

• <part.page.#.bleed.left.mil>
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• <part.page.#.bleed.left.mm>

• <part.page.#.bleed.left.pt>

• <part.page.#.bleed.left.um>

• <part.page.#.bleed.right>

• <part.page.#.bleed.left.cm>

• <part.page.#.bleed.left.ft>

• <part.page.#.bleed.left.in>

• <part.page.#.bleed.left.m>

• <part.page.#.bleed.left.mil>

• <part.page.#.bleed.left.mm>

• <part.page.#.bleed.left.pt>

• <part.page.#.bleed.left.um>

• <part.page.#.bleed.top>

• <part.page.#.bleed.top.cm>

• <part.page.#.bleed.top.ft>

• <part.page.#.bleed.top.in>

• <part.page.#.bleed.top.m>

• <part.page.#.bleed.top.mil>

• <part.page.#.bleed.top.mm>

• <part.page.#.bleed.top.pt>

• <part.page.#.bleed.top.um>

• <part.page.#.color.#.coverage>

• <part.page.#.color.#.name>

• <part.page.#.color.#.process>

• <part.page.#.color.#.type>

• <part.page.#.color.#.values>

• <part.page.#.color.count>

• <part.page.#.color.count.pad.#>
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• <part.page.#.colors.analysis>

• <part.page.#.colors.detection>

• <part.page.#.colors.source>

• <part.page.#.creep>

• <part.page.#.creep.cm>

• <part.page.#.creep.ft>

• <part.page.#.creep.in>

• <part.page.#.creep.m>

• <part.page.#.creep.mil>

• <part.page.#.creep.mm>

• <part.page.#.creep.pt>

• <part.page.#.creep.um>

• <part.page.#.file.checksum>

• <part.page.#.file.name>

• <part.page.#.file.number>

• <part.page.#.file.number.pad.#>

• <part.page.#.file.path>

• <part.page.#.file.timestamp>

• <part.page.#.index>

• <part.page.#.index.pad.#>

• <part.page.#.locked>

• <part.page.#.name>

• <part.page.#.position.x>

• <part.page.#.position.x.cm>

• <part.page.#.position.x.ft>

• <part.page.#.position.x.in>

• <part.page.#.position.x.m>

• <part.page.#.position.x.mil>
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• <part.page.#.position.x.mm>

• <part.page.#.position.x.pt>

• <part.page.#.position.x.um>

• <part.page.#.position.y>

• <part.page.#.position.y.cm>

• <part.page.#.position.y.ft>

• <part.page.#.position.y.in>

• <part.page.#.position.y.m>

• <part.page.#.position.y.mil>

• <part.page.#.position.y.mm>

• <part.page.#.position.y.pt>

• <part.page.#.position.y.um>

• <part.page.#.rotation>

• <part.page.#.scale.x>

• <part.page.#.scale.x.cm>

• <part.page.#.scale.x.ft>

• <part.page.#.scale.x.in>

• <part.page.#.scale.x.m>

• <part.page.#.scale.x.mil>

• <part.page.#.scale.x.mm>

• <part.page.#.scale.x.pt>

• <part.page.#.scale.x.um>

• <part.page.#.scale.y>

• <part.page.#.scale.y.cm>

• <part.page.#.scale.y.ft>

• <part.page.#.scale.y.in>

• <part.page.#.scale.y.m>

• <part.page.#.scale.y.mil>
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• <part.page.#.scale.y.mm>

• <part.page.#.scale.y.pt>

• <part.page.#.scale.y.um>

• <part.page.#.size.height>

• <part.page.#.size.height.cm>

• <part.page.#.size.height.ft>

• <part.page.#.size.height.in>

• <part.page.#.size.height.m>

• <part.page.#.size.height.mil>

• <part.page.#.size.height.mm>

• <part.page.#.size.height.pt>

• <part.page.#.size.height.um>

• <part.page.#.size.width>

• <part.page.#.size.width.cm>

• <part.page.#.size.width.ft>

• <part.page.#.size.width.in>

• <part.page.#.size.width.m>

• <part.page.#.size.width.mil>

• <part.page.#.size.width.mm>

• <part.page.#.size.width.pt>

• <part.page.#.size.width.um>

• <part.page.#.visible>

• <part.part-type>

• <part.processes>

• <part.rotation.custom-values>

• <part.rotation.type>

• <part.stock>

• <part.tiled.die.name>
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• <part.tiled.die.path>

• <part.tiled.die.source>

• <part.tiled.die.source-noext>

• <part.tiled.die.type>

• <part.tiled.size.height>

• <part.tiled.size.height.cm>

• <part.tiled.size.height.ft>

• <part.tiled.size.height.in>

• <part.tiled.size.height.m>

• <part.tiled.size.height.mil>

• <part.tiled.size.height.mm>

• <part.tiled.size.height.pt>

• <part.tiled.size.height.um>

• <part.tiled.size.width>

• <part.tiled.size.width.cm>

• <part.tiled.size.width.ft>

• <part.tiled.size.width.in>

• <part.tiled.size.width.m>

• <part.tiled.size.width.mil>

• <part.tiled.size.width.mm>

• <part.tiled.size.width.pt>

• <part.tiled.size.width.um>

• <part.tiled.tiles>

• <part.tiled.tiles.pad.#>

• <part.tiled.tiling.cutting-tool>

• <part.tiled.tiling.horizontal.extension>

• <part.tiled.tiling.horizontal.extension-rule>

• <part.tiled.tiling.horizontal.extension.cm>
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• <part.tiled.tiling.horizontal.extension.ft>

• <part.tiled.tiling.horizontal.extension.in>

• <part.tiled.tiling.horizontal.extension.m>

• <part.tiled.tiling.horizontal.extension.mil>

• <part.tiled.tiling.horizontal.extension.mm>

• <part.tiled.tiling.horizontal.extension.pt>

• <part.tiled.tiling.horizontal.extension.um>

• <part.tiled.tiling.horizontal.gap>

• <part.tiled.tiling.horizontal.gap.cm>

• <part.tiled.tiling.horizontal.gap.ft>

• <part.tiled.tiling.horizontal.gap.in>

• <part.tiled.tiling.horizontal.gap.m>

• <part.tiled.tiling.horizontal.gap.mil>

• <part.tiled.tiling.horizontal.gap.mm>

• <part.tiled.tiling.horizontal.gap.pt>

• <part.tiled.tiling.horizontal.gap.um>

• <part.tiled.tiling.horizontal.method>

• <part.tiled.tiling.horizontal.no-image>

• <part.tiled.tiling.horizontal.no-image.cm>

• <part.tiled.tiling.horizontal.no-image.ft>

• <part.tiled.tiling.horizontal.no-image.in>

• <part.tiled.tiling.horizontal.no-image.m>

• <part.tiled.tiling.horizontal.no-image.mil>

• <part.tiled.tiling.horizontal.no-image.mm>

• <part.tiled.tiling.horizontal.no-image.pt>

• <part.tiled.tiling.horizontal.no-image.um>

• <part.tiled.tiling.horizontal.number>

• <part.tiled.tiling.horizontal.number.pad.#>
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• <part.tiled.tiling.horizontal.overlap>

• <part.tiled.tiling.horizontal.overlap-rule>

• <part.tiled.tiling.horizontal.overlap.cm>

• <part.tiled.tiling.horizontal.overlap.ft>

• <part.tiled.tiling.horizontal.overlap.in>

• <part.tiled.tiling.horizontal.overlap.m>

• <part.tiled.tiling.horizontal.overlap.mil>

• <part.tiled.tiling.horizontal.overlap.mm>

• <part.tiled.tiling.horizontal.overlap.pt>

• <part.tiled.tiling.horizontal.overlap.um>

• <part.tiled.tiling.horizontal.size>

• <part.tiled.tiling.horizontal.size.cm>

• <part.tiled.tiling.horizontal.size.ft>

• <part.tiled.tiling.horizontal.size.in>

• <part.tiled.tiling.horizontal.size.m>

• <part.tiled.tiling.horizontal.size.mil>

• <part.tiled.tiling.horizontal.size.mm>

• <part.tiled.tiling.horizontal.size.pt>

• <part.tiled.tiling.horizontal.size.um>

• <part.tiled.tiling.horizontal.sizes>

• <part.tiled.tiling.horizontal.type>

• <part.tiled.tiling.horizontal.uniform-final-size>

• <part.tiled.tiling.order>

• <part.tiled.tiling.preset>

• <part.tiled.tiling.start>

• <part.tiled.tiling.vertical.extension>

• <part.tiled.tiling.vertical.extension-rule>

• <part.tiled.tiling.vertical.extension.cm>
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• <part.tiled.tiling.vertical.extension.ft>

• <part.tiled.tiling.vertical.extension.in>

• <part.tiled.tiling.vertical.extension.m>

• <part.tiled.tiling.vertical.extension.mil>

• <part.tiled.tiling.vertical.extension.mm>

• <part.tiled.tiling.vertical.extension.pt>

• <part.tiled.tiling.vertical.extension.um>

• <part.tiled.tiling.vertical.gap>

• <part.tiled.tiling.vertical.gap.cm>

• <part.tiled.tiling.vertical.gap.ft>

• <part.tiled.tiling.vertical.gap.in>

• <part.tiled.tiling.vertical.gap.m>

• <part.tiled.tiling.vertical.gap.mil>

• <part.tiled.tiling.vertical.gap.mm>

• <part.tiled.tiling.vertical.gap.pt>

• <part.tiled.tiling.vertical.gap.um>

• <part.tiled.tiling.vertical.method>

• <part.tiled.tiling.vertical.no-image>

• <part.tiled.tiling.vertical.no-image.cm>

• <part.tiled.tiling.vertical.no-image.ft>

• <part.tiled.tiling.vertical.no-image.in>

• <part.tiled.tiling.vertical.no-image.m>

• <part.tiled.tiling.vertical.no-image.mil>

• <part.tiled.tiling.vertical.no-image.mm>

• <part.tiled.tiling.vertical.no-image.pt>

• <part.tiled.tiling.vertical.no-image.um>

• <part.tiled.tiling.vertical.number>

• <part.tiled.tiling.vertical.number.pad.#>
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• <part.tiled.tiling.vertical.overlap>

• <part.tiled.tiling.vertical.overlap-rule>

• <part.tiled.tiling.vertical.overlap.cm>

• <part.tiled.tiling.vertical.overlap.ft>

• <part.tiled.tiling.vertical.overlap.in>

• <part.tiled.tiling.vertical.overlap.m>

• <part.tiled.tiling.vertical.overlap.mil>

• <part.tiled.tiling.vertical.overlap.mm>

• <part.tiled.tiling.vertical.overlap.pt>

• <part.tiled.tiling.vertical.overlap.um>

• <part.tiled.tiling.vertical.size>

• <part.tiled.tiling.vertical.size.cm>

• <part.tiled.tiling.vertical.size.ft>

• <part.tiled.tiling.vertical.size.in>

• <part.tiled.tiling.vertical.size.m>

• <part.tiled.tiling.vertical.size.mil>

• <part.tiled.tiling.vertical.size.mm>

• <part.tiled.tiling.vertical.size.pt>

• <part.tiled.tiling.vertical.size.um>

• <part.tiled.tiling.vertical.sizes>

• <part.tiled.tiling.vertical.type>

• <part.tiled.tiling.vertical.uniform-final-size>

Plate
• <plate.external-id>

• <plate.locked>

• <plate.name>

• <plate.position.x>

• <plate.position.x.cm>

• <plate.position.x.ft>
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• <plate.position.x.in>

• <plate.position.x.m>

• <plate.position.x.mil>

• <plate.position.x.mm>

• <plate.position.x.pt>

• <plate.position.x.um>

• <plate.position.y>

• <plate.position.y.cm>

• <plate.position.y.ft>

• <plate.position.y.in>

• <plate.position.y.m>

• <plate.position.y.mil>

• <plate.position.y.mm>

• <plate.position.y.pt>

• <plate.position.y.um>

• <plate.price>

• <plate.punch>

• <plate.punch.cm>

• <plate.punch.ft>

• <plate.punch.in>

• <plate.punch.m>

• <plate.punch.mil>

• <plate.punch.mm>

• <plate.punch.pt>

• <plate.punch.um>

• <plate.rotation>

• <plate.size.height>

• <plate.size.height.cm>
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• <plate.size.height.ft>

• <plate.size.height.in>

• <plate.size.height.m>

• <plate.size.height.mil>

• <plate.size.height.mm>

• <plate.size.height.pt>

• <plate.size.height.um>

• <plate.size.width>

• <plate.size.width.cm>

• <plate.size.width.ft>

• <plate.size.width.in>

• <plate.size.width.m>

• <plate.size.width.mil>

• <plate.size.width.mm>

• <plate.size.width.pt>

• <plate.size.width.um>

• <plate.type>

• <plate.z-order>

• <plate.z-order.pad.#>

Press
• <press.cost>

• <press.external-id>

• <press.feed-type>

• <press.gripper>

• <press.gripper.cm>

• <press.gripper.ft>

• <press.gripper.in>

• <press.gripper.m>

• <press.gripper.mil>
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• <press.gripper.mm>

• <press.gripper.pt>

• <press.gripper.um>

• <press.manufacturer>

• <press.name>

• <press.process-type>

• <press.processes>

• <press.speed>

• <press.speed-units>

Product
• <product.artwork.creator>

• <product.artwork.format>

• <product.artwork.page-count>

• <product.artwork.page-number>

• <product.artwork.pages>

• <product.artwork.path>

• <product.artwork.pdf-version>

• <product.artwork.pdfx-profile>

• <product.artwork.pdfx-version>

• <product.artwork.producer>

• <product.artwork.title>

• <product.back-inks>

• <product.color>

• <product.color.pad.#>

• <product.description>

• <product.due-date>

• <product.front-inks>

• <product.group>

• <product.index>
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• <product.index.pad.#>

• <product.layouts>

• <product.max-overruns>

• <product.max-overruns.cm>

• <product.max-overruns.ft>

• <product.max-overruns.in>

• <product.max-overruns.m>

• <product.max-overruns.mil>

• <product.max-overruns.mm>

• <product.max-overruns.pt>

• <product.max-overruns.um>

• <product.min-overruns>

• <product.min-overruns.cm>

• <product.min-overruns.ft>

• <product.min-overruns.in>

• <product.min-overruns.m>

• <product.min-overruns.mil>

• <product.min-overruns.mm>

• <product.min-overruns.pt>

• <product.min-overruns.um>

• <product.name>

• <product.notes>

• <product.overrun>

• <product.overrun-percent>

• <product.placed>

• <product.placed.pad.#>

• <product.priority>

• <product.priority.pad.#>
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• <product.quantity>

• <product.quantity.pad.#>

• <product.total>

Project
• <project.bleed-splitting>

• <project.client>

• <project.contact>

• <project.cost>

• <project.cost-die>

• <project.cost-plate>

• <project.cost-press>

• <project.cost-stock>

• <project.creator-os>

• <project.filename>

• <project.filepath>

• <project.id>

• <project.last-saved>

• <project.layout-count>

• <project.layout-count.pad.#>

• <project.name>

• <project.notes>

• <project.overrun>

• <project.phoenix-version>

• <project.phone>

• <project.press-time>

• <project.product.#.back-inks>

• <project.product.#.color>

• <project.product.#.color.pad.#>

• <project.product.#.description>
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• <project.product.#.due-date>

• <project.product.#.front-inks>

• <project.product.#.group>

• <project.product.#.index>

• <project.product.#.index.pad.#>

• <project.product.#.layouts>

• <project.product.#.max-overruns>

• <project.product.#.max-overruns.cm>

• <project.product.#.max-overruns.ft>

• <project.product.#.max-overruns.in>

• <project.product.#.max-overruns.m>

• <project.product.#.max-overruns.mil>

• <project.product.#.max-overruns.mm>

• <project.product.#.max-overruns.pt>

• <project.product.#.max-overruns.um>

• <project.product.#.min-overruns>

• <project.product.#.min-overruns.cm>

• <project.product.#.min-overruns.ft>

• <project.product.#.min-overruns.in>

• <project.product.#.min-overruns.m>

• <project.product.#.min-overruns.mil>

• <project.product.#.min-overruns.mm>

• <project.product.#.min-overruns.pt>

• <project.product.#.min-overruns.um>

• <project.product.#.name>

• <project.product.#.notes>

• <project.product.#.overrun>

• <project.product.#.overrun-percent>
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• <project.product.#.part.#.bound.binding-edge>

• <project.product.#.part.#.bound.binding-method>

• <project.product.#.part.#.bound.creep.amount>

• <project.product.#.part.#.bound.creep.amount.cm>

• <project.product.#.part.#.bound.creep.amount.ft>

• <project.product.#.part.#.bound.creep.amount.in>

• <project.product.#.part.#.bound.creep.amount.m>

• <project.product.#.part.#.bound.creep.amount.mil>

• <project.product.#.part.#.bound.creep.amount.mm>

• <project.product.#.part.#.bound.creep.amount.pt>

• <project.product.#.part.#.bound.creep.amount.um>

• <project.product.#.part.#.bound.creep.calculation>

• <project.product.#.part.#.bound.creep.method>

• <project.product.#.part.#.bound.creep.transition>

• <project.product.#.part.#.bound.creep.transition.cm>

• <project.product.#.part.#.bound.creep.transition.ft>

• <project.product.#.part.#.bound.creep.transition.in>

• <project.product.#.part.#.bound.creep.transition.m>

• <project.product.#.part.#.bound.creep.transition.mil>

• <project.product.#.part.#.bound.creep.transition.mm>

• <project.product.#.part.#.bound.creep.transition.pt>

• <project.product.#.part.#.bound.creep.transition.um>

• <project.product.#.part.#.bound.creep.type>

• <project.product.#.part.#.bound.jog-edge>

• <project.product.#.part.#.bound.n-up.gap>

• <project.product.#.part.#.bound.n-up.gap.cm>

• <project.product.#.part.#.bound.n-up.gap.ft>

• <project.product.#.part.#.bound.n-up.gap.in>

314



2Phoenix

• <project.product.#.part.#.bound.n-up.gap.m>

• <project.product.#.part.#.bound.n-up.gap.mil>

• <project.product.#.part.#.bound.n-up.gap.mm>

• <project.product.#.part.#.bound.n-up.gap.pt>

• <project.product.#.part.#.bound.n-up.gap.um>

• <project.product.#.part.#.bound.n-up.number>

• <project.product.#.part.#.bound.n-up.number.pad.#>

• <project.product.#.part.#.bound.page-size.height>

• <project.product.#.part.#.bound.page-size.height.cm>

• <project.product.#.part.#.bound.page-size.height.ft>

• <project.product.#.part.#.bound.page-size.height.in>

• <project.product.#.part.#.bound.page-size.height.m>

• <project.product.#.part.#.bound.page-size.height.mil>

• <project.product.#.part.#.bound.page-size.height.mm>

• <project.product.#.part.#.bound.page-size.height.pt>

• <project.product.#.part.#.bound.page-size.height.um>

• <project.product.#.part.#.bound.page-size.width>

• <project.product.#.part.#.bound.page-size.width.cm>

• <project.product.#.part.#.bound.page-size.width.ft>

• <project.product.#.part.#.bound.page-size.width.in>

• <project.product.#.part.#.bound.page-size.width.m>

• <project.product.#.part.#.bound.page-size.width.mil>

• <project.product.#.part.#.bound.page-size.width.mm>

• <project.product.#.part.#.bound.page-size.width.pt>

• <project.product.#.part.#.bound.page-size.width.um>

• <project.product.#.part.#.bound.pages-per-section>

• <project.product.#.part.#.bound.pages-per-section.pad.#>

• <project.product.#.part.#.bound.reading-order>
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• <project.product.#.part.#.bound.sections>

• <project.product.#.part.#.bound.sections.pad.#>

• <project.product.#.part.#.bound.self-cover>

• <project.product.#.part.#.bound.signatures>

• <project.product.#.part.#.bound.signatures.pad.#>

• <project.product.#.part.#.bound.trim.face>

• <project.product.#.part.#.bound.trim.face.cm>

• <project.product.#.part.#.bound.trim.face.ft>

• <project.product.#.part.#.bound.trim.face.in>

• <project.product.#.part.#.bound.trim.face.m>

• <project.product.#.part.#.bound.trim.face.mil>

• <project.product.#.part.#.bound.trim.face.mm>

• <project.product.#.part.#.bound.trim.face.pt>

• <project.product.#.part.#.bound.trim.face.um>

• <project.product.#.part.#.bound.trim.jog>

• <project.product.#.part.#.bound.trim.jog.cm>

• <project.product.#.part.#.bound.trim.jog.ft>

• <project.product.#.part.#.bound.trim.jog.in>

• <project.product.#.part.#.bound.trim.jog.m>

• <project.product.#.part.#.bound.trim.jog.mil>

• <project.product.#.part.#.bound.trim.jog.mm>

• <project.product.#.part.#.bound.trim.jog.pt>

• <project.product.#.part.#.bound.trim.jog.um>

• <project.product.#.part.#.bound.trim.lip>

• <project.product.#.part.#.bound.trim.lip-type>

• <project.product.#.part.#.bound.trim.lip.cm>

• <project.product.#.part.#.bound.trim.lip.ft>

• <project.product.#.part.#.bound.trim.lip.in>
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• <project.product.#.part.#.bound.trim.lip.m>

• <project.product.#.part.#.bound.trim.lip.mil>

• <project.product.#.part.#.bound.trim.lip.mm>

• <project.product.#.part.#.bound.trim.lip.pt>

• <project.product.#.part.#.bound.trim.lip.um>

• <project.product.#.part.#.bound.trim.non-jog>

• <project.product.#.part.#.bound.trim.non-jog.cm>

• <project.product.#.part.#.bound.trim.non-jog.ft>

• <project.product.#.part.#.bound.trim.non-jog.in>

• <project.product.#.part.#.bound.trim.non-jog.m>

• <project.product.#.part.#.bound.trim.non-jog.mil>

• <project.product.#.part.#.bound.trim.non-jog.mm>

• <project.product.#.part.#.bound.trim.non-jog.pt>

• <project.product.#.part.#.bound.trim.non-jog.um>

• <project.product.#.part.#.bound.trim.spine>

• <project.product.#.part.#.bound.trim.spine.cm>

• <project.product.#.part.#.bound.trim.spine.ft>

• <project.product.#.part.#.bound.trim.spine.in>

• <project.product.#.part.#.bound.trim.spine.m>

• <project.product.#.part.#.bound.trim.spine.mil>

• <project.product.#.part.#.bound.trim.spine.mm>

• <project.product.#.part.#.bound.trim.spine.pt>

• <project.product.#.part.#.bound.trim.spine.um>

• <project.product.#.part.#.component.#.bleed.margin>

• <project.product.#.part.#.component.#.bleed.margin.cm>

• <project.product.#.part.#.component.#.bleed.margin.ft>

• <project.product.#.part.#.component.#.bleed.margin.in>

• <project.product.#.part.#.component.#.bleed.margin.m>
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• <project.product.#.part.#.component.#.bleed.margin.mil>

• <project.product.#.part.#.component.#.bleed.margin.mm>

• <project.product.#.part.#.component.#.bleed.margin.pt>

• <project.product.#.part.#.component.#.bleed.margin.um>

• <project.product.#.part.#.component.#.bleed.margins.bottom>

• <project.product.#.part.#.component.#.bleed.margins.bottom.cm>

• <project.product.#.part.#.component.#.bleed.margins.bottom.ft>

• <project.product.#.part.#.component.#.bleed.margins.bottom.in>

• <project.product.#.part.#.component.#.bleed.margins.bottom.m>

• <project.product.#.part.#.component.#.bleed.margins.bottom.mil>

• <project.product.#.part.#.component.#.bleed.margins.bottom.mm>

• <project.product.#.part.#.component.#.bleed.margins.bottom.pt>

• <project.product.#.part.#.component.#.bleed.margins.bottom.um>

• <project.product.#.part.#.component.#.bleed.margins.left>

• <project.product.#.part.#.component.#.bleed.margins.left.cm>

• <project.product.#.part.#.component.#.bleed.margins.left.ft>

• <project.product.#.part.#.component.#.bleed.margins.left.in>

• <project.product.#.part.#.component.#.bleed.margins.left.m>

• <project.product.#.part.#.component.#.bleed.margins.left.mil>

• <project.product.#.part.#.component.#.bleed.margins.left.mm>

• <project.product.#.part.#.component.#.bleed.margins.left.pt>

• <project.product.#.part.#.component.#.bleed.margins.left.um>

• <project.product.#.part.#.component.#.bleed.margins.right>

• <project.product.#.part.#.component.#.bleed.margins.left.cm>

• <project.product.#.part.#.component.#.bleed.margins.left.ft>

• <project.product.#.part.#.component.#.bleed.margins.left.in>

• <project.product.#.part.#.component.#.bleed.margins.left.m>

• <project.product.#.part.#.component.#.bleed.margins.left.mil>
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• <project.product.#.part.#.component.#.bleed.margins.left.mm>

• <project.product.#.part.#.component.#.bleed.margins.left.pt>

• <project.product.#.part.#.component.#.bleed.margins.left.um>

• <project.product.#.part.#.component.#.bleed.margins.top>

• <project.product.#.part.#.component.#.bleed.margins.top.cm>

• <project.product.#.part.#.component.#.bleed.margins.top.ft>

• <project.product.#.part.#.component.#.bleed.margins.top.in>

• <project.product.#.part.#.component.#.bleed.margins.top.m>

• <project.product.#.part.#.component.#.bleed.margins.top.mil>

• <project.product.#.part.#.component.#.bleed.margins.top.mm>

• <project.product.#.part.#.component.#.bleed.margins.top.pt>

• <project.product.#.part.#.component.#.bleed.margins.top.um>

• <project.product.#.part.#.component.#.bleed.type>

• <project.product.#.part.#.component.#.component-type>

• <project.product.#.part.#.component.#.double-sided>

• <project.product.#.part.#.component.#.flat.bundle-size>

• <project.product.#.part.#.component.#.flat.bundle-size.pad.#>

• <project.product.#.part.#.component.#.flat.die.name>

• <project.product.#.part.#.component.#.flat.die.path>

• <project.product.#.part.#.component.#.flat.die.source>

• <project.product.#.part.#.component.#.flat.die.source-noext>

• <project.product.#.part.#.component.#.flat.die.type>

• <project.product.#.part.#.component.#.offcut.margins.bottom>

• <project.product.#.part.#.component.#.offcut.margins.bottom.cm>

• <project.product.#.part.#.component.#.offcut.margins.bottom.ft>

• <project.product.#.part.#.component.#.offcut.margins.bottom.in>

• <project.product.#.part.#.component.#.offcut.margins.bottom.m>

• <project.product.#.part.#.component.#.offcut.margins.bottom.mil>
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• <project.product.#.part.#.component.#.offcut.margins.bottom.mm>

• <project.product.#.part.#.component.#.offcut.margins.bottom.pt>

• <project.product.#.part.#.component.#.offcut.margins.bottom.um>

• <project.product.#.part.#.component.#.offcut.margins.left>

• <project.product.#.part.#.component.#.offcut.margins.left.cm>

• <project.product.#.part.#.component.#.offcut.margins.left.ft>

• <project.product.#.part.#.component.#.offcut.margins.left.in>

• <project.product.#.part.#.component.#.offcut.margins.left.m>

• <project.product.#.part.#.component.#.offcut.margins.left.mil>

• <project.product.#.part.#.component.#.offcut.margins.left.mm>

• <project.product.#.part.#.component.#.offcut.margins.left.pt>

• <project.product.#.part.#.component.#.offcut.margins.left.um>

• <project.product.#.part.#.component.#.offcut.margins.right>

• <project.product.#.part.#.component.#.offcut.margins.left.cm>

• <project.product.#.part.#.component.#.offcut.margins.left.ft>

• <project.product.#.part.#.component.#.offcut.margins.left.in>

• <project.product.#.part.#.component.#.offcut.margins.left.m>

• <project.product.#.part.#.component.#.offcut.margins.left.mil>

• <project.product.#.part.#.component.#.offcut.margins.left.mm>

• <project.product.#.part.#.component.#.offcut.margins.left.pt>

• <project.product.#.part.#.component.#.offcut.margins.left.um>

• <project.product.#.part.#.component.#.offcut.margins.top>

• <project.product.#.part.#.component.#.offcut.margins.top.cm>

• <project.product.#.part.#.component.#.offcut.margins.top.ft>

• <project.product.#.part.#.component.#.offcut.margins.top.in>

• <project.product.#.part.#.component.#.offcut.margins.top.m>

• <project.product.#.part.#.component.#.offcut.margins.top.mil>

• <project.product.#.part.#.component.#.offcut.margins.top.mm>
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• <project.product.#.part.#.component.#.offcut.margins.top.pt>

• <project.product.#.part.#.component.#.offcut.margins.top.um>

• <project.product.#.part.#.component.#.offcut.type>

• <project.product.#.part.#.component.#.page.#.bleed.bottom>

• <project.product.#.part.#.component.#.page.#.bleed.bottom.cm>

• <project.product.#.part.#.component.#.page.#.bleed.bottom.ft>

• <project.product.#.part.#.component.#.page.#.bleed.bottom.in>

• <project.product.#.part.#.component.#.page.#.bleed.bottom.m>

• <project.product.#.part.#.component.#.page.#.bleed.bottom.mil>

• <project.product.#.part.#.component.#.page.#.bleed.bottom.mm>

• <project.product.#.part.#.component.#.page.#.bleed.bottom.pt>

• <project.product.#.part.#.component.#.page.#.bleed.bottom.um>

• <project.product.#.part.#.component.#.page.#.bleed.left>

• <project.product.#.part.#.component.#.page.#.bleed.left.cm>

• <project.product.#.part.#.component.#.page.#.bleed.left.ft>

• <project.product.#.part.#.component.#.page.#.bleed.left.in>

• <project.product.#.part.#.component.#.page.#.bleed.left.m>

• <project.product.#.part.#.component.#.page.#.bleed.left.mil>

• <project.product.#.part.#.component.#.page.#.bleed.left.mm>

• <project.product.#.part.#.component.#.page.#.bleed.left.pt>

• <project.product.#.part.#.component.#.page.#.bleed.left.um>

• <project.product.#.part.#.component.#.page.#.bleed.right>

• <project.product.#.part.#.component.#.page.#.bleed.left.cm>

• <project.product.#.part.#.component.#.page.#.bleed.left.ft>

• <project.product.#.part.#.component.#.page.#.bleed.left.in>

• <project.product.#.part.#.component.#.page.#.bleed.left.m>

• <project.product.#.part.#.component.#.page.#.bleed.left.mil>

• <project.product.#.part.#.component.#.page.#.bleed.left.mm>

321



2 Phoenix

• <project.product.#.part.#.component.#.page.#.bleed.left.pt>

• <project.product.#.part.#.component.#.page.#.bleed.left.um>

• <project.product.#.part.#.component.#.page.#.bleed.top>

• <project.product.#.part.#.component.#.page.#.bleed.top.cm>

• <project.product.#.part.#.component.#.page.#.bleed.top.ft>

• <project.product.#.part.#.component.#.page.#.bleed.top.in>

• <project.product.#.part.#.component.#.page.#.bleed.top.m>

• <project.product.#.part.#.component.#.page.#.bleed.top.mil>

• <project.product.#.part.#.component.#.page.#.bleed.top.mm>

• <project.product.#.part.#.component.#.page.#.bleed.top.pt>

• <project.product.#.part.#.component.#.page.#.bleed.top.um>

• <project.product.#.part.#.component.#.page.#.color.#.coverage>

• <project.product.#.part.#.component.#.page.#.color.#.name>

• <project.product.#.part.#.component.#.page.#.color.#.process>

• <project.product.#.part.#.component.#.page.#.color.#.type>

• <project.product.#.part.#.component.#.page.#.color.#.values>

• <project.product.#.part.#.component.#.page.#.color.count>

• <project.product.#.part.#.component.#.page.#.color.count.pad.#>

• <project.product.#.part.#.component.#.page.#.colors.analysis>

• <project.product.#.part.#.component.#.page.#.colors.detection>

• <project.product.#.part.#.component.#.page.#.colors.source>

• <project.product.#.part.#.component.#.page.#.creep>

• <project.product.#.part.#.component.#.page.#.creep.cm>

• <project.product.#.part.#.component.#.page.#.creep.ft>

• <project.product.#.part.#.component.#.page.#.creep.in>

• <project.product.#.part.#.component.#.page.#.creep.m>

• <project.product.#.part.#.component.#.page.#.creep.mil>

• <project.product.#.part.#.component.#.page.#.creep.mm>
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• <project.product.#.part.#.component.#.page.#.creep.pt>

• <project.product.#.part.#.component.#.page.#.creep.um>

• <project.product.#.part.#.component.#.page.#.file.checksum>

• <project.product.#.part.#.component.#.page.#.file.name>

• <project.product.#.part.#.component.#.page.#.file.number>

• <project.product.#.part.#.component.#.page.#.file.number.pad.#>

• <project.product.#.part.#.component.#.page.#.file.path>

• <project.product.#.part.#.component.#.page.#.file.timestamp>

• <project.product.#.part.#.component.#.page.#.index>

• <project.product.#.part.#.component.#.page.#.index.pad.#>

• <project.product.#.part.#.component.#.page.#.locked>

• <project.product.#.part.#.component.#.page.#.name>

• <project.product.#.part.#.component.#.page.#.position.x>

• <project.product.#.part.#.component.#.page.#.position.x.cm>

• <project.product.#.part.#.component.#.page.#.position.x.ft>

• <project.product.#.part.#.component.#.page.#.position.x.in>

• <project.product.#.part.#.component.#.page.#.position.x.m>

• <project.product.#.part.#.component.#.page.#.position.x.mil>

• <project.product.#.part.#.component.#.page.#.position.x.mm>

• <project.product.#.part.#.component.#.page.#.position.x.pt>

• <project.product.#.part.#.component.#.page.#.position.x.um>

• <project.product.#.part.#.component.#.page.#.position.y>

• <project.product.#.part.#.component.#.page.#.position.y.cm>

• <project.product.#.part.#.component.#.page.#.position.y.ft>

• <project.product.#.part.#.component.#.page.#.position.y.in>

• <project.product.#.part.#.component.#.page.#.position.y.m>

• <project.product.#.part.#.component.#.page.#.position.y.mil>

• <project.product.#.part.#.component.#.page.#.position.y.mm>
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• <project.product.#.part.#.component.#.page.#.position.y.pt>

• <project.product.#.part.#.component.#.page.#.position.y.um>

• <project.product.#.part.#.component.#.page.#.rotation>

• <project.product.#.part.#.component.#.page.#.scale.x>

• <project.product.#.part.#.component.#.page.#.scale.x.cm>

• <project.product.#.part.#.component.#.page.#.scale.x.ft>

• <project.product.#.part.#.component.#.page.#.scale.x.in>

• <project.product.#.part.#.component.#.page.#.scale.x.m>

• <project.product.#.part.#.component.#.page.#.scale.x.mil>

• <project.product.#.part.#.component.#.page.#.scale.x.mm>

• <project.product.#.part.#.component.#.page.#.scale.x.pt>

• <project.product.#.part.#.component.#.page.#.scale.x.um>

• <project.product.#.part.#.component.#.page.#.scale.y>

• <project.product.#.part.#.component.#.page.#.scale.y.cm>

• <project.product.#.part.#.component.#.page.#.scale.y.ft>

• <project.product.#.part.#.component.#.page.#.scale.y.in>

• <project.product.#.part.#.component.#.page.#.scale.y.m>

• <project.product.#.part.#.component.#.page.#.scale.y.mil>

• <project.product.#.part.#.component.#.page.#.scale.y.mm>

• <project.product.#.part.#.component.#.page.#.scale.y.pt>

• <project.product.#.part.#.component.#.page.#.scale.y.um>

• <project.product.#.part.#.component.#.page.#.size.height>

• <project.product.#.part.#.component.#.page.#.size.height.cm>

• <project.product.#.part.#.component.#.page.#.size.height.ft>

• <project.product.#.part.#.component.#.page.#.size.height.in>

• <project.product.#.part.#.component.#.page.#.size.height.m>

• <project.product.#.part.#.component.#.page.#.size.height.mil>

• <project.product.#.part.#.component.#.page.#.size.height.mm>
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• <project.product.#.part.#.component.#.page.#.size.height.pt>

• <project.product.#.part.#.component.#.page.#.size.height.um>

• <project.product.#.part.#.component.#.page.#.size.width>

• <project.product.#.part.#.component.#.page.#.size.width.cm>

• <project.product.#.part.#.component.#.page.#.size.width.ft>

• <project.product.#.part.#.component.#.page.#.size.width.in>

• <project.product.#.part.#.component.#.page.#.size.width.m>

• <project.product.#.part.#.component.#.page.#.size.width.mil>

• <project.product.#.part.#.component.#.page.#.size.width.mm>

• <project.product.#.part.#.component.#.page.#.size.width.pt>

• <project.product.#.part.#.component.#.page.#.size.width.um>

• <project.product.#.part.#.component.#.page.#.visible>

• <project.product.#.part.#.component.#.signature.folding-pattern>

• <project.product.#.part.#.component.#.signature.folds.horizontal>

• <project.product.#.part.#.component.#.signature.folds.horizontal.pad.#>

• <project.product.#.part.#.component.#.signature.folds.total>

• <project.product.#.part.#.component.#.signature.folds.total.pad.#>

• <project.product.#.part.#.component.#.signature.folds.vertical>

• <project.product.#.part.#.component.#.signature.folds.vertical.pad.#>

• <project.product.#.part.#.component.#.signature.index>

• <project.product.#.part.#.component.#.signature.index.pad.#>

• <project.product.#.part.#.component.#.signature.page-count>

• <project.product.#.part.#.component.#.signature.page-count.pad.#>

• <project.product.#.part.#.component.#.signature.relative-index>

• <project.product.#.part.#.component.#.signature.relative-index.pad.#>

• <project.product.#.part.#.component.#.size.height>

• <project.product.#.part.#.component.#.size.height.cm>

• <project.product.#.part.#.component.#.size.height.ft>
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• <project.product.#.part.#.component.#.size.height.in>

• <project.product.#.part.#.component.#.size.height.m>

• <project.product.#.part.#.component.#.size.height.mil>

• <project.product.#.part.#.component.#.size.height.mm>

• <project.product.#.part.#.component.#.size.height.pt>

• <project.product.#.part.#.component.#.size.height.um>

• <project.product.#.part.#.component.#.size.width>

• <project.product.#.part.#.component.#.size.width.cm>

• <project.product.#.part.#.component.#.size.width.ft>

• <project.product.#.part.#.component.#.size.width.in>

• <project.product.#.part.#.component.#.size.width.m>

• <project.product.#.part.#.component.#.size.width.mil>

• <project.product.#.part.#.component.#.size.width.mm>

• <project.product.#.part.#.component.#.size.width.pt>

• <project.product.#.part.#.component.#.size.width.um>

• <project.product.#.part.#.component.#.spacing.margin>

• <project.product.#.part.#.component.#.spacing.margin.cm>

• <project.product.#.part.#.component.#.spacing.margin.ft>

• <project.product.#.part.#.component.#.spacing.margin.in>

• <project.product.#.part.#.component.#.spacing.margin.m>

• <project.product.#.part.#.component.#.spacing.margin.mil>

• <project.product.#.part.#.component.#.spacing.margin.mm>

• <project.product.#.part.#.component.#.spacing.margin.pt>

• <project.product.#.part.#.component.#.spacing.margin.um>

• <project.product.#.part.#.component.#.spacing.margins.bottom>

• <project.product.#.part.#.component.#.spacing.margins.bottom.cm>

• <project.product.#.part.#.component.#.spacing.margins.bottom.ft>

• <project.product.#.part.#.component.#.spacing.margins.bottom.in>
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• <project.product.#.part.#.component.#.spacing.margins.bottom.m>

• <project.product.#.part.#.component.#.spacing.margins.bottom.mil>

• <project.product.#.part.#.component.#.spacing.margins.bottom.mm>

• <project.product.#.part.#.component.#.spacing.margins.bottom.pt>

• <project.product.#.part.#.component.#.spacing.margins.bottom.um>

• <project.product.#.part.#.component.#.spacing.margins.left>

• <project.product.#.part.#.component.#.spacing.margins.left.cm>

• <project.product.#.part.#.component.#.spacing.margins.left.ft>

• <project.product.#.part.#.component.#.spacing.margins.left.in>

• <project.product.#.part.#.component.#.spacing.margins.left.m>

• <project.product.#.part.#.component.#.spacing.margins.left.mil>

• <project.product.#.part.#.component.#.spacing.margins.left.mm>

• <project.product.#.part.#.component.#.spacing.margins.left.pt>

• <project.product.#.part.#.component.#.spacing.margins.left.um>

• <project.product.#.part.#.component.#.spacing.margins.right>

• <project.product.#.part.#.component.#.spacing.margins.left.cm>

• <project.product.#.part.#.component.#.spacing.margins.left.ft>

• <project.product.#.part.#.component.#.spacing.margins.left.in>

• <project.product.#.part.#.component.#.spacing.margins.left.m>

• <project.product.#.part.#.component.#.spacing.margins.left.mil>

• <project.product.#.part.#.component.#.spacing.margins.left.mm>

• <project.product.#.part.#.component.#.spacing.margins.left.pt>

• <project.product.#.part.#.component.#.spacing.margins.left.um>

• <project.product.#.part.#.component.#.spacing.margins.top>

• <project.product.#.part.#.component.#.spacing.margins.top.cm>

• <project.product.#.part.#.component.#.spacing.margins.top.ft>

• <project.product.#.part.#.component.#.spacing.margins.top.in>

• <project.product.#.part.#.component.#.spacing.margins.top.m>
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• <project.product.#.part.#.component.#.spacing.margins.top.mil>

• <project.product.#.part.#.component.#.spacing.margins.top.mm>

• <project.product.#.part.#.component.#.spacing.margins.top.pt>

• <project.product.#.part.#.component.#.spacing.margins.top.um>

• <project.product.#.part.#.component.#.spacing.type>

• <project.product.#.part.#.component.#.tile.die.name>

• <project.product.#.part.#.component.#.tile.die.path>

• <project.product.#.part.#.component.#.tile.die.source>

• <project.product.#.part.#.component.#.tile.die.source-noext>

• <project.product.#.part.#.component.#.tile.die.type>

• <project.product.#.part.#.component.#.tile.index>

• <project.product.#.part.#.component.#.tile.index.pad.#>

• <project.product.#.part.#.component.#.tile.tile-count>

• <project.product.#.part.#.component.#.tile.tile-count.pad.#>

• <project.product.#.part.#.component.count>

• <project.product.#.part.#.component.count.pad.#>

• <project.product.#.part.#.flat.templates>

• <project.product.#.part.#.grain>

• <project.product.#.part.#.is-bound>

• <project.product.#.part.#.page.#.bleed.bottom>

• <project.product.#.part.#.page.#.bleed.bottom.cm>

• <project.product.#.part.#.page.#.bleed.bottom.ft>

• <project.product.#.part.#.page.#.bleed.bottom.in>

• <project.product.#.part.#.page.#.bleed.bottom.m>

• <project.product.#.part.#.page.#.bleed.bottom.mil>

• <project.product.#.part.#.page.#.bleed.bottom.mm>

• <project.product.#.part.#.page.#.bleed.bottom.pt>

• <project.product.#.part.#.page.#.bleed.bottom.um>
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• <project.product.#.part.#.page.#.bleed.left>

• <project.product.#.part.#.page.#.bleed.left.cm>

• <project.product.#.part.#.page.#.bleed.left.ft>

• <project.product.#.part.#.page.#.bleed.left.in>

• <project.product.#.part.#.page.#.bleed.left.m>

• <project.product.#.part.#.page.#.bleed.left.mil>

• <project.product.#.part.#.page.#.bleed.left.mm>

• <project.product.#.part.#.page.#.bleed.left.pt>

• <project.product.#.part.#.page.#.bleed.left.um>

• <project.product.#.part.#.page.#.bleed.right>

• <project.product.#.part.#.page.#.bleed.left.cm>

• <project.product.#.part.#.page.#.bleed.left.ft>

• <project.product.#.part.#.page.#.bleed.left.in>

• <project.product.#.part.#.page.#.bleed.left.m>

• <project.product.#.part.#.page.#.bleed.left.mil>

• <project.product.#.part.#.page.#.bleed.left.mm>

• <project.product.#.part.#.page.#.bleed.left.pt>

• <project.product.#.part.#.page.#.bleed.left.um>

• <project.product.#.part.#.page.#.bleed.top>

• <project.product.#.part.#.page.#.bleed.top.cm>

• <project.product.#.part.#.page.#.bleed.top.ft>

• <project.product.#.part.#.page.#.bleed.top.in>

• <project.product.#.part.#.page.#.bleed.top.m>

• <project.product.#.part.#.page.#.bleed.top.mil>

• <project.product.#.part.#.page.#.bleed.top.mm>

• <project.product.#.part.#.page.#.bleed.top.pt>

• <project.product.#.part.#.page.#.bleed.top.um>

• <project.product.#.part.#.page.#.color.#.coverage>
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• <project.product.#.part.#.page.#.color.#.name>

• <project.product.#.part.#.page.#.color.#.process>

• <project.product.#.part.#.page.#.color.#.type>

• <project.product.#.part.#.page.#.color.#.values>

• <project.product.#.part.#.page.#.color.count>

• <project.product.#.part.#.page.#.color.count.pad.#>

• <project.product.#.part.#.page.#.colors.analysis>

• <project.product.#.part.#.page.#.colors.detection>

• <project.product.#.part.#.page.#.colors.source>

• <project.product.#.part.#.page.#.creep>

• <project.product.#.part.#.page.#.creep.cm>

• <project.product.#.part.#.page.#.creep.ft>

• <project.product.#.part.#.page.#.creep.in>

• <project.product.#.part.#.page.#.creep.m>

• <project.product.#.part.#.page.#.creep.mil>

• <project.product.#.part.#.page.#.creep.mm>

• <project.product.#.part.#.page.#.creep.pt>

• <project.product.#.part.#.page.#.creep.um>

• <project.product.#.part.#.page.#.file.checksum>

• <project.product.#.part.#.page.#.file.name>

• <project.product.#.part.#.page.#.file.number>

• <project.product.#.part.#.page.#.file.number.pad.#>

• <project.product.#.part.#.page.#.file.path>

• <project.product.#.part.#.page.#.file.timestamp>

• <project.product.#.part.#.page.#.index>

• <project.product.#.part.#.page.#.index.pad.#>

• <project.product.#.part.#.page.#.locked>

• <project.product.#.part.#.page.#.name>
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• <project.product.#.part.#.page.#.position.x>

• <project.product.#.part.#.page.#.position.x.cm>

• <project.product.#.part.#.page.#.position.x.ft>

• <project.product.#.part.#.page.#.position.x.in>

• <project.product.#.part.#.page.#.position.x.m>

• <project.product.#.part.#.page.#.position.x.mil>

• <project.product.#.part.#.page.#.position.x.mm>

• <project.product.#.part.#.page.#.position.x.pt>

• <project.product.#.part.#.page.#.position.x.um>

• <project.product.#.part.#.page.#.position.y>

• <project.product.#.part.#.page.#.position.y.cm>

• <project.product.#.part.#.page.#.position.y.ft>

• <project.product.#.part.#.page.#.position.y.in>

• <project.product.#.part.#.page.#.position.y.m>

• <project.product.#.part.#.page.#.position.y.mil>

• <project.product.#.part.#.page.#.position.y.mm>

• <project.product.#.part.#.page.#.position.y.pt>

• <project.product.#.part.#.page.#.position.y.um>

• <project.product.#.part.#.page.#.rotation>

• <project.product.#.part.#.page.#.scale.x>

• <project.product.#.part.#.page.#.scale.x.cm>

• <project.product.#.part.#.page.#.scale.x.ft>

• <project.product.#.part.#.page.#.scale.x.in>

• <project.product.#.part.#.page.#.scale.x.m>

• <project.product.#.part.#.page.#.scale.x.mil>

• <project.product.#.part.#.page.#.scale.x.mm>

• <project.product.#.part.#.page.#.scale.x.pt>

• <project.product.#.part.#.page.#.scale.x.um>
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• <project.product.#.part.#.page.#.scale.y>

• <project.product.#.part.#.page.#.scale.y.cm>

• <project.product.#.part.#.page.#.scale.y.ft>

• <project.product.#.part.#.page.#.scale.y.in>

• <project.product.#.part.#.page.#.scale.y.m>

• <project.product.#.part.#.page.#.scale.y.mil>

• <project.product.#.part.#.page.#.scale.y.mm>

• <project.product.#.part.#.page.#.scale.y.pt>

• <project.product.#.part.#.page.#.scale.y.um>

• <project.product.#.part.#.page.#.size.height>

• <project.product.#.part.#.page.#.size.height.cm>

• <project.product.#.part.#.page.#.size.height.ft>

• <project.product.#.part.#.page.#.size.height.in>

• <project.product.#.part.#.page.#.size.height.m>

• <project.product.#.part.#.page.#.size.height.mil>

• <project.product.#.part.#.page.#.size.height.mm>

• <project.product.#.part.#.page.#.size.height.pt>

• <project.product.#.part.#.page.#.size.height.um>

• <project.product.#.part.#.page.#.size.width>

• <project.product.#.part.#.page.#.size.width.cm>

• <project.product.#.part.#.page.#.size.width.ft>

• <project.product.#.part.#.page.#.size.width.in>

• <project.product.#.part.#.page.#.size.width.m>

• <project.product.#.part.#.page.#.size.width.mil>

• <project.product.#.part.#.page.#.size.width.mm>

• <project.product.#.part.#.page.#.size.width.pt>

• <project.product.#.part.#.page.#.size.width.um>

• <project.product.#.part.#.page.#.visible>
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• <project.product.#.part.#.part-type>

• <project.product.#.part.#.processes>

• <project.product.#.part.#.rotation.custom-values>

• <project.product.#.part.#.rotation.type>

• <project.product.#.part.#.stock>

• <project.product.#.part.#.tiled.die.name>

• <project.product.#.part.#.tiled.die.path>

• <project.product.#.part.#.tiled.die.source>

• <project.product.#.part.#.tiled.die.source-noext>

• <project.product.#.part.#.tiled.die.type>

• <project.product.#.part.#.tiled.size.height>

• <project.product.#.part.#.tiled.size.height.cm>

• <project.product.#.part.#.tiled.size.height.ft>

• <project.product.#.part.#.tiled.size.height.in>

• <project.product.#.part.#.tiled.size.height.m>

• <project.product.#.part.#.tiled.size.height.mil>

• <project.product.#.part.#.tiled.size.height.mm>

• <project.product.#.part.#.tiled.size.height.pt>

• <project.product.#.part.#.tiled.size.height.um>

• <project.product.#.part.#.tiled.size.width>

• <project.product.#.part.#.tiled.size.width.cm>

• <project.product.#.part.#.tiled.size.width.ft>

• <project.product.#.part.#.tiled.size.width.in>

• <project.product.#.part.#.tiled.size.width.m>

• <project.product.#.part.#.tiled.size.width.mil>

• <project.product.#.part.#.tiled.size.width.mm>

• <project.product.#.part.#.tiled.size.width.pt>

• <project.product.#.part.#.tiled.size.width.um>
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• <project.product.#.part.#.tiled.tiles>

• <project.product.#.part.#.tiled.tiles.pad.#>

• <project.product.#.part.#.tiled.tiling.cutting-tool>

• <project.product.#.part.#.tiled.tiling.horizontal.extension>

• <project.product.#.part.#.tiled.tiling.horizontal.extension-rule>

• <project.product.#.part.#.tiled.tiling.horizontal.extension.cm>

• <project.product.#.part.#.tiled.tiling.horizontal.extension.ft>

• <project.product.#.part.#.tiled.tiling.horizontal.extension.in>

• <project.product.#.part.#.tiled.tiling.horizontal.extension.m>

• <project.product.#.part.#.tiled.tiling.horizontal.extension.mil>

• <project.product.#.part.#.tiled.tiling.horizontal.extension.mm>

• <project.product.#.part.#.tiled.tiling.horizontal.extension.pt>

• <project.product.#.part.#.tiled.tiling.horizontal.extension.um>

• <project.product.#.part.#.tiled.tiling.horizontal.gap>

• <project.product.#.part.#.tiled.tiling.horizontal.gap.cm>

• <project.product.#.part.#.tiled.tiling.horizontal.gap.ft>

• <project.product.#.part.#.tiled.tiling.horizontal.gap.in>

• <project.product.#.part.#.tiled.tiling.horizontal.gap.m>

• <project.product.#.part.#.tiled.tiling.horizontal.gap.mil>

• <project.product.#.part.#.tiled.tiling.horizontal.gap.mm>

• <project.product.#.part.#.tiled.tiling.horizontal.gap.pt>

• <project.product.#.part.#.tiled.tiling.horizontal.gap.um>

• <project.product.#.part.#.tiled.tiling.horizontal.method>

• <project.product.#.part.#.tiled.tiling.horizontal.no-image>

• <project.product.#.part.#.tiled.tiling.horizontal.no-image.cm>

• <project.product.#.part.#.tiled.tiling.horizontal.no-image.ft>

• <project.product.#.part.#.tiled.tiling.horizontal.no-image.in>

• <project.product.#.part.#.tiled.tiling.horizontal.no-image.m>
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• <project.product.#.part.#.tiled.tiling.horizontal.no-image.mil>

• <project.product.#.part.#.tiled.tiling.horizontal.no-image.mm>

• <project.product.#.part.#.tiled.tiling.horizontal.no-image.pt>

• <project.product.#.part.#.tiled.tiling.horizontal.no-image.um>

• <project.product.#.part.#.tiled.tiling.horizontal.number>

• <project.product.#.part.#.tiled.tiling.horizontal.number.pad.#>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap-rule>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap.cm>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap.ft>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap.in>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap.m>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap.mil>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap.mm>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap.pt>

• <project.product.#.part.#.tiled.tiling.horizontal.overlap.um>

• <project.product.#.part.#.tiled.tiling.horizontal.size>

• <project.product.#.part.#.tiled.tiling.horizontal.size.cm>

• <project.product.#.part.#.tiled.tiling.horizontal.size.ft>

• <project.product.#.part.#.tiled.tiling.horizontal.size.in>

• <project.product.#.part.#.tiled.tiling.horizontal.size.m>

• <project.product.#.part.#.tiled.tiling.horizontal.size.mil>

• <project.product.#.part.#.tiled.tiling.horizontal.size.mm>

• <project.product.#.part.#.tiled.tiling.horizontal.size.pt>

• <project.product.#.part.#.tiled.tiling.horizontal.size.um>

• <project.product.#.part.#.tiled.tiling.horizontal.sizes>

• <project.product.#.part.#.tiled.tiling.horizontal.type>

• <project.product.#.part.#.tiled.tiling.horizontal.uniform-final-size>
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• <project.product.#.part.#.tiled.tiling.order>

• <project.product.#.part.#.tiled.tiling.preset>

• <project.product.#.part.#.tiled.tiling.start>

• <project.product.#.part.#.tiled.tiling.vertical.extension>

• <project.product.#.part.#.tiled.tiling.vertical.extension-rule>

• <project.product.#.part.#.tiled.tiling.vertical.extension.cm>

• <project.product.#.part.#.tiled.tiling.vertical.extension.ft>

• <project.product.#.part.#.tiled.tiling.vertical.extension.in>

• <project.product.#.part.#.tiled.tiling.vertical.extension.m>

• <project.product.#.part.#.tiled.tiling.vertical.extension.mil>

• <project.product.#.part.#.tiled.tiling.vertical.extension.mm>

• <project.product.#.part.#.tiled.tiling.vertical.extension.pt>

• <project.product.#.part.#.tiled.tiling.vertical.extension.um>

• <project.product.#.part.#.tiled.tiling.vertical.gap>

• <project.product.#.part.#.tiled.tiling.vertical.gap.cm>

• <project.product.#.part.#.tiled.tiling.vertical.gap.ft>

• <project.product.#.part.#.tiled.tiling.vertical.gap.in>

• <project.product.#.part.#.tiled.tiling.vertical.gap.m>

• <project.product.#.part.#.tiled.tiling.vertical.gap.mil>

• <project.product.#.part.#.tiled.tiling.vertical.gap.mm>

• <project.product.#.part.#.tiled.tiling.vertical.gap.pt>

• <project.product.#.part.#.tiled.tiling.vertical.gap.um>

• <project.product.#.part.#.tiled.tiling.vertical.method>

• <project.product.#.part.#.tiled.tiling.vertical.no-image>

• <project.product.#.part.#.tiled.tiling.vertical.no-image.cm>

• <project.product.#.part.#.tiled.tiling.vertical.no-image.ft>

• <project.product.#.part.#.tiled.tiling.vertical.no-image.in>

• <project.product.#.part.#.tiled.tiling.vertical.no-image.m>
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• <project.product.#.part.#.tiled.tiling.vertical.no-image.mil>

• <project.product.#.part.#.tiled.tiling.vertical.no-image.mm>

• <project.product.#.part.#.tiled.tiling.vertical.no-image.pt>

• <project.product.#.part.#.tiled.tiling.vertical.no-image.um>

• <project.product.#.part.#.tiled.tiling.vertical.number>

• <project.product.#.part.#.tiled.tiling.vertical.number.pad.#>

• <project.product.#.part.#.tiled.tiling.vertical.overlap>

• <project.product.#.part.#.tiled.tiling.vertical.overlap-rule>

• <project.product.#.part.#.tiled.tiling.vertical.overlap.cm>

• <project.product.#.part.#.tiled.tiling.vertical.overlap.ft>

• <project.product.#.part.#.tiled.tiling.vertical.overlap.in>

• <project.product.#.part.#.tiled.tiling.vertical.overlap.m>

• <project.product.#.part.#.tiled.tiling.vertical.overlap.mil>

• <project.product.#.part.#.tiled.tiling.vertical.overlap.mm>

• <project.product.#.part.#.tiled.tiling.vertical.overlap.pt>

• <project.product.#.part.#.tiled.tiling.vertical.overlap.um>

• <project.product.#.part.#.tiled.tiling.vertical.size>

• <project.product.#.part.#.tiled.tiling.vertical.size.cm>

• <project.product.#.part.#.tiled.tiling.vertical.size.ft>

• <project.product.#.part.#.tiled.tiling.vertical.size.in>

• <project.product.#.part.#.tiled.tiling.vertical.size.m>

• <project.product.#.part.#.tiled.tiling.vertical.size.mil>

• <project.product.#.part.#.tiled.tiling.vertical.size.mm>

• <project.product.#.part.#.tiled.tiling.vertical.size.pt>

• <project.product.#.part.#.tiled.tiling.vertical.size.um>

• <project.product.#.part.#.tiled.tiling.vertical.sizes>

• <project.product.#.part.#.tiled.tiling.vertical.type>

• <project.product.#.part.#.tiled.tiling.vertical.uniform-final-size>
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• <project.product.#.part.count>

• <project.product.#.part.count.pad.#>

• <project.product.#.placed>

• <project.product.#.placed.pad.#>

• <project.product.#.priority>

• <project.product.#.priority.pad.#>

• <project.product.#.quantity>

• <project.product.#.quantity.pad.#>

• <project.product.#.total>

• <project.product.count>

• <project.product.count.pad.#>

• <project.run-length>

• <project.run-length.pad.#>

• <project.sourcetemplate>

• <project.time>

• <project.underrun>

• <project.units>

• <project.usage>

• <project.waste>

Repeat
• <repeat.items>

• <repeat.items.pad.#>

• <repeat.locked>

• <repeat.position.x>

• <repeat.position.x.cm>

• <repeat.position.x.ft>

• <repeat.position.x.in>

• <repeat.position.x.m>

• <repeat.position.x.mil>
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• <repeat.position.x.mm>

• <repeat.position.x.pt>

• <repeat.position.x.um>

• <repeat.position.y>

• <repeat.position.y.cm>

• <repeat.position.y.ft>

• <repeat.position.y.in>

• <repeat.position.y.m>

• <repeat.position.y.mil>

• <repeat.position.y.mm>

• <repeat.position.y.pt>

• <repeat.position.y.um>

• <repeat.rotation>

• <repeat.size.height>

• <repeat.size.height.cm>

• <repeat.size.height.ft>

• <repeat.size.height.in>

• <repeat.size.height.m>

• <repeat.size.height.mil>

• <repeat.size.height.mm>

• <repeat.size.height.pt>

• <repeat.size.height.um>

• <repeat.size.width>

• <repeat.size.width.cm>

• <repeat.size.width.ft>

• <repeat.size.width.in>

• <repeat.size.width.m>

• <repeat.size.width.mil>
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• <repeat.size.width.mm>

• <repeat.size.width.pt>

• <repeat.size.width.um>

• <repeat.type>

• <repeat.z-order>

• <repeat.z-order.pad.#>

Ribbon

Roll

Second
• <second>

Section
• <section.binding-method>

• <section.index>

• <section.index.pad.#>

• <section.pages>

• <section.pages.pad.#>

• <section.signatures>

• <section.signatures.pad.#>

Segment

Sheet
• <sheet.cost>

• <sheet.dimensions>

• <sheet.external-id>

• <sheet.grade>

• <sheet.grain>

• <sheet.height>

• <sheet.height.cm>

• <sheet.height.ft>
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• <sheet.height.in>

• <sheet.height.m>

• <sheet.height.mil>

• <sheet.height.mm>

• <sheet.height.pt>

• <sheet.height.um>

• <sheet.name>

• <sheet.price>

• <sheet.stock>

• <sheet.width>

• <sheet.width.cm>

• <sheet.width.ft>

• <sheet.width.in>

• <sheet.width.m>

• <sheet.width.mil>

• <sheet.width.mm>

• <sheet.width.pt>

• <sheet.width.um>

Spot
• <spot.#.abbr>

• <spot.#.abbr>

• <spot.#.first>

• <spot.#.first>

• <spot.#.name>

• <spot.#.name>

• <spot.#.neutral-density>

• <spot.#.neutral-density>

• <spot.#.number>

• <spot.#.number>
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• <spot.#.smart>

• <spot.#.smart>

• <spot.#.type>

• <spot.#.type>

Spots
• <spots>

Spots-stacked
• <spots-stacked>

• <spots-stacked.abbr>

• <spots-stacked.first>

• <spots-stacked.full>

• <spots-stacked.number>

• <spots-stacked.smart>

• <spots.abbr>

• <spots.first>

• <spots.full>

• <spots.number>

• <spots.smart>

Stock
• <stock.description>

• <stock.external-id>

• <stock.name>

• <stock.sheets>

• <stock.sheets.pad.#>

• <stock.thickness>

• <stock.thickness.cm>

• <stock.thickness.ft>

• <stock.thickness.in>

• <stock.thickness.m>
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• <stock.thickness.mil>

• <stock.thickness.mm>

• <stock.thickness.pt>

• <stock.thickness.um>

• <stock.vendor>

• <stock.weight>

Surface
• <surface.items.bounds.height>

• <surface.items.bounds.height.cm>

• <surface.items.bounds.height.ft>

• <surface.items.bounds.height.in>

• <surface.items.bounds.height.m>

• <surface.items.bounds.height.mil>

• <surface.items.bounds.height.mm>

• <surface.items.bounds.height.pt>

• <surface.items.bounds.height.um>

• <surface.items.bounds.width>

• <surface.items.bounds.width.cm>

• <surface.items.bounds.width.ft>

• <surface.items.bounds.width.in>

• <surface.items.bounds.width.m>

• <surface.items.bounds.width.mil>

• <surface.items.bounds.width.mm>

• <surface.items.bounds.width.pt>

• <surface.items.bounds.width.um>

• <surface.items.bounds.x>

• <surface.items.bounds.x.cm>

• <surface.items.bounds.x.ft>

• <surface.items.bounds.x.in>
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• <surface.items.bounds.x.m>

• <surface.items.bounds.x.mil>

• <surface.items.bounds.x.mm>

• <surface.items.bounds.x.pt>

• <surface.items.bounds.x.um>

• <surface.items.bounds.y>

• <surface.items.bounds.y.cm>

• <surface.items.bounds.y.ft>

• <surface.items.bounds.y.in>

• <surface.items.bounds.y.m>

• <surface.items.bounds.y.mil>

• <surface.items.bounds.y.mm>

• <surface.items.bounds.y.pt>

• <surface.items.bounds.y.um>

• <surface.items.count>

• <surface.items.count.pad.#>

• <surface.origin.x>

• <surface.origin.x.cm>

• <surface.origin.x.ft>

• <surface.origin.x.in>

• <surface.origin.x.m>

• <surface.origin.x.mil>

• <surface.origin.x.mm>

• <surface.origin.x.pt>

• <surface.origin.x.um>

• <surface.origin.y>

• <surface.origin.y.cm>

• <surface.origin.y.ft>
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• <surface.origin.y.in>

• <surface.origin.y.m>

• <surface.origin.y.mil>

• <surface.origin.y.mm>

• <surface.origin.y.pt>

• <surface.origin.y.um>

• <surface.plate>

• <surface.sheet>

• <surface.side>

• <surface.stock>

Template
• <template.comments>

• <template.items>

• <template.items.pad.#>

• <template.locked>

• <template.name>

• <template.position.x>

• <template.position.x.cm>

• <template.position.x.ft>

• <template.position.x.in>

• <template.position.x.m>

• <template.position.x.mil>

• <template.position.x.mm>

• <template.position.x.pt>

• <template.position.x.um>

• <template.position.y>

• <template.position.y.cm>

• <template.position.y.ft>

• <template.position.y.in>
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• <template.position.y.m>

• <template.position.y.mil>

• <template.position.y.mm>

• <template.position.y.pt>

• <template.position.y.um>

• <template.preset-mirroring>

• <template.preset-rotation>

• <template.rotation>

• <template.size.height>

• <template.size.height.cm>

• <template.size.height.ft>

• <template.size.height.in>

• <template.size.height.m>

• <template.size.height.mil>

• <template.size.height.mm>

• <template.size.height.pt>

• <template.size.height.um>

• <template.size.width>

• <template.size.width.cm>

• <template.size.width.ft>

• <template.size.width.in>

• <template.size.width.m>

• <template.size.width.mil>

• <template.size.width.mm>

• <template.size.width.pt>

• <template.size.width.um>

• <template.source-file>

• <template.template-type>
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• <template.type>

• <template.z-order>

• <template.z-order.pad.#>

Time
• <time.iso>

• <time.long>

• <time.medium>

• <time.short>

Varnish
• <varnish.#.abbr>

• <varnish.#.first>

• <varnish.#.name>

• <varnish.#.neutral-density>

• <varnish.#.number>

• <varnish.#.smart>

• <varnish.#.type>

Varnishes
• <varnishes>

• <varnishes.abbr>

• <varnishes.first>

• <varnishes.full>

• <varnishes.number>

• <varnishes.smart>

Varnishes-stacked
• <varnishes-stacked>

• <varnishes-stacked.abbr>

• <varnishes-stacked.first>

• <varnishes-stacked.full>

• <varnishes-stacked.number>
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• <varnishes-stacked.smart>

Year
• <year.long>

• <year.short>

Keyword Mappings
Phoenix 7.0 was our biggest release ever! With some of the changes in Phoenix 7.0, the structure of
certain keywords has changed.

The table below shows how they've changed, with the old keyword used pre-7.0 on the left, and the new
keyword that it's mapped to on the right. Moving forward, please use the new keyword style.

Old Keyword New Keyword

group.x group.position.x

group.y group.position.y

group.height group.size.height

group.width group.size.width

plate.x plate.position.x

plate.y plate.position.y

plate.height plate.size.height

plate.width plate.size.width

product.allowed-rotations part.rotation.custom-values

product.artwork.name component.page.1.file.name

product.bleed component.bleed.margin

product.bleed-bottom component.bleed.margins.bottom

product.bleed-left component.bleed.margins.left

product.bleed-right component.bleed.margins.right

product.bleed-top component.bleed.margins.top

product.bleed-type component.bleed.type

product.bundle-size component.flat.bundle-size

product.die-name component.flat.die.name

product.die-path component.flat.die.path

product.die-source component.flat.die.source

product.die-source-noext component.flat.die.source-noext

product.die-type component.flat.die.type

product.grain part.grain

product.height component.size.height
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Old Keyword New Keyword

product.number component.number

product.offcut-bottom component.offcut.margins.bottom

product.offcut-left component.offcut.margins.left

product.offcut-right component.offcut.margins.right

product.offcut-top component.offcut.margins.top

product.ordered product.quantity

product.rotation component.rotation

product.rotation-type part.rotation.type

product.spacing component.spacing.margin

product.spacing-bottom component.spacing.margins.bottom

product.spacing-left component.spacing.margins.left

product.spacing-right component.spacing.margins.right

product.spacing-top component.spacing.margins.top

product.spacing-type component.spacing.type

product.stock part.stock

product.templates part.flat.templates

product.width component.size.width

product.x component.position.x

product.y component.position.y

repeat.x repeat.position.x

repeat.y repeat.position.y

repeat.height repeat.size.height

repeat.width repeat.size.width

side.origin-x surface.origin.x

side.origin-y surface.origin.y

side.type surface.side

job.product.([0-9]+).allowed-rotations project.product.$1.part.1.rotation.custom-values

job.product.([0-9]+).artwork-back project.product.$1.part.1.page.2.file.name

job.product.([0-9]+).artwork-front project.product.$1.part.1.page.1.file.name

job.product.([0-9]+).bleed project.product.
$1.part.1.component.1.bleed.margin

job.product.([0-9]+).bleed-bottom project.product.
$1.part.1.component.1.bleed.margins.bottom
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job.product.([0-9]+).bleed-left project.product.
$1.part.1.component.1.bleed.margins.left

job.product.([0-9]+).bleed-right project.product.
$1.part.1.component.1.bleed.margins.right

job.product.([0-9]+).bleed-top project.product.
$1.part.1.component.1.bleed.margins.top

job.product.([0-9]+).bleed-type project.product.$1.part.1.component.1.bleed.type

job.product.([0-9]+).bundle-size project.product.
$1.part.1.component.1.flat.bundle-size

job.product.([0-9]+).die-name project.product.
$1.part.1.component.1.flat.die.name

job.product.([0-9]+).die-path project.product.
$1.part.1.component.1.flat.die.path

job.product.([0-9]+).die-source project.product.
$1.part.1.component.1.flat.die.source

job.product.([0-9]+).die-source-noext project.product.
$1.part.1.component.1.flat.die.source-noext

job.product.([0-9]+).die-type project.product.
$1.part.1.component.1.flat.die.type

job.product.([0-9]+).grain project.product.$1.part.1.grain

job.product.([0-9]+).height project.product.
$1.part.1.component.1.size.height

job.product.([0-9]+).offcut-bottom project.product.
$1.part.1.component.1.offcut.margins.bottom

job.product.([0-9]+).offcut-left project.product.
$1.part.1.component.1.offcut.margins.left

job.product.([0-9]+).offcut-right project.product.
$1.part.1.component.1.offcut.margins.right

job.product.([0-9]+).offcut-top project.product.
$1.part.1.component.1.offcut.margins.top

job.product.([0-9]+).ordered project.product.$1.quantity

job.product.([0-9]+).rotation-type project.product.$1.part.1.rotation.type

job.product.([0-9]+).spacing project.product.
$1.part.1.component.1.spacing.margin

job.product.([0-9]+).spacing-bottom project.product.
$1.part.1.component.1.spacing.margins.bottom

job.product.([0-9]+).spacing-left project.product.
$1.part.1.component.1.spacing.margins.left
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Old Keyword New Keyword

job.product.([0-9]+).spacing-right project.product.
$1.part.1.component.1.spacing.margins.right

job.product.([0-9]+).spacing-top project.product.
$1.part.1.component.1.spacing.margins.top

job.product.([0-9]+).spacing-type project.product.
$1.part.1.component.1.spacing.type

job.product.([0-9]+).stock project.product.$1.part.1.stock

job.product.([0-9]+).templates project.product.$1.part.1.flat.templates

job.product.([0-9]+).width project.product.$1.part.1.component.1.size.width

job. project.

Deprecated Keywords
The following keywords from previous versions are no longer supported in Phoenix:

• <layout.back-passes>
• <layout.cost-die>
• <layout.cost-plate>
• <layout.cost-press>
• <layout.crease-length>
• <layout.cut-length>
• <layout.front-passes>
• <layout.press-time>
• <press.cost>
• <press.speed>
• <press.speed-units>
• <product.artwork.creator>
• <product.artwork.format>
• <product.artwork.page-count>
• <product.artwork.page-number>
• <product.artwork.pages>
• <product.artwork.path>
• <product.artwork.pdf-version>
• <product.artwork.pdfx-profile>
• <product.artwork.pdfx-version>
• <product.artwork.producer>
• <product.artwork.title>
• <product.back-inks>
• <product.front-inks>
• <job.cost-die>
• <job.cost-plate>
• <job.cost-press>
• <job.press-time>
• <job.product.#.back-inks>
• <job.product.#.front-inks>
• <job.time>
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• <sheet.height>
• <sheet.price>
• <sheet.width>
• <stock.sheets>
• <stock.thickness>
• <stock.weight>

2.11.2.  Artwork

keyword description

.artwork.creator> Software used to create the artwork. Example:
Adobe Illustrator CC 2015.3 (Macintosh)

.artwork.format> Artwork file typeExample: PDF

.artwork.page-count> Number of total pages in the artwork file

.artwork.page-number> Page number of the artwork

.artwork.pages> Number of total pages in the artwork file

.artwork.path> Artwork file path

.artwork.pdf-version> Artwork PDF version

.artwork.pdfx-profile> PDF/X Profile, if one exists

.artwork.pdfx-version> PDF/X Version, if one exists

.artwork.producer> PDF producerExample: Adobe PDF library 15.00

.artwork.title> Title of artwork from PDF

2.11.3.  Bleed

keyword description

.bleed.margin>† Overall bleed distance of the given object. Single
value when bleed spacing is uniform, "None" when
no bleed mask, "CAD" when bleed comes from
CAD file, and four values when side bleed spacing
differs (rectangular bleed) with order "left top
right bottom"

.bleed.margin. See Margins on page 370

.bleed.type> Type of bleed of the given product item. Values
can be "Rectangle", "Contour", "CAD", or "None".

.bleed.bottom>† Bottom page bleed

.bleed.left>† Left page bleed

.bleed.right>† Right page bleed
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keyword description

.bleed.top>† Top page bleed

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.4.  Bound

keyword description

.bound.binding-edge> Binding edge. One of Top, Left, Bottom, or Right

.bound.binding-method> Binding method for the product. One of Perfect
Bound, Saddle Stitch, or None

.bound.creep. See creep

.bound.jog-edge> Jog edge specified. One of Left, Top, Right, or
Bottom

.bound.n-up. See n-up

.bound.page-size. See page-size

.bound.pages-per-section> Number of pages in each section of the bound
product

.bound.reading-order> Reading order. One of Normal or Calendar

.bound.sections> Number of sections of the

.bound.self-cover> Whether bound products in Calendar reading
order contain the front and back covers of the
calendar

.bound.signatures> Number of signatures in the bound product
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keyword description

.bound.trim. See trim

2.11.5.  Bounds

keyword description

.bounds.height>† The total height of the items on the current
surface

.bounds.width>† The total width of the items on the current
surface

.bounds.x>† The X-coordinate of the bounds of items on the
current surface

.bounds.y>† The Y-coordinate of the bounds of items on the
current surface
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.6.  Cloud

keyword description

<cloud.user. See user

2.11.7.  Color

keyword description

.color.coverage> Percentage (0-100) of coverage of the given color

.color.name> Name of the color

.color.process> Process for the specified color (Printing, Cutting,
Technical, etc.)

.color.type> Color type, for example: CMYK

.color.values> Color values, for example: 0, 100, 100, 0

.color.count> Number of colors for the given item

2.11.8.  Colors

.colors.analysis> Color analysis mode for the given product (Fast or
Raster). For more information on color analysis,
see the Products page
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.colors.detection> When Color Analysis is set to Raster, returns
the value of the Color Detection field, either
Bleed or Cut. This value determines which area
of the component Phoenix is considering when
analyzing colors.

.colors.source> Source of colors for the item, either Specified or
From Artwork

2.11.9.  Component

keyword description

<component.bleed. See bleed

<component.colors> Colors in the specified component

<component.column> Column number of the component item when the
item is part of a Step and Repeat group

<component.component-type> Product Type for the component.Example: Tiled

.component.custom. Custom keyword based on a user-defined custom
property. For more on custom properties, see
Custom Properties

<component.double-sided> Whether or not the component is double sided,
either true or false

<component.flat. See flat

<component.instanceid> Instance number of the component. For use when
you need to identify multiple instances of the
same component

<component.locked> Whether or not the component is locked on the
artboard in Phoenix, either true or false

<component.name> Name of the component

<component.number> Product number of the given
component.Example: 4-A

<component.offcut. See offcut

<component.page. See page

<component.position. See position

<component.rotation> Rotation of the given component, from - 180° to
180°

<component.row> Row number of the component item when the
item is part of a Step and Repeat group

<component.signature. See signature

<component.size. See size
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keyword description

<component.spacing. See spacing

<component.tile. See tile

<component.type> Type of object for the componentExample:
Product

<component.z-order> Order of the component in the layout on the z-
axis. Numbers start at 1 for the lowest item, and
count up for subsequent items on top

.component.id> ID of the component in a lane, ribbon, segment, or
roll. *Only available in CSV Report Export

.component.index> Index of the component in a lane, ribbon,
segment, or roll. *Only available in CSV Report
Export

.component.part. See part

.component.product. See product

.component.repeats> Number of repeats the component in a lane,
ribbon, segment, or roll. *Only available in CSV
Report Export

.component.count> Number of components in the part

2.11.10.  Creep

keyword description

.creep.amount>† Amount of creep applied

.creep.calculation> How Creep is calculated, either From Stock, Per
Page, or Total

.creep.method> Method of creep calculation, either Offset or
Scale

.creep.transition>† Transition percentage when using Custom Creep

.creep.type> Type of creep. One of None, Inward, Outward,
Both, or Custom
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.11.  Custom

Phoenix 7.0 introduced the ability to add custom properties to Products, allowing you to add custom
values to properties. These properties can then be used in marks, in Imposition AI Plan Rules, export
presets, reports, and more.

Phoenix 8.0 brings custom properties to even more areas of Phoenix, including Components, Parts,
Projects, Surfaces, and Layouts. These custom properties can be added manually by clicking the
dropdown in the Properties panel and adding a new custom property, or they can be added through
scripting.

Custom properties always take the form of .custom.customPropertyName. For example, we could add
a new custom property to all projects specifying the destintion Store ID for the project. First, navigate
to the project view to find the project properties in the Properties panel, and click the dropdown to add
a property:
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Once the custom property is added to the project, we can add or edit a value, and then that value is
available as a keyword <project.custom.StoreID> anywhere we can use keywords!

Default Product Properties
You can add custom properties to all products on creation by adding a Default Custom Property and
optionally specify a value for it. This adds a custom property to all products created. Where this is
especially useful is if you are using custom properties with marks that perform validation, such as
barcodes. These marks are verified to make sure they contain valid data - for Phoenix to see a custom
product property and display it as an available option in the marks creator, you need to first define it
in the Preferences. Note that you can specify a default value for the custom property, but that is not
necessary.
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2.11.12.  Date

keyword description

<date.h1> Displays the value '12' if the current month is not
December.Useful for creating date-clock custom/
text marks.

<date.h10> Displays the value '10' if the current month is not
October.Useful for creating date-clock custom/
text marks.

<date.h11> Displays the value '11' if the current month is not
November.Useful for creating date-clock custom/
text marks.

<date.h12> Displays the value '12' if the current month is not
December.Useful for creating date-clock custom/
text marks.

<date.h2> Displays the value '2' if the current month is not
February.Useful for creating date-clock custom/
text marks.

<date.h3> Displays the value '3' if the current month is not
March.Useful for creating date-clock custom/text
marks.

<date.h4> Displays the value '4' if the current month is not
April.Useful for creating date-clock custom/text
marks.
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keyword description

<date.h5> Displays the value '5' if the current month is not
May.Useful for creating date-clock custom/text
marks.

<date.h6> Displays the value '6' if the current month is not
June.Useful for creating date-clock custom/text
marks.

<date.h7> Displays the value '7' if the current month is not
July.Useful for creating date-clock custom/text
marks.

<date.h8> Displays the value '8' if the current month is not
August.Useful for creating date-clock custom/
text marks.

<date.h9> Displays the value '9' if the current month is
not September.Useful for creating date-clock
custom/text marks.

<date.iso> ISO 8601 format of current date. Example:
2020-10-15

<date.long> Long text-based format of current date. Uses
month long format, day short format and year long
format. Example: October 15, 2020

<date.m1> Displays the value '12' if the current month is
before December. Useful for creating blanking
date-clock custom/text marks.

<date.m10> Displays the value '10' if the current month is
before October. Useful for creating blanking date-
clock custom/text marks.

<date.m11> Displays the value '11' if the current month is
before November. Useful for creating blanking
date-clock custom/text marks.

<date.m12> Displays the value '12' if the current month is
before December. Useful for creating blanking
date-clock custom/text marks.

<date.m2> Displays the value '2' if the current month is
before February. Useful for creating blanking
date-clock custom/text marks.

<date.m3> Displays the value '3' if the current month is before
March. Useful for creating blanking date-clock
custom/text marks.

<date.m4> Displays the value '4' if the current month is
before April. Useful for creating blanking date-
clock custom/text marks.
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keyword description

<date.m5> Displays the value '5' if the current month is before
May. Useful for creating blanking date-clock
custom/text marks.

<date.m6> Displays the value '6' if the current month is before
June. Useful for creating blanking date-clock
custom/text marks.

<date.m7> Displays the value '7' if the current month is before
July. Useful for creating blanking date-clock
custom/text marks.

<date.m8> Displays the value '8' if the current month is before
August. Useful for creating blanking date-clock
custom/text marks.

<date.m9> Displays the value '9' if the current month is before
September. Useful for creating blanking date-
clock custom/text marks.

<date.medium> Medium text-based date format of current date.
Uses Medium month format, short day format and
long year format. Example: Oct 15, 2020

<date.short> Short number-based date format of current date.
Uses short day format, short month format and
short year format. Example: 10/15/20

2.11.13.  Day

keyword description

<day.iso> ISO 8601 format of current day of the month from
01 to 31. Example: 08

<day.short> Short format of current day of the month from 1 to
31. Example: 8

2.11.14.  Die

keyword description

.die.name> 1-up die name of the given product's die if die
came from a CAD layout

.die.path> Full file path of the CAD layout the product's die
came from

.die.source> The file name of the CAD layout the nth product's
die came from, excluding file extension.
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keyword description

.die.source-noext> The file name of the CAD layout the nth product's
die came from, excluding file extension.

.die.type> Die type of the component

2.11.15.  Distortion

keyword description

<distortion.horizontal> Percentage amount of plate distortion in the
horizontal direction. When project is exported to
PDF the keyword is resolved to the final distortion
value used during export, whether distortion
values are taken from the plate or explicitly
defined in PDF export settings. Example: 98.5%

<distortion.vertical> Percentage amount of plate distortion in the
vertical direction. When project is exported to
PDF the keyword is resolved to the final distortion
value used during export, whether distortion
values are taken from the plate or explicitly
defined in PDF export settings. Example: 98.5%

2.11.16.  File

keyword description

.file.checksum> Checksum of the artwork file

.file.name> File name of the artwork

.file.number> Page number within the artwork file of the
artwork assigned to this page

.file.path> File path for the artwork

.file.timestamp> Artwork file timestamp, in unix time

2.11.17.  Flat

keyword description

.flat.bundle-size> Bundle size of the product, if set

.flat.die. See die
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keyword description

.flat.templates> List of template the given product is restricted to

2.11.18.  Folds

keyword description

.folds.horizontal> Number of horizontal folds in the signature

.folds.total> Total number of folds in the signature

.folds.vertical> Number of vertical folds in the signature

2.11.19.  Grade

keyword description

<grade.caliper>† Thickness of the current grade in the layout

<grade.cost> Cost of the current grade in the layout

<grade.external-id> External ID of the current grade in the layout

<grade.name> Name of the current grade in the layout

<grade.stock> The stock that the current grade belongs to in the
layout

<grade.weight> The weight of the current grade in the layout
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.20.  Group

keyword description

<group.items> Number of items contained in the given group

<group.locked> True/false of whether the group is positionally
locked

<group.name> Name of the given group item, includes ID
number.

<group.position. See position

<group.rotation> Rotation of the given group item from -180° to
180°.

<group.size. See size

<group.type> Type of the item. Returns Group

<group.z-order> Order of the group in the layout on the z-axis.
Numbers start at 1 for the lowest item, and count
up for subsequent items on top

2.11.21.  Horizontal

keyword description

.horizontal.extension>† Horizontal tile extension rule when horizontal
tiling method is set to "Gap"
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keyword description

.horizontal.extension-rule> Horizontal tile extension rule when horizontal
tiling method is set to "Gap"

.horizontal.gap>† Horizontal gap between tiles

.horizontal.method> Horizontal tiling method. One of None, Gap, or
Overlap,

.horizontal.no-image>† Horizontal overlap no image area, used to specify
the area where glue will be placed so no artwork
should be printed

.horizontal.number> Number of horizontal tiles

.horizontal.overlap>† How the tiles should overlap. One of Top, Bottom,
or Both

.horizontal.overlap-rule> How the tiles should overlap. One of Top, Bottom,
or Both

.horizontal.size>† Sizes of tiles in the horizontal direction when
horizontal tiling rule is set to "Variable Sizes"

.horizontal.sizes> Sizes of tiles in the horizontal direction when
horizontal tiling rule is set to "Variable Sizes"

.horizontal.type> Type of horizontal tiling. One of None, Fixed
Number, Fixed Size, or Variable Sizes

.horizontal.uniform-final-size> Boolean of whether or not the horizontal tiles are
of uniform final size
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.22.  Hour

keyword description

<hour> The current hour

2.11.23.  Index Number

Phoenix keywords can reference items on a sheet. Many times, there will be multiple possible items,
but you only want to select the Nth item. For instance, you want to return the 1st ink on a product. If
Phoenix had a smartname for each individual possible ink, the list would be enormous. Instead, Phoenix
uses a placeholder '#' symbol that you can replace with the index that you want to use. So for the ink
example above, you would choose the keyword <ink.#.name> and replace the # with 1:

<ink.1.name>

Similiarly, for finding the number of times the 2nd product is placed in a project, you would use
<project.product.#.placed> and then replace the # with 2:

<project.product.2.placed>
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Any time you see a hash symbol in a keyword in Phoenix, that is a representation of a number that you
can replace to find the Nth item.

2.11.24.  Ink

keyword description

<ink.abbr> Abbreviated ink name of the nth ink in the layout.
Abbreviated name uses the first and last letter of
the ink name except for process colors which are
abbreviated to a single letter (CMYK).

<ink.first> First letter of ink name of the nth ink in the layout.
The letter 'K' is used for process color Black.

<ink.name> Full ink name of the nth ink in the layout

<ink.neutral-density> Neutral Density of the nth ink in the
layout.Example: 0.461

<ink.number> The number of the nth ink in the layout.

<ink.smart> Smart abbreviated ink name of the nth ink in the
layout. Smart text uses Pantone, HKS, TOYO,
Trumatch and other ink type formats to produce
optimal abbreviated names.

<ink.type> Ink type of the nth ink in the layout. Ink type is one
of the following: Normal, Bleed, Crease, Cut, Glue,
Varnish, Technical

2.11.25.  Inks

keyword description

<inks.abbr> Same as <inks> keywords except spot ink names
are abbreviated using the first and last letter of
each ink. Process colors are abbreviated to a
single letter (CMYK).

<inks.first> Same as <inks> keywords except ink names are
shortened to only first letter. The letter 'K' is used
for process color Black.

<inks.full> Same as <inks> keyword

<inks.number> Same as <inks> keywords except ink number is
used instead of ink name. The ink number is the
position of the ink in the layout's ink list as shown
in the Inks Panel.

<inks.smart> Same as <inks> keywords except ink names are
abbreviated using smart text. Smart text uses

368



2Phoenix

keyword description
Pantone, HKS, TOYO, Trumatch and other ink type
formats to produce optimal abbreviated names.

2.11.26.  Inks-stacked

keyword description

<inks-stacked.abbr> Same content and behavior as <inks.abbr>
keyword except ink name abbreviations are
placed on top of each other.

<inks-stacked.first> Same content and behavior as <inks.first>
keyword except ink name first letters are placed
on top of each other.

<inks-stacked.full> Same content and behavior as <inks.full> keyword
except ink names are placed on top of each other.

<inks-stacked.number> Same content and behavior as <inks.number>
keyword except ink names are placed on top of
each other.

<inks-stacked.smart> Same content and behavior as <inks.smart>
keyword except ink name smart texts are placed
on top of each other.

2.11.27.  Items

keyword description

.items.bounds. See bounds

.items.count> The count of items on the current surface

2.11.28.  Lane

Note:  Ribbon keywords are only available for use in CSV Reports

keyword description

<lane.component. See component

<lane.gutter>† Size of the lane gutter. *Only available in CSV
Report Export

<lane.id> ID of the lane, or lane within a segment, or roll.
*Only available in CSV Report Export
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keyword description

<lane.index> Index of the lane, or lane within a segment, or roll.
*Only available in CSV Report Export

<lane.name> Name of the lane, or lane within a segment, or roll.
*Only available in CSV Report Export

<lane.position. See position

<lane.ribbon. See ribbon

<lane.size. See size

.lane.count> Count of the lane within a segment, or roll. *Only
available in CSV Report Export

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.29.  Layout

keyword description

<cloud.user. See user

2.11.30.  Margins

keyword description

.margins.bottom>† Bottom margin of the given product object.

.margins.left>† Left margin of the given product object
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keyword description

.margins.right>† Right margin of the given product object

.margins.top>† Top margin of the given product object

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.31.  Material

keyword description

<roll.material.grade>** Grade of the roll material. *Only available in CSV
Report Export
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keyword description

<roll.material.stock>** Stock of the roll material. *Only available in CSV
Report Export

2.11.32.  Minute

keyword description

<minute> The current minute

2.11.33.  Month

keyword description

<month.iso> ISO 8601 format for the current month from 01 to
12 Example: 03

<month.letter> Current month represented as a single capital
letter starting with "A" for January, "B" for
February, etc.

<month.long> Long word form of the current month. Example:
March

<month.medium> Medium word form of the current month.
Example: Mar

<month.short> Short numeric value for the current month from 1
to 12

2.11.34.  Muller-martini

keyword description

.muller-martini.finishing> Generates a value for Muller Martini Ventura
MC Digital “Finishing” barcodes. This keyword
encodes signature information including
signature size and fold count in a format specific
to these devices.

.muller-martini.order> Generates a value for Muller Martini Ventura MC
Digital “Order” barcodes. This keyword encodes
signature information including signature and
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keyword description
section indices in a format specific to these
devices.

2.11.35.  N-up

keyword description

.n-up.gap>† Gap between N-ups

.n-up.number> N-up number

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.36.  Name

keyword description

.name.first> Optional modifier to specify the first name of the
currently logged in user
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keyword description

.name.last> Optional modifier to specify the last name of the
currently logged in user

2.11.37.  Offcut

keyword description

.offcut.margins. See margins

.offcut.type> Type of offcut applied to the item. One of None,
Contour, or Margins

2.11.38.  Origin

keyword description

.origin.x>† X-coordinate of the origin of the surface. Value
should be 0 unless the origin is moved

.origin.y>† Y-coordinate of the origin of the surface. Value
should be 0 unless the origin is moved
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.39.  Page

keyword description

.page.bleed. See bleed

.page.color. See color

.page.colors. See colors

.page.creep> Page creep applied

.page.file. See file

.page.index> Page index

.page.locked> True/false of whether the page is positionally
locked

.page.name> Name of the page

.page.position. See position

.page.rotation> Rotation applied to the page

.page.scale. See scale

.page.size. See size
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keyword description

.page.visible> True/false of whether the page is visible or
hidden, respectively

2.11.40.  Page-size

keyword description

.page-size.height>† Height of the bound product page

.page-size.width>† Width of the bound product page

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.41.  Part

keyword description

<part.bound. See bound

.part.custom. Custom keyword based on a user-defined custom
property. For more on custom properties, see
Custom Properties

<part.flat. See flat

<part.grain> Grain direction of the product

<part.is-bound> Boolean to determine if the product part is bound
or not, returns true/false

376



2Phoenix

keyword description

<part.page. See page

<part.part-type> Product type of the partExample: Flat

<part.processes> Processes used for the partExample: Printing,
Cutting

<part.rotation. See rotation

<part.stock> Stock name of the given product item

<part.tiled. See tiled

.part.component. See component

.part.count> Count of the number of this part in the given
context

2.11.42.  Plate

keyword description

<plate.external-id> External ID of the plate

<plate.locked> Whether or not the plate is locked in position, true
or false

<plate.name> Name of the plate

<plate.position. See position

<plate.price> Price of the plate

<plate.punch>† Punch offset of the plate in current project units

<plate.rotation> Rotation of the plate in degrees

<plate.size. See size

<plate.type> Type of item. Returns Plate

<plate.z-order> Order of the plate in the layout on the z-axis.
Numbers start at 1 for the lowest item, and count
up for subsequent items on top
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.43.  Position

keyword description

.position.x>† X position of the given item in project units

.position.y>† Y position of the given item in project units
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.44.  Press

keyword description

<press.cost> The cost to run the press used in the current
layout

<press.external-id> External ID of current press

<press.feed-type> The feed type for the press used. One of Sheet or
Roll

<press.gripper>† Gripper offset of current press in project units

<press.manufacturer> Manufacturer property of the current press

<press.name> Name of the current press

<press.process-type> The type of the current pressExample: Digital
Printing

<press.processes> The process(es) used by the current
pressExample: Printing

<press.speed> The speed units defined for the current
press, to be used in conjunction with
<press.speed>.Example: Sheets/Hours

<press.speed-units> The speed units defined for the current
press, to be used in conjunction with
<press.speed>.Example: Sheets/Hours
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.45.  Product

keyword description

<product.artwork. See artwork

<product.back-inks> Comma-separated list of inks used on the back
side of the product

<product.color> RGBA display color of the given product

.product.custom. Custom keyword based on a user-defined custom
property. For more on custom properties, see
Custom Properties

<product.description> Description property of the given product

<product.due-date> Due date property of the given product

<product.front-inks> Comma-separated list of inks used on the front
side of the product

<product.group> Group name property of the given product

<product.index> Index number of the given product

<product.layouts> A comma delimited list of layouts the product is
placed in.

<product.max-overruns>† Max overrun percentage allowed for the given
product

<product.min-overruns>† Min overrun percentage allowed for the given
product
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keyword description

<product.name> Name of the given product item as appears in the
Products Panel

<product.notes> Notes property of the given product

<product.overrun> Overruns of the product as a percentage of the
ordered amount

<product.overrun-percent> Overruns of the product as a percentage of the
ordered amount

<product.placed> Number of instances of the product placed

<product.priority> Priority of the product as an integer from 1 to 10

<product.quantity> Ordered amount of the given product
item.Example: 15000

<product.total> Total number of product in the project to be
printed including overruns

.product.part. See part

.product.count> Total number of products in the project

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.46.  Project

keyword description

<project.bleed-splitting> The type of Bleed Splitting chosen for the
project.One of Rectangular, Signatures, or None
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keyword description

<project.client> Client Name property value in the project

<project.contact> Contact Name property value in the project

<project.cost> Total stock costs across all layouts in the project

<project.cost-die> The die cost of the project

<project.cost-plate> The cost of plates in the project

<project.cost-press> The total cost of presses in the project

<project.cost-stock> Total stock costs across all layouts in the project

<project.creator-os> Computer OS version used to create this project

.project.custom. Custom keyword based on a user-defined custom
property. For more on custom properties, see
Custom Properties

<project.filename> File name of this PHX project the last time it
was saved excluding path information.Example:
LD-12532.phx

<project.filepath> File name of this PHX project the last time it was
saved including full path information.Example: /
projects/labels/LD-12532.phx

<project.id> Project ID property value in the project

<project.last-saved> Timestamp of last time the current project was
saved

<project.layout-count> Number of layouts in the project

<project.name> Project Name property in the project defined
independently of the current filename used to
save the project (PHX).

<project.notes> Notes property in the project

<project.overrun> Average percentage of overruns across all
products in the project

<project.phoenix-version> Version of Phoenix this project was last saved
from

<project.phone> Contact Phone property value in the project

<project.press-time> Total press time across the entire project

<project.product. See product

<project.run-length> Total sum of all layout run lengths in the project

<project.sourcetemplate> Full path of project template current project was
created from. If project was not created from a
template, value is empty

<project.time> The total time required to produce the project

382



2Phoenix

keyword description

<project.underrun> Average percentage of underruns across all
products in the project

<project.units> Current units being used in the project

<project.usage> Average sheet usage percentage across all
layouts in the project

<project.waste> Percentage of total waste in the project

2.11.47.  Repeat

keyword description

<repeat.items> Total number of items in the repeat

<repeat.locked> True/False of whether the repeat position is
locked

<repeat.position. See position

<repeat.rotation> Rotation applied to the repeatExample: 90°

<repeat.size. See size

<repeat.type> Type of repeatExample: Repeat

<repeat.z-order> Order of the repeat in the layout on the z-axis.
Numbers start at 1 for the lowest item, and count
up for subsequent items on top

2.11.48.  Ribbon

Note:  Ribbon keywords are only available for use in CSV Reports

keyword description

<ribbon.component. See component

<ribbon.gutter>† Size of the ribbon gutter. *Only available in CSV
Report Export

<ribbon.id> ID of the ribbon, or ribbon within a lane, segment,
or roll. *Only available in CSV Report Export

<ribbon.index> Index of the ribbon, or ribbon within a lane,
segment, or roll. *Only available in CSV Report
Export

<ribbon.name> Name of the ribbon, or ribbon within a lane,
segment, or roll. *Only available in CSV Report
Export
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keyword description

<ribbon.position. See position

<ribbon.size. See size

.ribbon.count> Total number of the ribbon within a lane,
segment, or roll. *Only available in CSV Report
Export

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.49.  Roll

Note:  Roll keywords are only available for use in CSV Reports

keyword description

<roll.component. See component

<roll.id> ID of the roll. *Only available in CSV Report Export

<roll.lane. See lane

<roll.material> Material used for the roll

<roll.name> Name of the roll

<roll.ribbon. See ribbon

<roll.segment. See segment
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keyword description

<roll.size. See size

2.11.50.  Rotation

keyword description

.rotation.custom-values> Allowed rotations values for the part

.rotation.type> Rotation type for the part: "Any", "Orthogonal",
"None", or "Custom"

2.11.51.  Scale

keyword description

.scale.x>† Horzontal scaling value applied to an item,
expressed in percentExample: 10%

.scale.y>† Vertical scaling value applied to an item,
expressed in percentExample: 10%
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.52.  Second

keyword description

<second> The current second

2.11.53.  Section

keyword description

<section.binding-method> Binding method for the section. One of Perfect
Bound, Saddle Stitch, or None

<section.index> Index of the section

<section.pages> Number of pages contained within the section

<section.signatures> Number of signatures in the section

2.11.54.  Segment

Note:  Segment keywords are only available for use in CSV Reports

keyword description

<segment.component. See component
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keyword description

<segment.id> ID of the segment, or segment within a roll. *Only
available in CSV Report Export

<segment.index> Index of the segment, or segment within a roll.
*Only available in CSV Report Export

<segment.lane. See lane

<segment.name> Name of the segment, or segment within a roll.
*Only available in CSV Report Export

<segment.position. See position

<segment.ribbon. See ribbon

<segment.size. See size

.segment.count> Total number of segments *Only available in CSV
Report Export

2.11.55.  Sheet

keyword description

<sheet.cost> Sheet-based cost for the current sheet being
used in the layout

<sheet.dimensions> Dimensions of the current sheet being used in the
layout

<sheet.external-id> External ID of current sheet being used in the
layout

<sheet.grade> Grade of current sheet being used in the layout

<sheet.grain> Grain direction of current sheet being used in the
layout

<sheet.height>† Height of the current sheet

<sheet.name> Name of current sheet being used in the layout

<sheet.price> Price of the current sheet

<sheet.stock> Name of stock current sheet comes from

<sheet.width>† Width of the current sheet
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Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.56.  Signature

keyword description

.signature.folding-pattern> Folding pattern used in the signatureExample:
F4-2

.signature.folds. See folds

.signature.index> Index of the signature within its section.If a bound
product has only one section, then this is the
same as signature.index>. If, for example, a book
has 4 signatures with 2 signatures in section 1 and
then 2 signatures in section 2, then it would look
like this:Signature 1 -> index: 1, relative-index:
1, section: 1Signature 2 -> index: 2, relative-
index: 2, section: 1Signature 3 -> index: 3,
relative-index: 1, section: 2Signature 4 -> index:
4, relative-index: 2, section: 2

.signature.muller-martini. See muller-martini

.signature.page-count> Total count of pages in the signature

.signature.relative-index> Index of the signature within its section.If a bound
product has only one section, then this is the
same as signature.index>. If, for example, a book
has 4 signatures with 2 signatures in section 1 and
then 2 signatures in section 2, then it would look
like this:Signature 1 -> index: 1, relative-index:
1, section: 1Signature 2 -> index: 2, relative-
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keyword description
index: 2, section: 1Signature 3 -> index: 3,
relative-index: 1, section: 2Signature 4 -> index:
4, relative-index: 2, section: 2

2.11.57.  Size

keyword description

.size.height>† Height of the given item in project units

.size.width>† Width of the given item in project units

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.58.  Spacing

keyword description

.spacing.margin>† Overall spacing of the given project item. Single
value when spacing type if "Uniform Spacing" or
all spacing margins are the same. When product
side spacing differs, all four sides' spacing
values will be output with order "left top right
bottom". When spacing type is "Spacing from
Bleed" this keyword will have the same value as
.product.bleed>

.spacing.margins. See margins
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keyword description

.spacing.type> Spacing type of the given project item. Values
can be "Spacing Margins", "Uniform Spacing", or
"Spacing from Bleed".

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.59.  Spot

keyword description

<spot.abbr> Abbreviated ink name of the nth spot ink in the
layout. Abbreviated name uses the first and last
letter of the ink name except for process colors,
which are abbreviated to a single letter (CMYK).

<spot.first> First letter of ink name of the nth spot ink in the
layout. The letter 'K' is used for process color
Black.

<spot.name> ull ink name of the nth spot ink in the layout

<spot.neutral-density> Neutral Density of the nth spot ink in the
layout._Example: 0.461

<spot.number> Ink number of the nth spot ink in the layout, i.e.
the position of the ink in the layout's ink list as
shown in the Inks Panel.

<spot.smart> Smart abbreviated ink name of the nth spot ink in
the layout. Smart text uses Pantone, HKS, TOYO,
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keyword description
Trumatch and other ink type formats to produce
optimal abbreviated names.

<spot.type> Ink type of the nth spot ink in the layout. Ink type
is one of the following: Normal, Bleed, Crease,
Cut, Glue, Varnish, Technical

2.11.60.  Spots

keyword description

<spots.abbr> Same as <inks.abbr> but includes only spot inks

<spots.first> Same as <inks.first> but includes only spot inks

<spots.full> Same as <inks.full> but includes only spot inks

<spots.number> Same as <inks.number> but includes only spot
inks

<spots.smart> Same as <inks.smart> but includes only spot inks

2.11.61.  Spots-stacked

keyword description

<spots-stacked.abbr> Same as <inks-stacked.abbr> but includes only
spot inks

<spots-stacked.first> Same as <inks-stacked.first> but includes only
spot inks

<spots-stacked.full> Same as <inks-stacked.full> but includes only
spot inks

<spots-stacked.number> Same as <inks-stacked.number> but includes
only spot inks

<spots-stacked.smart> Same as <inks-stacked.smart> but includes only
spot inks

2.11.62.  Stock

keyword description

<stock.description> Description property of current stock in the
project

<stock.external-id> External ID of current stock in the project
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keyword description

<stock.name> Name of current stock in the project

<stock.sheets> Count of sheets used for the current layout

<stock.thickness>† Thickness of the current stockExample: 0.05 mm

<stock.vendor> Vendor property of current stock in the project

<stock.weight> Weight of the current stockExample: 250 gsm

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.63.  Surface

keyword description

.surface.custom. Custom keyword based on a user-defined custom
property. For more on custom properties, see
Custom Properties

<surface.items. See items

<surface.origin. See origin

<surface.plate> Name of the plate used for the current surface of
the layout

<surface.sheet> Name of the sheet used for the current surface

<surface.side> Type of current side, either Front or Back
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keyword description

<surface.stock> Name of the stock used for the current surface

2.11.64.  Template

keyword description

<template.comments> Comments saved in the die template

<template.items> Count of items in the die template

<template.locked> True/False of whether the die template is locked
on the layout

<template.name> Name of the die template

<template.position. See position

<template.preset-mirroring> Returns Horizontal, Vertical, or None based upon
whether the die template was mirrored on import
into the templates library

<template.preset-rotation> True/False of whether the die template has been
rotated on import into the templates library

<template.rotation> Rotation value of the imported die template

<template.size. See size

<template.source-file> File path of the die template that was imported
into the Templates library. Phoenix retains the
URL when it was imported, but it may have moved
since the template was imported into Phoenix

<template.template-type> Type of templateExample: Die

<template.type> Type of item, returns Die Template

<template.z-order> Order of the template in the layout on the z-axis.
Numbers start at 1 for the lowest item, and count
up for subsequent items on top

2.11.65.  Tile

keyword description

.tile.die. See die

.tile.index> Index of the tile
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keyword description

.tile.tile-count> Total number of tiles

2.11.66.  Tiled

keyword description

.tiled.die. See die

.tiled.size. See size

.tiled.tiles> The total number of tiles in this tiled product part

.tiled.tiling. See tiling

2.11.67.  Tiling

keyword description

.tiling.cutting-tool> Tool type specified as the cutting tool for the tiled
productExample: Cut

.tiling.horizontal. See horizontal

.tiling.order> Tiling Order. One of Snaking Vertical, Snaking
Horizontal, Zigzag Vertical, or Zigzag Horizontal

.tiling.preset> Tiling Preset used

.tiling.start> Location of the first tile. One of Top Left, Top
Right, Bottom Left, or Bottom Right

.tiling.vertical. See vertical

2.11.68.  Time

keyword description

<time.iso> ISO 8601 format of current time including hours,
minutes and seconds._Example: 23:06:49

<time.long> Long length format of current time including
hours, minutes, seconds, and time zone.Example:
11:06:49 PM EST

<time.medium> Medium length format of current time including
hours, minutes and seconds.Example: 11:06:49 PM

394



2Phoenix

keyword description

<time.short> Short length format of current time including
hours and minutes.Example: 11:06 PM

2.11.69.  Trim

keyword description

.trim.face>† The face trim margin of bound signatures in this
part

.trim.jog>† The trim margin of the jog edges of bound
signatures in this part

.trim.lip>† The lip type of bound signatures in this part

.trim.lip-type> The lip type of bound signatures in this part

.trim.non-jog>† The trim margin of the non-jog edges of bound
signatures in this part

.trim.spine>† The spine margin of bound signatures in this part

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.70.  User

keyword description

.user.description> Description for the currently logged in user

395



2 Phoenix

keyword description

.user.email> Email Address for the currently logged in user

.user.name> Name of the currently logged in user

.user.title> User title for the currently logged in user

2.11.71.  Varnish

keyword description

<varnish.abbr> Abbreviated ink name of the nth varnish ink in the
layout. Abbreviated name uses the first and last
letter of the ink name except for process colors
which are abbreviated to a single letter (CMYK).

<varnish.first> First letter of ink name of the nth varnish ink in
the layout. The letter 'K' is used for process color
Black.

<varnish.name> Full ink name of the nth varnish ink in the layout

<varnish.neutral-density> Neutral Density of the nth varnish ink in the
layout.Example: 0.461

<varnish.number> Ink number of the nth varnish ink in the layout,
i.e. the position of the ink in the layout's ink list as
shown in the Inks Panel.

<varnish.smart> Smart abbreviated ink name of the nth varnish
ink in the layout. Smart text uses Pantone, HKS,
TOYO, Trumatch and other ink type formats to
produce optimal abbreviated names.

<varnish.type> Ink type of the nth varnish ink in the layout. Ink
type is one of the following: Normal, Bleed,
Crease, Cut, Glue, Varnish, Technical

2.11.72.  Varnishes

keyword description

<varnishes.abbr> Same as <inks.abbr> but includes only varnish
inks

<varnishes.first> Same as <inks.first> but includes only varnish
inks

<varnishes.full> Same as <inks.full> but includes only varnish inks

<varnishes.number> Same as <inks.number> but includes only varnish
inks
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keyword description

<varnishes.smart> Same as <inks.smart> but includes only varnish
inks

2.11.73.  Varnishes-stacked

keyword description

<varnishes-stacked.abbr> Same as <inks-stacked.abbr> but includes only
varnish inks

<varnishes-stacked.first> Same as <inks-stacked.first> but includes only
varnish inks

<varnishes-stacked.full> Same as <inks-stacked.full> but includes only
varnish inks

<varnishes-stacked.number> Same as <inks-stacked.number> but includes
only varnish inks

<varnishes-stacked.smart> Same as <inks-stacked.smart> but includes only
varnish inks

2.11.74.  Vertical

keyword description

.vertical.extension>† Vertical tile extension rule when vertical tiling
method is set to "Gap"

.vertical.extension-rule> Vertical tile extension rule when vertical tiling
method is set to "Gap"

.vertical.gap>† Vertical gap between tiles

.vertical.method> Vertical tiling method. One of None, Gap, or
Overlap,

.vertical.no-image>† Vertical overlap no image area, used to specify
the area where glue will be placed so no artwork
should be printed

.vertical.number> Number of vertical tiles

.vertical.overlap>† How the tiles should overlap. One of Top, Bottom,
or Both

.vertical.overlap-rule> How the tiles should overlap. One of Top, Bottom,
or Both

.vertical.size>† Sizes of tiles in the vertical direction when
vertical tiling rule is set to "Variable Sizes"
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keyword description

.vertical.sizes> Sizes of tiles in the vertical direction when
vertical tiling rule is set to "Variable Sizes"

.vertical.type> Type of vertical tiling. One of None, Fixed
Number, Fixed Size, or Variable Sizes

.vertical.uniform-final-size> Boolean of whether or not the vertical tiles are of
uniform final size

Note:
† These keywords are available with custom modifiers to return a specific unit of
measurement! Simply add one of the following modifiers:

modifier description

.cm> Measurement in centimeters

.ft> Measurement in feet

.in> Measurement in inches

.m> Measurement in meters

.mil> Measurement in mils, also known as
“thousandths" or "thou"

.mm> Measurement in millimeters

.pt> Measurement in points

.um> Measurement in meters

2.11.75.  Year

keyword description

<year.long> Full four digits of current year.Example: 2014

<year.short> Last two digits of current year.Example: 14

2.12.  Preferences

Phoenix has a number of preferences that determine how Phoenix behaves in certain scenarios.
To view and edit preferences, navigate to the Phoenix menu (on a Mac) or Edit (on a PC) and choose
Preferences.

The Preferences are made up of General preferences, as well as preference tabs for Interface, Drag &
Drop, Project, Product, Estimating, Inks, Ink Mappings, Die Import, Presets, and Diagnostics. See below
for an explanation of each preference option.
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General

Field Description

Default Units Set the units for Phoenix to use by default

Default Currency Set the currency Phoenix should use for costing
and estimating

Nudge Defines the distance used for a "nudge," which
is when an object is selected and the arrow
keys are used to transform it up, down, left, or
right. A large nudge is a nudge with the shift key
depressed. The "Scale with zoom" option, when
enabled, scales the nudge up or down depending
on the zoom level. For instance, if you are zoomed
in to a small area on a layout, and nudge, with
this option disabled, the nudge would still move
the default distance. With "Scale with zoom"
enabled, however, the nudge would be scaled
proportionately to the zoom level, so the nudge
would be a smaller distance than default.

Enable Snap Toggles whether snapping is enabled when
dragging items

Snap Strength Sets the level of intensity of snapping objects
to other objects. The other strength options
define how strong the snap is, which refers to
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Field Description
the distance from another object before the snap
occurs.

Only snap outer most edge of components in
Layout View

When enabled, this limits what is snapped while
dragging a product in the layout view. When
disabled, snap includes cut path and bleed path

Guide Color Sets the color of guides in Phoenix

Disable Artboard scrolling with mouse wheel By default, if you have a mouse scroll wheel, the
scroll wheel controls artboard scrolling. This
option disables this feature.

Double-clicking marks in Artboard launches edit
dialog

When enabled, you can edit a mark by double-
clicking it in the Artboard

Auto-detect external edits to imported artwork If enabled, Phoenix will monitor artwork to detect
changes. If a change is detected, Phoenix will
prompt the user to ask if the artwork should be
updated in the project.

Autosnap updated artwork If artwork is updated, this option enables
autosnapping for the updated artwork. If
disabled, autosnapping won't happen, and
the dieline from the original file will remain
unchanged.

Auto-detect external edits to PDF-based marks If using a custom mark based on a PDF, this
option will monitor for any changes to the original
PDF and notify the user if changes are detected.

Die match tolerance Sets the tolerance level for matching artwork
to die templates. A larger number equates to a
looser tolerance, and a smaller number means a
tighter fit. It is recommended to leave this value
at the default level, however, if your template
does not match your die line well, you can adjust
this value to compensate.

Precision Defines the precision of values displayed within
the Phoenix UI. This does not affect the precision
of any calculations or values within Phoenix, it
only truncates the displayed value.

Reset All Warning Dialogs Resets any warning dialog windows that have
previously been dismissed and instructed to not
warn the user again

Reset Layout Phoenix retains the size, and configuration of
your Phoenix panels to make for a consistent user
experience. If you want to reset the layout to the
default, you can click the Reset Layout button.
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Interface

Field Description

Tab Text Choose what should be displayed in each project's
tab. Options are Filename, Project Name, or
Project ID

Artboard Background Choose your artboard background. Options are
Plain (no background), Origin lines, or Grid.

Clipping Path Color Set the color of product clipping paths in Phoenix

Spacing Path Color Set the color of product spacing paths in Phoenix

Offcuts Color Set the color of product offcuts in Phoenix

Product Number Color Set the color of product numbers in Phoenix

Product Number Size Set the relative size of product numbers

Show plate punch If using plates, define whether to show plate
punch

Show plate material If using plates, define whether to show plate
material

Show Sheet grain Choose whether to display sheet grain

Drag and Drop
Phoenix 8.0 introduces new drag and drop behavior, where you can customize exactly what happens
and what options are available when dragging and dropping files into Phoenix.

Each drag and drop behavior is completely customizable through the Preferences in the Drag &
Drop pane. For each category in the preferences, a scenario is described, and the type of item being
dropped is listed. Next to each item is a dropdown where you can sepcify the desired behavior.
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Project

Field Description

New Project Default Press Optionally set a default press to be assigned
when creating a new project. By having a default
sheet set for the press as well, you can have
a sheet and press automatically defined upon
project creation. Note that this does not affect
any layouts created via Imposition AI's Plan or
Optimize modes.

Add layout with project creation Optionally have a new layout create each time a
project is created. When not selected, layouts will
need to be created manually or via Imposition AI.

Embed artwork in project save Optionally save artwork inside of projects upon
save. This will increase the project file size, but
make it much easier to share projects without
breaking links to artwork.

Show project properties dialog when creating
new projects

Option to display project properties dialog to
allow the user to set the project name, ID, and
other project properties when a new project is
created

Lock assigned artwork Option to lock assigned artwork so that it cannot
be moved or modified on the artboard. Locked
artwork can be unlocked manually using the
lock icon in the top left of the Phoenix UI when a
locked object is selected.

Lock die layouts on import Option to lock die layouts so they cannot be
moved or modified in a layout

Bleed splitting Behaviour for component instances in layouts so
that bleeds are automatically split. The possible
choices are defined below:

None - No bleed splittings.

Signatures - Only bound and folded components
(signatures) will have bleed splitting applied.

Rectangular - All rectangular components
will have bleed splitting applied. This covers
bound and folded signatures. And flat and tiled
components that have a rectangular dieline.

Product

Field Description

Enable file convention Enables Phoenix to extract product properties
from a defined filename convention. See
Filename Conventions on page 102 for more info.

Automatically set die design from tool type
mappings

Use autosnapping to create the die design in a
product based on the tool type mappings in the
Tool Types library.
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Field Description

Use grain direction from cad data when available Enables automatically setting the grain direction
on a product if the CAD file used to create it had a
grain direction set.

Use CAD from PDF+ structural design when
available

When enabled, products created from PDF+ files
that contain structural design info will look for the
referenced CAD data to set the product die shape.
In the event that the CAD data cannot be found,
Phoenix will revert to tool type mappings or the
artwork trimbox.

Shape Search When searching for a die design from lines in the
artwork, this defines how Phoenix should search
for shapes.

Largest sets the largest continuous path that
matches the tool type mappings as the die
design.

Merged sets the lines defined in the tool type
mappings as the die design, but merged together
into one path.

Multiple splits up multiple cut paths into separate
products

Gap Margin When searching for a die design, defines the
maximum gap margin that may appear in the
die shape. Any gap larger than this amount will
prevent that line from being considered as a
potential die design.

Raster Analysis Threshold Sets the ink coverage percentage required to
consider a color as included on a page

Set product name from artwork Sets the name of the product from the artwork
file name

Show dialog when creating new product from
artwork

Option to show the product dialog to set certain
product parameters when a new product is
created from artwork

Page Handling Defines how multipage artwork is handled upon
import.

One product per two pages means that a
multipage artwork will be split into multiple
products, with odd numbered pages being the
front of the product, and even numbered pages
becoming the backside graphic.

One product per page will create multiple single-
sided products, with each page becoming a
separate product.

One product per file will create a single sided
product from the first page of a multipage pdf.
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Estimating
Processes: Customizable actions that can be assigned to a product via Tool Type Mappings.

Process Types: Process Types allow for further categorization of Processes.

Modes:

Modes allow for customizable operation settings for specific production processes and equipment.
Adding a new Mode allows users to more accurately model real-world production speeds and costing
per device.

Modes are defined by a Name, Description (optional) and Value. When creating a Product in Phoenix,
a specific Mode can be set by using the Mode 'Name', or if there are many Modes across many devices,
passing a mode 'Value' for the Product allows Phoenix to evaluate the most cost-effective device to use
which meets the processing requirements and minimum Mode value.

Stock Types: All stocks in Phoenix are categozied by their Stock Type. Stock Types provide a useful
way of specifying whether devices can use a group of stocks or not (via inclusion/exclusion rules).

Inks
The Inks preference panel allows you to define the default ink order, as well as view, add, and edit inks
in the Ink Database. To add, edit, or delete an ink, click the +, pencil, or trash buttons, respectively.

When adding (or editing) an ink, the above dialog appears. You can set the Name and optional
Description for the ink. In addition, define the type of ink, and whether the ink is defined by CMYK
values or LAB values.
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2.13.  Keyboard Shortcuts

Phoenix is built for speed. This section outlines the many shortcuts in Phoenix that can dramatically
cut down the time it takes to build print-ready layouts in Phoenix.

2.13.1.  Toolbars

The tools in the main Toolbar are split into six sections. The different sections can be shown/hidden
from the Window -> Toolbars sub-menu or by right clicking on the toolbar and checking the sections to
be shown.

To switch between tools, you can click on the corresponding button or you can use the single- stroke
hot keys when available.

Toolbox
Some of the most frequently used tools in Phoenix are placed in the Toolbox Toolbar.

Tool Hotkey Tool Overview

 Selection v Main selection tool for selecting
items, entering item context,
moving items and more

 Hand h Hand tool for moving artboard
around and zooming in and out

 Measure m Measure distances between
items in artboard

 Move t Move one product relative to
another by selecting reference
points on die lines between the
two

 Zoom z Zoom in and out of the artboard

 Fit All in View ctrl+alt+0 Fit all items in the current
artboard into view

Marks
The Marks toolbar contains mark-related tools Place Numbers, Camera mark, and Dimension Mark.
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Tool Hotkey Tool Overview

 Place Number n Place new Product Number
Marks directly into Products
in Product or Layout View by
mouse click

 Camera Mark Manually place a camera mark in
the layout by clicking mouse in
the artboard

 Dimension Mark d Manually create a dimension
mark by clicking on snap points
in Product or Layout View to
measure distances

Imposition AI
The Imposition AI toolbar is available when the license includes the Imposition AI module.

Tool Hotkey Tool Overview

 Smart Place s Select an open area in the layout
to find unfulfilled products in the
project that can be placed while
honoring spacing and media
margin constrains

 Impose Opens the Imposition AI dialog
and runs the Impose tool with
the latest settings

 Populate Opens the Imposition AI dialog
and runs the Populate tool with
the latest settings

 Optimize Opens the Imposition AI dialog
and runs the Optimize tool with
the latest settings

 Plan Opens the Imposition AI dialog
and runs the Plan tool with the
latest settings

Alignment
The Alignment toolbar provides tools to quickly align selected items to media or other items.
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Tool Tool Overview

 Alignment Target Select what target the alignment is to be based
off

 Align Left Align to the left edge of the alignment target

 Align Center Horizontal Align to the horizontal center of the alignment
target

 Align Right Align to the right edge of the alignment target

 Align Bottom Align to the bottom edge of the alignment target

 Align Center Vertical Align to the vertical center of the alignment
target

 Align Top Align to the top edge of the alignment target

 Span Horizontally Horizontally space the selected items evenly
spanning the alignment target by the given gap
distance

 Span Vertically Vertically space the selected items, evenly
spanning the alignment target by the given gap
distance

Geometry
The Geometry toolbar reports the positions, rotations, and dimensions of selected items and when
possible allows you to accurately define new values for them.

Tool Tool Overview

 Reference Point Set the reference point for the item

 X Position X position of item relative to the reference point.
When possible, item position(s) can be moved by
editing this field.

Y Position Y position in layout relative to the reference point.
When possible, item position(s) can be moved by
editing this field.

 Item Width Item width. When possible, item widths can be
changed by editing this field.

 Item Height Item height. When possible, item widths can be
changed by editing this field.

 Item Rotation Item rotation. When possible, item widths can be
changed by editing this field.

 Lock Items Lock/Unlock items
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Drawing
The drawing tools are used for drawing and editing die designs and bleed paths in die edit and bleed
edit modes, drawing shape marks to products or layouts in normal mode, or manipulating bleed
overlaps in overlaps mode.

Tool Hotkey Tool Overview

 Direct Selection a Select and move individual
control points on a path in die
edit and bleed edit modes.

 Line l Add new lines in die and bleed
edit modes. Draw line marks in
normal mode.

 Rect r Add new rectangles in die and
bleed edit modes. Draw line
marks in normal mode.

 Ellipse e Add new ellipses in die and bleed
edit modes. Draw line marks in
normal mode.

 Pen p Draw paths (lines and curves)
directly in the shape in die edit
and bleed edit modes.

 Add Anchor Point = Add anchor points to an existing
path in die edit and bleed edit
modes.

 Delete Anchor Point - Delete anchor points to an
existing path in die edit and
bleed edit modes.

 Anchor Point Tool shift + c Select anchor points and
manipulate the handles to
change the curve shape in die
edit and bleed edit modes.

 Cut c Clicking on a path splits the path
segment in two in die edit and
bleed edit modes. In overlaps
mode, drawing a line splits bleed
overlaps in two so they can
beresolved independently.

Delete Multiple Anchors Shortcut
Shortcut: Shift + Delete
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Description: Removes all currently selected anchor points in a single action. Available in both Die edit
and Bleed edit modes. Selection Tool Shortcuts.

2.13.2.  Selection Tool Shortcuts

Typically, left click is used with Selection Tool (v) to select a given item while right click on an item
will show that item's Content Menu. Left clicking and dragging the mouse in an area with no items
will create a selection area that will select all items inside the rectangle when you release the mouse
button. The following additional shortcuts are available:

Forcing Selection Area
Shortcut: Control + Shift + Left Click + Mouse Drag

Description: Normally selection area gets created when you start Left Click + Mouse Drag in an area
with no items. Sometimes you will want to select multiple items with selection area but it is dicult
or impossible to start selection area in an empty region. If you hold down the Control and Shift keys, a
selection area will be created regardless of whether an item is beneath the cursor or not.

Multiple Item Selection
Shortcut: Shift

Description: To add more items to your current selection, hold down the Shift key while clicking on
the additional items. Similarly, hold Shift key while using Selection Area to add all items in the current
mouse selection area to your existing selected item(s).

Alt+Drag Duplicate
Shortcut: Alt + Left Click Item(s) + Mouse Drag

Description: Holding the Alt key while moving items in the Artboard with your mouse will duplicate the
item in the destination instead of moving the items, essentially performing duplicate and move in a
single action.

Alt+Drag Duplicate works on single items as well as multiple selected items, giving you the power to
duplicate entire groups of items to a specific location in one shot. All relative positions of selected
items are preserved during this action.

Alt+Click
Shortcut: Alt + Left Click when item(s) are selected

Description: This shortcut behaves similarly to Alt + Drag Duplicate. Select item(s) and click anywhere
on the artboard to duplicate those items in the location of the mouse click. The new duplicate item(s)
will be centered in the cursor position of the click. For multiple item selection, the relative positions of
items are preserved.

Swap Items Shortcut
Shortcut: Control + Left Click Item(s)

Description: You can swap two items or groups of items in the sheet in a single action by selecting an
item (source) and click on another item (destination) while holding the Control key. The selected source
items will move to the position of the clicked destination item while the destination item will move
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into the position of the source items. Product items, marks, and groups can all be swapped using this
shortcut. If any source or destination items are locked, a dialog will appear explaining the swap action
cannot be performed.

The reference point used during Swap Items is controlled by the 9-point selection widget in the
Geometry Panel. For example, if the center point is selected in the Geometry Panel, the center source
and destination item positions are swapped. If the lower-left corner of the 9-point selector is chosen
instead, the lower-left corner positions of source and destination items are swapped.

Multiple destination items can be swapped by holding the Control key and left mouse button while
dragging the mouse to create a selection area. Once the mouse button is released, all items in the
selection area will be treated as destination swap items. This features allows you to quickly swap entire
groups of items without explicitly grouping them beforehand.

Zooming in Selection Tool
Shortcut: Control + Mouse Scroll Wheel

Description: You can quickly switch to the Zoom Tool to zoom in and out of the Artboard but if your
mouse has a scroll wheel it can be even faster to stay in the Selection Tool, hold down the Control key
and move the scroll wheel up and down to zoom in and out.

Scrolling Up and Down in Selection Tool
Shortcut: Mouse Scroll Wheel

Description: To move the Artboard up and down in Selection Tool move your mouse scroll wheel up and
down respectively.

Fit Item in View
Shortcut: Alt + Shift + Left Click

Description: If you hold the Alt and Shift keys and click on an item, the Artboard will automatically zoom
in fitting the item in the visible space. For example, if you want to zoom into a specific mark, hold down
Alt and Shift and click on the mark in the Selection Tool.

Entering Item Context
Shortcut: Double Click

Description: If you want to edit child items of another item, such as Repeat Marks within a Repeat
or Artwork within a Product, double click on the parent item(s) until you are in the desired context to
perform edits.

Leaving Item Context
Shortcut: Escape

Description: To quickly leave any item context and go back to the global context press the Escape key.
Note this also works for leaving Overlaps Tool Mode, Output Preview Mode and other context-based tool
modes.

2.13.3.  Hand Tool Shortcuts
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Hand Tool (h) works normally by holding down the left mouse button and dragging to move the Artboard
around. This is at times the most ecient way to move around.

Zooming in Hand Tool
Shortcut: Mouse Scroll Wheel

Description: You can quickly switch to the Zoom Tool to zoom in and out of the Artboard but if your
mouse has a scroll wheel you can also zoom in and out by moving the scroll wheel up and down.

Spacebar Shortcut
Shortcut: Hold down Spacebar key

Description: Hold down the spacebar at any time to temporarily switch to the Hand Tool. Once the
spacebar is released the previous tool will be restored. This shortcut allows you to pop into Hand Tool
to do fast navigation before continuing with your current tool without having to switch back and forth.

2.13.4.  Measure Tool Shortcuts

Measure Tool (m) works normally by holding down the left mouse button to start measuring, dragging
the cursor to the desired location and releasing the button to take a measurement at any angle. When
starting a measurement, the Measure Panel will appear automatically if not visible.

Forcing Horizontal or Vertical Measurements
Shortcut: Shift + Left Click + Mouse Drag

Description: Holding down the Shift key while taking measurements forces the measurement line to
be either horizontal or vertical depending on current cursor position. This is useful for measuring the
distance in a single dimension only.

2.13.5.  Cut Overlap Tool Shortcuts

 

 

Cut Overlap Tool (c) works in Overlap Tool Mode by drawing a line bisecting a given overlap. Start the
cut by holding the left mouse button and moving the cursor to the desired endpoint. Releasing the left
mouse button will perform the cut on the overlap closest to the start point of the line drawn.

Cutting All Same Overlaps at Once
Shortcut: Control + Left Click + Mouse Drag

Description: Holding down the Shift key while drawing the bisection line will cause the overlap cut
to extend to all other identical overlaps in the layout. For example if you have the cartons with the
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same flaps overlapping 20 times that all need to be cut before resolving, holding the Control key during
overlap cut will perform all 20 cuts at once.

2.13.6.  Zoom Tool Shortcuts

Zoom Tool (z) will zoom into the Artboard when left mouse button is clicked. Also you can zoom into a
defined area by holding down left mouse button, dragging the mouse to define the desired zoom area
and releasing the mouse button.

Zooming Out in Zoom Tool
Shortcut: Control + Left Click

Description: Holding down the Control key while clicking will zoom out slightly instead of zoom in.

2.13.7.  Creating Products from Artwork Shortcut

You can create new products from artwork files by using the File menu and selecting "New Product
from Artwork…" or by selecting the same action from the Products Panel action menu in the upper left
corner of panel.

Shortcut: Drag and Drop Artwork File

Description: Another way to quickly create a product from artwork is to drag and drop the artwork
file externally into Phoenix. A new product will be created with default values and die design set to
the Trim Box of the artwork. Also, if the artwork file contains exactly two pages, the second page is
automatically set to the back side artwork of the new product.

2.13.8.  Import Die Template Shortcuts

Die layouts can be imported normally by using the File menu and selecting "Import Die Template…" to
use the default import preset for the given CAD format defined in Preferences -> Die Import.

They can also be imported and placed into the current layout in a single action by selecting "Place Die
Template…" instead.

You can also import die layouts using the interactive Die Import Wizard to confirm line mappings,
choose a different import preset or define a new preset. To do this normally, select the "Import using
Die Import Wizard" and "Place using Die Import Wizard" options from the File menu.

Import actions are also accessible from the action menu in the Files panel (upper left corner).

Place Die Template Shortcut
Shortcut: Drag and Drop CAD File

Description: Dropping a die layout CAD file directly into Phoenix while in Layout View will import the
layout as a die template using the default import preset for the given CAD format and place it in the
current layout being viewed. If no default import preset is defined for the CAD format the Die Import
Wizard is launched.
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Place Using Die Import Wizard Shortcut
Shortcut: Control + Drag and Drop CAD File

Description: To force the Die Import Wizard to be used to import and place the CAD file, hold down the
Control key while dropping the file into Phoenix.

2.13.9.  Autosnap Shortcut

Autosnapping artwork into a product die or die template is one of the most powerful features in
Phoenix. Autosnap handles a wide range of scenarios such as mismatched rotation, non-centered
artwork, incorrect Trim Box sizes, etc., providing perfect placement of artwork in the product die for a
vast majority of cases.

The normal way to autosnap artwork into a die is by clicking on the Choose Artwork button in the
Product View or Layout View toolbar.

 

 

Shortcut: Control + Drag and Drop Artwork File

Description: A shortcut for snapping artwork into the die is to hold down the Control key while drag
and dropping the artwork file into the desired side (Front or Back) in Product View or in Layout View. If
Control key is not held down a new product will be created from the artwork.

When in Layout View, the artwork being dropped into Phoenix will be snapped into all selected product
or die template items in the Artboard. If all instances of a product are selected, artwork will be snapped
into the existing product. In cases where a subset of all product's instances are selected, the following
steps take place automatically:

1. A new product will be created using the name of the artwork file by duplicating the existing product.
2. The artwork will be autosnapped into this new product.
3. Selected product or template items in the Artboard will be replaced by instances of this new

product.

If you are drilled into the context of a product instance in Layout View, you are editing the product itself
and behavior is the same as in Product View.

Also note, if you are snapping to the Front of the product or template item and the given artwork has
two pages, the first page automatically snaps into the Front of the product while the second page
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snaps to the Back of the same product. If you need to snap different pages of the artwork file to the
given side(s) of a product, click on the Choose Artwork button down arrow to open the Page Mapping
dialog.

2.13.10.  Creating New Empty Product Shortcut

Shortcut: Control + Shift + N

Description: This shortcut opens the New Empty Product dialog where you can create a new product
by specifying width and height.

2.13.11.  Creating Non-Rectangular Product from Artwork Shortcut

Shortcut: Alt + Drag and Drop Artwork File

Description: In Phoenix, you can create products directly from artwork files. Additionally, in Product
View you can use the "Die Design from Inks…" or "Die Design from Layers…" option to create the
product die design directly from paths in the artwork.

Alternatively, you can perform both steps in one action by holding down the Alt key while dropping
artwork into Phoenix. As with normal drag and drop, a new product will be created from the artwork
using the file name as product name. The shortcut also causes the artwork spot ink and PDF layers
to be matched with line types using the Line Type Mappings defined in Preferences to create the die
design from the artwork, with inks and layers matching line types in the Cut category used to define the
die design shape.

2.13.12.  Assigning Product Group Marks Shortcut

By default, dropping a Group or Product Mark from the Marks Panel into Layout View will apply that
mark to all Group or Products in the current side of the layout respectively. You can assign a Group or
Product Mark to a specific Repeat item or specific Product by holding down the Control key.

Shortcut: Control + Drag and Drop Mark Item (in Layout View)

Description: Dropping Group or Product Marks into Layout View applies that mark globally to the
project. This means that mark will be in all current and future Groups/Products unless removed or
hidden explicitly within them. By using the Control key shortcut you can apply the smart mark to the
specific Repeat the cursor is under when releasing the mouse button in the case of Group Smart Marks
or, in the case of Product Smart Marks, you can apply the mark to the product that a product item
belongs too under the cursor. The mark will appear only in instances of the given product in the project.

2.13.13.  Assigning Product Mark to Single Product Item Shortcut

You can assign a Product Mark to one specific instance of a Product in a given layout by holding the Alt
key while dropping the mark into Layout View.

Shortcut: Alt + Drag and Drop Mark Item (in Layout View)
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Description: When the Alt key is held down while dropping a smart Product Mark into the Artboard
it will apply the mark only to the product item under the cursor. The mark will not be visible in other
product items belonging to the same product and is not applied to other products in the project.

This shortcut works by applying the mark to the product but turning on visibility of the mark only in the
single product item in the Artboard. This means you can turn visibility of that mark on in other product
items at any time. Note: Non-visible items are not included at export time.

This shortcut differs from the Assigning Product/Group Marks Shortcut where the mark becomes
visible across all product items in the project, not just the single item under cursor.

2.13.14.  Copying Library Items Shortcut

If you would like to make a copy of a library item (Press, Plate, Mark, Mark Set) you can right click on the
item and select "Duplicate". This makes a copy of the item in the same folder as the original. Now if you
want to move the copy to a different folder you can drag and drop the new item into the folder.

Shortcut: Control + Drag and Drop Item (into same panel)

Description: Pressing Control while dragging and dropping the original item will keep that item in place
while making a copy of the item. If you want to make a copy in the same folder make sure to keep the
cursor position within that folder. You can also move the cursor into a different folder to make the copy
directly into that destination folder.

2.13.15.  Rotate Items Shortcut

Rotate Items Shortcuts will rotate currently selected items in Layout View and Product View. When
multiple items are selected they will all be rotated in place.

Alt + Left Arrow Key (rotate 90 degrees counter-clockwise)

Alt + Right Arrow Key (rotate 90 degrees clockwise)

Alt + Up Arrow Key (rotate 180 degrees)

Alt + Down Arrow Key (rotate 180 degrees)

2.13.16.  Mark Inspection Mode Shortcut

Shortcuts: Control + Shift + M

Description: Enters Mark Inspection mode, which will highlight all the marks in Layout View, providing a
clear way to verify mark placement.
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3.  Automation Guide

3.1.  Automation in Phoenix

Phoenix offers an unprecedented level of automation for imposition, estimation, and planning tasks.
Most of the powerful features available in the desktop user interface of Phoenix are also available in
automation with the same level of control.

There are multiple ways of running automation in Phoenix depending on your needs:

• REST Service – The Phoenix REST web service is the most powerful and flexible way of automating
Phoenix with support from all modern programming languages. The REST API includes 125 different
methods automating nearly every feature in Phoenix, from imposition and planning to library
management. The service is fully documented with a live interactive web client and comprehensive
Open API (Swagger) documentation.

• Hot Folders – Phoenix hot folders features 35 actions covering a wide range of imposition and
planning tasks. Hot folders also include a powerful scripting interface giving you complete control
over what comes into the hot folders and how that data is processed.

• Switch Connector – Seamless integration with the popular Switch workflow solution from Enfocus
used together with the mature Phoenix configurator available within Switch itself, providing fine-
grained automation of the most powerful tool in Phoenix: Plan.

• CERM Connector – Connector to the popular CERM MIS system, providing tight integration with
Phoenix Plan tool from within CERM itself.

Requirements
Automation in Phoenix requires the Automate module. This module gives you access to all the
automation capabilities in Phoenix: REST Service, unlimited hot folders, Switch Connector, and CERM
Connector.

Since automation can be resource intensive, the system requirements are higher in a few areas when
running in an automated mode. 8 GB of memory and 4 CPU cores are required to run automation.

Running in Automated Mode
When running automation in Phoenix all jobs must be closed in the user interface to ensure the
necessary resources are available during automation.

In addition, only one type of automation can be run at a given time. For example, if the REST Service is
running, no hot folders can be started. Multiple hot folders can run at the same time as long as other
automation types are not running.
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3.2.  REST API

3.2.1.  Phoenix REST API Overview

 

 

The Phoenix REST web service is the most powerful and flexible way of automating Phoenix, with
support from all modern programming languages. The REST API includes hundreds of methods
automating nearly every feature in Phoenix, from imposition and planning to library management.
The service is fully documented with a live interactive web client and comprehensive Open API live
documentation.

Starting the REST Service
To use the REST API, open Phoenix and navigate to the Automate Panel. If it's not already visible, simply
go to the Window menu and choose Automate. From there, if the REST Service isn't listed, add it by
clicking the dropdown menu in the Automate Panel and choosing "Add REST Service."
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Right click on the REST Service entry in the Automation Panel and click "Start" to start the service.
Once the REST Service says "Running", it's up and ready to start receiving HTTP requests.

 

 

The service runs on port 8022 on the host system, however this is editable via the Edit option in the
right click menu. You can reach the service on any system that has access to this system and port on
the network, provided your network security settings and firewall are configured appropriately.

Simply access http://hostname:8022/phoenix in your web browser, where HOSTNAME is the hostname
or IP address of your computer.

Note:

Accessing Locally:

If you are accessing the service from the same computer you can use localhost as the
hostname, e.g.: http://localhost:8022/phoenix

418

http://hostname:8022/phoenix
http://localhost:8022/phoenix


3Phoenix

Note:

Auto Start:

If you would like the REST Service to start automatically when Phoenix launches, select "Auto
Start" from the context menu.

Live Documentation Page
To open the interactive documentation for the REST API in your default browser, start the REST
Service as described above and wait until Status has changed to "Started". Next, right click on the
REST Service entry again and click on "Live Documentation…"

 

 

The "Phoenix REST API" web page should appear in your browser. Click on an operation name to
expand. You can then fill in the JSON or XML to form a request along with parameters in the URL.
Clicking on "Trying it out!" will make the actual call to the REST Service at which point you will see the
response coming back. This is a great tool for testing and diagnostic purposes.

3.2.2.  REST API Examples

Below are example workflows that can be automated with the REST API.

The first two workflows, Impose and Plan, utilize the Imposition AI tools in the Jobs API. These tools
can be used for estimating cost as well as generating optimized print-ready layouts. The third workflow
shows how to add new stocks and sheets to the Phoenix library via the Libraries API

Phoenix Plan Example
The quickest way to get started with the Phoenix API is to use the 'Plan' endpoint to auto-generate
imposed layouts. The Plan Imposition AI tool will search across multiple press and sheet/roll
combinations to find the best overall job, which might have two or more layouts.

Plan does not require a sheet to be present in the job. Instead, the Plan operation accepts a list of
presses and sheets to be used in the evaulation of the most cost-effective imposed solution.

Step 1 - Create New Job

For the full list of available properties, see POST Job  in the API documentation.

419

https://docs.tilialabs.com/phoenix/automation/restAPI/api.html#post-/jobs


3 Phoenix

New Job

POST /jobs
{
  "id": "000123"
}

Important:  "id" is the only required property when creating a new job. Other properties can be
defined as well.

Job from template
To create a new job from an existing job template (PHXT) define the path of the template.

POST /jobs
{
  "id": "000123",
  "template": "/Users/tyler/Desktop/phoenixAPI/template-1.phxt"
}

Important:  If Phoenix is running on Windows OS, a backslash ("\") in the path requires an
escape character ("\\"). For example: C:\\Users\\tyler\\Desktop\\Phoenix\\jj-label.pdf

Step 2 - Add Products

For the full list of available properties, see POST Job  in the API documentation.

Empty Product
Create empty flat products by defining width and height

POST /jobs/000123/products
{
  "name": "Product-A",
  "ordered": 35000,
    "stock": "14pt Glossy",
  "width": "6in",
  "height": "4in",
  "bleed-margin": ".125in"
}

From Artwork
Create a product from artwork files directly

In this example the die shape is derived from the paths in the PDF if spot colors or layers match line
type mappings defined in Phoenix. If no paths match, then the PDF TrimBox or image size is used.

Phoenix will accept virtually any type of graphic file input (PDF, AI, TIFF, JPG, PNG, etc...)!

POST /jobs/000123/products
{
  "name": "Product-B",
  "ordered": 3500,
    "stock": "14pt Glossy",
  "artwork": "/Users/tyler/Desktop/phoenixAPI/artwork/jj-label.pdf",
  "bleed-margin": ".125in"
}
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Tip:  You can tell Phoenix to use the "dieshape-source" field to explicitly control how the die
shape is defined in the product. For example, if you set "dieshape-source" to ArtworkTrimbox it
will use the PDF TrimBox or image size regardless of line type mappings.

From CAD
Create a product from 1-up design in CAD file (CFF2, DDES, DXF)

The main difference here is the addition of the "cad-file" property in the body. When this property is
specified, Phoenix will use the specified CAD file as the source of the dieline. The artwork will be either
auto-snap (if inks exist in artwork) or center the artwork in the CAD shape when the product is created.

POST /jobs/000123/products
{
  "name": "Product-C",
  "ordered": 3500,
    "stock": "14pt Glossy",
  "cad-file": "/Users/tyler/Desktop/phoenixAPI/cad/quackers-carton.cf2",
  "bleed-margin": ".125in"
}

Tip:  When using a CAD file as the shape of the cutpath for the product, the spacing-margins
can still be utilized to determine the spacing required between products on the sheet.

From Die Design
Create a product from a 1-up design in your Phoenix Die Design library

You can import your die designs into the Die Design library in Phoenix and then reference them by their
name when creating products from the designs using the "die-design" field.

POST /jobs/000123/products
{
    "name": "Product-D",
    "ordered": 3500,
    "stock": "14pt Glossy",
    "die-design ": "CRTN-1158",
    "bleed-margin": ".125in"
}

Tip:  When using a Die Design as the shape of the cutpath for the product, the spacing-margins
can still be utilized to determine the spacing required between products on the sheet.

Advanced Product Options
Advanced properties that can be used to control the Plan results: Setting additional properties
during product creation allows you to have full control of how a product is imposed.

POST /jobs/000123/products
{
    "name": "Product-E",
    "ordered": 3500,
    "stock": "14pt Glossy",
    "artwork": "/Users/tyler/Desktop/phoenixAPI/artwork/jj-label.pdf",
    "marks": ["CODE128_PR_NAME", "PATCH"], // Pass a list of marks to attatch to the
 product
    "max-overruns": "10%", // Specify a max allowed overrun per product
    "min-overruns": "-10%", // Specify a min allowed overrun per product
    "spacing-type": "Margins", // Control gutters by specifying margins
    "spacing-margins": { // Set 0in to allow knife-to-knife
        "left": "0in",
        "top": "0in",
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        "right": "0in",
        "bottom": "0in"
    },
    "rotation": "None" // Control the allowed rotation per product
}

Important:  Notice the Job 'id' 000123 from Step 1 is being used in the URL.

Important:  If Phoenix is running on Windows OS, a backslash ("\") in the path requires an
escape character ("\\"). For example: C:\\Users\\tyler\\Desktop\\Phoenix\\jj-label.pdf

Tip:

As an alternative to creating products one-by-one directly with the API, you can create several
products in one shot by importing a CSV file describing each product using the CSV import API 
endpoint:

POST /jobs/000123/products/import/csv 
{
    "path": "/Users/tyler/Desktop/phoenixAPI/products-1.csv"
}

See lessons for examples on the standard CSV format in Phoenix. Alternatively, you can define
your own CSV format, create a corresponding preset in Phoenix, and reference this preset by
name using the "preset" field.

Step 3 - Run Plan

After all of the products have been successfully added to the job, run 'Plan' by specifying the
presses, stocks, and defining the settings to be used for the Plan tool. Keep in mind this endpoint is
asynchronous.

For the full list of available properties, see POST Plan in the API documentation.

Run Plan (simple)

POST /jobs/000123/plan/start
{
    "profiles": ["Default"],
    "presses": [
        "CD 102",
        "HP Indigo 10000",
        "HP Indigo 7900",
        "HP 7600",
    ],
    "sheets": [],
    "rolls": []
}

Run Plan (Advanced)
With the Plan endpoint, you can completely customize the Imposition AI Profile 'on-the-fly' to control
every aspect of the imposition algorithm.

POST /jobs/000123/plan/start
{
    "presses": [
        "CD 102",
        "HP Indigo 10000",
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        "HP Indigo 7900",
        "HP 7600",
    ],
    "stocks-inline": [
        {
            "name": "14pt Glossy"
        }
    ],
    "profiles-inline": [
        {
            "name": "Sequential",
            "strategies": {
                "horizontal-cut": "true",
                "vertical-cut": "false",
                "die-table-cut": "false",
                "free-nesting": "false",
                "grid-nesting": "false",
                "strip-nesting": "false",
                "horizontal-strip": "false",
                "vertical-strip": "false",
                "templates": "false"
            },
            "strip-options": {
                "strip-rule": "None",
                "template-rule": "None",
                "alignment": "TopLeft",
                "gutter": "0mm",
                "gutter-rule": "Always"
            },
            "layout-options": {
                "sheet-fill": "Min",
                "allow-bleed-in-gripper": "false",
                "user-derived-sheets": "false",
                "ordered-placement": {
                    "favor-ordered-placement": "true",
                    "start-corner": "BottomLeft",
                    "order-method": "HorizontalSnake"
                }
            },
            "plan-options": {
                "plan-mode": "Sequential",
                "allow-product-spanning": "true"
            }
        }
    ],
    "templates": []
}

Tip:  Leaving a list property empty ([]) (for example, 'sheets') tells Phoenix to test all applicable
sheet sizes in the Stocks library.

Important:  The Phoenix Plan endpoint will run the Plan algorithm searching legal
combinations of devices and sheet sizes until either all permuations are exhausted, a
maximum specified amount of time has lapsed (use the "stop-minutes" property to define the
max amount of time to run plan), or a manual stop occurs by using to the '/jobs/{projectid}/
plan/stop' endpoint.

Step 4 - Get Plan Status

Due to the ASYNC nature of the Plan tool, you can check the current status of Plan. The status will let
you know the current state of the Plan algorithm in real-time (data such as: number of results, lowest
waste percentage, lowest number of layouts).

You can also see how long plan has been running as well as view errors and/or warnings.
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For the full list of available properties, see GET Plan Status  in the API documentation.

GET /jobs/000123/plan/status 

Tip:  You can continue asking for the status of Plan to quickly understand the current lowest
cost result, lowest waste result, and the lowest number of layouts in a result.

Step 5 - Get Plan Results

Results will contain information on the quality of each plan generated by Plan as well as statistics on
each layout within the plan. Optionally, you can sort, paginate, and request additional details about the
Plan results such as thumbnails of the layouts, dielines, etc...

For the full list of available properties, see GET Plan Results  in the API documentation.

Get Plan Results (Simple)

GET /jobs/000123/plan/results 

Get Plan Results (advanced)

GET /jobs/000123/plan/results?limit=5&start=1&sorting=Cost&layouts=true&thumb=true&plan-
thumb=true&thumb-width=200&thumb-height=200&render-mode=Artwork

Tip:  See the GET Plan Results  for a full list of query parameters you can use to control the data
that is returned from this call.

Step 6 - Apply a Plan Result

After determining which Plan result you would like to use from the list of plan results, simply 'apply' the
specific Plan result index to the job.

For the full list of available properties, see POST Apply Plan in the API documentation.

Apply the first result

POST /jobs/000123/plan/result/1/apply

Apply the third result

POST /jobs/000123/plan/result/3/apply

Step 7 - Export Layout PDF Print File

After applying the result, you can export the PDF print file. Keep in mind the 'path' property is the full
unc path which needs to be accessible by the Phoenix computer.

For the full list of available properties, see POST Export PDF in the API documentation.

POST /jobs/000123/export/pdf
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{
  "path": "/Users/tyler/Desktop/phoenixAPI/000123_imposed.pdf"
}

Important:

When using a backslash ("\") in the path, don't forget to escape the backslash character with a
backslash ("\\"). For example: C:\\Users\\tyler\\Desktop\\Phoenix\\jj-label.pdf

Step 8 - Export Layout PDF Cut File

After applying the Plan result, you can export the PDF cut/die file. Keep in mind the 'path' property is
the full unc path which needs to be accessible by the Phoenix computer.

For the full list of available properties, see POST Export PDF in the API documentation.

POST /jobs/000123/export/die/pdf
{
  "path": "/Users/tyler/Desktop/phoenixAPI/000123_imposed_CUT.pdf"
}

Important:

When using a backslash ("\") in the path, don't forget to escape the backslash character with a
backslash ("\\"). For example: C:\\Users\\tyler\\Desktop\\PhoenixOutput\\imposed.pdf

Step 9 - Export JSON Report

After applying the Plan result, you can export a JSON Report file. This JSON report file provides all of
the details about the imposition plan (# of sheets, costing, overruns, etc...). This report can be used by
an external MIS or ERP system to eliminate production data entry.

Keep in mind the 'path' property is the full unc path which needs to be accessible by the Phoenix
computer.

POST /jobs/000123/export/report/json
{
  "path": "/Users/tyler/Desktop/phoenixAPI/000123_report.json"
}

Step 10 - Export Phoenix Job File

After applying the Plan result, you can save the job (PHX) file. The Phoenix job file is useful for when
additional 'manual' steps need to be performed using the Phoenix application.

For example, prepress may need to manually place a special sheet or product mark for the press.

POST /jobs/000123/save
{
  "path": "/Users/tyler/Desktop/phoenixAPI/000123.phx"
}

Tip:  Saving a Phoenix job file is also a good way to visualize results inside of Phoenix when
debugging API workflows.
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Step 11 - Close/Delete Job

DELETE /jobs/{jobid}

DELETE /jobs/000123

Important:  '{jobid}' is the only required url param when removing/deleting a job. In the above
example, the 'jobid' = '000123'

Important:  It is best practice to remove/delete the job after tasks are completed to alleviate
unnecessary memory consumption by the Phoenix API.

Phoenix Impose Example
The Impose algorithm is used to determine the most cost-effective Single** gang layout based on the
current list of products, a specified press, and a specified sheet size. The 'Impose' Imposition AI tool
differs from the 'Plan' Imposition AI tool as 'Plan' will return results containing potentially many layouts.

Using Impose is useful when you would like Phoenix to evaluate one or many products to be ran on one
single press run.

Step 1 - Create New Job

For the full list of available properties, see POST Job  in the API documentation.

New Job

POST /jobs
{
  "id": "000123"
}

Important:  "id" is the only required property when creating a new job. Other properties can be
defined as well.

Job from template
To create a new job from an existing job template (PHXT) define the path of the template.

POST /jobs
{
  "id": "000123",
  "template": "/Users/tyler/Desktop/phoenixAPI/template-1.phxt"
}

Important:  If Phoenix is running on Windows OS, a backslash ("\") in the path requires an
escape character ("\\"). For example: C:\\Users\\tyler\\Desktop\\Phoenix\\jj-label.pdf

Step 2 - Add Products

For the full list of available properties, see POST Product in the API documentation.
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Empty Product
Create empty flat products by defining width and height

POST /jobs/000123/products
{
  "name": "Product-A",
  "ordered": 35000,
    "stock": "14pt Glossy",
  "width": "6in",
  "height": "4in",
  "bleed-margin": ".125in"
}

From Artwork
Create a product from artwork files directly

In this example the die shape is derived from the paths in the PDF if spot colors or layers match line
type mappings defined in Phoenix. If no paths match, then the PDF TrimBox or image size is used.

Phoenix will accept virtually any type of graphic file input (PDF, AI, TIFF, JPG, PNG, etc...)!

POST /jobs/000123/products
{
  "name": "Product-B",
  "ordered": 3500,
    "stock": "14pt Glossy",
  "artwork": "/Users/tyler/Desktop/phoenixAPI/artwork/jj-label.pdf",
  "bleed-margin": ".125in"
}

Tip:  You can tell Phoenix to use the "dieshape-source" field to explicitly control how the die
shape is defined in the product. For example, if you set "dieshape-source" to ArtworkTrimbox it
will use the PDF TrimBox or image size regardless of line type mappings.

From CAD
Create a product from 1-up design in CAD file (CFF2, DDES, DXF)

The main difference here is the addition of the "cad-file" property in the body. When this property is
specified, Phoenix will use the specified CAD file as the source of the dieline. The artwork will be either
auto-snap (if inks exist in artwork) or center the artwork in the CAD shape when the product is created.

POST /jobs/000123/products
{
  "name": "Product-C",
  "ordered": 3500,
    "stock": "14pt Glossy",
  "cad-file": "/Users/tyler/Desktop/phoenixAPI/cad/quackers-carton.cf2",
  "bleed-margin": ".125in"
}

Tip:  When using a CAD file as the shape of the cutpath for the product, the spacing-margins
can still be utilized to determine the spacing required between products on the sheet.

From Die Design
Create a product from a 1-up design in your Phoenix Die Design library
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You can import your die designs into the Die Design library in Phoenix and then reference them by their
name when creating products from the designs using the "die-design" field.

POST /jobs/000123/products
{
    "name": "Product-D",
    "ordered": 3500,
    "stock": "14pt Glossy",
    "die-design ": "CRTN-1158",
    "bleed-margin": ".125in"
}

Tip:  When using a Die Design as the shape of the cutpath for the product, the spacing-margins
can still be utilized to determine the spacing required between products on the sheet.

Advanced Product Options
Advanced properties that can be used to control the Plan results: Setting additional properties
during product creation allows you to have full control of how a product is imposed.

POST /jobs/000123/products
{
    "name": "Product-E",
    "ordered": 3500,
    "stock": "14pt Glossy",
    "artwork": "/Users/tyler/Desktop/phoenixAPI/artwork/jj-label.pdf",
    "marks": ["CODE128_PR_NAME", "PATCH"], // Pass a list of marks to attatch to the
 product
    "max-overruns": "10%", // Specify a max allowed overrun per product
    "min-overruns": "-10%", // Specify a min allowed overrun per product
    "spacing-type": "Margins", // Control gutters by specifying margins
    "spacing-margins": { // Set 0in to allow knife-to-knife
        "left": "0in",
        "top": "0in",
        "right": "0in",
        "bottom": "0in"
    },
    "rotation": "None" // Control the allowed rotation per product
}

Important:  Notice the Job 'id' 000123 from Step 1 is being used in the URL.

Important:  If Phoenix is running on Windows OS, a backslash ("\") in the path requires an
escape character ("\\"). For example: C:\\Users\\tyler\\Desktop\\Phoenix\\jj-label.pdf

Tip:

As an alternative to creating products one-by-one directly with the API, you can create several
products in one shot by importing a CSV file describing each product using the CSV import API
endpoint:

POST /jobs/000123/products/import/csv 
{
    "path": "/Users/tyler/Desktop/phoenixAPI/products-1.csv"
}

See lessons for examples on the standard CSV format in Phoenix. Alternatively, you can define
your own CSV format, create a corresponding preset in Phoenix, and reference this preset by
name using the "preset" field.
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Step 3 - Assign Sheet to Job

For the full list of available properties, see POST Set Layout Sheet in the API documentation.

If you created an empty job or your job template did not include a sheet, you will need to assign a sheet
to the job before running Impose.

POST /jobs/000123/layouts/1/sheet 
{
  "stock": "14pt Glossy",
  "grade": "300 gsm",
  "name": "36 x 28\" Long"
}

Tip:  Notice a backslash ("\") in the 'name' property is required to escape the special character
(") in the name of the sheet

Step 4 - Assign Press to Job

For the full list of available properties, see POST Set Layout Press in the API documentation.

Now, you will need to assign a press to be used before running Impose.

POST /jobs/000123/layouts/1/press 
{
  "name": "CD 102"
}

Step 5 - Run Impose

For the full list of available properties, see POST Run Impose Tool in the API documentation.

Impose All Products

POST /jobs/000123/layouts/1/press 
{
  "name": "CD 102"
}

Impose Specific Products

POST /jobs/000123/impose/1
{
  "profiles": ["Default"],
  "products": ["ProductName1","ProductName1","ProductName3"],
  "templates": []
} 

Tip:  Leaving a list property empty ([]) (for example, 'products') tells Phoenix to Impose using all
available products in the job.

This will cause Phoenix to generate several ganged results for layout 1.
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Attention:  In addition to the Imposition AI profile, you can specify a subset of products from
the job to impose, as well as a subset of templates when using template-based ganging. You
can also have Phoenix stop running impose after a certain number of minutes using the "stop-
minutes" property.

Step 6 - Get Impose Results

For the full list of available properties, see GET Impose Results in the API documentation.

Results will contain information on the quality of each imposed result generated by the Impose tool
as well as statistics on each layout. Optionally, you can request thumbnails of the Impose results to
display renderings of the layout with artwork, dieline, or layout with randomized colors.

Get Impose Results (simple)

GET /jobs/000123/impose/1/results 

Get Impose Results (advanced)

GET /jobs/000123/impose/1/results?thumb=true&thumb-width=200&thumb-height=200&render-
mode=Artwork

Tip:  See the GET Impose Results for a full list of query parameters you can use to control the
data that is returned from this call

Step 7 - Apply an Impose Result

For the full list of available properties, see POST Apply Impose Result in the API documentation.

To apply an Impose result to the job, do the following:

Apply First Impose Result

POST /jobs/000123/impose/1/result/1/apply 

This will apply the first result from the results list to the job.

Apply Third Impose Result

POST /jobs/000123/impose/1/result/3/apply 

This will apply the third result from the results list to the job.

Step 8 - Export Layout PDF Print File

After applying the result, you can export the PDF print file. Keep in mind the 'path' property is the full
unc path which needs to be accessible by the Phoenix computer.

For the full list of available properties, see POST Export PDF in the API documentation.

POST /jobs/000123/export/pdf
{
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  "path": "/Users/tyler/Desktop/phoenixAPI/000123_imposed.pdf"
}

Important:

When using a backslash ("\") in the path, don't forget to escape the backslash character with a
backslash ("\\"). For example: C:\\Users\\tyler\\Desktop\\Phoenix\\jj-label.pdf

Step 9 - Export Layout PDF Cut File

After applying the result, you can export the PDF cut/die file. Keep in mind the 'path' property is the full
unc path which needs to be accessible by the Phoenix computer.

For the full list of available properties, see POST Export PDF in the API documentation.

POST /jobs/000123/export/die/pdf
{
  "path": "/Users/tyler/Desktop/phoenixAPI/000123_imposed_CUT.pdf"
}

Important:

When using a backslash ("\") in the path, don't forget to escape the backslash character with a
backslash ("\\"). For example: C:\\Users\\tyler\\Desktop\\PhoenixOutput\\imposed.pdf

Step 10 - Export JSON Report

After applying the result, you can export a JSON Report file. This JSON report file provides all of the
details about the imposition plan (# of sheets, costing, overruns, etc...). This report can be used by an
external MIS or ERP system to eliminate production data entry.

Keep in mind the 'path' property is the full unc path which needs to be accessible by the Phoenix
computer.

POST /jobs/000123/export/report/json
{
  "path": "/Users/tyler/Desktop/phoenixAPI/000123_report.json"
}

Step 11 - Export Phoenix Job File

After applying the result, you can save the job (PHX) file. The Phoenix job file is useful for when
additional 'manual' steps need to be performed using the Phoenix application.

For example, prepress may need to manually place a special sheet or product mark for the press.

POST /jobs/000123/save
{
  "path": "/Users/tyler/Desktop/phoenixAPI/000123.phx"
}

Tip:  Saving a Phoenix job file is also a good way to visualize results inside of Phoenix when
debugging API workflows.
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Step 12 - Close/Delete Job

DELETE /jobs/{jobid}

DELETE /jobs/000123

Important:  '{jobid}' is the only required url param when removing/deleting a job. In the above
example, the 'jobid' = '000123'

Important:  It is best practice to remove/delete the job after tasks are completed to alleviate
unnecessary memory consumption by the Phoenix API.

Managing Stocks Library
Stocks contain one or more grades which define thickness and/or weight. Each grade in turn contains
the lists of sheets and rolls that are available.

Step 1 – Create a New Stock
For this example, we will create a new stock called "Cougar Cover Cream Uncoated" and add three sheet
sizes for this stock to the library.

For the full list of available properties, see POST Add Stocks in the API documentation.

POST /libraries/stocks 
  {
    "name": "Cougar Cover Cream Uncoated",
    "description": "Description of stock",
    "notes": "Additional Notes",
    "external-id": "A reference ID to link to external databases",
    "vendor": "Cougar",
    "grades": [
        {
            "caliper": "18pt",
            "name": "130# Cover",
            "weight": "130",
            "weight-units": "Lb",
            "weight-type": "Cover",
            "sheets": [
                {
                    "dimension1": "40in",
                    "dimension2": "28in",
                    "cost": "1670",
                    "cost-units": "Per1000Lb",
                    "grain": "Long"
                },
                {
                    "dimension1": "29in",
                    "dimension2": "20in",
                    "cost": "1660",
                    "cost-units": "Per1000Lb",
                    "grain": "Long"
                },
                {
                    "dimension1": "19in",
                    "dimension2": "13in",
                    "cost": "1660",
                    "cost-units": "Per1000Lb",
                    "grain": "Long"
                }
            ]
        }
    ]
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  } 

Upon success this call returns the URL of the newly created stock which contains the auto-generated
ID.

RESPONSE
{
    "type": "responseEntity",
    "success": true,
    "status-code": 200,
    "errors": [],
    "warnings": [],
    "resources": [
        "http://localhost:8022/phoenix/libraries/v2/stocks/704a1cee-46c7-4ba7-be2f-
adc19611d4ea"
    ]
}

Step 2 – Add a New Sheet Size
It is common for your business system (MIS or ERP System) or stock inventory management system to
add a new sheet size or change the stock pricing for a certain vendor. Let's see how we can update a
stock to make Phoenix aware of changes from an external system.

For this example, we will add a new sheet size (40" x 26") to the stock we created above in Step 1 called
"Cougar Cover Cream Uncoated".

Below you can see we are passing the stock 'id' (704a1cee-46c7-4ba7-be2f-adc19611d4ea) from the
Step 1 response when we initially added the stock (PUT /libraries/v2/stocks/704a1cee-46c7-4ba7-
be2f-adc19611d4ea). When updating the stock, pass the most recent information from the business
system to update the stock. In our case, you can see we added a new sheet size in the 'sheets' list (40" x
26").

For the full list of available properties, see PUT Stocks in the API documentation.

PUT /libraries/v2/stocks/704a1cee-46c7-4ba7-be2f-adc19611d4ea 
{
  "name": "Cougar Cover Cream Uncoated",
  "description": "Description of stock",
  "notes": "Additional Notes",
  "external-id": "A reference ID to link to external databases",
  "vendor": "Cougar",
  "grades": [
      {
          "caliper": "18pt",
          "name": "130# Cover",
          "weight": "130",
          "weight-units": "Lb",
          "weight-type": "Cover",
          "sheets": [
              {
                  "dimension1": "40in",
                  "dimension2": "28in",
                  "cost": "1670",
                  "cost-units": "Per1000Lb",
                  "grain": "Long"
              },
              {
                  "dimension1": "29in",
                  "dimension2": "20in",
                  "cost": "1660",
                  "cost-units": "Per1000Lb",
                  "grain": "Long"
              },
              {
                  "dimension1": "19in",
                  "dimension2": "13in",
                  "cost": "1660",
                  "cost-units": "Per1000Lb",
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                  "grain": "Long"
              },
              {
                  "dimension1": "40in",
                  "dimension2": "26in",
                  "cost": "1660",
                  "cost-units": "Per1000Lb",
                  "grain": "Long"
              }
          ]
      }
  ]
  } 

Step 3 – Remove a Stock from Library

Note:  ## Note you use the stock ID returned from step 1 to refer to the stock and grade in the
URL.

For the full list of available properties, see DELETE Stocks in the API documentation.

DELETE /libraries/v2/stocks/704a1cee-46c7-4ba7-be2f-adc19611d4ea 

Tiling Graphics Example
In this tiling example, we are asking Phoenix to auto-generate horizontal tiles that will be less than or
equal to the maximum width of our roll material (60") so that the resulting print files will fit properly on
the roll material. In the example below, we will use the API to generate the horizontal tiles, while setting
the vertical tiling to None (typical use-case from our roll-based printers).

Step 1 - Create new Project
Create a new Phoenix project by posting an id to the endpoint.

You will use the ID in the upcoming calls to reference back to your project when adding products,
nesting, and exporting.

POST /jobs
{
     "id":"Project Name" 
}

"id" is the only required property when creating a new project. Other properties can be defined as well.
See API Swagger documentation (http://localhost:8022/) Method: POST

Step 2 – Add a tiled product to the job
For each tiled product, create an associated product in the Phoenix project. Specify the width, height,
artwork path, and tiling settings of the product. You can set different tiling setups for horizontal and
vertical tiling. In our example, we are asking Phoenix to autogenerate tiles that are less than or equal
to the maximum width of our roll material (60") and setting the vertical scale to None (typical use-case
from our roll-based printers)

POST /jobs/{projectid}/products
{
"name": "Tiled Product 1",
"type": "Tiled",
"ordered": "1",
"stock": "Roll",
"width": "90in",
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"height": "70in",
"rotation": "Orthogonal",
"bleed-type": "Margins",
"bleed-margins": {
    "bottom": ".125in",
    "left": ".125in",
    "right": ".125in",
    "top": ".125in"
},
"min-overruns": "0",
"max-overruns": "0",
"marks": [],
"tiling": {
    "type": "StandardTiling",
    "start": "Top Left",
    "order": "Snaking Horizontal",
    "horizontal-rule": {
        "type": "FixedSize",
        "size": 4320
    },
    "horizontal-method": {
        "type": "Overlap",
        "overlap-rule": "Top",
        "overlap": 72
    }
},
"front-inks": ["C","M","Y","K"],
"back-inks": ["C","M","Y","K"]
}

Tip:  It's good to point out the tiles entity (tile size & tile overlap values) uses points (1 inch == 72
points).

When creating tiled products, you can specify a specific number of tiles and Phoenix will automatically
compute the tile sizes.

You can also pass a customized list of tiles for Phoenix to use when generating tiles. For example, you
can pass the X,Y cordinates to precisely define the tiles that Phoenix will produce.

Step 3 – Run Plan
After all of the products have been successfully added to the job, run 'Plan' by specifying the
presses, stocks, and defining the settings to be used for the Plan tool. Keep in mind this endpoint is
asynchronous.

The Phoenix Plan endpoint will run the Plan algorithm searching all legal combinations of devices and
sheet sizes until either all permuations are exhausted, a maximum specified amount of time has lapsed
(use the "stop-minutes" property to define the max amount of time to run plan), or a manual stop occurs
by using to the '/jobs/{projectid}/plan/stop' endpoint.

POST /jobs/{{projectId}}/plan/start
{
 "presses": [
  "HP Latex 3100"
 ],
"profiles-inline": [
    {
        "name": "Roll Nesting",
        "strategies": {
            "horizontal-cut": "true",
            "vertical-cut": "false",
            "die-table-cut": "false",
            "free-nesting": "false",
            "grid-nesting": "false",
            "strip-nesting": "false",
            "horizontal-strip": "false",
            "vertical-strip": "false",
            "templates": "false"
        },
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        "strip-options": {
            "strip-rule": "None",
            "template-rule": "None",
            "alignment": "TopLeft",
            "gutter": "0mm",
            "gutter-rule": "Always"
        },
        "layout-options": {
            "sheet-fill": "Min",
            "allow-bleed-in-gripper": "false",
            "user-derived-sheets": "false",
            "ordered-placement": {
                "favor-ordered-placement": "true",
                "start-corner": "BottomLeft",
                "order-method": "HorizontalSnake"
            }
        },
        "plan-options": {
            "plan-mode": "Sequential",
            "allow-product-spanning": "true"
        }
    }
],
"templates": [
]
}

Step 4 – Get Plan status

GET /jobs/{{projectId}}/plan/status

Due to the ASYNC nature of the Plan tool, it may be required to check the current status of Plan. The
status will let you know the current 'state' of the Plan algorithm in real-time. You can see how long plan
has been running as well as view errors or warnings.

By creating a loop, you can continue asking for the status of Plan to quickly understand the current
lowest cost result, lowest waste result, and the lowest number of layouts in a result.

Step 5b. – Stop plan tool if currently running (if needed)
To manually STOP the Plan algorithm in a specific Phoenix job, simply call this endpoint to STOP Plan at
its current state.

/jobs/{{projectId}}/plan/stop

Step 5a. – Get list of most recent results

Method: GET
/jobs/{{projectId}}/plan/results?
limit=5&start=1&sorting=Cost&layouts=true&thumb=true&plan-thumb=true&thumb-
width=200&thumb-height=200&render-mode=Artwork

Results will contain information on the quality of each plan generated by Plan as well as statistics on
each layout within the plan.

You can limit the results, sort results, and ask for thumbnails of the results to display in your
application for the end-user.

See the Live Documentation for a full list of query parameters you can use to control the data that is
returned from this call.

Query Params
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Param value

limit 5

start 1

sorting Cost

layouts true

thumb true

plan-thumb true

thumb-width 200

thumb-height 200

render-mode Artwork

Step 6 – Apply a Plan result
After determining which Plan result you would like to use, simply 'apply' the specific Plan result to the
job by doing the following:

POST /jobs/{{projectId}}/plan/results/1/apply

This will apply the first result from the Plan results list of the job. Before applying a result, use sorting
params in the GET request to determine the best result to apply.

The first result is not always the "best" result, it is important to iterate through the results to apply the
result that fits your need.

To apply the third Plan result from the Plan results list, make a POST call to the endpoint POST /jobs//
plan/results/3/apply Method: POST

{{baseUrl}}/jobs/01234567/plan/results/1/apply

Step 7 – Get all products of current project

GET /jobs/{{projectId}}/products?thumb=false&thumb-width=200&thumb-height=200&render-
mode=Colors 

After applying the Plan result, you can GET the products in the job to pull information about the product
such as number of times the product is placed on the layout and the layout index (if multiple layouts are
created by Plan) for which the product is imposed on.

See the Live Documentation for a full list of query parameters you can use to control the data that is
returned from this call.

Query Params

Param value

thumb false

thumb-width 200

thumb-height 200

render-mode Colors
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Step 8 – Export the layout PDF print file
After applying the Plan result, you can export the PDF print file. Keep in mind the 'path' property is the
full unc path which needs to be accessible by the Phoenix computer.

POST phoenix/jobs/{{projectId}}/export/pdf
{
  "path": "D:\\Users\\tyler\\Desktop\\PhoenixDebug\\{{projectId}}_PRINT.pdf"
}

When using a backslash ("\") in the path, don't forget to escape the backslash character with a
backslash ("\\"). For example: C:\\Users\\tyler\\Desktop\\PhoenixOutput\\imposed.pdf

Step 9 – Export the layout PDF Cut file
After applying the Plan result, you can export the PDF cut file. Keep in mind the 'path' property is the full
unc path which needs to be accessible by the Phoenix computer.

POST phoenix/jobs/{{projectId}}/export/die/pdf
{
  "path": "D:\\Users\\tyler\\Desktop\\PhoenixDebug\\{{projectId}}_CUT.pdf"
}

When using a backslash ("\") in the path, don't forget to escape the backslash character with a
backslash ("\\"). For example: C:\\Users\\tyler\\Desktop\\PhoenixOutput\\imposed.pdf Method: POST

Step 10 – Export Phoenix Project File
From here you can save the project (PHX) file.

POST /jobs/{{projectId}}/save
{
  "path": "D:\\Users\\tyler\\Desktop\\PhoenixDebug\\{{projectId}}.phx"
}

Step 11 – Export Tiling Installation Report
Phoenix will auto-generate a tiling report PDF for installation purposes. This can be used for installers
to know the order/sequence of the tiles that have been shipped.

POST /jobs/{{projectId}}/save
{
  "path": "D:\\Users\\tyler\\Desktop\\PhoenixDebug\\{{projectId}}_InstallReport.pdf"
}

Step 12 – Close the Phoenix job

DELETE /jobs/{{projectId}}

"{projectId}" is the only required url param when removing/deleting a job.
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It is best practice to remove/delete the job after tasks are completed to alleviate unnecessary memory
consumption by the Phoenix API.

3.2.3.  REST API Live Docs (Open API)

The REST API Live Docs (Open API) can be found here

3.3.  Hot Folders

Hot Folders automation allows you to drive Phoenix without human interaction using input and output
folders. A total of 35 actions are available, supporting several workflows in Phoenix including die
template, artwork imposition and the powerful Imposition AI tools: Impose, Populate, Optimize, and
Plan. In addition, all export and report formats found in Phoenix are supported.

Hot folders are driven by XML files. In addition, scripting is available using a pre-defined JavaScript
interface to support non-XML inputs (PDF, CSV, etc), custom logic, notifications for success and error
cases, and much more.

Real-time activity for each hot folder can be monitored with Hot Folder View. This view displays a list
of log messages detailing all actions that have taken place as well as an overview of all successful and
failed jobs. Search filtering is available to find jobs with specific IDs, log entries related to specific
actions, and more

3.3.1.  Configuring Hot Folders

Hot folders are created, edited and removed in the Automate Panel. To access the Automate Panel,
go to the Windows menu and select "Automate". The Automate Panel shows all hot folders you have
created and shows status, processed task and error counts.

To create a new hot folder, click on the dropdown icon in the upper-left corner of the Automate Panel
and select "New Hot Folder..." from the menu. For detailed info on the parameters for setting up a hot
folder, see the Automate on page 183 section of the User Guide.

To edit hot folder settings, the hot folder must first be stopped. Next, right click on the hot folder in the
Automate Panel and select "Edit...". This will launch the Hot Folder Dialog where changes can be made
to any parameter of the hot folder.

If you made changes to the Actions XML or Script file and want to reload them, you can do so by editing
the hot folder and re-loading. Alternatively, you can just right click on the hot folder in the Automate
Panel and select "Reload Actions/Script" which will reload the files in one step.

Hot Folder View
Overview: For each hot folder you can get a real-time activity view by entering Hot Folder View. To
enter Hot Folder View, double click on the hot folder in the Automate Panel or right click on the hot
folder and select "Hot Folder View".

Hot Folder View is opened in the Artboard as a separate tab. This means you can open multiple Hot
Folder Views simultaneously and switch between them and active jobs by using the Artboard tabs.
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Main Log: Within Hot Folder View, the main list of log entries takes up the right side of the view. Logs
are updated in real time. Log entries containing paths are hyperlinked to quickly open the file. This is
especially useful for export or report actions and the Save Job action where clicking on the saved job
path will open the job directly in Phoenix.

Search: Above the log table is a Search text box. Entering text into the Search box and pressing enter
will filter the list of log entries to those entries containing the search text. To clear search and view all
log entries again, click the 'X' icon on the far-right side of the Search text box.

Tasks List: In the upper left panel of Hot Folder View is the Tasks List. This is a high-level view of the
tasks that completed with success or errors. Double clicking on a task in this list will filter the log
entries to logs generated by this task.

Actions List: In the lower left panel of Hot Folder View is a list of all actions in the Hot Folder. Double
clicking on an action in this list will filter the log entries to logs related to the given action.

Starting/Stopping Hot Folders
To start or stop a hot folder, right click on the hot folder in the Automate Panel and select "Start" or
"Stop" respectively. You can also click on the start or stop icons in the upper-left corner of Hot Folder
View for the given hot folder. For starting or stopping all hot folders, click on the dropdown icon in the
upper-left corner of the Automate Panel and select "Start All" or "Stop All" respectively.

3.3.2.  How Hot Folders Work in Phoenix

There are two related concepts at the heart of hot folders: actions and resources.

Actions define what a hot folder does. Actions are described in an Actions XML file that is associated
with the hot folder at setup time. This means the same list of actions is performed for each task
coming through the hot folder.

Note:  For the list of available actions, please see Actions on page 444

Resources define the inputs and outputs of the actions. A Resources XML file is dropped into the
hot folder to kick off new work when the hot folder is running. This file can contain job ID, paths of
file(s) to import, presses, marks, export paths, preset names and more. Resources have a one-to-one
relationship to the actions defined in the hot folder Actions XML file. Alternatively, resources can be
built up programmatically using the scripting interface to support virtually any format as input to the
hot folder.

For each action, there is a corresponding resource. In XML, the corresponding resource element for a
given action always appends "-resource" to the action element name.

For example, in the Create Job action, the XML element name for the action is "<create-job>". The
corresponding resource element name is "<create-job-resource>".

3.3.3.  Defining Resources

Resources for actions can be specified a number of different ways:

Defined entirely in the Resources XML coming into the hot folder
For Import Product CSV action, the corresponding XML will look something like this:
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Actions XML:

<import-product-csv id="4" />

Resources XML:

<import-product-csv-resource idref="4">
    <preset>MIS X Preset</preset>
    <path>/Users/user1/products.csv</path>
</import-product-csv-resource>

Partially defined in the Actions XML file
This is useful when certain parameter(s) of an action's resource are static and others are dynamic.
For example, if the same preset is always used in our Import Product CSV example but the input path
changes, the corresponding XML can look something like this to avoid always specifying preset name
in the Resources XML file:

Actions XML:

<import-product-csv id="4">
    <import-product-csv-resource>
        <preset>MIS X Preset</preset>
    </import-product-csv-resource>
</import-product-csv>

Resources XML:

<import-product-csv-resource idref="4">
    <path>/Users/user1/products.csv</path>
</import-product-csv-resource>

Wholly defined in the Actions XML file itself
This is useful for actions that do not change parameters from job to job. For example if you are always
using the same press, "B1 Press" on every job in the hot folder you can define the press in the Actions
XML. At that point you do not need a corresponding resource in the Resources XML.

Actions XML:

<set-press id="2">
    <set-press-resource>
        <name>B1 Press</name>
    </set-press-resource>
</set-press> 

Wholly or partially defined in Javascript code.
Using the scripting interface of hot folders, you can build up the list of resources programmatically,
giving you more dynamic control and the ability to support file formats other than Resources XML such
as PDF/AI/TIFF, CSV, etc. The returned list of resources is merged with any resources defined in the
Actions XML in the same way as using the Resources XML directly, so only dynamic parameters need to
be defined in your scripts.

// Create list of resources for this task
var resources = []; 
var createJob = new CreateJobResource(1);
createJob.id = filename;
createJob.notes = "Hot Folder " + date;resources.push(createJob);
…
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return resources; 

Combining Resources
When an action's resource is defined in both the Actions XML and in the incoming Resources XML, the
resource is combined. In the example B) in the previous section, the hot folder will take the preset "MIS
X Preset" defined in the Actions XML and the path from the Resources XML and perform the import
action with both these parameters.

In cases where the same parameter is defined in the Actions XML and the incoming Resources XML,
the Resources XML value is used. This is useful if you want to define default values in the Actions XML
that can be optionally overridden on-the-fly in the Resources XML file.

Mapping Resources to Actions
Since each action has a unique resource type, resources defined in incoming Resources XML files are
simply mapped to the corresponding action in the Actions XML by default.

On top of this, you can optionally define IDs to correlate actions and resources. While not required, it
is recommended to use IDs since mapping is explicit. Also, several actions can be defined more than
once in an Actions XML file (e.g. Apply Mark action) so using IDs removes ambiguity in the mapping
process.

For ID mapping, you start by assigning unique ID numbers to the actions you define in the Actions XML.
Each action XML element has an optional "id" attribute for this purpose:

<create-job id="1">
...

Each resource XML element has an optional "idref" attribute that refers to the corresponding action's
ID.

<create-job-resource idref="1">
…

Note:  For resources defined with the action in the Actions XML file, the idref attribute is
ignored since the resource is always associated with its parent action in that case.

3.3.4.  Actions XML Format

Actions XML file is a standards compliant XML 1.0 file. When not specified, the default character set is
assumed to be UTF-8. Please refer to the Actions XML schema file included with this documentation
for the formal definition of the Actions XML format.

Note:  For the list of available actions, please see Actions

All Actions XML files have the following structure where "action1" through "actionN" elements are
replaced with valid actions defined in Section 4 below:

<?xml version="1.0" encoding="UTF-8"?>
<phoenix-actions version="1.0">
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    <action1 id="1">...</action1>
    ... 
    <actionN id="N">...</actionN>
</phoenix-actions> 

Action Order: When automating jobs, actions are run in order from top to bottom. The first action in
the Actions XML file must always be the Create Job action, i.e. <\create-job>.

File Type: The input file type in hot folders is an XML resource file by default, but you can configure the
hot folder to expect a different format such as PDF or CSV. Most often this is used in conjunction with
scripting to convert incoming files to a list of resources. See the Scripting section for more details. In
these scenarios, you need to add the "file-type" attribute to the <\phoenix-actions> and specify the file
extension of the input file. For example, if the incoming file is CSV, the <\phoenix-actions> element will
look like this:

<phoenix-actions version="1.0" file-type="csv"> 

3.3.5.  Resources XML Format

As with Actions, the Resources XML file is a standard XML 1.0 file with default character set of UTF-8.
Please refer to the Resources XML schema file included with this documentation for the formal
definition of the Resources XML format.

All Resources XML files have the following structure where "action1-resource" through "actionN-
resource" elements are replaced with valid resources defined in Section 4 below corresponding to the
actions defined in the Actions XML for the given hot folder.

<?xml version="1.0" encoding="UTF-8"?>
<phoenix-resources version="1.0">
    <action1-resource idref="1">...</action1-resource>
    ...
    <actionN-resource idref="N">...</actionN-resource>
</phoenix-resources> 

Output Paths in Resources
Output file paths for job save, export, and report actions can be an absolute path like:

<path>/Users/prepress/job-1023/imposed.pdf</path> 

If an Output Folder has been specified in the hot folder, relative paths are also supported. Relative
paths will based off of the Output Folder. For example, if the Output Folder is /Users/prepress and the
Export PDF action resource path is:

<path>job-1023/imposed.pdf</path> 

Then the PDF will be exported to the path:

/Users/prepress/job-1023/imposed.pdf 

Library Names in Resources
Library names in resources such as presses or marks are folder based. If the library item being
referenced is in a folder or sub-folder, the folders are listed with '/' path separator.
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For example, the 'CAL 4C SLUR' mark is in the Calibration folder within the Defaults folder.

In the Apply Mark action resource XML, it's library name would look like this:

<apply-mark-resource>
    <name>Defaults/Calibration/CAL 4C SLUR</name>
</apply-mark-resource>  -->

3.4.  Actions

Below is a list of all actions that can be automated using hot folders and their corresponding resources.
All fields are optional unless otherwise indicated in the field description.

3.4.1.  Opening/Creating Jobs

A new job can be created or an existing job can be opened in hot folders. One of these actions must be
the first action defined in the Actions XML file.

Create Job Action
Description: Creates a new job

XML Element: <create-job>

Resource Format:

<create-job-resource><id>Job ID</id> ID of job to create
    <name>Job Name</name> Name of job to create
    <template-path>Path</template-path> Path of PHXT template to create job with
    <contact>Contact</contact> Name of contact person
    <phone>Phone</phone> Phone number of contact person
    <client>Client</client> Client name
    <notes>Notes</notes> Job notes
    <default-bleed>Scalar</default-bleed> Default product bleed offset
    <units>Units</units> Units of job, defaults to preferences
</create-job-resource>

Note:  Using job templates via the <template-path> element can be a powerful way of creating
jobs. Phoenix templates (PHXT) can include everything in a job except artwork. For example,
new jobs with imported CAD layouts, resolved bleed overlaps, pre-defined media, properties,
marks, etc. can be loaded in this single action using templates.

Open Job Action
Description: Opens an existing job

XML Element: <open-job>

Resource Format:

<open-job-resource><path>Path</path> Path of the PHX job to be opened (required)
    <id>ID</id> ID to give to the opened job
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</open-job-resource>

3.4.2.  Adding and Editing Layouts

Add Layout Action
Description: Adds a layout to the job

XML Element: <add-layout>

Resource Format:

<add-layout-resource><name>Name</name> Optional layout name, when specified overrides
 default name
</add-layout-resource>

Edit Layout Action
Description: Edits properties of an existing layout in the job

XML Element: <edit-layout>

Resource Format:

<edit-layout-resource><name>Name</name>Optional layout name, when specified edits the
 current layout name
    <workstyle>Workstyle</workstyle> Workstyle of layout, when specified changes current
 layout workstyle: FlatWork, Sheetwise, or Perfecting
    <run-length>Run length</run-length> Layout run length, when specified overrides the
 current layout run length 
</edit-layout-resource>

3.4.3.  Setting Media

The "Hot Folders" module offers three actions for setting media in a job: Set Press, Set Plate, and Set
Sheet.

Set Press Action
Description: Sets the press to use in the job layout

XML Element: <set-press>

Resource Format:

<set-press-resource><name>Press Name</name> Name of press in Press Library (required)
</set-press-resource>

Note

If the press referenced has default plate and/or sheet defined, the plate or sheet will be added to the
layout automatically. This is the same behavior as dragging and dropping the press into a layout within
Phoenix.

Set Plate Action
Description: Sets the plate to use in the job layout
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XML Element: <set-plate>

Resource Format:

<set-plate-resource><name>Plate Name</name> Name of plate in Plates Library (required)
</set-plate-resource>

Set Sheet Action
Description: Sets the sheet to use in the job layout

XML Element: <set-sheet>

Resource Format:

<set-sheet-resource><stock>Stock Name</stock> Stock name in Stocks Library (required)
    <grade>Grade Name</grade> Grade name within that Stock (required)
    <name>Sheet Name</name> Sheet name within that Grade (required)
</set-sheet-resource

Resize Sheet Action
Description: Resizes the current sheet in the job layout

XML Element: <resize-sheet>

Resource Format:

<resize-sheet-resource><width>Sheet width</width> New width of current layout sheet
 (required)
    <height>Sheet height</height> New height of current layout sheet (required)
</resize-sheet-resource>

3.4.4.  Adding Products

There are two actions for adding new products to the job: Add Products and Import Product CSV.

Add Products Action
Description: Adds variable number of products to the job defined in the corresponding resource

XML Element: <add-products>

Resource Format:

<add-products-resource><products> (required)
        <product> (required)
          <name>Product Name</name> Name of product to create (required) 
          <ordered>Number</ordered> Ordered amount of product
          <stock>Stock Name</stock> Name of stock product is to be printed on
          <grade>Grade Name</grade> Name of grade product is to be printed on 
          <grain>Direction</grain> Grain direction: Horizontal, Vertical, None
          <rotation>Rotation</ rotation> Rotation type to allow in product: An,
 Orthogonal, None, or Custom
          <allowed-rotations>Rotations</allowed-rotation> List of custom rotations to
 allow
          <width>Scalar</width> Width of product (empty product or scaling)
          <height>Scalar</height> Height of product (empty product or scaling)
          <artwork>Path</artwork> Path of artwork file to use to create product or snap
 into product if die defined
          <page>Number</page> Page number of artwork file to use forfront of product,
 defaults to page 1 
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          <back-artwork>Path</back-artwork> Path of artwork file to use for back of
 product
          <back-page>Number</back-page> Page number of artwork file to use forback of
 product, defaults to page 1
          <group>Group Name</group> Group that the product belongs to
          <front-inks> Inks to use for front of product
            <ink>Ink Name</ink> First Ink (required)
            <ink>...</ink> Additional Ink(s) 
          </front-inks><back-inks> Inks to use for back of product
            <ink>Ink Name</ink> First Ink (required)
            <ink>...</ink> Additional Ink(s) 
          </back-inks><due-date>Date</due-date> Product due date
          <priority>Priority</priority> Optional priority of product 1 being highest
          <dieshape-source>Source</dieshape-source> Dieshape source: CAD, ArtworkPaths,
 ArtworkTrimbox, CustomSize, DieDesignLibrary
          <cad-file>Path</cad-file> Path of CAD file to use when defining product based
 on 1-up design in a CAD file
          <cad-design>Design Name</cad-design> Design name of 1-up CAD design in the CAD
 file, defaults to first 1-up in the CAD file when not defined
          <die-design>Design Name</die-design> Design name of 1-up design in the die
 designlibrary
          <spacing-type>Type</spacing-type> Spacing Type: Margins, Uniform, Bleed
          <spacing-margin>Scalar</spacing-margin> Single scalar margin when type is
 Uniform 
          <spacing-margins> Spacing margins when type is Margins
            <left>Scalar</left> Left spacing margin
            <top>Scalar</top> Top spacing margin
            <right>Scalar</right> Right spacing margin
            <bottom>Scalar</bottom> Bottom spacing margin
          </spacing-margins><bleed-type>Type</bleed-type> Bleed Type: Margins, Contour,
 CAD, None
          <bleed-margin>Scalar</bleed-margin> Single scalar margin when type is Contour
          <bleed-margins> Bleed margins when type is Margins
            <left>Scalar</left> Left bleed margin
            <top>Scalar</top> Top bleed margin
            <right>Scalar</right> Right bleed margin
            <bottom>Scalar</bottom> Bottom bleed margin
          </bleed-margins><offcut-margins> Offcut margins
            <left>Scalar</left> Left offcut margin
            <top>Scalar</top> Top offcut margin
            <right>Scalar</right> Right offcut margin
            <bottom>Scalar</bottom> Bottom offcut margin
          </offcut-margins><min-overruns>Number</min-overruns> Minimum percentage of
 overruns
          <max-overruns>Number</max-overruns> Maximum percentage of overruns
          <bundle-size>Number</bundle-size> Product bundle size, i.e. the allowed
 multiples of the product that can be produced 
          <description>Description</description> Product description
          <notes>Notes</notes> Product notes
          <marks> Optional product marks to apply to this product
            <mark>Mark name</mark> First mark to apply
            <mark>…</mark> Additional marks to apply
          </marks><templates> List of templates to restrict this product to
            <template>Template name</template> First template
            <template>…</ template> Additional templates
          </templates ><autosnap-ink>Ink Name</autosnap-ink> Spot ink name to use for
 autosnap in imported artwork
          <back-autosnap-ink>Ink Name</back-autosnap-ink> Spot ink name to use for
 autosnap on back of imported artwork
          <autosnap-layer>Layer Name</autosnap-layer> PDF layer name to use for autosnap
 in imported artwork
          <back-autosnap-layer>Layer Name</back-autosnap-layer> PDF layer name to use for
 autosnap on back of imported artwork
          <cut-ink>Ink Name</cut-ink> Spot ink name to use for cut lines in Imported
 artwork (deprecated)
          <crease-ink>Ink Name</crease-ink> Spot ink name to use for crease lines in
 imported artwork (deprecated)
          <bleed-ink>Ink Name</bleed-ink> Spot ink name to use for bleed lines in
 imported artwork (deprecated)
          <cut-layer>Layer Name</cut-layer> PDF layer name to use for cut lines in
 imported artwork (deprecated)
          <crease-layer>Layer Name</crease-layer> PDF layer name to use for crease lines
 in imported artwork (deprecated)
          <bleed-layer>Layer Name</bleed-layer> PDF layer name to use for bleed lines in
 imported artwork (deprecated)
        </product><product> 
          …Additional product(s) to create
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        </product></products></add-products-resource>

Note:  As with product CSV import, one of the following is required to create a product: height/
width, artwork, or a die design. If none of these fields are present, the shape of the product
cannot be determined and Add Products action will fail.

Import Product CSV Action
Description: Add products from CSV file

XML Element: <import-product-csv>

Resource Format:

<import-product-csv-resource><path>Path</path> Path of CSV file (required)
        <preset>Preset Name</preset> Name of preset to import, defaults toStandard Preset
 when not specified
        <base-folder>Folder name</base-folder> Optional base folder to use for relative
 paths
</import-product-csv-resource>

Note:  For non-standard CSV formats, you will need to create a preset beforehand in the Import
Product CSV dialog in Phoenix and use the saved preset name in the <preset> element.

3.4.5.  Importing and Placing Dies, and Assigning Artwork

The hot folder feature includes actions for importing and placing CAD die templates into layouts, auto-
snapping artwork into dies, and assigning artwork files to products automatically.

Import Die Template Action
Modules: CAD Description: Import die template from existing CAD file

XML Element: <import-die-template>

Resource Format:

<import-die-template-resource><path>Path</path> Path of CAD file (required)
        <preset>Preset Name</preset> Name of preset to import, defaults to preset defined
 in preferences for given CAD format when not specified
</import-die-template-resource>

Note:  CAD file format is detected automatically. For PDF-based CAD die templates, the
Structural PDF feature included in Phoenix Pro is required.

Place Die Template Action
Modules: CAD Description: Place imported die template

XML Element: <place-die-template>

Resource Format:

<place-die-template-resource><name>Template Name</name> Name of Template to be placed
        <x>Number</x> X-value of coordinates where template is placed
        <y>Number</y> Y-value of coordinates where template is placed
</place-die-template-resource>
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Assign Artwork Files Action
Description: Automatically assign artwork files in a given folder to products in the jobs based on file
name matching

XML Element: <assign-artwork-files>

Resource Format:

<assign-artwork-files-resource><path>Path</path> Path of artwork files (required)
        <include-sub-folders>Boolean</include-sub-folders> Whether to include artwork in
 subfolders
</assign-artwork-files-resource>

Autosnap Action
Description: Autosnap variable list of artwork files into specific die locations or products in the job

XML Element: <autosnap>

Resource Format:

<autosnap-resource><artworks><artwork><path>Path</path> Path of artwork file (required)
            <front-page>Number</front-page> Front page number to snap, defaults to 1
            <back-page>Number</back-page> Number of back page to snap, defaults to none
 meaning no snap to back side
            <cut-ink>Ink Name</cut-ink> Name of spot cut line ink. Automatically detected
 when not specified
            <products> List of product names to snap artwork into
                <product>Name</product> First product name
                <product>...</product> Additional product name(s)
            <products><dies> List of dies in layout to snap artwork into
                <die number="N" layout="L" /> First die to snap artwork into. Die number
 attribute "number" is required. Layout number attribute "layout" is the layout that the
 die is found on and defaults to layout 1
                <die number="..." layout="..." />Additional die(s) to snap artwork into
                …
            <dies></artwork><artwork>Additional artworks(s) to snap
            ...
            </artwork></artworks></autosnap-resource>

Note:  For each <artwork> element, at least one <product> or <die> is needed. You cannot
however define both products and dies in the same <artwork> element.

3.4.6.  Applying Marks

There are two actions for adding marks to a job in hot folders: Apply Mark and Apply Mark Set. Both
actions support all Smart Mark types. Manual Marks are not supported in automation.

Apply Mark Action
Description: Apply a smart mark from the Marks library to the job

XML Element: <apply-mark>

Resource Format:

<apply-mark-resource><name>Mark Name</name> Name of mark in Marks Library (required)
</apply-mark-resource>
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Apply Mark Set Action
Description: Apply a mark set from the Mark Set library to the job

XML Element: <apply-mark-set>

Resource Format:

<apply-mark-set-resource><name>Mark Set Name</name> Name of mark set in Mark Set Library
 (required)
</apply-mark-set-resource>

Step and Repeat Action
Description: Step and repeat a given product in a layout

XML Element: <step-repeat>

Resource Format:

<step-repeat-resource><product-name>Product Name</product-name> Name of product to step
 and repeat (required)
    <x>X position</x> Optional X position to place repeat group in sheet. This value is
 ignored if an auto-fill option is defined in settings in horizontal direction.
    <y>Y position</y> Optional Y position to place repeat group in sheet. This value is
 ignored if an auto-fill option is defined in settings in vertical direction
    <settings> Settings controlling how step and repeat group is generated (required)
        <rows>Number</rows> Number of rows in step and repeat grid when vertical-fill is
 not set or is None
        <columns>Number</columns> Number of columns in step and repeat grid when
 horizontal-fill is not set or is None
        <head-turn>Head turn</head-turn> Head turn rotation to apply on every other row
 and/or column (None, Row, Column, or ColumnRow)
        <initial-rotation>Number</initial-rotation> Initial rotation to apply to product
 when building step and repeat grid
        <horizontal-gap-type>Gap type</horizontal-gap-type> Horizontal gap type defining
 how gap(s) are interpreted. (Center, Edge, or Smart) Default: Edge
        <vertical-gap-type>Gap type</vertical-gap-type> Vertical gap type defining how
 gap(s) are interpreted. (Center, Edge, or Smart) Default: Edge
        <horizontal-gap>Scalar Value</horizontal-gap> Horizontal gap scalar value
 (required)
        <vertical-gap>Scalar value</vertical-gap> Vertical gap scalar value (required)
        <even-horizontal-gap>Scalar value</even-horizontal-gap> Optional even horizontal
 gap scalar value. When set, horizontal-gap is used for odd horizontal gap spacing while
 this gap value is used for even rows
        <even-vertical-gap>Scalar value</even-vertical-gap> Optional even vertical gap
 scalar value. When set, vertical-gap is used for odd vertical gap spacing while this gap
 value is used for even columns
        <stagger>Stagger type</stagger> Type of stagger to apply to rows or columns. If
 not specified no stagger is applied. (None, Horizontal, or Vertical)
        <stagger-amount>Number</stagger-amount> Stagger amount when stagger is not None
        <stagger-restart>Number</stagger-restart> Number of rows or columns before
 staggeramount is restarted back to 0. If not defined, stagger value continues to be
 applied to each subsequent row or column indefinitely.
        <horizontal-fill>Fill type</horizontal-fill> Whether to automatically fill the
 sheet as much as possible in the horizontal direction. By default horizontal-fill is
 off (None) in which case the columns field needs to be defined. (None, Pack, Expand, or
 Wrap)
        <vertical-fill>Fill type</vertical fill> Whether to automatically fill the sheet
 as much as possible in the vertical direction. By default horizontal-fill is off (None)
 in which case the rows field needs to be defined
        <sheet-margins> When specified, these margins are applied to the sheet to define
 the area to be used for auto fill. If not set the current sheet content margins are
 used.
            <left>Scalar</left> Left sheet margin
            <top>Scalar</top> Top sheet margin
            <right>Scalar</right> Right sheet margin
            <bottom>Scalar</bottom> Bottom sheet margin
        </sheet-margins><bleed-offset>Scalar</bleed-offset> When set, a bleed offset is
 applied to each in the step and repeat group and rectangular bleeds are automatically
 resolved. If not set, product bleed masks are used.
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    </settings></step-repeat-resource>

3.4.7.  Imposition AI

All four Imposition AI tools in Phoenix are available as hot folder actions when the Imposition AI module
is included in your license.

Impose Action
Modules: Imposition AI Description: Run Impose tool on the job with selected products and profile and
apply the most cost-ecient result automatically.

XML Element: <impose>

Resource Format:

<impose-resource><products> Products to include, when not specified all products in the
 job are included
        <product>Product Name</product> First Product
        <product>...</product> Additional product(s)
    </products><profiles><profile>Profile Name</profile> Profile to use, when not
 specified Default profile is used
    </profiles><templates> Templates to use, when not specified all templates matching
 products in the job and Templates library are included
        <template>Template Name</ template > First template
        <template >...</template> Additional template(s)
    </templates ><stop-minutes>Number</stop-minutes> Max time to allow Impose to run in
 minutes
</impose-resource>

Populate Action
Modules: Imposition AI Description: Run Populate tool on the job with selected products and profile,
and apply the first result automatically.

XML Element: <populate>

Resource Format:

<populate-resource><products> Products to include, when not specified all products in the
 job are included
        <product>Product Name</product> First Product
        <product>...</product> Additional product(s)
    </products><profiles><profile>Profile Name</profile> Profile to use, when not
 specified Default profile is used
    </profiles><stop-minutes>Number</stop-minutes> Max time to allow Populate to run in
 minutes
</populate-resource>

Optimize Action
Modules: Imposition AI Description: Run Optimize tool across the given sheet and press combinations
and apply the most cost-effective layout automatically to the job.

XML Element: <optimize>

Resource Format:

<optimize-resource><products> Products to include, when not specified all products in the
 job are included
        <product> Product Name</product>First Product
        <product>...</product> Additional product(s)
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    </products><profiles><profile>Profile Name</profile> Profile to use, when not
 specified Default profile is used
    </profiles><presses> Presses to use from Press library, when not specified all
 presses in library are used
        <press>Press Name</press> Name of first press
        <press>...</press> Name of additional press(es)
        ...
    </presses><sheets> Sheets to use, when not specified all sheets in all product stocks
 are used
        <sheet> First sheet
            <stock>Stock Name</stock> Name of stock to use (required)
            <grade>Grade Name</grade> Name of grade within that Stock
            <name>Sheet Name</name> Name of sheet within that Grade (required)
        </sheet><sheet> Additional sheet(s)
        …
        </sheet></sheets><rolls> Rolls to use, when not specified all rolls in all
 product stocks are used
        <roll> First roll
            <stock>Stock Name</stock> Name of stock to use (required)
            <grade>Grade Name</grade> Name of grade within that Stock
            <name>Sheet Name</name> Name of roll within that Grade (required)
        </roll><roll>Additional roll(s)
        …
        </roll></rolls><templates> Templates to use, when not specified all templates
 matching products in the job and Templates library are included
        <template>Template Name</template> First template
        <template>...</template> Additional template(s)
    </templates><stop-minutes>Number</stop-minutes> Max time to allow Optimize to run in
 minutes
</optimize-resource>

Plan Action
Modules: Imposition AI Description: Run Plan tool across the given sheet and press combinations and
apply the most cost-effective plan automatically to the job.

XML Element: <plan>

Resource Format:

<plan-resource><products> Products to include when running Optimize, when not specified
 all products in the job are included
        <product>Product Name</product> First Product
        <product>...</product> Additional product(s)
    </products><profiles><profile>Profile Name</profile> Profile to use when running
 Optimize, when not specified Default profile is used
    </profiles><presses> Presses to use from Press library, when not specified all
 presses in library are used
        <press>Press Name</press> Name of first press
        <press>...</press> Name of additional press(es)
        ...
    </presses><sheets> Sheets to use, when not specified all sheets in all product stocks
 are used
        <sheet> First sheet
            <stock>Stock Name</stock> Name of stock to use (required)
            <grade>Grade Name</grade> Name of grade within that Stock
            <name>Sheet Name</name> Name of sheet within that Grade (required)
        </sheet><sheet> Additional sheet(s)
            …
        </sheet></sheets><rolls> Rolls to use, when not specified all rolls in all
 product stocks are used
        <roll> First roll
            <stock>Stock Name</stock> Name of stock to use (required)
            <grade>Grade Name</grade> Name of grade within that Stock (required)
            <name>Sheet Name</name> Name of roll within that Grade (required)
        </roll><roll> Additional roll(s)
            …
        </roll></rolls><templates> Templates to use, when not specified all templates
 matching products in the job and Templates library are included
        <template>Template Name</template> First template
        <template >...</template> Additional template(s)
    </templates ><stop-minutes>Number</stop-minutes> Max time to allow Plan to run in
 minutes
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</plan-resource>

3.4.8.  Saving and Exporting Jobs

Save Job Action
Description: Save current job to a given path

XML Element: <save-job>

Resource Format:

<save-job-resource>
    <path>Path</path> Path to save job to (required)
    <embed-artwork>Boolean</embed-artwork> Whether to embed artwork files into the saved
 job (PHX), defaults to preferences
</save-job-resource> 

Save Job Template Action
Description: Save current job as a template to a given path

XML Element: <save-job-template>

Resource Format:

<save-job-template-resource>
    <path>Path</path> Path to save template to (required)
</save-job-template-resource>

Export PDF Action
Description: Export imposed PDF

XML Element: <export-pdf>

Resource Format:

<export-pdf-resource>
    <path>Path</path> Path to save imposed PDF to (required)
    <preset>Preset Name</preset> Name of PDF Export Preset to use, defaults to Factory
 Default PDF Export
</export-pdf-resource>

Export JDF Action
Description: Export absolute path, relative path, or MIME JDF depending on JDF Export Preset used.

XML Element: <export-jdf>

Resource Format:

<export-jdf-resource>
    <path>Path</path> Path to save imposed JDF to (required)
    <preset>Preset Name</preset> Name of JDF Export Preset to use, defaults to Factory
 Default JDF Export
</export-jdf-resource>
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Export Vector Separation Action
Description: Export imposed vector separation file

XML Element: <export-vector-separation>

Resource Format:

<export-vector-separation-resource>
    <path>Path</path> Path to save separation PDF to (required)
    <preset>Preset Name</preset> Name of Export Vector Separation Preset to use
 (required)
</export-vector-separation-resource>

Export Cover Sheet Action
Description: Export Cover Sheet PDF

XML Element: <export-cover-sheet>

Resource Format:

<export-cover-sheet-resource>
    <path>Path</path> Path to save cover sheet to (required)
    <preset>Preset Name</preset> Name of PDF Export Preset to use, defaults to Factory
 Default PDF Export 
</export-cover-sheet-resource>

3.4.9.  Exporting Die Layouts

The hot folders feature supports four actions for exporting jobs layouts as dies or cutting data for post-
press: Export CFF2 Layout, Export PDF Layout, and Export Cutting JDF.

Export CFF2 Layout Action
Description: Export job layout in CFF2 CAD layout format

XML Element: <export-cff2-layout>

Resource Format:

<export-cff2-layout-resource>
    <path>Path</path> Path to save CFF2 layout file to (required)
    <preset>Preset Name</preset> Name of CFF2 Export Preset to use, defaults to CF2
 Default Preset
</export-cff2-layout-resource>

Export PDF Layout Action
Description: Export job layout die lines as PDF file

XML Element: <export-pdf-layout>

Resource Format:

<export-pdf-layout-resource>
    <path>Path</path> Path to save PDF Die Layout file (required)
    <preset>Preset Name</preset> Name of PDF Die Layout Preset to use, defaults to PDF
 Default Preset
</export-pdf-layout-resource>
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Export Cutting JDF Action
Description: Export cutting JDF file, i.e. CIP4 cutting data.

XML Element: <export-cutting-jdf>

Resource Format:

<export-cutting-jdf-resource>
    <path>Path</path> Path to save Cutting JDF file to (required)
    <preset>Preset Name</preset> Name of PostScript Die Layout Preset to use, defaults to
 PostScript Default Preset
</export-cutting-jdf-resource>

3.4.10.  Reports

Hot folder automation supports all three Phoenix report formats: PDF, XML, and JSON. PDF reports are
ideal for sharing job estimates with colleagues or clients, while text-based XML and JSON formats are
designed to pass job and product information back to the MIS and/or workflow system.

Export PDF Report Action
Description: Export PDF job report

XML Element: <export-pdf-report>

Resource Format:

<export-pdf-report-resource>
    <path>Path</path> Path to save PDF report to (required)
    <preset>Preset Name</preset> Name of PDF job report preset to use, defaults to PDF
 Report Default Preset
</export-pdf-report-resource>

Export XML Report Action
Description: Export XML job report

XML Element: <export-xml-report>

Resource Format:

<export-xml-report-resource>
    <path>Path</path> Path to save XML report to (required)
    <preset>Preset Name</preset> Name of XML job report preset to use, defaults to XML
 Report Default Preset
</export-xml-report-resource>

Export JSON Report Action
Description: Export JSON job report

XML Element: <export-json-report>

Resource Format:

<export-json-report-resource>
    <path>Path</path> Path to save JSON report to (required)
    <preset>Preset Name</preset> Name of JSON job report preset to use, defaults to JSON
 Report Default Preset
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</export-json-report-resource>

3.5.  Scripting

With scripting, anything is possible.

Phoenix can use scripts in multiple places to automate and empower you to do more than ever:

• Use scripts in Hotfolders to take them to the next level

• Use scripts in Impostion AI to iterate through layout results

• Use scripts in Script Marks to create any mark you can think of

• Use scripts in file exports to enable advanced customization of the reports

• Use Action Scripts to script the UI

For even more on scripting, our entire scripting library is available for you in the scripting folder in the
nav bar on the left.

Note:

GitHub Repo

We've shared some scripting examples and files on our github page! Check out tilia-phoenix-
scripts (opens new window) as we continue to build out our examples and share ideas and
suggestions for things you want to see!

An overview of all classes can be found here

3.5.1.  HotFolder Scripting

Hotfolders automation includes an optional scripting interface, providing an unprecedented amount of
customization during automation. Scripting is done in the popular JavaScript language.

There are several uses for scripting in hot folders. Below are some of the more common examples:

• Support input files with formats other than the standard Resources XML format described in
this document. For example, another XML format, CSV spreadsheet, or other text-based format
containing information about the job to be automated.

• Waiting for a certain number of input files to come into the hot folder or a certain duration before
performing actions.

• Analyzing the results of ganging tools to remove layouts that do not meet certain criteria such as
sheet usage or waste and moving products from these layouts back into the input file to be ganged
with more incoming files.

• Customized notification when a job has succeeded or failed. Provided utility methods in the
scripting environment make it easy to send email alerts or record error details in local files.

• Convert image files to PDFs or breaking up large PDFs into tiles using the PDFUtils utility methods.
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Scripting Hooks
Hot folder scripting has three entry points that you can implement to add custom behavior to hot
folders: onStart(), onSuccess(), and onFail(). All three functions are optional, but at least one of these
functions needs to be implemented in a script when it is loaded into a hot folder.

onStart()
Description: Initial hook when a file comes into the hot folder. This function is called before any
actions are processed to convert the incoming file into a list of resource objects needed by the actions
in the hot folder, perform tiling or image to PDF conversion, delay processing based on a custom
trigger event, and more. Trigger Event: Called when a file comes into the hot folder with file extension
matching the file-type attribute in <phoenix-actions> element, or .xml if file-type is not specified.

Arguments:

• state (FolderState): Hot folder state
• inputs (InputFile List): List of InputFiles
• Return Type: A JavaScript array of resource objects needed by actions. These are the same

resource objects that are normally represented in Resources XML files. Note: As mentioned in the
Actions XML Format section, by default hot folders watch for files with the .xml extension. If the
file format you are processing in onStart() does not have a .xml extension you need to specify the
expected extension in the Actions XML file in the <phoenix-actions> element attribute called "file-
type". For example, if the incoming file in the hot folder is a CSV file with extension .csv, the Actions
XML needs to specify the csv extension:

<phoenix-actionsversion="1.0"file-type="csv">

onSuccess()
Description: Hook called when all actions in the hot folder have completed successfully. This hook
is useful for sending notification emails, adding custom logging, moving per-layout export files into
folders organized by presses/stocks, moving products in sub-par layouts back into the input folder, and
more. Trigger Event: All actions in the hot folder have completed successfully for a given task.

Arguments:

• state (FolderState) – Hot folder state (see section 3.5.2)
• inputs (InputFile List) -List of InputFiles (see section 3.5.3)
• job (JobEntity) – Job object representing detailed information about the job that completed. Job

entity format is the same as the JSON job report. You can find the formal schema definition in this
guide under the Schemas folder. Return Type: None

onFail()
Description: Hook called when an error occurred during hot folder processing. This hook is useful for
sending notification emails or recording the event by other means. Trigger Event: An error occurred
during processing for a given task. Arguments:

• state (FolderState) – Hot folder state (see section 6.2)
• inputs (InputFile List) -List of InputFiles (see section 6.3)
• report (ErrorReport) – Error report listing errors and warnings that occurred during task processing.

Error Report format formal schema definition in this guide under the Schemas folder. Return Type:
None
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Classes

FolderState Class

Method Description Arguments Return Type

getName() Returns the HotFolder
name

None Hotfolder name as a
String

getTaskId () Method for getting
the task ID. Task IDs
are automatically
generated unique IDs
used for tracking and
logging.

None Task Id as a string

getOutputFolder() Method for getting the
output folder

None Configured output
folder path as a string

getData() Method for retrieving
values from the data
store for this hot folder.
Data store can be used
in scripting to record
state across scripting
hook calls

key (String) – the key
for the desired value

Data value as a string

setData() Method for recording
values in the data store

key (String) – the key to
associate with the value

value (String) - value
being added to the map

None

removeData() Method for removing
values from the data
store

key (String) – the key
for the value being
removed

None

debug() Method for adding a
debug message to this
hot folder's logs. Log
messages will appear in
Hot Folder View.

message (String) –
message to be added

None

info() Method for adding a
info message to this hot
folder's logs

message (String) –
message to be added

None

error() Method for adding a
error message to this
hot folder's logs

message (String) –
message to be added

None

InputFile Class
Input file class representing a single input file in a hot folder
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Method Description Arguments Return Type

isProcessed() Method returning
whether the file was
processed

None Boolean. Returns true
if the file has been
processed

getName() Method gets file name None File name as a String

getPath() Method gets file path None File path as a String

getLastModified() Method gets time stamp
of when the file arrived
in the input folder

None Long (Time Stamp)

moveToProcessed() Method to move
an input file to the
processed state
and corresponding
processed folder

None Boolean, returns true
if file is successfully
moved

moveToErrors() Method to move file to
Errors Folder

None Boolean, returns true
if file is successfully
moved

moveToInput() Method to move file to
Input Folder

None Boolean, returns true
if file is successfully
moved

Mail Class

Method Description Arguments Return Type

getHostname() Gets the Hostname None Hostname as a string

setHostname() Sets the Hostname hostname (String) None

getSmtpPort() Gets the SMTP port
number

None SMTP port number as a
string

setSmtpPort() Sets the SMTP port
number

number (Int) – SMTP
port number

None

setAuthentication() Sets the username
and password for
authentication

username (String)

password (String)

None

setFrom() Sets the from address address (String) – From
address

None

setSubject() Sets the email subject subject (String) None

setMessage() Sets the email message
text

message (String) None

addTo() Adds a recipient
address

address (String) None

addCc() Adds a Cc address address (String) None

addBcc() Adds a Bcc address address (String) None

send() Sends the email None None
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Method Description Arguments Return Type

setUseTls() Sets the use of
Transport Layer
Security (TLS)

useTls (Boolean) None

setUseSsl() Sets the use of Secure
Sockets Layer (SSL)

useSsl (Boolean) None

getSslSmtpPort() Gets the SSL SMTP port
number

None SSL SMTP port number
as a string

setSslSmtpPort() Sets the SSL SMTP port
number

Number (Int) – SSL
SMTP port number

None

addHeader() Adds a header to the
email

name (String) – Header
name

value (String) – Header
value

None

Document Class
Document class representing a PDF document

Method Description Arguments Return Type

pageCount() The page count of the
document

None Number – The number
of pages in the
document

page() Page in the document pageNumber (Number)
– page number to return

Page class – Page
for the page number
specified

pages() Pages in the document None Array of pages

save(String path) Save the document Path (String) – Path to
save document to

None

close() Close the document None None

Page Class
Page class representing a page of PDF document

Method Description Arguments Return Type

getMediaBox() Gets the mediaBox Rect
of the PDF page

None Rect

setMediaBox() Sets the mediaBox Rect
on the PDF page

mediaBox (Rect) None

getCropBox() Gets the cropBox Rect
of the PDF page

None Rect

setCropBox() Sets the cropBox Rect
on the PDF page

cropBox (Rect) None

getTrimBox() Gets the trimBox Rect
of the PDF page

None Rect
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Method Description Arguments Return Type

setTrimBox() Sets the trimBox Rect
on the PDF page

trimBox (Rect) None

getBleedBox() Gets the bleedBox Rect
of the PDF page

None Rect

setBleedBox() Sets the bleedBox Rect
on the PDF page

bleedBox (Rect) None

getArtBox() Gets the artBox Rect of
the PDF page

None Rect

setArtBox() Sets the artBox Rect on
the PDF page

artBox (Rect) None

Rect Class
Input file class representing a single input file in a hot folder

Method Description Arguments Return Type

getX() Returns the x value of
the Rect position

None Double

setX() Sets the x value of the
Rect position

x (Double) None

getY() Returns the y value of
the Rect position

None Double

setY() Sets the y value of the
Rect position

y (Double) None

getWidth() Returns the width of the
Rect

None Double

setWidth() Sets the width of the
Rect

width (Double) None

getHeight() Returns the height of
the Rect

None Double

setHeight() Sets the height of the
Rect

height (Double) None

Utility Classes
Several utility classes are provided within the scripting environment for moving and parsing files,
working work PDFs, sending email notifications and more.

JobUtils

Method Description Arguments Return Type

open() Opens a Phoenix job
(PHX) at the given path
and returns the full Job
entity for that job

path (String) – File path Job Entity object
representing opened
job or thrown exception
on failure
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Method Description Arguments Return Type

artworkFiles() Opens a Phoenix job
(PHX) at the given path
and returns all original
artwork file paths
referenced in the job

path (String) – File path Array (String) of
artwork files path

FileUtils

Method Description Arguments Return Type

tempPath() Returns the standard
system temporary
directory

File directory as a string

tempFile() Creates a temporary file
and returns the full path

File path as a string

mkDir() Create a new local
directory with the given
path

Path (String) File path Boolean returns
true if directory was
successfully created

filename() Retrieves the file name path (String) – File path File name as string
excluding parent folders

basename() Retrieves the base file
name

path (String) – File path Base file name as string

directory() Retrieves the file's
directory

path (String) – File path File directory as a string
excluding file name

isDirectory() Check if path is a
directory

path (String) – File Path Boolean returns true if
path is a directory

isFile() Check if path is a file path (String) – File Path Boolean returns true if
path is a File

copyFile() Copies file from 'source'
to 'destination'

source (String) – The
source file

destination (String) –
The destination of the
file being copied

Boolean, returns true on
successful copy

moveFile() Moves 'source' file to
'destination'

source (String) – The
source file

destination (String) –
The destination of the
file

Boolean, returns true on
successful move

concat() Appends the file name
to the base path

base path (String)

filename (String)

Returns combined base
path and file name as a
string

text() Extracts all text from a
file into a single string

path (String) – File path

encoding (String) –
Optional text encoding,

file text as a string

462



3Phoenix

Method Description Arguments Return Type
defaults to UTF-8 if
omitted

lines() Extracts all text from a
file into a list of strings
for each line in the file

path (String) – File path

encoding (String) –
Optional text encoding,
defaults to UTF-8 if
omitted

File text as a list of
strings

files() Lists all files of given
types in the specified
directory

directory (String) –
Directory to search in

extensions (String) –
Optional extension of
file types to include,
defaults to all file types

recurse (Boolean) –
Optional search for
files recursively in sub-
folders

List of file paths

csv() Generates a list of
string arrays from a CSV
file's values with each
array representing a
row of the CSV file

path (String) – Path of
CSV file

CSV values as a list of
arrays of string cell
values

xml() Reads an XML file into a
DOM object

path (String) – Path of
XML file

DOM Object

find() Retrieves file with
'filename' in given
'directory' searching
recursively into child
directories

directory (String) – File
directory

filename (String) – File
name

Absolute path of the file
as a string

delete() Deletes a file path (String) – Path of
file to be deleted

None

MailUtils

Method Description Arguments Return Type

create() Creates a new email hostname (String) –
Server host name

port (Int) – Port number
(optional), defaults to 25

Mail Object
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PDFUtils

Method Description Arguments Return Type

Open() Opens a PDF document path (String) – Path to
the PDF document

Document

createFromImage() Create PDF document
from an image

path (String) – Image
file path

Document

createFromImage() Create PDF document
from an image

path (String) – Image
file path

width (String) –
Document width in
points

height (String) -
Document height in
points

Document

createTiles() Create tiled PDF
document

path (String) – Path of
Document to be tiled

rects (Rects List) – Tile
rects

bleed (String) – Tile
bleed

Document

createTiles() Create tiled PDF
document

document (String) –
Document to be tiled

rects (Rects List) – Tile
rects

bleed (String) – Tile
bleed

Document

impose() Impose a multi-page
artwork file using a
given folding pattern
and binding method,
saving the resulting PDF
file to a given output
path with option to
separate cover

artwork (String) – Input
artwork file

foldingPattern (String)
– Name of folding
pattern in Folding
library to use while
imposing artwork pages

bindingMethod (String)
– Name of binding
method being used

pageMargins (Margins)
– Sheet margins to add

faceTrim (String) –
Amount of face trim

headTrim (String) –
Amount of head trim

None
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Method Description Arguments Return Type
footTrim (String) –
Amount of foot trim

spineSize (String) –
Size of book spine

separateCover (String)
– If set to "true" exports
the cover pages of the
artwork to a separate
file with "-cover" postfix
added to output path

output (String) – Output
path to save imposed
PDF to

saveSubSet() Opens a PDF file at
inputPath and saves
all the pages between
startPage and endPart
inclusively to an
outputPath as a new
PDF

path (String)- Path of
Document

Name (String) Output
name

Start(Int) start page

End(Int) end page

Document

GeomUtils

Method Description Arguments Return Type

rect() Creates new Rect None Rect

rect() Creates a Rect at
position (x,y) of
dimensions ('width' X
'height')

x (Double) – x value of
the Rect

y (Double) – y value of
the Rect

width (Double) – Rect
width

height (Double) – Rect
height

Rect

Example Hotfolder Scripts
Below you'll find some example scripts and snippets to help you understand how scripting works, as
well as help with some common scripting needs

Find a product's custom property
You can access a product's default properties fairly simply, by using product.index or product.name.
If you want to access a custom property, however, they are stored in a properties list inside of the
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product. An easy way to find your property is to loop through the custom properties and return the
value if the property name matches the one you're looking for:

// Grab first product to find product properties
// required for file naming. Could place this in 
// a loop to look through all products

var product = job.products.get(0);

// Loop through all of this product's properties, 
// saving StoreNum property values
for (var i=0; i<product.properties.size(); i++) {
    var property = product.properties.get(i);

    if (property.name == "StoreNum"){
        var store = property.value;
    }
}

3.5.2.  Imposition AI Scripting

Imposition AI provides the option to run scripts when layout results are applied, providing some
powerful tools to evaluate layouts, modify them, and access items within the layouts.

Example Imposition AI Script
Below you'll find an example script to help you understand how scripting works, as well as help with
some common scripting needs. More examples will be added over time, so check back later for more
examples. Keep in mind that Tilia Labs does offer solution services for building custom marks, so reach
out to your salesperson to inquire about scripting today!

Find the layout template, and save it as a product property
This script looks through each layout and finds the template used in the layout. Then it adds the
layout name as a custom product property to the first product. The use case for this one is that the
user needed to add a custom barcode mark to each layout with the template name. This wasn't easily
possible in version 7 so this script solved the problem: After Imposition AI was run, a barcode mark was
applied to the layout using the keyword <layout.product.1.LayoutTemplate>. This script is delivered as
is to help share scripting concepts and is not designed to be used in production.

/*
 * Tilia Labs Inc.
 * Copyright (c) 2012-*, All Rights Reserved
 * Script author: david@tilialabs.com
 */

var PROPERTY_NAME = "LayoutTemplate";

function run(context) {
  // Get the job we are currently operating on
  var job = context.job;

  // Get the jobs api for performing actions on jobs
  var jobs = context.jobs;
  // Loop over each layout in the job
  var layoutIndex;
  for (layoutIndex = 0; layoutIndex < job.layouts.size(); layoutIndex++) {
    var layout = job.layouts.get(layoutIndex);
    var template = layout.templates.get(0).name

    // Get the list of products placed on this layout
    var products = context.layoutProducts(layout.index);
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    if (products != undefined && products != null) {
      // Loop over each layout placed in the layout
      var productIndex;
      var product = products.get(0);
      jobs.setProductProperty(
        job.id,
        product,
        PROPERTY_NAME,
        //SET NEW PRODUCT PROPERTY VALUE BELOW, 
        template
      );
    }
  }
}

3.5.3.  Mark Scripting Example

Below you'll find some example scripts and snippets to help you understand how scripting works, as
well as help with some common scripting needs

Find a product's custom property
This script looks through all items in a layout, and finds products in the layout. Then it finds the
products location and index property, and draws the index on top of the product. This script is
delivered as is to help share scripting concepts and is not designed to be used in production.

/*
 * Tilia Labs Inc.
 * Copyright (c) 2012-*, All Rights Reserved
 * Script author: david@tilialabs.com
 * 
 * Product Index Mark - 2021-02-05
 *
 * This script looks through all items in a layout, and finds 
 * products in the layout. Then it finds the products location 
 * and index property, and draws the index on top of the product. 
 * This script is delivered as is to help share scripting 
 * concepts and is not designed to be used in production. 
 * 
 */

// Create array to store layout items
var items = [];

function run(context){
    // find items on the layout
    var products = findProducts(context,context.root)
    for (var i=0;i<items.length;i++) {
        var product = items[i]
        // Set product name
        var productName = product.name
        // Find product location on sheet
        var productX = product.globalRect.left;
        var productY = product.globalRect.bottom;
        // Find product width and height
        var productHeight = getProductHeight(context, productName)
        var productWidth = getProductWidth(context, productName)
  
        // Find product property
        var productIndex = getProductIndex(context, productName);

        // Create a drawable painter from the mark context
        var painter = new Painter(context.data);
        // Create color to be used in mark
        var ink = new Color(100, 0, 100, 0);
        // Clear the pen so there will be no stroke
        painter.clearPen();
        painter.clearBrush();
        // Set brush (fill) color
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        painter.setBrush(ink);
        // Set font and style
        var titleFont = new Font("Times New Roman");
        titleFont.style = "Bold";
        // Set title text and font
        var title = new Text(productIndex);
        title.font = titleFont;
        title.size = 72;
        // Set title location
        title.point = new Point(
            productX,
            productY
        );
        painter.draw(title);
    }
    return true;
}

function findProducts(context,item) {
    // if item is a product, store it in array
    if (item.type === Type.Product) {
  context.log("Found***")
        items.push(item)
    }
    // continue to look through additional items and loop
    // back in to see if there are more product items
    var children = item.children;
    for (var index = 0; index < children.size(); index++) {
      var child = findProducts(children.get(index));
      if (child !== undefined) {
        return;
      }
    }
    return;
  }

function getProductHeight(context, productName) {
    // take product item and see if its name matches
    // a job product. If so, return height
    for(var i=0;i<context.job.products.size();i++) {
        var product = context.job.products.get(i);
        if (product.name == productName) {
            return product.height;
        }
    }
}

function getProductWidth(context, productName) {
    // take product item and see if its name matches
    // a job product. If so, return width
    for(var i=0;i<context.job.products.size();i++) {
        var product = context.job.products.get(i);
        if (product.name == productName) {
            return product.width;
        }
    }
}

function getProductIndex(context, productName) {
    // take product item and see if its name matches
    // a job product. If so, return product index.
    // this function can be modified to get any product
    // property
    for(var i=0;i<context.job.products.size();i++) {
        var product = context.job.products.get(i);
        if (product.name == productName) {
            return product.index;
        }
    }
}
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3.6.  Phoenix2Switch App

Phoenix automation offers seamless integration with the popular Enfocus Switch workflow solution
via the Phoenix2Switch app, available in the Enfocus AppStore. This app provides two modes for
automating the Plan Imposition AI tool in Phoenix: through CSV import and directly from artwork files.
In both modes, you have full control over all product properties, Plan settings, and export actions
through Switch properties.

A full explanation of the Phoenix2Switch app, can be found here

3.7.  CERM Connector

Phoenix automation includes seamless integration with the popular CERM MIS System (opens new
window). In this integration, Phoenix is driven completely by CERM through its user interface. This
combination is especially compelling for sheet-fed label ganging.

3.7.1.  Requirements

Automation of Phoenix within CERM requires the Automate and Imposition AI modules in Phoenix.
Phoenix version 8.0 or higher is required to work with CERM 7.28 and above.

3.7.2.  Using the CERM Connector

The steps for getting started are similar to other automation options in Phoenix.

1. Open the Automate Panel in Phoenix

Go to the Windows menu and click on "Automation". The Automation Panel should appear on the left
side of the Phoenix window.

2. Start CERM Connector in Phoenix

If the Automate panel does not include the CERM Connector, click on the upper left corner of the
panel and select "Add CERM Connector" from the dropdown menu.
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Right click on the CERM Connector entry in the Automation Panel and click "Start" from the context
menu to start the service. CERM MIS can now access Phoenix automation.

 

 

Note:  If you would like the CERM Connector to start automatically when Phoenix launches,
select "Auto Start" from the context menu. This is strongly recommended when you are mostly
driving Phoenix from CERM.
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